Modular Messaging Software

Release 2

Messaging Application Server Administration Guide

for Avaya Modular Messaging with the Avaya MAS and MSS
To prevent intrusions to your telecommunications equipment, you and your responsibility on acquired knowledge and resources from a variety of sources communications peers, and your managers. Base the fulfillment of your ment rests with you – an Avaya customer's system administrator, your tele-
The final responsibility for securing both this system and its networked equip-

Avaya Web Page
The world wide web home page for Avaya is:
http://www.avaya.com

Preventing Toll Fraud
Toll Fraud is the unauthorized use of your telecommunications system by an unauthorized party (for example, a person who is not a corporate employee, agent, subcontractor, or working on your company’s behalf). Be aware that there is a risk of toll fraud associated with your system and that, if toll fraud occurs, it can result in substantial additional charges for your telecommunications services.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need technical assistance or support, call the Technical Service Center’s Toll Fraud Intervention Hotline at 1.800.643.2353.

Providing Telecommunications Security
Telecommunications security of voice, data, and/or video communications is the prevention of any type of intrusion to, that is, either unauthorized or malicious access to or use of, your company’s telecommunications equipment by some party.

Your company’s “telecommunications equipment” includes both this Avaya product and any other voice/data/video equipment that could be accessed via this Avaya product (that is, “networked equipment”).

An “outside party” is anyone who is not a corporate employee, agent, subcontractor, or working on your company’s behalf. Whereas, a “malicious party” is Anyone, including someone who may be otherwise authorized, who accesses your telecommunications equipment with either malicious or mischievous in-

Such intrusions may be either to/through synchronous (time-multiplexed and/ or circuit-based) or asynchronous (character-, message-, or packet-based) equipment or interfaces for reasons of:

• Utilization (of capabilities special to the accessed equipment)
• Theft (such as, of intellectual property, financial assets, or toll-facility access)
• Eavesdropping (privacy invasions to humans)
• Miscrief (troubling, but apparently innocuous, tampering)
• Harm (such as harmful tampering, data loss or alteration, regardless of motive or intent)

Be aware that there may be a risk of unauthorized intrusions associated with your system and/or its networked equipment. Also realize that, if such an intrusion should occur, it could result in a variety of losses to your company, including but not limited to, human/data privacy, intellectual property, material assets, financial resources, labor costs, and/or legal costs).

Your Responsibility for Your Company’s Telecommunications Security
The final responsibility for securing both this system and its networked equipment rests with you – an Avaya customer’s system administrator, your telecommunications peers, and your managers. Base the fulfillment of your responsibility on acquired knowledge and resources from a variety of sources including but not limited to:

• Installation documents
• System administration documents
• Security documents and anti-virus patches
• Hardware/software-based security tools
• Shared information between you and your peers
• Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your peers should carefully program and configure your:

• Avaya provided telecommunications systems and their interfaces
• Avaya provided software applications, as well as their underlying hardware/software platforms and interfaces
• Any other equipment networked to your Avaya products

Avaya does not warrant that this product is immune from or will prevent unauthorized use of telecommunications services or facilities accessed through or connected to it. Avaya is not responsible for any damages or charges that result from either unauthorized uses or from incorrect installations of the security patches that are made available from time to time. Suspected security vulnerabilities with Avaya products should be reported to Avaya by sending mail to securityalerts@avaya.com.

Federal Communications Commission Statement
Part 15: Class A Statement. This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio-frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at his own expense.

Industry Canada (IC) Interference Information
This digital apparatus does not exceed the Class A limits for radio noise emissions set out in the radio interference regulations of Industry Canada.

Le Présent Appareil Nomérique n’émet pas de bruits radioélectriques dépas-
sant les limites applicables aux appareils numériques de la class A préscrites dans le reglement sur le brouillage radioélectrique édicté par le Industrie Can-
da.

Trademarks
All trademarks identified by ® and ™ are registered trademarks or trademarks of Avaya Inc. All other trademarks are the property of their respective owners.

Ordering Information
Call: Avaya Publications Center
Voice 1 800 457-1235  International Voice +1 207 866 6701
Fax 1 800 457-1764  International Fax +1 207 626 7269

Write: GlobalWare Solutions
200 Ward Hill Avenue
Haverhill, MA 01835 USA
Attn: Avaya Account Management

Email: totalware@gwsmail.com

Obtaining Products
To learn more about Avaya products and to order products, visit www.avaya.com.

European Union Declaration of Conformity
The “CE” mark affixed to the equipment means that it conforms to the referenced European Union (EU) Directives listed below:

EMC Directive89/336/EEC
Low-Voltage Directive73/23/EEC

For more information on standards compliance, contact your local distributor.

Warranty
Avaya Inc. provides a limited warranty on this product. Refer to your sales agreement to establish the terms of the limited warranty. In addition, Avaya’s standard warranty language as well as information regarding support for this product, while under warranty, is available through the following web site: www.avaya.com/support.
# Contents

Preface ix

## Chapter 1  Messaging Application Server (MAS) Basics

- System administration tools .................................................. 1-2
  - Voice Mail System Configuration .......................................... 1-2
  - Visual Voice Editor .......................................................... 1-2
  - Caller Applications Editor .................................................. 1-2
- Preventive maintenance ....................................................... 1-3
- Backing up system data ....................................................... 1-3
- Diagnostic and reporting tools .............................................. 1-4
  - Operation History Viewer .................................................. 1-4
  - Monitoring tools ............................................................. 1-4
  - Reporting Tool ............................................................... 1-4
- Logging in to a messaging application server ............................. 1-5
- Opening Messaging Application Server programs ........................ 1-5
- Changing the display language ............................................. 1-5

## Chapter 2  Introduction to Voice Mail System Configuration

- Introduction to Voice Mail System Configuration .......................... 2-2
- Opening Voice Mail System Configuration .................................... 2-3
- Changing the home MAS ...................................................... 2-5
- Supporting messaging subscribers ......................................... 2-6

## Chapter 3  Telephone User Interface Administration

- Introduction to configuring the telephone user interface .................. 3-2
- Configuring TUI general properties ......................................... 3-4
- Configuring TUI receptionist properties ................................... 3-6
- Configuring time and greeting properties ................................... 3-8
- Configuring message timing properties ..................................... 3-10
- Configuring subscriber properties ......................................... 3-12
- Configuring caller properties .............................................. 3-14
### Chapter 4  PBX Configuration
- Introduction to configuring a PBX .......................... 4-2
- Configuring PBX properties (analog) ......................... 4-4
- Configuring PBX properties (IP H.323) ...................... 4-13
- Configuring PBX properties (QSIG) ......................... 4-16
- Configuring PBX properties (set emulation) ............... 4-25

### Chapter 5  Voice Mail Domain Administration
- Introduction to configuring a voice mail domain ........... 5-2
- Configuring the Automated Attendant ....................... 5-5
- Configuring Call Me ........................................ 5-13
- Configuring message waiting indicator (MWI) ............. 5-16
- Configuring fax ............................................. 5-18
- Configuring voice mail domain security .................... 5-25
- Configuring message store security ......................... 5-28
- Configuring the Privacy Enforcement Level ................. 5-30
- Configuring languages ...................................... 5-32
- Configuring the audio encoding format ..................... 5-34
- Configuring access to messages when the MAS goes offline .... 5-35
- Configuring serviceability .................................. 5-38
- Viewing and configuring licensing ............................ 5-43
- Configuring the tracing system .............................. 5-48

### Chapter 6  Telephony Interface Configuration
- Introduction to configuring the telephony interface ...... 6-2
- Configuring the analog telephony interface ................. 6-3
- Configuring the telephony interface for IP H.323 ......... 6-5
- Configuring the telephony interface for QSIG or set emulation .... 6-6
- Configuring automatic call distribution (ACD) ............ 6-8

### Chapter 7  PBX Integration
- Introduction to configuring PBX integration ............... 7-2
- Selecting a PBX type ........................................ 7-5
- Configuring PBX integration general properties .......... 7-6
- Configuring serial general properties ..................... 7-8
- Configuring serial NEC/ Ericsson/ DMID properties ....... 7-10
- Configuring inband properties ................................ 7-12
- Configuring remote properties .............................. 7-19
- Configuring QSIG and set emulation properties ........... 7-20
- Configuring C-LAN properties ................................ 7-22
- Configuring PBX integration properties for IP H.323 ....... 7-24
Chapter 8  Messaging Application Server Configuration
Introduction to configuring a messaging application server ........................................... 8-2
Selecting an MAS for the first time ................................................................. 8-3
Configuring messaging ................................................................. 8-4
Configuring text-to-speech ................................................................. 8-6
Viewing languages installed on the MAS ......................................................... 8-10
Configuring port groups ................................................................. 8-11
Configuring MAS serviceability ............................................................... 8-16
Configuring the tracing file size ............................................................... 8-18
Adding or removing MASs ................................................................. 8-19

Chapter 9  Voice Mail Domain Management
Introduction to managing voice mail domains ................................................... 9-2

Chapter 10  Custom Prompts
Introduction to customizing prompts .......................................................... 10-2
Creating a working copy of the prompt file ...................................................... 10-6
Changing the audio format ................................................................. 10-7
Working with Visual Voice Editor ............................................................... 10-8
Starting Visual Voice Editor ................................................................. 10-8
Screen areas and controls ................................................................. 10-8
Setting up customized prompts ....................................................................... 10-11
Copying changes across MASs ....................................................................... 10-20
Configuring customized prompts ..................................................................... 10-21
Importing and exporting recordings ................................................................... 10-26

Chapter 11  Caller Applications
Introduction to caller applications ........................................................................ 11-2
About the Caller Applications software ........................................................ 11-3
Caller Applications Editor .............................................................................. 11-3
Caller Applications Runtime .......................................................................... 11-3
Creating caller applications (process overview) ................................................ 11-6
Using the Caller Applications Editor ........................................................... 11-11
Starting the Caller Applications Editor ........................................................ 11-11
Understanding and using the Action menu ..................................................... 11-12
Understanding the toolbar icons ...................................................................... 11-14
Administering caller applications ...................................................................... 11-17
Caller application deployment .......................................................................... 11-42

Chapter 12  Reports
Introduction to reports ....................................................................................... 12-2
Enabling transaction generation ........................................................................ 12-4
Selecting a data source ...................................................................................... 12-5
Specifying options for report generation ......................................................... 12-8
Generating an Hourly Statistics report ................................................................. 12-9
Generating a Login Failures report ................................................................. 12-12
Generating a Port Statistics report ............................................................... 12-15
Generating a System Usage report ............................................................... 12-18
Generating a User Mailbox Statistics report ............................................. 12-23
Generating a Basic Metrics report ............................................................... 12-27
Zooming in on reports ................................................................................. 12-30
Exporting reports ......................................................................................... 12-31
Printing reports ........................................................................................... 12-34

Chapter 13 Operation History Events
Introduction to viewing operation history events ........................................... 13-2
  Understanding session files ......................................................................... 13-2
  Starting Operation History Viewer ............................................................. 13-3
Enabling collection of operation history events ........................................... 13-4
Selecting a data source ............................................................................... 13-5
Creating sessions ......................................................................................... 13-8
Viewing a session ......................................................................................... 13-13
Saving sessions ........................................................................................... 13-16
Opening sessions ......................................................................................... 13-17
Displaying or changing session properties ................................................ 13-18
Displaying event properties ....................................................................... 13-19
Exporting operation history events ............................................................. 13-20
Setting new session defaults ..................................................................... 13-22

Chapter 14 System Performance Monitoring
Introduction to monitoring ........................................................................... 14-2
Using Performance Monitor ......................................................................... 14-3
Using Port Monitor ......................................................................................... 14-8
Testing Dialogic lines .................................................................................. 14-16

Chapter 15 Event, Error, and Alarm Logs
Overview of event, error, and alarm logs on the MAS .................................. 15-2
Displaying the MAS event and error logs .................................................... 15-3
Displaying the MAS alarm logs ................................................................. 15-5

Appendix Appendix A: MAS Alarms
CM (Call Me) alarms .................................................................................. A-3
MM (Mailbox Monitor) alarms ................................................................... A-4
MT (Maintenance) alarms .......................................................................... A-6
MW (Message Waiting Indicator) alarms .................................................. A-15
TS (tracing server) alarms .......................................................................... A-17
VB (Avaya Voice Browser) alarms ............................................................. A-18
VS (Voice server, MAS-specific) alarms ..................................................... A-23
Appendix Appendix B: Examples of Caller Applications
   A word to AUDIX users ................................................................. B-2
   The caller application creation process ......................................... B-4
   Examples of caller applications .................................................. B-5

Appendix Appendix C: Stopping and (re)starting Modular Messaging (MM) services
   Stopping a Modular Messaging (MM) service ............................ C-2
   Starting (Restarting) a Modular Messaging (MM) service ............. C-3

Appendix Appendix D: Glossary

Index 1
Preface

Overview

This guide provides all the information necessary to administer the Avaya Modular Messaging software on a messaging application server (MAS). It includes comprehensive step-by-step instructions on important tasks, such as how to configure the MAS and run diagnostic tools.

Audience

This guide is intended for use by system administrators. It assumes familiarity with mail server administration. The audience should also have a basic understanding of S3400 family message server concepts, as outlined on the Avaya Modular Messaging Release 2 Documentation, 585-310-819, Issue 1, CD-ROM.
Modular Messaging documentation

See the following documentation for more information about Avaya Modular Messaging on the S3400 family of messaging servers:

- **Avaya Modular Messaging Release 2 Documentation**, 585-310-819, Issue 1, CD-ROM.
  
  Contains all documentation about the Avaya Modular Messaging, including concepts and feature descriptions, and instructions for administration, installation, maintenance, and other user information. This information includes the documents that follow, in PDF format.

- **Avaya Modular Messaging Release 2 Installation**, 585-310-332
  
  Provides information on how to install both the message storage server and the messaging application server.

- **Avaya Modular Messaging Client Access to a Subscriber Mailbox**, 585-310-790, Issue 2
  
  Provides information on how to install the Modular Messaging Software client interface for POP3 and IMAP4 users.

- **Avaya Modular Messaging Release 2 Telephone User Interface Guide**
  
  Provides information on using the telephone user interface.

- **Aria® Telephone User Interface for Avaya Modular Messaging Quick Reference Guide**, 585-310-786
  
  Provides at-a-glance information on using Modular Messaging from the telephone user interface for subscribers using the Aria TUI.

- **AUDIX® Telephone User Interface for Avaya Modular Messaging Quick Reference Guide**
  
  Provides at-a-glance information on using Modular Messaging from the telephone user interface for subscribers using the AUDIX TUI.

- **Avaya Modular Messaging Subscriber Options**, 585-310-789, Issue 2.
  
  Provides information on using the Subscriber Options software on a client PC.

Avaya Modular Messaging support

For Avaya Modular Messaging support, visit the Avaya Support Centre at [http://support.avaya.com](http://support.avaya.com)
For important, up-to-date information on Avaya Modular Messaging, see the Readme file available on the Avaya Modular Messaging CD-ROM.
## Summary of chapters

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chapter 1, “Messaging Application Server (MAS) Basics”</strong></td>
<td>Introduces MAS administration, diagnostic, and reporting tools.</td>
</tr>
<tr>
<td><strong>Chapter 2, “Introduction to Voice Mail System Configuration”</strong></td>
<td>Introduces the Voice Mail System Configuration application.</td>
</tr>
<tr>
<td><strong>Chapter 3, “Telephone User Interface Administration”</strong></td>
<td>Describes how to configure a telephone user interface (TUI) for a voice mail domain.</td>
</tr>
<tr>
<td><strong>Chapter 5, “Voice Mail Domain Administration”</strong></td>
<td>Describes how to configure properties in a voice mail domain.</td>
</tr>
<tr>
<td><strong>Chapter 8, “Messaging Application Server Configuration”</strong></td>
<td>Describes how to configure an MAS in a voice mail domain.</td>
</tr>
<tr>
<td><strong>Chapter 9, “Voice Mail Domain Management”</strong></td>
<td>Describes how to manage voice mail domains.</td>
</tr>
<tr>
<td><strong>Chapter 10, “Custom Prompts”</strong></td>
<td>Describes how to use the Visual Voice Editor application to customize prompts for use by the automated attendant.</td>
</tr>
<tr>
<td><strong>Chapter 11, “Caller Applications”</strong></td>
<td>Describes how to use Caller Applications Editor to create and deploy caller applications.</td>
</tr>
<tr>
<td><strong>Chapter 12, “Reports”</strong></td>
<td>Describes how to use the Reporting Tool to help you monitor the voice mail system usage.</td>
</tr>
<tr>
<td><strong>Chapter 13, “Operation History Events”</strong></td>
<td>Describes how to use the Operation History Viewer to view operation history events generated by the voice mail system.</td>
</tr>
<tr>
<td><strong>Chapter 14, “System Performance Monitoring”</strong></td>
<td>Describes how to monitor the voice mail system.</td>
</tr>
<tr>
<td><strong>Chapter 15, “Event, Error, and Alarm Logs”</strong></td>
<td>Provides information about generating and viewing logs for system events, errors, and alarms.</td>
</tr>
<tr>
<td><strong>Appendix A, MAS Alarms</strong></td>
<td>Provides sample reports for reference.</td>
</tr>
<tr>
<td><strong>Appendix B, Examples of Caller Applications</strong></td>
<td>Provides an example caller application.</td>
</tr>
</tbody>
</table>
Conventions

The following conventions are used in this guide:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Capitals</td>
<td>Names of applications, field names, menu items and dialog boxes.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Book titles.</td>
</tr>
<tr>
<td>KEY+KEY</td>
<td>Key combinations in which you press and hold down one key and then press another.</td>
</tr>
<tr>
<td></td>
<td>Numbers in square boxes correspond to numbers on your telephone keypad.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Field names.</td>
</tr>
</tbody>
</table>
1

Messaging Application Server (MAS)
Basics

This chapter introduces messaging application server (MAS) administration, diagnostic, and reporting tools.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System administration tools</td>
<td>1-2</td>
</tr>
<tr>
<td>Preventive maintenance</td>
<td>1-3</td>
</tr>
<tr>
<td>Backing up system data</td>
<td>1-3</td>
</tr>
<tr>
<td>Diagnostic and reporting tools</td>
<td>1-4</td>
</tr>
<tr>
<td>Logging in to a messaging application server</td>
<td>1-5</td>
</tr>
<tr>
<td>Opening Messaging Application Server programs</td>
<td>1-5</td>
</tr>
<tr>
<td>Changing the display language</td>
<td>1-5</td>
</tr>
</tbody>
</table>
System administration tools

The Avaya Messaging Application Server provides the following administration tools.

Voice Mail System Configuration

This administration tool presents a collection of dialog boxes for configuring and maintaining the voice mail system. Properties that are shared across messaging application servers (MASs) grouped in a voice mail domain can be configured centrally. Any changes made to a voice mail domain’s properties are then updated and replicated automatically to all MASs in the domain. For more information, see Chapter 2, “Introduction to Voice Mail System Configuration,” Chapter 3, “Telephone User Interface Administration,” Chapter 5, “Voice Mail Domain Administration,” and Chapter 9, “Voice Mail Domain Management”.

Visual Voice Editor

This administration tool provides a graphical user interface for recording company prompts for use by the automated attendant. Customized prompts can be recorded using the local multimedia capabilities on a personal computer. Visual Voice Editor displays audio data as a waveform to enable precise editing of a prompt. For more information, see Chapter 10, “Custom Prompts”.

Caller Applications Editor

Caller Applications Editor enables you to customize the Messaging Application Server telephone user interface by creating additional levels of menus and prompts. It consists of Microsoft Management Console (MMC) snap-ins and extensions. It is added to the Avaya Modular Messaging menu during installation. For more information, see Chapter 11, “Caller Applications”.


Preventive maintenance

To help prevent possible disk problems and minimize disk errors, Avaya recommends that the MAS drive be maintained by running the following Windows maintenance tools on a regular basis:

- Disk Defragmenter system tool
- chkdsk command

For details about using these tools, see your Windows operating system documentation.

Backing up system data

System data on the MAS is backed up daily using a scheduled task.

System data backups does the following:

- The system copies all caller application configuration data stored in *.uma files from C:\Program Files\Avaya Modular Messaging\Vserver\Callerapps to C:\Program Files\Avaya Modular Messaging\Vserver\CABACKUP.

- NTBackup backs up the selected files to a backup configuration file named DailyMASBackup.bks. This file resides in the directory C:\Avaya_Support\CMD. The files that are backed up include the following:
  - C:\Avaya_Support\Tone_Files\
  - C:\Program Files\Avaya Modular Messaging\Vserver\Spool
  - C:\Program Files\Avaya Modular Messaging\Vserver\CABACKUP
  - C:\Winnt\system32\drivers\etc (hosts file only)
Diagnostic and reporting tools

The following diagnostic and reporting tools are provided.

Operation History Viewer

Using this diagnostic tool, you can view events generated by voice mail system activity and logged in the operation history database. By creating a “session”, you restrict the number of events to only those that meet your criteria. You can view live events as they are added to the operation history database, or view historical events. For more information, see Chapter 13, “Operation History Events”.

Monitoring tools

Using the following diagnostic tools, you can check the performance of MASs. Proper monitoring can help you to find and fix problems before they have an impact on your organization. Two monitoring tools are available:

- Microsoft Windows Performance Monitor
  You can make use of all the monitoring capabilities of this tool to check the status of a particular messaging application server.

- Port Monitor
  This provides a graphical user interface for checking and changing the status of ports on a particular messaging application server, as appropriate.

For more information, see Chapter 14, “System Performance Monitoring”.

Reporting Tool

Using the Reporting Tool, you can generate a number of reports for monitoring voice mail system usage, planning capacity, and tracking security. Once you have generated a report, you can view it on the screen or print it for easy reference. You can also export a report to many popular file formats or attach it to a message sent using a MAPI-enabled e-mail system. For more information, see Chapter 12, “Reports”.
Logging in to a messaging application server

As a customer administrator, you normally use the customer account when administering an MAS. This account is created on your primary controller and applies to each MAS in your Modular Messaging system. Your installer creates the initial account and password based on your input.

You log in to your account using the normal Windows initial login windows on your PC.

Opening Messaging Application Server programs

To open the administration, diagnostic, and reporting tools, click Start > Programs > Avaya Modular Messaging.

Changing the display language

You can change the display language for messaging application server administration, diagnostic and reporting tools.

Note: If you change the display language to a language that is not the system language, some buttons and dialog boxes may continue to appear in the system language.

To change the display language

1. From the Modular Messaging Software folder, click Languages. The system displays the Language page.

2. Select the language in which you want to display administration, diagnostic and reporting tools. You can select from the languages installed with the messaging application server.

3. Click OK.
This chapter introduces you to configuring the voice mail system.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to Voice Mail System Configuration</td>
<td>2-2</td>
</tr>
<tr>
<td>Changing the home MAS</td>
<td>2-5</td>
</tr>
<tr>
<td>Supporting messaging subscribers</td>
<td>2-6</td>
</tr>
</tbody>
</table>
Introduction to Voice Mail System Configuration

When configuring a voice mail system you define how messaging applications servers (MASs) in a voice mail domain interact with other parts of the messaging environment, for example, PBXs.

The Voice Mail System Configuration application presents a collection of dialog boxes for configuring the system. Properties fall into two categories:

- **Shared across MASs grouped in a voice mail domain**
  
  For these properties, configuration can be carried out centrally. Any changes made to a voice mail domain’s properties are updated and replicated automatically to all MASs in the voice mail domain.

  For more information, see:

  — [Telephone User Interface Administration](#)
  — [Voice Mail Domain Administration](#)
  — [Voice Mail Domain Management](#)

- **Specific to an MAS**
  
  For these properties, configuration must be carried out for each MAS in a voice mail domain.

  For more information, see:

  — [Messaging Application Server Configuration](#)

**Before you begin**

Before you begin the configuration, you should be familiar with your messaging environment, including the e-mail server and MAS setup. You should also be familiar with the concept of a voice mail domain. For more information on the Avaya Modular Messaging messaging environment, see the *Avaya Modular Messaging Concepts and Planning Guide*. 
Opening Voice Mail System Configuration

To open the Voice Mail System Configuration application, click Start > Programs > Avaya Modular Messaging > Voice Mail System Configuration.

Components of the voice mail system are represented in a hierarchical tree structure in the Voice Mail System Configuration window.

Figure 2-1 shows an example of a hierarchy in the Voice Mail System Configuration window.

Figure 2-1. Voice Mail System Configuration window
1 Voice mail domain components
2 Messaging application server components

Selecting an item in the tree expands the branch to show additional items, or it may provide a direct path to a dialog box. To open the dialog box for a component that you want to configure, double-click the appropriate item.

**Note:** If you have not installed a tracing system, the Tracing System branch is not displayed in the Voice Mail System Configuration window.
Changing the home MAS

The home MAS is any machine in the voice mail domain from which you administer system configuration. You can change the home MAS by providing the Voice Mail System Configuration application with a new MAS name. It may be necessary to do this if the server or servers that it was previously using are not running or have been removed from the voice mail domain.

To change the home MAS

1. If it is not already open, start the Voice Mail System Configuration application (see Opening Voice Mail System Configuration on page 2-3).

2. On the Tools menu, click Options.

   The system displays the Options dialog box.

3. In the Home Message Application Server field, enter the name of an MAS. Clicking Browse opens the Select Computer dialog box where you can search for and select an MAS.

4. Click OK.
Supporting messaging subscribers

Avaya Modular Messaging subscribers have three tools for getting, receiving, and managing messages:

- The telephone user interface
- Subscriber Options
- An e-mail client

The client can be an IMAP4 client like Microsoft Outlook Express or IBM Lotus Notes 5, or a POP3 client like Microsoft Outlook. For more information, see Avaya Modular Messaging Client Access to a Subscriber Mailbox, 585-310-790, available on your Modular Messaging Release 2 Documentation CD-ROM.

In addition, with Microsoft Outlook, subscribers can use Modular Messaging Add-in tools, which appear as three new icons, two of which are integrated into Outlook, and one of which appears in your Programs submenu in Windows. These tools are as follows:

- The Voice Form, which allows voice recording and listening from Outlook.
- The Voice Recorder, which allows voice recording for attachments within Outlook messages and attachments within other application files such as Microsoft Word.
- The Voice Mail tab, which integrates the most common functions of Subscriber Options within Outlook.

For more information about these tools, see Avaya Modular Messaging Client Add-in for Microsoft® Outlook® User Guide on your Modular Messaging Release 2 Documentation CD-ROM.

To help your subscribers succeed and maximize their use of Modular Messaging, do the following:

- Install client add-ins on subscriber PCs.
The Subscriber Options software, which helps subscribers manage their mailboxes, as well as the client software add-in tools, is available on your messaging application server DVD or CD. The software is in a file called `setup.exe`. You can find it by accessing the MAS DVD or CD-ROM with your domain administrator account and searching the `d:/Install/Client Install/` directory.

You can allow subscribers to install the Subscriber Options and add-in software themselves. Simply post the software to your internal website and tell subscribers where to get it. Installation instructions are available in the *Client Add-in for Microsoft Outlook User Guide*.

**Note:** If the client is not running Microsoft Outlook, the installation program will allow only Subscriber Options to be installed.

- Post the following documents to your internal website and tell subscribers where to get them. These guides are in PDF format and are available on your documentation CD-ROM
  - *Avaya Modular Messaging Subscriber Options*, 585-310-789
  - *Avaya Modular Messaging Online TUI Guide*
  - *Avaya Modular Messaging Client Add-in for Microsoft® Outlook® User Guide*
  - *Avaya Modular Messaging Client Access to a Subscriber Mailbox*, 585-310-790

- Distribute the Avaya Modular Messaging quick reference guides. These documents are available on your *Modular Messaging Release 2* documentation CD-ROM.
This chapter describes how to configure a telephone user interface (TUI) for a voice mail domain.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to configuring the telephone user interface</td>
<td>3-2</td>
</tr>
<tr>
<td>Configuring TUI general properties</td>
<td>3-4</td>
</tr>
<tr>
<td>Configuring TUI receptionist properties</td>
<td>3-6</td>
</tr>
<tr>
<td>Configuring time and greeting properties</td>
<td>3-8</td>
</tr>
<tr>
<td>Configuring message timing properties</td>
<td>3-10</td>
</tr>
<tr>
<td>Configuring subscriber properties</td>
<td>3-12</td>
</tr>
<tr>
<td>Configuring caller properties</td>
<td>3-14</td>
</tr>
<tr>
<td>Configuring attendant schedules</td>
<td>3-16</td>
</tr>
<tr>
<td>Configuring Dial by Name properties</td>
<td>3-19</td>
</tr>
</tbody>
</table>
Introduction to configuring the telephone user interface

The telephone user interface (TUI) provides callers and subscribers with easy access to the system over the telephone. You can configure the following TUI properties for a voice mail domain.

- **General**
  
  Use this tab to enable the automated attendant service and to activate the TUI's setup tutorial for new subscribers.
  
  See [Configuring TUI general properties](#) on page 3-4.

- **Receptionist**
  
  Use this tab to specify all the conditions for transferring a caller to the receptionist.
  
  See [Configuring TUI receptionist properties](#) on page 3-6.

- **Time / Greeting**
  
  Use this tab to define your organization's daily business hours and control which greetings are played by the automated attendant at different times of the day.
  
  See [Configuring time and greeting properties](#) on page 3-8.

- **Message Timing**
  
  Use this tab to configure timing parameters for voice message playback controls on the telephone keypad.
  
  See [Configuring message timing properties](#) on page 3-10.

- **Subscriber**
  
  Use this tab to set up security features to help prevent unauthorized user access to a mailbox.
  
  See [Configuring subscriber properties](#) on page 3-12.

- **Caller**
  
  Use this tab to configure caller options.
  
  See [Configuring caller properties](#) on page 3-14.

- **Attendant Schedules**
Use this tab to add, delete, copy or rename attendant schedules.

See Configuring attendant schedules on page 3-16.

- **Dial by Name**

Use this tab to configure the way in which names are stored in the front end database (FEDB) for use by Dial by Name.

See Configuring Dial by Name properties on page 3-19.

---

**Notes:**

- You need to administer the TUI only on the MAS that is the primary domain controller. The other servers, if any, will automatically pickup the properties established for the TUI from the primary controller.

- You may be prompted to stop and restart the MAS after you have made changes to a property in Voice Mail System Configuration. If so, the changes will not take effect until you stop and restart the MAS.

- When configuring the TUI, changes may take a few minutes to become effective on all MASs. It is recommended that you run only one instance of Voice Mail System Configuration at a time in the voice mail domain.

---

**Before you begin**

Ensure you have read Chapter 2, "Introduction to Voice Mail System Configuration". That chapter introduces you to the Voice Mail System Configuration application used to perform the configuration.

Start the Voice Mail System Configuration application from the Modular Messaging Software folder.
Configuring TUI general properties

To configure basic TUI properties for a voice mail domain, use the Telephone User Interface - Voice Mail Domain dialog box, General tab.

To display the Telephone User Interface - Voice Mail Domain dialog box, General tab:

1. In the Voice Mail System Configuration window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Telephone User Interface for that voice mail domain.

   The system displays the Telephone User Interface - Voice Mail Domain dialog box, with the General tab active.

To configure general TUI properties, configure the following fields:

- **Enable Automated Attendant** The system Automated Attendant greets callers and instructs them how to proceed. It also allows other call handling features, such as call blocking, call screening, and intercom paging. When enabled, the system can be set to present callers with a list of menu options from which to choose (for more information, see Configuring the Automated Attendant on page 5-5). When disabled, the system transfers callers directly to the subscriber’s mailbox, where they can leave a message.

   If your PBX does not support Direct Inward Dialing (DID), we recommend that you enable the Automated Attendant. By default, this check box is selected.

   **Note:** If you disable the automated attendant, subscribers cannot use the call screening, call blocking and intercom paging features.

- **Enable Caller Applications** Select to enable caller applications in the voice mail domain. If disabled, deployed applications are ignored by the MASs in the voice mail domain. If a caller application is in use when it is disabled, it will continue to work until it is no longer in use. By default, this check box is selected.

- **Number of Digits in a Mailbox** Enter the number of digits in a subscriber’s mailbox number. The range is 3 through 10 and the default is 4. Avaya recommends that you make subscribers’ mailbox numbers the same as their telephone extension numbers. If a subscriber has multiple extension
numbers, make the mailbox number the same as the primary extension number.

**Note:** The primary extension number is the one that defines call handling behavior for the subscriber and that is used for the Message Waiting Indicator (if configured/enable for that).

- **Educator for New Mailboxes** (Aria TUI only) Select to play the setup tutorial to new subscribers the first time they open their mailboxes. The tutorial guides new subscribers through the process of changing their passwords and recording personalized prompts. This check box is selected by default.

- **Maximum Call Duration in Minutes** Enter the number of minutes that callers or subscribers are permitted to spend using the TUI during one session. When this time is up, they are disconnected. The range is 0 through 99 and the default is 30. If 0 is configured, there is no time limit on a TUI session.

  **Note:** If subscribers reach the maximum duration time when recording a message, they are disconnected when they finish recording, and cannot address or send the message.

- **Default Input Timeout in Seconds** Enter the number of seconds the TUI waits for a dual tone multi-frequency (DTMF) response from callers before prompting them to proceed. This timeout period begins anew each time a key is pressed. The range is 0 through 99 and the default is 5.

  If a caller exceeds this timeout at any prompt, then the system prompts the caller to try again. In the case of a login attempt, the user is told that the login attempt was invalid and is prompted to try again.

  If the caller exceeds the timeout four consecutive times, then the system terminates the call.

  **Note:** Relevant United States regulations require that time-out periods be long enough to permit people with disabilities to make a selection without being disconnected. These regulations do not specify, or even suggest, a minimal amount of time that must be allowed. Avaya recommends that you use a value of at least 40 seconds for this field.

- **Allow Private Call Answering Messages** Select this option to allow callers to mark as private messages left for subscribers. When this option is selected, the caller hears a prompt at the end of the message allowing the message to be marked as private. When this option is cleared, then the privacy option prompt does not play. This option is selected by default.
Configuring TUI receptionist properties

To configure receptionist properties for a voice mail domain, use the Receptionist tab. You can set up receptionist mailbox numbers and specify all the conditions for transferring a caller to the receptionist.

To display the Telephone User Interface - Voice Mail Domain dialog box, Receptionist tab:

1. In the Voice Mail System Configuration window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Telephone User Interface for that voice mail domain.

   The system displays the Telephone User Interface - Voice Mail Domain dialog box, with the General tab active.

3. Click the Receptionist tab.

To configure receptionist properties, configure the following fields:

- **Default Receptionist Mailbox Number** Enter the mailbox number to which callers are transferred when they require receptionist assistance. The default is 0.

- **After Hours Receptionist Mailbox Number** Enter the mailbox number to which callers are transferred when they require receptionist assistance outside of business hours. The default is 0.

- **Inform Subscriber Transfer is from Auto Attendant** Select to enable the automated attendant to inform a subscriber before it transfers a caller to the subscriber’s extension. When cleared, the automated attendant transfers the caller immediately, without telling them it is doing so. This check box is cleared by default.

- **Disconnect all Rotary Callers** Select to disconnect callers using a non-touchtone telephone. When cleared, callers are transferred to the receptionist. If you select to disconnect callers from non-touchtone telephones, make sure your system greetings give another number to dial. This check box is cleared by default.

- **Number Attempts Rotary Transfer to Busy Receptionist** Specify the number of times the TUI attempts to transfer a caller from a non-touchtone telephone to a busy receptionist. The range is 0 to 9 and the default is 3. If the number of attempts is exceeded, callers are transferred to the receptionist mailbox where they can leave a message.

- **Maximum Number of Errors** Specify the number of errors a caller is permitted to make when attempting to use the TUI. The range is 0 through
9, and the default is 3. If the maximum number of errors is exceeded, the caller is disconnected or transferred to the receptionist. If you enter 0 as the maximum number of errors, the caller is disconnected after making the first error. If you want to transfer callers to the receptionist, make sure the Transfer Calls to Receptionist after Maximum Errors check box is selected.

- **Maximum Number of No Entries** Specify the number of “no entries” a caller is permitted to make when using the TUI. The range is 0 through 9 and the default is 3. A “no entry” is defined as no response from the caller when prompted to proceed. If the maximum number of no entries is exceeded, the caller is politely disconnected. If you enter 0 as the maximum number of no entries, the caller is disconnected after the first no entry occurrence. If the callers do not respond after your initial office greeting, they are transferred to the receptionist.

- **Transfer Calls to Receptionist after Maximum Errors** Select to transfer callers to the receptionist if they exceed the number of permitted errors when using the TUI. If this check box is cleared, callers are disconnected. This check box is selected by default.

- **Transfer Invalid Mailboxes during Business Hours** Select to specify what happens to calls to an invalid mailbox number during business hours. When selected, the TUI dials the extension number if the mailbox number is invalid. When cleared, callers are informed that the mailbox number is invalid. If callers exceed the maximum number of errors, they are politely disconnected or transferred to the business hours receptionist. This check box is cleared by default.

**Note:** If you want callers to be transferred to the business hours receptionist, make sure that the Transfer Calls to Receptionist after Maximum Errors check box is selected.

- **Transfer Invalid Mailboxes after Business Hours** Select to specify what happens to calls to an invalid mailbox number after business hours. When selected, the TUI dials the extension number if the mailbox number is invalid. When cleared, callers are informed that the mailbox number is invalid. If callers exceed the maximum number of errors, they are politely disconnected or transferred to the after-hours receptionist. This check box is cleared by default.

**Note:** If you want callers to be transferred to the after-hours receptionist, make sure that the Transfer Calls to Receptionist after Maximum Errors check box is selected.
Configuring time and greeting properties

To define your organization’s daily business hours and to control when certain greetings are played by the automated attendant, use the **Time / Greeting** tab.

For information on configuring time of day greetings in the automated attendant, see Configuring Time of Day properties on page 5-10.

To display the Telephone User Interface - Voice Mail Domain dialog box, Time/Greeting tab:

1. In the Voice Mail System Configuration window, click the voice mail domain.
   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Telephone User Interface for that voice mail domain.
   The system displays the Telephone User Interface - Voice Mail Domain dialog box, with the General tab active.

3. Click the Time / Greeting tab.

To configure time and greeting properties, configure the following fields:

- **Daily Settings** Select the day for which you want to define business hours. For the selected day, you can select one of three options: ‘Open All Day’, ‘Closed All Day’ or ‘Selected Hours’. Avaya recommends that you set up business hours for each day of the week.

- **Open All Day** Select to specify that the office is open all day. For any day that ‘Open All Day’ is set, the automated attendant greets callers with the appropriate Morning, Afternoon, or Evening greeting. It uses the start times you specify in the Start of Morning, Start of Afternoon and Start of Evening fields to determine which greeting to play.

- **Closed All Day** Select to specify that the office is closed all day. For any day that ‘Closed All Day’ is set, the automated attendant plays the Closed greeting to callers. They are then transferred to the after-hours receptionist mailbox.

- **Selected Hours** Select to specify the business and after-business hours for a particular day. This is the default setting. If you select this option, you must enter the Open and Close times:

  — **Open** Enter the time designated as the start of business hours for the selected day. During business hours, the appropriate greeting (Morning, Afternoon, or Evening) is played. The default is 09:00.
— **Close** Enter the time designated as the end of business hours for the selected day. After business hours, the Closed greeting is played. The default is 17:00.

- **Start of Morning** Enter the start time for the Morning greeting. The default is 09:00.

- **Start of Afternoon** Enter the start time for the Afternoon greeting. The default is 12:00.

- **Start of Evening** Enter the start time for the Evening greeting. The default is 18:00.
Configuring message timing properties

To configure message timing properties for a voice mail domain, use the Message Timing tab. You can configure the voice message playback controls on the telephone keypad and specify the number of seconds permitted for recording personalized prompts.

To display the Telephone User Interface - Voice Mail Domain dialog box, Message Timing tab:

1. In the Voice Mail System Configuration window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Telephone User Interface for that voice mail domain.

   The system displays the Telephone User Interface - Voice Mail Domain dialog box, with the General tab active.

3. Click the Message Timing tab.

To configure message timing properties, configure the following fields:

- **Seconds to Rewind Message When Rewind Button Pressed**  Enter the amount of time, in seconds, by which subscribers can rewind a voice message when they press the Rewind key on the keypad. The range is 0 through 99 and the default is 5.

- **Seconds to Pause Message When Pause Button Pressed**  Enter the amount of time, in seconds, by which a message is paused when a subscriber presses the Pause key on the keypad while playing or recording a voice message. The range is 0 through 99 and the default is 5.

- **Seconds to Fast Forward Message When Fast Forward Button Pressed**  Enter the amount of time, in seconds, by which subscribers can fast forward a voice message when they press the Fast Forward key on the keypad. The range is 0 through 99 and the default is 5.

- **Maximum Mailbox Prompt Length in Seconds**  Enter the amount of time, in seconds, that subscribers are given for recording a mailbox prompt such as a personal greeting. The range is 1 through 999 and the default is 90. When using the TUI, subscribers hear a warning message 10 seconds before the end of the prompt length. To avoid this warning message playing at the start of a recording, it is recommended that you enter a minimum value of 20.
**Note:** This setting does not apply to the Spoken Name prompt. The maximum length of the Spoken Name prompt depends on the audio encoding format selected:

- For GSM 6.10, it is 20 seconds.
- For G.711 mu-law, it is 8 seconds.
- For G.711 A-law, it is 8 seconds.

**Minimum Message Length in Seconds** Enter the amount of time, in seconds, that defines the shortest allowable voice message from an external caller. Any shorter voice messages are discarded. If you set the minimum message length to 0, no messages are discarded. The range is 0 through 9, and the default is 0.
Configuring subscriber properties

To configure subscriber properties for a voice mail domain, use the Subscriber tab.

To display the Telephone User Interface - Voice Mail Domain dialog box, Subscriber tab:

1. In the Voice Mail System Configuration window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Telephone User Interface for that voice mail domain.

   The system displays the Telephone User Interface - Voice Mail Domain dialog box, with the General tab active.

3. Click the Subscriber tab.

To configure Subscriber properties, configure the following fields:

- **Enable Confirmation before Deleting Messages** Select to prompt subscribers to confirm message deletions. When cleared, deleted messages can still be reviewed during the same session. This check box is cleared by default.

- **Enable Extended Password Security** Select to force subscribers to press [#] after entering their mailbox password. If subscribers do not press [#] when this check box is selected, the system waits for a response and then permits access, as long as the correct password was entered. When this check box is cleared, subscribers can open their mailboxes as soon as the last digit of their password is entered. This check box is selected by default.

- **Minimum Password Length** Enter a value to specify the minimum number of digits for a mailbox password. The range is 0 through 32, and the default is 4. If you enter 0, subscribers are not required to enter a password. Therefore, 0 is not a recommended value for security reasons. Increasing the number of digits in a password lowers the probability that an unauthorized user can gain access.

   If you change the minimum password length to a higher value, existing subscribers are prompted to enter a new password containing the new minimum number of digits before they can proceed.

**Note:** The setting in this field can be used—particularly when using the AUDIX TUI, which does not have an Educator function—to force a password change for new subscribers on initial login. The administrators can set an initial password that is shorter than this value so that, when the subscriber logs in for the first time, the system forces a password change.
Enable Password Expiry  Select to expire a subscriber's password after the time interval you specify in the Days before Password Expiry field. This check box is cleared by default.

Days before Password Expiry  (Active only if the Enable Password Expiry check box is selected) Enter the time interval, in days, from the date subscribers last changed their passwords before they are forced to change them again. The range is 1 through 999 and the default is 60. It is recommended that subscribers enter a new password at least every six months to reduce unauthorized user access.

Login Failures before Mailbox Lockout  Enter a number to specify how many password entry errors per call subscribers can make before they are locked out of their mailbox. The range is 3 through 999 and the default is 5.

Number of Previous Passwords Disallowed  Enter the number of different passwords a user must use before any old (previous) passwords can be reused.

Initial Password for New Mailboxes:

- None  Select to allow new subscribers to open their mailboxes without entering a password, if the minimum password length is set to zero. For security reasons, use this option with caution.

- Default  Select to assign the default password to all new mailboxes. The default password is a string of 1s, for example, 1111 if the value entered in the Minimum Password Length field is 4. It is recommended that you make the default password more secure by entering a new number in the Default Password field.

Note: This value, used in conjunction with the Minimum Password Length setting, can be used to force a password change for new subscribers, particularly when using the AUDIX TUI, which does not have an Educator function. For example, if the Minimum Password Length field were set to 6, and you entered a value of 1111 in the Default Password field, the first time a new subscriber tries to log in, the system forces the subscriber to change the password.

- Random  Select to assign a different randomly generated password to each new mailbox. On creating a subscriber account, a message box appears containing the password, which the administrator must communicate to the mailbox subscriber. “Random” is the default password method and is the most secure.
Configuring caller properties

To configure caller properties for a voice mail domain, use the Caller tab.

To display the Telephone User Interface - Voice Mail Domain dialog box, Caller tab:

1. In the Voice Mail System Configuration window, click the voice mail domain. If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Telephone User Interface for that voice mail domain. The system displays the Telephone User Interface - Voice Mail Domain dialog box, with the General tab active.

3. Click the Caller tab.

To configure Caller properties, configure the following fields:

- **Permit Callers to Leave Multiple Messages** Select to allow callers to leave more than one voice message per call. If cleared, callers are disconnected after leaving the first voice message. This check box is selected by default.

- **Permit Callers to Access Directory Services** Select to allow callers to use Dial By Name to search for a subscriber extension or mailbox number by spelling the subscriber's name using the telephone keypad. This check box is selected by default.

- **Outcalling Restrictions** Clear the digits that callers are not allowed to enter as the initial digit in an invalid mailbox, when the Transfer Invalid Mailboxes during Business Hours or Transfer Invalid Mailboxes after Business Hours check boxes are selected on the Receptionist tab.

Avaya recommends that you clear the digit or digits used to request external lines from the PBX. This helps prevent telephone toll fraud by prohibiting callers from obtaining an external line when dialing the initial digit of an invalid mailbox number. For example, if 9 is configured to request an external line from the PBX, and 9 is cleared, dialing the invalid mailbox 9004 does not get an external line. All digits are selected by default.

For information on the Transfer Invalid Mailboxes during Business Hours check box, see Transfer Invalid Mailboxes during Business Hours on page 3-7. For more information on the Transfer Invalid Mailboxes...
after Business Hours check box, see Transfer Invalid Mailboxes after Business Hours on page 3-7.

1. In the Voice Mail System Configuration window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.
Configuring attendant schedules

To set up attendant schedule properties for a voice mail domain, use the **Attendant Schedules** tab. You can edit, copy, rename and delete existing schedules, and create new schedules.

The Attendant Schedule defines the availability of a subscriber’s personal operator. A subscriber can have an extension number configured (by a system administrator) as a personal operator number. This personal operator replaces the system-wide Automated Attendant during the times specified in the Attendant Schedule.

**To display the Telephone User Interface - Voice Mail Domain dialog box, Attendant Schedules tab:**

1. In the **Voice Mail System Configuration** window, click the voice mail domain.
   
   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click **Telephone User Interface** for that voice mail domain.
   
   The system displays the **Telephone User Interface - Voice Mail Domain** dialog box, with the **General** tab active.

3. Click the **Attendant Schedules** tab.

**To add an attendant schedule:**

1. On the **Attendant Schedules** tab, click **Add**.
   
   The system displays the **Enter Attendant Schedule Name** dialog box.

2. In the **Schedule Name** field, type the desired name for the schedule.

3. Click **OK**.

**Note:** Schedule names must be unique.

4. Use the schedule grid to set the schedule time. For more information, see [Using the schedule grid](#) on page 3-18.

**To copy an attendant schedule:**

1. On the **Attendant Schedules** tab, click the schedule to be copied.

2. Click **Copy As**.

3. In the **Schedule Name** field, type the desired name for the schedule.
4. Click **OK**.

   **Note:** Schedule names must be unique.

5. Modify the new schedule as desired. For more information, see *Using the schedule grid* on page 3-18.

### To rename an attendant schedule:

1. On the **Attendant Schedules** tab, click **Rename**.

2. In the **Schedule Name** field, type a name for the schedule.

3. Click **OK**.

   **Note:** Schedule names must be unique.

### To delete an attendant schedule:

**Note:** Before attempting to delete a schedule, verify that it is not currently in use.

1. On the **Attendant Schedules** tab, click the name of the schedule to be deleted.

2. Click **Delete**.

   **Note:** The system deletes the schedule immediately; there is no confirmation box.

### To edit an attendant schedule:

1. On the **Attendant Schedules** tab, click the name of the schedule that you want to edit.

   The schedule appears in the panel at the bottom of the screen.

2. Edit the schedule as described in *Using the schedule grid* on page 3-18.
Using the schedule grid

To select a time or block of time for the attendant schedule, use the schedule grid. The grid has the weekdays along the y-axis and the time of day along the x-axis. Cells on the grid represent a time interval, either 1 hour, 15 minutes, or 5 minutes depending on the current selection under Interval.

A cell can have one of two states, on (blue) or off (white). Clicking a cell toggles its state. In Figure 3-2, each cell represents a quarter of an hour. If you select “15 Minute” under View detail, a scroll bar appears below the grid that you can use to view all the cells.

Figure 3-2. Schedule Grid

1. Toggle all
2. Column/Hour headers
3. Row/Day headers

Tips for using the schedule grid

- To toggle (select or deselect) all cells, click the top left cell.
- To toggle the state of the first cell of a column and set all of the other cells in that column to the same state, click a column/hour header. This action selects that block of time for all days.
- To toggle the state of the first cell of a row and set all of the other cells in that row to the same state, click a row/day header. This action selects or deselects all hours for the selected day.
- To change the state of multiple cells at the same time, click a cell and drag the mouse cursor over the other cells.
Configuring Dial by Name properties

Dial by Name is a method of addressing that allows callers to spell a recipient's name on the telephone keypad.

To configure the way in which names are stored in the front end database (FEDB) for use by Dial by Name, use the Dial by Name tab. If the FEDB contains names that are not easily mapped to a telephone keypad, for example if you are using a far eastern language, you should configure Dial by Name to map the recipient's e-mail address instead of their first name and last name.

To display the Telephone User Interface - Voice Mail Domain dialog box, Dial by Name tab:

1. In the Voice Mail System Configuration window, click the voice mail domain.
   
   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Telephone User Interface for that voice mail domain.
   
   The system displays the Telephone User Interface - Voice Mail Domain dialog box, with the General tab active.

3. Click the Dial by Name tab.

To configure Dial by Name properties:

From the Match names using: drop-down list, select the method to use when matching names using Dial By Name. You can select from:

- **Lastname, Firstname** Stores the subscriber's last name followed by their first name. This is the recommended setting.

- **E-mail Address** Stores the subscriber's e-mail address. This enables you to use Dial by Name for names that contain characters that do not appear on the telephone keypad, for example if you are using far eastern languages. It is recommended that you use this setting only if the FEDB contains names that are not easily mapped to a telephone keypad. Enter only the first part of the subscriber's e-mail address (before the @ symbol) for example, JSmith.

**Note:** If you use the “Last Name, First Name” method to match names, when all the last names in the GAL have been found, the system searches e-mail aliases for matches.
This chapter describes how to configure a Private Branch Exchange (PBX) for a voice mail domain.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to configuring a PBX</td>
<td>4-2</td>
</tr>
<tr>
<td>Configuring PBX properties (analog)</td>
<td>4-4</td>
</tr>
<tr>
<td>Configuring PBX properties (IP H.323)</td>
<td>4-13</td>
</tr>
<tr>
<td>Configuring PBX properties (QSIG)</td>
<td>4-16</td>
</tr>
<tr>
<td>Configuring PBX properties (set emulation)</td>
<td>4-25</td>
</tr>
</tbody>
</table>
Introduction to configuring a PBX

Configuring a PBX determines the way in which the PBX communicates with the voice mail domain.

The screens you use to configure a PBX depend on the type of voice processing you are using.

You can configure a PBX for the following:

- **Analog**
  
  This topic describes how to configure PBX properties if you are using analog voice ports. Configure your PBX for analog telephony if your PBX supports any of the following types of switch integration:
  
  - Controlled LAN (C-LAN)
  
  - Digital Multiplexed Interface - 4 (DMI-4)
  
  - Inband
  
  - Serial RS-232
  
  See Configuring PBX properties (analog) on page 4-4.

- **IP H.323**
  
  This topic describes how to configure PBX properties if you are using IP connectivity between the messaging application server (MAS) and the Avaya PBX. Configure your PBX for IP telephony if your PBX supports H.323-based IP switch integration.

  See Configuring PBX properties (IP H.323) on page 4-13.

- **QSIG**
  
  This topic describes how to configure PBX properties if you are using E1 or T1 QSIG voice cards. Configure your PBX for QSIG telephony if your PBX supports Q-Signaling (QSIG) switch integration.

  See Configuring PBX properties (QSIG) on page 4-16.

- **Set emulation**
  
  This topic describes how to configure PBX properties if you are using set emulation voice cards. Configure your PBX for set emulation telephony if your PBX supports digital set emulation (DSE) switch integration.

  See Configuring PBX properties (set emulation) on page 4-25.
For more information on configuring your PBX, see the PBX configuration notes. Configuration notes are available from the Avaya Support Center, at http://support.avaya.com.

Notes:

- You need administer the PBX configuration only on the MAS that is the primary domain controller. The other servers, if any, will automatically pickup the properties established for the PBX configuration from the primary controller.

- You may be prompted to stop and restart the MAS after you have made changes to a property in Voice Mail System Configuration. If so, the changes will not take effect until you stop and restart the MAS.

- When you configure a PBX, changes may take a few minutes to become effective on all MASs. It is recommended that you run only one instance of Voice Mail System Configuration at a time in the voice mail domain.

Before you begin

Ensure you have read Chapter 2, "Introduction to Voice Mail System Configuration". That chapter introduces you to the Voice Mail System Configuration application used to perform the configuration.

Start the Voice Mail System Configuration application from the Modular Messaging software folder.
Configuring PBX properties (analog)

This section describes how to configure PBX properties if you are using analog voice cards.

To configure PBX properties for analog telephony:

1. In the Voice Mail System Configuration window, click the voice mail domain.

2. Click PBXs (expanding the list, if necessary).

3. Double-click the PBX you want to configure.

   The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.

4. Configure the following PBX properties:

   - **General**
     
     Use this tab to set up general PBX options. You can use it to control the voice mail system volume and to set options for dual tone multi-frequency (DTMF) dialing tones.

     See Configuring PBX General properties (analog) on page 4-5.

   - **Call Transfer**
     
     Use this tab to set up options for PBX call transfer. You can specify transfer release codes.

     See Configuring call transfer properties (analog) on page 4-7.

   - **Hangup Detection**
     
     Use this tab to set up options for PBX hangup detection. You can specify string options and tone settings for DTMF hangup.

     See Configuring Hangup Detection properties (analog) on page 4-10.

   - **Intercom Paging**
     
     Use this tab to set up options for PBX intercom paging. Intercom paging allows callers to page subscribers in the building if they do not answer their extensions.

     See Configuring Intercom Paging properties (analog) on page 4-11.

5. To save the settings, click **OK**.
Configuring PBX General properties (analog)

To specify basic PBX options for a particular PBX type, use the **PBX Configuration - Voice Mail Domain** dialog box, **General** tab. You can control the voice mail system volume and specify options for dual tone multi-frequency (DTMF) dialing tones.

**To configure PBX analog General properties:**

1. In the **Voice Mail System Configuration** window, click the voice mail domain.

2. Click **PBXs** (expanding the list, if necessary).

3. Double-click the PBX you want to configure.

   The system displays the **PBX Configuration - Voice Mail Domain** dialog box for the selected PBX.

4. Click the **General** tab.

5. Configure the following fields:

   - **Go Off Hook when Port Disabled** Select to place a port off hook when it is disabled. If cleared, the port rings but does not answer. This check box is selected by default.

   - **Pause before Digits (ms)** Enter the time, in milliseconds, that the voice mail system waits after taking the voice port off hook before becoming available. The range is 100 through 9999, and the default is 500.

   - **Pause Interval for Comma in Dial String (ms)** Enter the duration, in milliseconds, represented by a comma in a dial string. The range is 100 through 9999, and the default is 2000.

   - **DTMF Inter-Digit Delay during Dialing (ms)** Enter the duration, in milliseconds, between DTMF tones when dialing. The range is 10 through 999, and the default is 80.

   - **DTMF Length during Dialing (ms)** Enter the duration, in milliseconds, of a DTMF tone when dialing. The range is 10 through 999, and the default is 80.

   - **DTMF Length during Detection (ms)** Enter the length, in milliseconds, of a DTMF tone during detection. The range is 1 through 999, and the default is 50.

   - **DTMF Length during Play (ms)** Enter the length, in milliseconds, of a DTMF tone during play. The range is 1 through 999, and the default is 50.

   - **Note:** Default values differ depending on the PBX type.
Configuring call transfer properties (analog)

To configure PBX call transfer properties for a voice mail domain, use the Call Transfer tab. You can specify release codes, if required by the PBX type.

To configure PBX analog Call Transfer properties:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Click PBXs (expanding the list, if necessary).
3. Double-click the PBX you want to configure.
   
The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.
4. Click the Call Transfer tab.
5. Configure the following fields:

   **Note:** Default values differ depending on the PBX type.

   - **Transfer Mode**  Select the mode to be used. You can select from Blind, Partial, or Full. The default is Blind.

   - **Transfer Prefix Code**  Enter the code which prefixes a call transfer, if required by the PBX. The code can be DTMF or a combination of the letters A through D, H, N, T, X, P, M, and R, and the special characters pound (#), asterisk (*), dash (-), comma (,), plus sign (+), and ampersand (&). You can enter up to 99 characters.

   - **Transfer Completion Code**  Enter the code that completes a call transfer, if required by the PBX. The code can be DTMF or a combination of the letters A through D, H, N, T, X, P, M, and R, and the special characters pound (#), asterisk (*), dash (-), comma (,), plus sign (+), and ampersand (&). You can enter up to 99 characters.

   **Note:** Leave this field blank for C-LAN integration.

   - **Transfer Release Code when Busy**  Enter a transfer release code for a busy extension, if required by the PBX. The code can be DTMF or a combination of the letters A through D, H, N, T, X, P, M, and R, and the special characters pound (#), asterisk (*), dash (-), comma (,), plus sign (+), and ampersand (&). You can enter up to 99 characters.

   - **Transfer Release Code when No Answer**  Enter a transfer release code for a ring-no-answer extension, if required by the PBX. The code can be DTMF or a combination of the letters A through D, H, N, T, X, P, M, and R, and the special characters pound (#), asterisk (*), dash (-), comma (,), plus sign (+), and ampersand (&). You can enter up to 99 characters.
- **Transfer Release Code when Reject** Enter a transfer release code for an extension rejection call, if required by the PBX. The code can be DTMF or a combination of the letters A through D, H, N, T, X, P, M, and R, and the special characters pound (#), asterisk (*), dash (-), comma (,), plus sign (+), and ampersand (&). You can enter up to 99 characters.

- **Flash Time Interval (ms)** Enter the time, in milliseconds, that the hookswitch must be pressed for the voice mail system to recognize it as a hookswitch flash signal. The range is 0 through 10000.

- **Enable Call Progress** Select to enable full call progress. When selected and a call is placed to an extension, the system listens for busy, invalid number, no answer, and connect signals. If cleared and a call is placed to an extension, the system assumes an answer. This check box is selected by default.

  **Note:** This property may be overridden by other applications when placing an outbound call.

- **Start Delay for Call Progress** Enter the duration, in milliseconds, between dialing a number and starting call progress. The range is 0 through 5000. For more information, see Call transfer codes.

  **Note:** This field is not available if you clear the Enable Call Progress check box.
Call transfer codes

You can create a transfer sequence using the codes listed below plus any dual tone multi-frequency (DTMF) digits.

<table>
<thead>
<tr>
<th>Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp; (ampersand)</td>
<td>Flash</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Pause</td>
</tr>
<tr>
<td>- (minus sign)</td>
<td>On hook</td>
</tr>
<tr>
<td>+ (plus sign)</td>
<td>Off hook</td>
</tr>
<tr>
<td>A, B, C, or D</td>
<td>Dial with full call progress, listen for busy, invalid number, no answer or connect</td>
</tr>
<tr>
<td>P</td>
<td>Dial with partial call progress, listen for busy or invalid number</td>
</tr>
<tr>
<td>N</td>
<td>Dial without call progress</td>
</tr>
<tr>
<td>X</td>
<td>Extension (place extension in dial string)</td>
</tr>
<tr>
<td>H</td>
<td>Hard hangup</td>
</tr>
<tr>
<td>T</td>
<td>DTMF</td>
</tr>
<tr>
<td>M</td>
<td>MF</td>
</tr>
<tr>
<td>R</td>
<td>Earth recall</td>
</tr>
<tr>
<td>0–9, # and *</td>
<td>Valid DTMF key presses</td>
</tr>
</tbody>
</table>
Configuring Hangup Detection properties (analog)

To configure PBX hangup detection properties for a voice mail domain, use the **Hangup Detection** tab. You can specify hangup string options and tone settings.

To configure PBX analog **Hangup Detection** properties:

1. In the **Voice Mail System Configuration** window, click the voice mail domain.
2. Click **PBXs** (expanding the list, if necessary).
3. Double-click the PBX you want to configure.

   The system displays the **PBX Configuration - Voice Mail Domain** dialog box for the selected PBX.
4. Click the **Hangup Detection** tab.
5. Configure the following fields:

   **Note:** Default values differ depending on the PBX type.

   - **Maximum Continuous Tone before Hanging Up (ms)** Enter the time, in milliseconds, that the voice mail system listens to a dial tone once a caller hangs up, before dropping the line. The range is 0 through 12000.

   - **Hangup String** Enter the sequence of DTMF digits and call transfer codes (& - = D H N T X P M) that the PBX sends to indicate that a call has terminated (been hung up).

      **Note:** This field is applicable to only certain switches that support inband integration. Leave this field blank for C-LAN, DMI-4, and RS-232 integrations.

   - **Hangup String Timeout (ms)** Enter the time, in milliseconds, that the voice mail system waits between digits before validating a hangup string. The range is 0 through 9999.

   - **Minimum Duration for Drop in Loop Current (ms)** Enter the time, in milliseconds, that must elapse before the voice mail system recognizes a true drop in loop current. The range is 0 through 3000. Setting this field to 0 disables this feature.

   - **Maximum Silence before Hanging Up (ms)** Enter the time, in milliseconds, that the voice mail system waits before hanging up if a user falls silent while recording. The range is 0 through 12000.
Configuring Intercom Paging properties (analog)

To configure PBX intercom paging properties for a voice mail domain, use the Intercom Paging tab. Using intercom paging, callers can page subscribers in the building if they do not answer their extensions.

Notes:

- Your PBX type may not support intercom paging.
- For Modular Messaging to do trunk-level paging, you must have additional hardware between the Modular Messaging system, the PBX, and the paging system. For more information, contact your Modular Messaging service or technical support representative.

To configure PBX Intercom Paging properties for analog telephony:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Click PBXs (expanding the list, if necessary).
3. Double-click the PBX you want to configure.

   The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.
4. Click the Intercom Paging tab.
5. Configure the following fields:

   - **Enable Intercom Paging** Select to allow a caller to page subscribers in the building if they do not answer their extension. This check box is cleared by default.
   - **Intercom Paging Code** Enter the intercom paging code sent to the PBX to start intercom paging, if required by the PBX. This field is blank by default.
   - **Release Code for Intercom Paging** Enter the code sent to the PBX to stop intercom paging. This field is blank by default.
   - **Repeat Intercom Paging Phrase** Select to get the automated attendant to play the intercom paging phrase (“there is a call for `<subscriber’s name>`”) twice instead of once. This check box is cleared by default.
   - **Number of Retries when Paging System is Busy** Enter a number to specify the number of times the voice mail system attempts to page a subscriber when met by a busy response. The range is 0 through 9, and the default is 3.
PBX Configuration

- **Number of Retries when No Answer**  Enter a number to specify the number of times a caller can request to page a subscriber whose extension is not answered. The range is 0 through 9, and the default is 3.

- **Paging Wait Time (sec)**  Enter the number of seconds a caller is kept on hold after paging a subscriber. The range is 0 through 99, and the default is 10.

**Note:** After you make changes to Intercom Paging properties, you must stop and restart the MAS. If you do not do so, the changes do not take effect.
Configuring PBX properties (IP H.323)

This section describes how to configure PBX properties for H.323-based IP integration.

To configure PBX properties for H.323-based IP integration:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Click PBXs (expanding the list, if necessary).
3. Double-click the PBX you want to configure.

   The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.

4. Configure the following PBX properties:
   - **Transfer / Outcall**
     
     Use this tab to configure the transfer mode.

     See Configuring Transfer / Outcall properties (IP H.323) on page 4-14.

   - **Outgoing Call**
     
     Use this tab to set up PBX outgoing call options, including the number plan and the number type.

     See Configuring Outgoing Call properties (IP H.323) on page 4-15.

5. To save the settings, click OK.
PBX Configuration

Configuring Transfer / Outcall properties (IP H.323)

To configure PBX IP H.323 call transfer properties for a voice mail domain, use the Transfer / Outcall tab.

To configure PBX IP H.323 Transfer / Outcall properties:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Click PBXs (expanding the list, if necessary).
3. Double-click the PBX you want to configure.

   The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.
4. Click the Transfer / Outcall tab.
5. Configure the following field:

   ▪ **Transfer mode**  Select to set up call progress analysis during call transfer. If **Full** is selected, the system listens for busy, invalid number, no answer, and connect signals. If **Partial** is selected, the system listens for busy and invalid number signals. If **Blind** is selected, no call progress analysis takes place.

---

**Note:**  To prevent callers from being disconnected when calls are re-routed to the MAS, select the **Full** transfer mode. Select the **Blind** or **Partial** transfer modes only when calls are not re-routed to the MAS.
Configuring Outgoing Call properties (IP H.323)

To specify the properties of an outgoing call, use the **Outgoing Call (IP H.323)** tab.

**To configure PBX IP H.323 Outgoing Calls properties:**

1. In the **Voice Mail System Configuration** window, click the voice mail domain.
2. Click PBXs (expanding the list, if necessary).
3. Double-click the PBX you want to configure.
   
   The system displays the **PBX Configuration - Voice Mail Domain** dialog box for the selected PBX.
4. Click the **Outgoing Calls** tab.
5. Configure the following fields:

   - **Number Type**  Select the Number Type designated by the local ISDN provider. The default is Unknown. Select one of the following supported values:
     - Unknown
     - International
     - National
     - Local

   - **Number Plan**  Select the Number Plan designated by the local ISDN provider. The default is Unknown. Select one of the following supported values:
     - Unknown
     - ISDN/Telephony E.164/E.163
     - Private

   - **Origin Number**  The Origin Number is the originating telephone number for all outgoing calls. This must be a unique number that does not conflict with any other extension in the MAS. You can enter up to 32 digits, and the default is 9999.
Configuring PBX properties (QSIG)

This section describes how to configure PBX properties if you are using Q-Signaling (QSIG) cards.

To configure PBX properties for QSIG integration:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Click PBXs (expanding the list, if necessary).
3. Double-click the PBX you want to configure.
   The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.
4. Configure the following PBX properties:
   - **General**
     - Use this tab to set up general PBX options. You can use it to set options for dual tone multi-frequency (DTMF) dialing tones.
     - See Configuring PBX General properties (QSIG) on page 4-18.
   - **Transfer / Outcall**
     - Use this tab to configure the transfer mode.
     - See Configuring Transfer / Outcall properties (QSIG) on page 4-19.
   - **Tone Detection**
     - Use this tab to specify the maximum silence before hanging up.
     - See Configuring tone detection (QSIG) on page 4-20.
   - **Outgoing Call**
     - Use this tab to set up PBX outgoing call options, including the layer 1 protocol and the number type.
     - See Configuring Outgoing Call properties (QSIG) on page 4-21.
   - **Intercom Paging**
     - Use this tab to set up PBX intercom paging options. Intercom paging allows callers to page subscribers in the building if they do not answer their extensions.
     - See Configuring Intercom Paging properties (QSIG) on page 4-23.
5. To save the settings, click **OK**.
Configuring PBX General properties (QSIG)

To specify basic PBX options for a particular PBX type (QSIG), use the PBX Configuration - Voice Mail Domain dialog box, General tab.

To configure PBX QSIG general properties:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Click PBXs (expanding the list, if necessary).
3. Double-click the PBX you want to configure.
   The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.
4. Click the General tab.
5. Configure the following fields:
   - **DTMF Inter-Digit Delay during Dialing (ms)** Enter the duration, in milliseconds, between DTMF tones when dialing. The range is 10 through 999, and the default is 80.
   - **DTMF Length during Dialing (ms)** Enter the duration, in milliseconds, of a DTMF tone when dialing. The range is 10 through 999, and the default is 80.
   - **DTMF Length during Detection (ms)** Enter the length, in milliseconds, of a DTMF tone during detection. The range is 1 through 999, and the default is 50.
Configuring Transfer / Outcall properties (QSIG)

To configure PBX QSIG call transfer properties for a voice mail domain, use the Transfer / Outcall tab.

To configure PBX QSIG Transfer / Outcall properties:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Click PBXs (expanding the list, if necessary).
3. Double-click the PBX you want to configure.

The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.
4. Click the Transfer / Outcall tab.
5. Configure the following field:

- **Transfer mode**  Select to set up call progress analysis during call transfer. If Full is selected, the system listens for busy, invalid number, no answer, and connect signals. If Partial is selected, the system listens for busy and invalid number signals. If Blind is selected, there is no call progress analysis.
Configuring tone detection (QSIG)

To configure QSIG tone detection for a voice mail domain, use the Tone Detection tab. You can specify maximum continuous tone before hanging up.

To configure tone detection (QSIG) properties:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Click PBXs (expanding the list, if necessary).
3. Double-click the PBX you want to configure.
   
The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.
4. Click the Tone Detection (QSIG) tab.
5. Configure the following field:

   - Maximum Silence Before Hanging Up (ms) Enter the duration, in milliseconds, that the voice mail system listens to a dial tone after a caller hangs up, before dropping the line. The range is 0 through 9999, and the default is 6000.
Configuring Outgoing Call properties (QSIG)

To specify the properties of an outgoing call, use the **Outgoing Call** (QSIG) tab.

**To configure PBX QSIG Outgoing Calls properties:**

1. In the **Voice Mail System Configuration** window, click the voice mail domain.
2. Click **PBXs** (expanding the list, if necessary).
3. Double-click the PBX you want to configure.
   - The system displays the **PBX Configuration - Voice Mail Domain** dialog box for the selected PBX.
4. Click the **Outgoing Calls** tab.
5. Configure the following fields:
   - **Layer 1 Protocol** This value defines the Layer 1 protocol used with the outgoing call. The default is G.711 A-law. Select one of the following supported values:
     - G.711u-law
     - G.711A-law
   - **BC Transfer Cap** This value defines the transfer rate for bearer capability information. The default is Speech. Select one of the following supported values:
     - Speech
     - Unrestricted Digital Data
     - Restricted Digital Data
   - **Number Type** Select the Number Type designated by the local ISDN provider. The default is Unknown. Select one of the following supported values:
     - Unknown
     - International
     - National
     - Local
PBX Configuration

- **Number Plan**  Select the Number Plan designated by the local ISDN provider. The default is Unknown. Select one of the following supported values:
  - Unknown
  - ISDN/Telephony E.164/E.163
  - Private

- **Origin Number**  The Origin Number is the originating telephone number for all outgoing calls. This must be a unique number that does not conflict with any other extension in the MAS. You can enter up to 32 digits, and the default is 9999.
Configuring Intercom Paging properties (QSIG)

The intercom paging feature allows callers to page subscribers in the building if they do not answer their extensions. To configure PBX intercom paging properties for a voice mail domain, use the Intercom Paging tab.

Notes:

- Your PBX type may not support intercom paging.
- For Modular Messaging to do trunk-level paging, you must have additional hardware between the Modular Messaging system, the PBX, and the paging system. For more information, contact your Modular Messaging service or technical support representative.

To configure PBX Intercom Paging properties for QSIG:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Click PBXs (expanding the list, if necessary).
3. Double-click the PBX you want to configure.
   
   The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.
4. Click the Intercom Paging tab.
5. Configure the following fields:

   - **Enable Intercom Paging**  Select to allow a caller to page subscribers in the building if they do not answer their extension. This check box is cleared by default.
   
   - **Intercom Paging Code**  Enter the intercom paging code sent to the PBX to start intercom paging, if required by the PBX. This field is blank by default.
   
   - **Release Code for Intercom Paging**  Enter the code sent to the PBX to stop intercom paging. This field is blank by default.
   
   - **Repeat Intercom Paging Phrase**  Select in order for the automated attendant to play the intercom paging phrase (“there is a call for <subscriber's name>”) twice instead of once. This check box is cleared by default.
   
   - **Number of Retries when Paging System is Busy**  Enter a number to specify the number of times the voice mail system attempts to page a subscriber when met by a busy response. The range is 0 through 9, and the default is 3.
PBX Configuration

- **Number of Retries when No Answer**  Enter a number to specify the number of times a caller can select to page a subscriber whose extension is not answered. The range is 0 through 9, and the default is 3.

- **Paging Wait Time (sec)**  Enter the number of seconds a caller is kept on hold after paging a subscriber. The range is 0 through 99, and the default is 10.

**Note:** After you make changes to **Intercom Paging** properties, you must stop and restart the MAS. If you do not do so, the changes do not take effect.
Configuring PBX properties (set emulation)

This section describes how to configure PBX properties if you are using set emulation cards.

To configure PBX properties for digital set emulation integration:

1. In the Voice Mail System Configuration window, click the voice mail domain.

2. Click PBXs (expanding the list, if necessary).

3. Double-click the PBX you want to configure.

   The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.

4. Configure the following PBX properties:

   - **General**
     
     Use this tab to set up general PBX options. You can use it to set options for dual tone multi-frequency (DTMF) dialing tones.
     
     See Configuring PBX General properties (set emulation) on page 4-26.

   - **Outcall / Transfer**
     
     Use this tab to set up PBX call transfer options, including the transfer mode and call progress options.
     
     See Configuring outcall/transfer properties (set emulation) on page 4-27.

   - **Tone Detection**
     
     Use this tab to set up PBX hangup-detection options.
     
     See Configuring tone detection (set emulation) on page 4-30.

   - **Intercom Paging**
     
     Use this tab to set up PBX intercom paging options. Intercom paging allows callers to page subscribers in the building if they do not answer their extensions.
     
     See Configuring intercom paging properties (set emulation) on page 4-31.

5. To save the settings, click OK.
Configuring PBX General properties (set emulation)

To specify basic PBX options for a particular PBX type (set emulation), use the PBX Configuration - Voice Mail Domain dialog box, General tab.

To configure PBX set emulation general properties:

1. In the Voice Mail System Configuration window, click the voice mail domain.

2. Click PBXs (expanding the list, if necessary).

3. Double-click the PBX you want to configure.

   The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.

4. Click the General tab.

5. Configure the following fields:

   - **DTMF Inter-Digit Delay during Dialing (ms)** Enter the duration, in milliseconds, between DTMF tones during detection. The range is 1 through 999, and the default is 80.

   - **DTMF Length during Dialing (ms)** Enter the duration, in milliseconds, of a DTMF tone when dialing. The range is 10 through 999, and the default is 80.

   - **DTMF Length during Detection (ms)** Enter the length, in milliseconds, of a DTMF tone during detection. The range is 1 through 9999, and the default is 50.

   - **Port Disable Key** Select the key used to disable the port on the MAS. When disabled, the PBX cannot send calls to that port and the port cannot make outgoing calls. The default is C.
Configuring outcall/transfer properties (set emulation)

To configure PBX set emulation call transfer properties for a voice mail domain, use the **Transfer / Outcall** tab.

**To configure PBX set emulation Transfer / Outcall properties:**

1. In the **Voice Mail System Configuration** window, click the voice mail domain.
2. Click **PBXs** (expanding the list, if necessary).
3. Double-click the PBX you want to configure.

The system displays the **PBX Configuration - Voice Mail Domain** dialog box for the selected PBX.
4. Click the **Transfer / Outcall** tab.
5. Configure the following fields:

   - **Transfer mode** Select to set up call progress analysis during call transfer. If Full is selected, the system listens for busy, invalid number, no answer, and connect signals. If Partial is selected, the system listens for busy and invalid number signals. If Blind is selected, no call progress analysis takes place.

   - **Start Delay for Call Progress** Enter the duration, in milliseconds, between dialing a number and starting call progress. The range is 0 through 20000, and the default is 6000.

   - **Initiate Transfer** Enter the dial string required to start a transfer. You can enter up to 50 characters. The default is ^KD,L%s for NT M-1 and ^Kk,L%s for G3 switches.

   - **Initiate Blind Transfer** Identifies the dial string required to start an unsupervised transfer. By default the behavior of the Initiate Blind Transfer dial string is the same as the behavior of the Initiate Transfer dial string. If required, you can add characters to control the behavior of this dial string. You can enter up to 50 characters, and the default is %s.

   - **Complete Transfer** Enter the dial string required to complete a transfer. You can enter up to 50 characters. The default is ^KD for NT M-1, and ^Kk for G3 switches.

   - **Retrieve Call** Enter the dial string required to drop a transferring call and reconnect the MAS to the calling party. You can enter up to 50 characters, and the default is ^KA.

   - **Drop Call** Enter the dial string required to drop a call by emulating the Release key. You can enter up to 50 characters. The default is ^KR for NT M-1, and ^Kj for G3 switches.
PBX Configuration

- **Make Call Prefix**: Enter the dial string required when using an alternate key for outgoing calls. This setting is used mostly for automatic call distribution (ACD) integrations, where outgoing calls are made on a different call appearance than incoming calls. You can enter up to 50 characters, and the default is Blank.

For more information on automatic call distribution, see Configuring automatic call distribution (ACD) on page 6-8.

For more information on dialing string syntax, see Dialing string syntax on page 4-29.
## Dialing string syntax

<table>
<thead>
<tr>
<th>Character</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>^</td>
<td>Substituted with the Escape key</td>
</tr>
<tr>
<td>L</td>
<td>Wait for dial tone</td>
</tr>
<tr>
<td>%s</td>
<td>Substituted with the number dialed</td>
</tr>
<tr>
<td>,</td>
<td>Pause</td>
</tr>
<tr>
<td>K</td>
<td>Identifies a particular key. For example, KD identifies the ‘D’ key</td>
</tr>
</tbody>
</table>
Configuring tone detection (set emulation)

To configure set emulation tone detection properties for a voice mail domain, use the Tone Detection tab. You can specify maximum continuous tone before hanging up.

To configure tone detection (set emulation) properties:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Click PBXs (expanding the list, if necessary).
3. Double-click the PBX you want to configure.
   The system displays the PBX Configuration - Voice Mail Domain dialog box for the selected PBX.
4. Click the Tone Detection (set emulation) tab.
5. Configure the following fields:

- **Maximum Silence before Hanging Up (ms)** Enter the time, in milliseconds, that the voice mail system listens to a dial tone after a caller hangs up, before dropping the line. The range is 0 through 9999, and the default is 6000.

- **Maximum Tone before Hanging Up (ms)** Enter the time, in milliseconds, that the voice mail system listens to a continuous tone, before dropping the line. This prevents the system from recording dial tones. The range is 0 through 12000, and the default is 6000.

- **Record trim length (ms)** Enter the amount of time to trim off a recording that is terminated by the caller hanging up. That is, when a caller records a message and then hangs up, the end of the recording will be trimmed by the amount of time specified in this field.
Configuring intercom paging properties (set emulation)

To configure PBX intercom paging properties for a voice mail domain, use the **Intercom Paging** tab. Using intercom paging, callers can page subscribers in the building if they do not answer their extensions.

### Notes:

- Your PBX type may not support intercom paging.
- For Modular Messaging to do trunk-level paging, you must have additional hardware between the Modular Messaging system, the PBX, and the paging system. For more information, contact your Modular Messaging service or technical support representative.

### To configure PBX intercom paging properties for set emulation:

1. In the **Voice Mail System Configuration** window, click the voice mail domain.
2. Click **PBXs** (expanding the list, if necessary).
3. Double-click the PBX you want to configure.
   
   The system displays the **PBX Configuration - Voice Mail Domain** dialog box for the selected PBX.
4. Click the **Intercom Paging** tab.
5. Configure the following fields:

   - **Enable Intercom Paging** Select to allow a caller to page subscribers in the building if they do not answer their extension. This check box is cleared by default.
   - **Intercom Paging Code** Enter the intercom paging code sent to the PBX to start intercom paging, if required by the PBX. This field is blank by default.
   - **Release Code for Intercom Paging** Enter the code sent to the PBX to stop intercom paging. This field is blank by default.
   - **Repeat Intercom Paging Phrase** Select in order for the automated attendant to play the intercom paging phrase (“there is a call for <subscriber's name>”) twice instead of once. This check box is cleared by default.
   - **Number of Retries when Paging System is Busy** Enter a number to specify the number of times the voice mail system attempts to page a subscriber when met by a busy response. The range is 0 through 9, and the default is 3.
- **Number of Retries when No Answer** Enter a number to specify the number of times a caller can select to page a subscriber whose extension is not answered. The range is 0 through 9, and the default is 3.

- **Paging Wait Time (sec)** Enter the number of seconds a caller is kept on hold after paging a subscriber. The range is 0 through 99, and the default is 10.

**Note:** After you make changes to **Intercom Paging** properties, you must stop and restart the MAS. If you do not do so, the changes do not take effect.
This chapter describes how to configure properties in a voice mail domain.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to configuring a voice mail domain</td>
<td>5-2</td>
</tr>
<tr>
<td>Configuring the Automated Attendant</td>
<td>5-5</td>
</tr>
<tr>
<td>Configuring Call Me</td>
<td>5-13</td>
</tr>
<tr>
<td>Configuring message waiting indicator (MWI)</td>
<td>5-16</td>
</tr>
<tr>
<td>Configuring fax</td>
<td>5-18</td>
</tr>
<tr>
<td>Configuring voice mail domain security</td>
<td>5-25</td>
</tr>
<tr>
<td>Configuring message store security</td>
<td>5-28</td>
</tr>
<tr>
<td>Configuring the Privacy Enforcement Level</td>
<td>5-30</td>
</tr>
<tr>
<td>Configuring languages</td>
<td>5-32</td>
</tr>
<tr>
<td>Configuring the audio encoding format</td>
<td>5-34</td>
</tr>
<tr>
<td>Configuring access to messages when the MAS goes offline</td>
<td>5-35</td>
</tr>
<tr>
<td>Configuring serviceability</td>
<td>5-38</td>
</tr>
<tr>
<td>Viewing and configuring licensing</td>
<td>5-43</td>
</tr>
<tr>
<td>Configuring the tracing system</td>
<td>5-48</td>
</tr>
</tbody>
</table>
Introduction to configuring a voice mail domain

Notes:

- Voice mail domain properties are shared among all MASs in the voice mail domain. If you administer a voice mail domain property on an MAS, the changes will be propagated to all MASs in the voice mail domain, regardless of which one you administered it on.

- You may be prompted to stop and restart the MAS after you have made changes to a property in Voice Mail System Configuration. If so, the changes will not take effect until you stop and restart the MAS.

- When configuring a voice mail domain, changes to domain-wide properties may take a few minutes to become effective on all MASs. It is recommended that you run only one instance of Voice Mail System Configuration at a time in the voice mail domain.

You can configure the following groups of properties for a voice mail domain:

- **Automated attendant**
  You can configure how the Automated Attendant greets callers and instructs them on how to proceed.
  
  See [Configuring the Automated Attendant](#) on page 5-5.

- **Call Me**
  You can configure Call Me properties.
  
  See [Configuring Call Me](#) on page 5-13.

- **Message Waiting Indicator**
  You can configure Message Waiting Indicator properties.
  
  See [Configuring message waiting indicator (MWI)](#) on page 5-16.

- **Fax**
  You can configure how the Fax feature works.
  
  See [Configuring fax](#) on page 5-18.

- **Security**
  You can configure which users or groups can administer the voice mail domain.
See Configuring voice mail domain security on page 5-25 and Configuring message store security on page 5-28.

Languages

You can configure the primary language to be used by the telephone user interface in the voice mail domain. You can also enable and disable multi-language text-to-speech, and select text-to-speech languages.

See Configuring languages on page 5-32.

Audio Encoding

You can configure the audio encoding format used for recording messages.

See Configuring the audio encoding format on page 5-34.

Messaging

You can configure how the system responds when one or more components go offline, including how users are able to access messages.

See Configuring access to messages when the MAS goes offline on page 5-35.

Serviceability

You can configure how alarm notifications are handled on your system.

See Configuring serviceability on page 5-38.

Licensing

You can view licensing information for your system.

See Viewing licensing information on page 5-44.

Tracing system

You can configure how the information about voice mail system activity is logged.

See Configuring the tracing system on page 5-48.

Before you begin

Ensure you have read Chapter 2, “Introduction to Voice Mail System Configuration”. That chapter introduces you to the Voice Mail System Configuration application used to perform the configuration.
Starting the Voice Mail System Configuration application

To perform many of the procedures and administrative tasks on the MAS, you must start the Voice Mail System Configuration application.

To start the Voice Mail System Configuration application, click Start > Programs > Avaya Modular Messaging > Voice Mail System Configuration.
Configuring the Automated Attendant

Note: If you are familiar with or are migrating from an Intuity AUDIX environment, you should be aware that the use of the term “automated attendant” in Avaya Modular Messaging systems carries somewhat different connotations than in AUDIX systems.

Modular Messaging’s Automated Attendant, if enabled, is used to prompt callers with the system greeting and collect their input (in the form of DTMF key presses). It can also be configured to offer single-digit menu choices and use the Dial By Name feature to reach subscribers.

In Modular Messaging, caller applications provide roughly the same functionality as AUDIX nested and other automated attendants. For a more thorough discussion of “automated attendants” in AUDIX compared with Modular Messaging, see Appendix B, Examples of Caller Applications. For more information about using caller applications, see Chapter 11, “Caller Applications”.

The system Automated Attendant greets callers and instructs them how to proceed through the system. We recommend using the Automated Attendant if:

- Your PBX does not support Direct Inward Dialing (DID).
- You want to use other call handling features, such as intercom paging, call blocking, and call screening.

Note: To enable or disable the Automated Attendant at the system level, you must use the Telephone User Interface - Voice Mail Domain dialog box, General tab. For more information, see Configuring TUI general properties on page 3-4.

The Automated Attendant provides only the initial prompt to get callers into the system. It is designed primarily to:

- Provide an initial welcome/greeting prompt to callers.
- Allow callers up to nine key press menu options (the 0 key is reserved for system use). Each key press menu option can be set to any of the following:
  - Allow callers to use the Dial By Name feature (Directory).
  - Allow callers to leave a message for the subscriber they are trying to reach (Message).
  - Transfer callers to somewhere else. Transfer options include subscriber mailboxes, system operators, or caller applications (Transfer).
— Be invalid—that is, the system does not recognize the key press as being a valid option (invalid).

You can configure the following Automated Attendant properties for the voice mail domain.

- **Attendant Main Menu Editor**

  Use this tab to configure the Automated Attendant Main Menu Prompt. This prompt helps callers to navigate through the TUI by providing them with menu options they can select using touchtone key presses.

  See [Configuring Attendant Main Menu Editor properties](#) on page 5-7.

- **Holidays**

  Use this tab to configure the Automated Attendant holiday prompts. You can set up alternate prompts to be played on specific dates, for example, when the office is closed for a public holiday.

  See [Configuring Holidays properties](#) on page 5-9.

- **Time of Day**

  Use this tab to configure the prompts that will be used during business morning, afternoon, evening, and closed hours.

  See [Configuring Time of Day properties](#) on page 5-10.

- **Language/Key Association**

  Use this tab to allow callers to select a language when entering the system. You can assign keypad digits for up to three languages supported by the TUI.

  See [Configuring Language/Key Association properties](#) on page 5-11.
Configuring Attendant Main Menu Editor properties

To configure the Automated Attendant main menu for a voice mail domain, use the **Attendant Main Menu Editor** tab. The Automated Attendant main menu helps callers find their way around the telephone user interface by prompting them on how to proceed. For example:

“For sales, press 1. For technical support, press 2. For accounting, press 3.”

**Important:** Before you can use this prompt on a live system you must record it or import a recording of it. If you record it before setting these properties, make a note of the prompt number. For information on recording this and other prompts, see Chapter 10, “Custom Prompts”.

To display the Attendant Main Menu Editor tab:

1. In the **Voice Mail System Configuration** window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click **Auto Attendant**.

   The system displays the **Auto Attendant - Voice Mail Domain** dialog box.

3. Click the **Attendant Main Menu Editor** tab.

To configure the Attendant Main Menu Editor properties, complete the following fields:

**Note:** The options on this tab are unavailable if any languages have been selected in the **Language/Key Association** tab (see Configuring Language/Key Association properties on page 5-11).

- **Auto Attendant Main Menu Prompt** Enter the number of the main Automated Attendant prompt as recorded in Visual Voice Editor. The range is 0 through 9999. By default, this is 0, which means that the system uses the pre-recorded system prompt, “Please enter the mailbox of the person you are calling.”

- **[Keypad Digits] 1 through 9** Select a keypad digit to configure. You can configure touchtone keypad digits 1 through 9. (The keys for *, # and 0 are reserved for system use and cannot be configured). Each keypad digit must be configured individually, using the **Key Settings** options.
Key Settings  You can make individual settings for each numeric key on the touchtone keypad (except 0, which is reserved for system use). By default, all key settings are Invalid.

- Invalid  Select to indicate this key is an invalid option. Use this setting if you specifically do not want to associate any action with the key press.

- Directory  Select to allow caller to use the Dial By Name feature when this key is pressed. The Dial By Name feature allows a caller to search for a subscriber extension or mailbox number by “spelling” the person’s name using the telephone keypad.

- Message  Select to allow a caller to leave a voice message when this keypad digit is pressed, followed by the extension number. This feature is called Quick Message.

Notes: If you select this option, make sure you either:

- Record your Automated Attendant Main Menu prompt to notify callers that they must enter this key press followed by the extension of the subscriber they are trying to reach; or

- Instruct your subscribers that they must include this key press as the first digit when giving their extension number to potential callers.

Transfer to: Mailbox Number  Select to allow the caller to transfer to the mailbox number you enter in the Mailbox Number field. This option is useful for transferring callers to particular departments, for example, “For technical support, press [2]”. The mailbox number you enter must have the correct number of digits, as required by the Number of Digits in a Mailbox field (see Configuring TUI general properties on page 3-4).

Note: This mailbox number can be associated with a caller application. For more information, see Chapter 11, “Caller Applications”. 
Configuring Holidays properties

To configure the Automated Attendant holiday prompts for a voice mail domain, use the **Holiday** tab. You can set up alternate prompts to be played on specific dates, for example, when the office is closed for a public holiday. You can configure up to 18 holidays to be active at one time.

**Important:** Make sure you have recorded the holiday prompts and made a note of the associated prompt numbers. For information on recording holiday prompts, see Chapter 10, "Custom Prompts".

To display the Holidays tab:

1. In the **Voice Mail System Configuration** window, click the voice mail domain.
   
   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click **Auto Attendant**.
   
   The system displays the **Auto Attendant - Voice Mail Domain** dialog box.

3. Click the **Holidays** tab.

To configure holiday properties, configure the following fields:

- **Date** Enter the date on which an alternate greeting is to be played. You can specify up to 18 dates as holidays.

- **Prompt** Enter the number of the prompt to be played as the holiday greeting. The default is 0 (which means that no holiday prompt is played).
Configuring Time of Day properties

To configure a voice mail domain with the prompts to play at certain times of the day, use the **Time of Day** tab. This means that you can set up one prompt to play in the morning hours (as defined by your organization’s daily business hours), a slightly different one to play in the afternoon, another to play in the evening hours, and a different one to play when you are closed for business.

Your organization’s daily business hours (morning, afternoon, evening, and closed hours) are defined in the **Time/Greeting** tab in the telephone user interface configuration. For information on defining daily business hours see the [Configuring time and greeting properties](#) on page 3-8.

**Important:** Make sure you have recorded the time of day prompts and made a note of the associated prompt numbers. For information on recording time of day prompts, see Chapter 10, “Custom Prompts.”

To display the Time of Day tab:

1. In the **Voice Mail System Configuration** window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click **Auto Attendant**.

   The system displays the **Auto Attendant - Voice Mail Domain** dialog box.

3. Click the **Time of Day** tab.

To configure Time of Day properties, configure the following fields:

- **Morning prompt** Enter the number of the prompt that greets callers during morning business hours. The range is 0 through 9999. By default, the system plays the standard pre-recorded welcome prompt.

- **Afternoon prompt** Enter the number of the prompt that greets callers during afternoon business hours. The range is 0 through 9999. By default, the system plays the standard pre-recorded welcome prompt.

- **Evening prompt** Enter the number of the prompt that greets callers during evening business hours. The range is 0 through 9999. By default, the system plays the standard pre-recorded welcome prompt.

- **Closed prompt** Enter the number of the prompt that greets callers after business hours. The range is 0 through 9999. By default, the system plays the standard pre-recorded welcome prompt.
Configuring Language/Key Association properties

If you require more than one language to be available to callers, you can set the system to present a list of language options to callers as the first prompt they hear when calling in to the system. You can also assign a keypad digit and Automated Attendant main menu greeting to each language supported by the TUI. These options are all set using the Language/Key Association tab.

When configured in this way, unless you use a Custom Language Selection Greeting prompt (see below), callers hear a default system prompt similar to the following:

"For English, press one. Pour français, appuyez sur le deux...".

Note that the prompt for each language is in that language.

Callers can then select the desired language by pressing the appropriate key on their touchtone keypads. When they do, they hear all following prompts in the selected language.

Notes:

- Selecting any language options on this tab automatically disables the Main Menu prompt on the Attendant Main Menu Editor tab (see Configuring Attendant Main Menu Editor properties on page 5-7). If you want your initial prompt to callers to include language selection as well as other options, you should not use this tab. Instead, you can use the system Automated Attendant and caller applications. For more information, see Chapter 11, “Caller Applications”.

- You can record the Main Menu Greeting for each required language. For information on recording customized prompts, see Chapter 10, “Custom Prompts”.

To display the Language/Key Association tab:

1. In the Voice Mail System Configuration window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Auto Attendant.

   The system displays the Auto Attendant - Voice Mail Domain dialog box.

3. Click the Language/Key Association tab.
To configure the Language/Key Association properties, configure the following fields:

- **Language 1 through 3** Select the languages that you want to configure. You can select any language supported by the TUI.

- **DTMF Key 1 through 3** Select DTMF keys for each associated language. You can select any DTMF key from 1 through 9.

- **Main Menu Greeting 1 through 3** Enter prompt numbers for the Automated Attendant main menu greeting to play when the associated language is selected. If you select anything other than 0, you must ensure that this welcome prompt is recorded in the correct language, but the system will automatically use the appropriate language prompts for all subsequent prompts. The range is 0 through 9999, and the default is 0, which is the default system prompt (in that language).

- **Custom Language Selection Greeting** Enter a prompt number in this field if you want to replace the default system language selection prompt with a different prompt. The range is 0 through 9999, and the default is 0, which is the default system prompt.
Configuring Call Me

To configure Call Me for a voice mail domain, use the Call Me dialog box.

Call Me allows subscribers to be called at one or more designated numbers each time they receive a message that meets certain criteria. (For more information about the rules and criteria that subscribers can set for this feature, see Enabling Call Me for subscribers on page 5-14.)

The subscriber is then invited to log on to the TUI in order to review the message.

Notes:

- If your system has more than one MAS, you should enable Call Me on only one MAS.

- When an MAS is offline, and offline access to call answer messages is configured, the Call Me feature does not operate unless Mailbox Monitor is still online and the Call Me server is able to contact another MAS in the voice mail domain. Similar considerations apply to the Message Waiting Indicator (MWI) feature being triggered by the arrival of interpersonal messages. MWI is never triggered by the arrival of call answer messages at an offline MAS.

- If, for any reason, you find it necessary to re-install the Call Me software after the initial system installation, you must first stop all Avaya Modular Messaging (MM) services on the MAS before installing it. Remember to restart the MM services when the software installation is complete. For the procedures to stop and restart the MM services, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

To display the Call Me property dialog box:

1. In the Voice Mail System Configuration window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Call Me.

   The system displays the Call Me - Voice Mail Domain dialog box, which has only one tab, the General tab.

To configure Call Me properties, configure the following fields:

- **Enable Call Me**  To enable the Call Me feature, select this check box. By default, this check box is cleared and this feature is not enabled.
Note: The following Call Me configuration fields are active only when Call Me is enabled. For more information about enabling Call Me, see Enabling Call Me for subscribers on page 5-14.

- **MAS Call Me Server**  Enter the name of the Call Me server, or use the browse button to locate the Call Me server.

- **Maximum number of concurrent calls**  This parameter controls the number of concurrent Call Me processes supported by the voice mail system. This number is limited in any case to a maximum of 24, but it should not exceed the number of ports configured for Call Me in the voice mail domain. The range is 1 through 24, and the default is 5.

  The value of this field also controls the maximum number of outcalls that may be simultaneously in the process of being initiated by the voice mail system. However, once a call is initiated and connected, another process takes over and the system is free to initiate another outcall. This means you can have more than 24 ports with outcalls in progress.

  For information on configuring port groups for Call Me, see Configuring usage properties for port groups on page 8-15.

- **System minimum interval between calls (mins)**  Enter the time, in minutes, for the minimum interval between calls. The interval determines the minimum time allowed between mailbox checks for messages meeting specified criteria. It also determines the minimum time allowed between call retries to the subscriber’s telephone number if the line is busy. The range is 1 through 1000, and the default is 3.

- **System default interval between calls (mins)**  Enter the time, in minutes, for the default interval between calls. The system displays the default interval time in the Call Me rule. The range is 1 through 1000, and the default is 10.

- **Line busy retries**  Enter the maximum number of retries attempted for a number if the system receives a line busy signal. The range is 0 through 5, and the default is 2.

**Enabling Call Me for subscribers**

To enable a subscriber to use Call Me you must select the **Call Me** option for the subscriber’s mailbox in the Subscriber Administration tool.

Subscribers set up their own rules for using Call Me in Subscriber Options by specifying values in the following rule description:

When `[schedule]` is active, if `[message type]` with `[importance]`, from `[sender]` have arrived, call telephone numbers in `[phone list]` within `[minutes]` and then every `[interval]`.

Subscribers can set up multiple Call Me rules, and can have more than one rule active at any time. For example they may want to be notified at 10 minute intervals if voice
messages have arrived, and at 20 minute intervals if e-mail messages have arrived during the same schedule. They may also use phone lists to designate more than one phone number the system should use when attempting to reach them.

**Note:** The interval time automatically resets each time the subscriber logs on. For example, if the interval time for checking for voice messages is 10 minutes, and the interval time for checking for e-mail messages is 20 minutes, after listening to a new voice message, the mailbox will not check for e-mail messages until 20 minutes after the subscriber has logged off, regardless of the when it last checked for e-mail messages. This ensures that the interval time between logging off the TUI and receiving another Call Me call is never lower than the interval time specified in a rule.
Configuring message waiting indicator (MWI)

To configure the message waiting indicator (MWI) for a voice mail domain, use the Message Waiting Indicator - Voice Mail Domain dialog box.

MWI allows subscribers to be alerted when messages meeting specified criteria arrive in their mailbox. Subscribers are alerted either by a lamp indicator on their telephone, or an audible tone (stutter dial-tone) when they pick up the receiver. The indicator is cleared when the message is opened, or saved or deleted using the TUI. Subscribers can set up mailbox rules for using MWI in Subscriber Options.

Notes:

- If, for any reason, you find it necessary to re-install the MWI software after the initial system installation, you must first stop all Avaya Modular Messaging (MM) services on the MAS before installing it. Remember to restart the MM services when the software installation is complete. For the procedures to stop and restart the MM services, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

- The following procedure configures the MWI feature for the entire system. For individual mailboxes, enable MWI using the Subscriber Administration tool.

To display the Message Waiting Indicator - Voice Mail Domain dialog box:

1. In the Voice Mail System Configuration window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Message Waiting Indicator.

   The system displays the Message Waiting Indicator - Voice Mail Domain dialog box, which has only one tab, the General tab.
To configure MWI properties, configure the following fields:

- **Enable Message Waiting Indicator (MWI)** To enable MWI for the system, select this check box. By default, this check box is cleared (MWI is not enabled).

**Notes:**

- If your system has more than one MAS, you should enable MWI on only one MAS.

- The following MWI configuration fields appear only when MWI is enabled. For more information about enabling MWI, see Enabling MWI for subscribers on page 5-17.

- **MAS MWI server** Enter the name of the machine on which the MWI service is installed. To locate the server by browsing, click the browse button.

- **Limit requests** Select if you want to restrict the number of MWI requests made per minute. By default, this check box is cleared.

- **Maximum requests per minute** Enter the maximum number of MWI requests that can be made to the MWI MAS per minute. This field is available only if you have selected the Limit requests check box. The default is 60.

**Tip:** The first MAS in the list is the first MAS to which MWI requests are made. If required, you can use the Up and Down arrows to move MASs up or down the list.

- **Message Application Servers that support MWI** This box displays a list of MASs in the voice mail domain that support MWI. If you are using per-port integration, (e.g. Inband, QSIG or set emulation), an MAS can support MWI only if it has an MWI port group defined.

To add an MAS to the list of MASs that support MWI, click the Add icon and type the name of the MAS.

To delete an MAS from the list, click the MAS that you want to delete and click the Delete icon. The system prompts you to confirm the deletion.

**Enabling MWI for subscribers**

To enable a subscriber to use MWI you must click the Allow Message Waiting Indicator option for the subscriber’s mailbox in the Subscriber Administration tool.

Subscribers set up their own rules for using MWI in Subscriber Options by specifying values in the following rule description:

“If [message type] messages, with [importance], have arrived, set my message waiting indicator.”
Configuring fax

Using the fax capability, subscribers can send and receive faxes using their mailboxes. To enable fax for a voice mail domain, you must configure the system to communicate with a fax server.

**Note:** If you are enabling fax after the initial installation, you must modify the existing tone file (.tsf file) to include the fax tone. For information on modifying the tone file, see the voice card installation section of the installation guide for your system.

To use the fax feature, do the following:

- Configure general properties for fax. See Configuring fax general properties on page 5-18.
- Configure fax access codes. See Configuring access codes on page 5-21.
- Add a cover page for outgoing faxes. See Adding a cover page on page 5-22.
- Configure advanced fax properties. See Configuring advanced fax properties on page 5-23.
- (Optional) Turn off the fax confirmation feature. See Turning off the fax confirmation feature on page 5-24.

### Configuring fax general properties

To configure fax for a voice mail domain, use the Fax - Voice Mail Domain dialog box.

**To display the Fax - Voice Mail Domain dialog box:**

1. In the Voice Mail System Configuration window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Fax.

   The system displays the Fax - Voice Mail Domain dialog box, which has only one tab, the General tab.
To configure general fax properties, configure the following field:

Notes:

- Only one MAS should be selected to process outgoing faxes for the voice mail domain.

- The options available to you depend on whether your message store is an MSS, Exchange, or Lotus Domino server. Options not available to you are grayed out on this screen.

Fax Enable  Select to enable faxing. This check box is cleared by default.

Note: The following fax fields are active only if you have the previous check box selected.

- **Use native fax support**  This button is automatically turned on if your message store is an MSS.

- **MAS Fax Sender Server**  Enter the name of the MAS that will process outgoing faxes. If your system has only one MAS, enter the name of that MAS. If you do not know the name of the MAS, you can use **Browse** to locate it.

- **FAX Mailbox**  Enter the mailbox number of the mailbox on the messaging server that is to be used for outgoing faxes. This number must match the number in the Fax Mailbox Number field on the Configure Subscriber Management page of the MSS.

- **Company Fax Number**  Enter the fax number that callers should use to send faxes to subscribers on the system. This number appears on any outgoing fax cover pages.

- **Cover Page**  Use this button to define company identification that appears on the cover page. See Adding a cover page on page 5-22.

- **Advanced**  Use this button to define advanced parameters for fax transmissions. See Configuring advanced fax properties on page 5-23.

- **Address Type**  Enter the address type used by the fax server, such as Fax or FACSys. If you do not know what this should be, contact your fax vendor to find out.

- **Canonical Addressing**  Select if your fax servers support canonical addressing. Canonical addressing specifies the full fax telephone number for the voice mail domain, for use by the telephone user interface. When a subscriber wants to send a fax, the system prompts for these outgoing numbers or allows alternative entries as an aid to addressing. The canonical address also allows the system to prevent unnecessary toll calls if the receiver of the fax uses the same country code or area code as the sender.
The canonical address includes the country code and area code, in other words:

+CountryCode [(AreaCode)] SubscriberNumber

For example:

+1 (408) 345 8000

If you enable canonical addressing, you must specify a default country code and area code for this voice mail domain.

- **Access Codes**  Use this button to configure access codes required for fax transmission. See [Configuring access codes](#) on page 5-21.
Configuring access codes

If you are using canonical addressing, you must also enter access codes for the fax address. Use the Access Codes dialog box to enter access codes.

To display the Access Codes dialog box and enter access codes:

1. In the Fax - Voice Mail Domain dialog box, click Access Codes.

   The system displays the Access Codes dialog box.

2. Configure the following fields:

   - **Trunk Code** Enter the digits required to get an outside line. You can enter up to 4 digits.

   - **Long Distance Code** Enter the national direct dialing prefix required to make a call within a country, from one area to another. For example, 1 if you are in the United States.

   - **International Code** Enter the international dialing prefix required to call a country from another country, for example 011 if you are dialing from the United States.
Adding a cover page

Define the text of fax cover pages in the Fax Cover Page dialog box. The cover page you define will be the default company name and address that appears when subscribers print faxes.

To display the Fax Cover Page dialog box:

1. In the Fax - Voice Mail Domain dialog box, click Cover Page.

   The system displays the Fax Cover Page dialog box.

2. Configure the following fields:

   - **Company Name** Enter your company name. Any characters are accepted.

   - **Company Address** Enter the address of your company. Any characters are accepted.

   Press Enter after each part of the address that you want to appear on a separate line on the cover page. For example, you may want to press Enter after the street name and press Enter after the city, state, and zip code (if in the U.S.), and list your country on the last line. For example, in the following address, each new line was created by pressing Enter at the end of the previous line.

   55555 W. Main St.
   New York, NY 10005
   U.S.A.
Configuring advanced fax properties

Advanced fax properties include the ability to configure the amount of time the system should allow between retries, the number of retries allowed, the number of outgoing fax calls allowed at one time, and the maximum number of pages an outgoing fax can have. Configure these advanced properties for fax in the Advanced Fax dialog box.

To display the Advanced Fax dialog box:

1. In the Fax - Voice Mail Domain dialog box, click Advanced.

   The system displays the Advanced Fax dialog box.

2. Configure the following fields:

   - **Normal Messages** Enter the maximum time allowed between retries when sending non-urgent fax messages. The default is 300.
   - **Urgent Messages** Enter the maximum time allowed between retries when sending urgent fax messages. The default is 120.
   - **Max no. retries** Enter the maximum number of retries allowed when sending fax messages.
   - **Max Concurrent Outgoing Calls** Enter the maximum number of concurrent outgoing fax calls allowed.
   - **Max Pages Per Fax** Enter the maximum number of pages that a single fax can include.
Turning off the fax confirmation feature

By default, whenever a subscriber successfully sends a fax, the system generates a message to the subscriber’s mailbox confirming that the fax was successfully sent. If you do not want this confirmation sent out for every fax message, you can disable it using the following procedure.

Notes:

- This procedure needs to be done only on the server (usually, but not necessarily, an MAS) that is using the MM Fax Sender Service to process outgoing faxes. Although it is installed and enabled on all MASs, there should be only one server per voice mail domain that actually uses this service; thus, you should only need to do this procedure once per voice mail domain.

- This procedure involves altering the registry. Avaya strongly recommends that, before making any changes to the registry, you make a backup copy of the registry file. For the procedure to make a backup copy of the registry file, see your Windows documentation.

To turn off the fax confirmation feature:

1. Click Start > Run...
2. In the Open: field, type regedit
3. Click OK.
4. Press Ctrl+F, or from the Edit menu, select Find...
5. In the Find what: field, enter: SendConfirmationMessages
6. Click Find Next.

The system should locate the registry key value SendConfirmationMessages at the following directory location:

```
HKEY_LOCAL_MACHINE\Software\Octel\Geneva\UM Fax Sender Server
```

Alternatively, you can navigate yourself to this directory location, where you should find the registry key value SendConfirmationMessages.

By default, this registry key value is set to 1.

7. Reset the value of the registry key value SendConfirmationMessages to 0 (zero).
Configuring voice mail domain security

You can limit the number of people in a voice mail domain who have access to administration applications and tools by editing two access control lists (ACLs). These ACLs define the following types of administration:

- **System administration**
  
  Members of the System Administration ACL can access and use all Modular Messaging Software administration applications and tools except subscriber administration tools.

  The default System Administration ACL has a single entry containing the account under which the first MAS was installed.

  See [Administering a System Administration access control list](#) on page 5-26.

- **Subscriber administration**
  
  Members of the Subscriber Administration ACL can use subscriber administration tools to enable subscribers to use Modular Messaging Software.

  The default Subscriber Administration ACL is empty. To enable subscribers to use the system, you must add at least one account or group to this list.

  See [Administering a Subscriber Administration access control list](#) on page 5-27.

- **Message Server Administration**
  
  The MAS uses this list to identify the message stores with which it communicates. The system also lists the protocols the MAS uses to get subscriber data from the message store.

  See [Configuring message store security](#) on page 5-28.

To run administration applications and tools, you must be logged on to a Windows domain.

**Note:** For more information about system security, see the “Getting Started” section on your system documentation CD.
Administering a System Administration access control list

Members of the System Administration access control list (ACL) can access all Modular Messaging Software administration applications and tools except subscriber administration tools. For example, they can use the Voice Mail System Configuration tool (VMSC) to change voice mail domain or MAS settings, or to create and deploy caller applications from the Caller Applications Editor.

**Note:** For more information about system security, see the “Getting Started” section on your system documentation CD.

To set up a System Administration ACL:

1. In the Voice Mail System Configuration window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Click Security.

3. Double-click System Administration.

   The system displays the Permissions for System Administration dialog box.

4. Click Add.

   The system displays the Select Users, Computers, or Groups dialog box.

5. In the Name column, highlight the group or user you want to add to the ACL.

   **Note:** By default, the groups and users listed belong to the same Windows domain as your account. If required, you can select a different Windows domain in the Look in: drop-down list.

6. Click Add.

   The system displays the group or user in the lower part of the screen.

7. Repeat step 5 and step 6 for all groups and users you want to add.

8. To return to the Permissions for System Administration dialog box, click OK.

9. In the Permissions for System Administration dialog box, click OK.
Administering a Subscriber Administration access control list

If you want to use Subscriber Options in an administrative role, then you must be included in the Subscriber Administration ACL.

**Note:** For more information about system security, see the “Getting Started” section on your system documentation CD.

**Important:** To administer a Subscriber Administration ACL, you must be a member of the System Administration ACL.

To set up a Subscriber Administration ACL:

1. In the **Voice Mail System Configuration** window, click the voice mail domain.
   
   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Click **Security**.

3. Double-click **Subscriber Administration**.
   
   The system displays the **Permissions for Subscriber Administration** dialog box.

4. Click **Add**.
   
   The system displays the **Select Users, Computers, or Groups** dialog box.

5. In the **Name** column, highlight the group or user you want to add to the ACL.
   
   **Note:** By default, the groups and users listed belong to the same Windows domain as your account. If required, you can select a different Windows domain in the **Look in:** drop-down list.

6. Click **Add**.
   
   The system displays the group or user in the lower part of the screen.

7. Repeat Step 5 and Step 6 for all groups and users you want to add.

8. To return to the **Permissions for Subscriber Administration** dialog box, click **OK**.

9. In the **Permissions for Subscriber Administration** dialog box, click **OK**.
Configuring message store security

To enable the Messaging Application Server to log onto the Message Storage Server (MSS), you must configure one or more account names and credentials for the MSS.

**Note:** For more information about system security, see the “Getting Started” section on your system documentation CD.

To configure message store security:

1. In the **Voice Mail System Configuration** window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Click **Security**.

3. Double-click **Messaging Servers Administration**.

   The system displays the **Message Servers - Voice Mail Domain** dialog box.

4. Click the **New** icon.

5. In the **Browse** dialog box, locate and click the message server (this is the message storage server), and click **OK**.

   You can only specify one message server in this release.

   **Note:** To delete a message store, highlight the message store name and click the **Delete** icon. The system prompts you to confirm the deletion.

6. In the **Credentials** box, click the **New** icon.

   The cursor jumps to a protocol field and displays an available protocol with a drop-down list to select one of the four protocol options.

7. Click the **Protocol** drop-down list and select the desired access protocol used on the message store.

   The access protocol is the interface used to access mailbox data, for example, IMAPI or LDAP. Normally, you add IMAPI, IMAP4, and LDAP. You add FAX only if your system will support FAX. The choices are as follows:

   - **IMAP4** This protocol is necessary for the MAS to access the MSS.
- **IMAPI**  This protocol is necessary for the Mailbox Monitor to access the message store. Mailbox Monitor manages the Message Waiting Indicator and Call Me servers.

- **LDAP**  This protocol is necessary to retrieve subscriber data.

- **FAX**  This protocol is necessary for the server to server as the FAX server.

8. In the **Password** column, type the password for the account.

   If you are changing a password, the system prompts you to enter the old password, new password, and password confirmation.

9. To add more accounts to the message store, repeat Step 6 through Step 8.

   You can add between one and four of the available protocol accounts, depending on the needs of your system.

10. Click **OK**.

**Note:** To delete a credential, highlight the credential name and click the **Delete** icon  .

The system prompts you to confirm the deletion.
Configuring the Privacy Enforcement Level

Traditional voice mail systems typically prevent subscribers from forwarding messages marked as private or from replying to private messages with the original message attached. Most email systems and email clients, however, do not prevent these actions, even when a message is marked as private.

The Privacy Enforcement Level setting allows system administrators to control how the system behaves with respect to subscriber attempts to forward messages marked as private, or attempts to reply to messages with the original private messages attached. Through the use of this setting, system administrators can determine whether their systems behave more like traditional voice mail systems or more like typical email systems.

To configure the Privacy Enforcement Level:

1. In the Voice Mail System Configuration window, click the voice mail domain.
   
   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click Messaging.
   
   The system displays the Messaging – Voice Mail Domain window, with the General tab active.

3. From the Privacy Enforcement Level field, select one of the following options:

   - **Full** (Default for new MAS/MSS systems) This option prevents subscribers from forwarding any message marked as private. It also prevents them from replying to a private message with the original message attached. This is the strongest level of privacy enforcement for MAS/MSS systems.

     When this option is selected, the system also restricts delivery of new private messages to recipients on networked machines (that is, other MAS/MSS or message systems in the network). This allows private messages to be delivered only to messaging systems capable of enforcing privacy settings.

     Selecting this option also overrides the Restrict Client Access to Mailboxes? class of service (COS) option on the MSS. When this option is selected, all COSs behave as if that option were set to Yes. For more information about the Restrict Client Access to Mailboxes? option, see Administering Email (Internet Messaging).

   - **Partial** This option prevents subscribers from forwarding any message marked as private or from replying to a private message with the original message attached. It does not, however, restrict delivery of new private messages to recipients on networked...
machines (that is, other MAS/MSS or message systems in the network). This allows private messages to be delivered to messaging systems that may not be capable of enforcing privacy settings.

**Note:** Avaya Modular Messaging subscribers may receive messages marked private from users on networked voice mail systems, such as Voice Profile for Internet Mail (VPIM) systems, who do not expect recipients to be able to forward them. This Privacy Enforcement Level does not, in all cases, preserve traditional voice mail semantics for private messages.

This also means that recipients of messages marked private may be able to forward them to others using email. This includes subscribers using the Avaya Outlook “thick” client and non-Avaya IMAP4 and POP3 clients, if the class of service (COS) has the *Restrict Client Access to Mailbox?* option set to *No*. For more information about the *Restrict Client Access to Mailbox?* option, see *Administering Email (Internet Messaging)*.

- **Notification Only** (Default for upgrades from previous Modular Messaging releases) This option does not prevent subscribers from forwarding private messages or replying with the original private message attached. Although messages are marked and announced in the TUIs as being private, they are not restricted from client access, and may be forwarded without restriction.

**Note:** Allowing recipients to forward messages marked as private violates the Voice Profile for Internet Mail (VPIM) specification (RFC 2421, section 4.2.13). Because of this, private messages originating from VPIM systems are not delivered to Modular Messaging subscribers when this option is selected.
Configuring languages

Multiple languages can be configured for use by the telephone user interface. When you configure a voice mail domain, you must configure a primary language. The primary language is the language that is played by the telephone user interface, unless instructed otherwise, for example, by caller language selection, or by subscriber mailbox configuration. The primary language is also used if multilingual text-to-speech conversion is requested, and the language of the text cannot be determined.

**Note:** The primary language must be a language that is installed on all MASs in the voice mail domain. See Chapter 8, "Messaging Application Server Configuration" for information on how to view a list of languages installed on an MAS.

To configure voice mail domain languages:

1. In the **Voice Mail System Configuration** window, click the voice mail domain.

   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

2. Double-click **Languages**.

   The system displays the **Languages - Voice Mail Domain** dialog box, which has one tab, the **Domain Languages** tab.

3. Configure the following options:

   - **Primary Language** Select the primary language to be used by the telephone user interface. Listed are all the languages in the voice mail domain. The system displays Not Set by default.

   - **Enable Multilingual Text-to-Speech** Select if you want language recognition to be used to identify the correct language for converting text into speech. If cleared, the primary language in the voice mail domain is used for all text-to-speech conversions. This check box is cleared by default.

   - **Select one or more languages to use for text-to-speech** Select the languages that you want to enable for text-to-speech conversions. By default the primary language only is selected.

      If the voice mail domain contains MASs from an earlier release, all languages supported by these MASs are listed. The languages supported by all MASs in the voice mail domain are selected by default. You can select additional languages; however, these will only be available on MASs that support them.
**Important:** After removing the last MAS that does not support multiple languages from the voice mail domain, you must refresh the domain languages. To do this, click **Refresh Domain Languages** from the **Edit** menu in the **Voice Mail System Configuration** window.
Configuring the audio encoding format

Modular Messaging Software supports Global Systems for Mobile Communications G.711 audio encoding format. This format determines the way in which audio is recorded on every MAS in the voice mail domain. In turn, this determines the format of voice messages sent using the TUI and desktop clients. The client applications configure themselves to use the selected audio encoding format.

To configure the audio encoding format:

1. Stop operation of the MAS.
   
   For the procedure to stop the MAS service (MM Messaging Application Server), see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

2. In the Voice Mail System Configuration window, click the voice mail domain.
   
   If you have more than one voice mail domain, you may need to expand the tree hierarchy to find the one you want.

3. Click Audio Encoding.
   
   The system displays the Audio Encoding dialog box.

4. From the Default Audio Encoding Format drop-down list, select the audio encoding format you require. You can select one of the following:

   - Microsoft GSM 6.10 (the default)
   - G.711 mu-law
   - G.711 A-law

5. Restart the MAS.
   
   For the procedure to restart the MAS service (MM Messaging Application Server), see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.
Configuring access to messages when the MAS goes offline

When an MAS loses the ability to access mailboxes on one or more mail servers in the voice mail domain, it is considered to be offline. There are a wide range of situations that can cause this. For example:

- The MAS has become physically disconnected from the network (a network cable has been unplugged).
- One or more message store servers (MSS, server) has become disconnected from the network.
- An important network component has failed.
- Network traffic has become congested.

While there are many other situations that can also cause this, for the purposes of this discussion, whenever an MAS is unable to communicate with and manage access to subscriber mailboxes, the MAS is considered to be offline.

You can configure the MAS to continue backup service when the MAS goes offline.

- When the MAS goes offline

  When the MAS goes offline, subscribers on the affected message store server(s) cannot access their messages using e-mail. However, you can configure the MAS so that while it is offline, subscribers can continue to access call answer messages using their telephones. During the time the MAS is offline, however, they cannot use the TUI to send or receive interpersonal voice mail messages.

  **Note:** Offline access is not available when using the AUDIX TUI.

For more information, see the following additional topics:

- [Configuring Offline Access](#) on page 5-36
- [Configuring messaging](#) on page 8-4
Configuring Offline Access

The MAS allows subscribers to continue to access call answer messages if the MAS becomes unavailable to subscribers over the network. In this case, subscribers must use the telephone and the Modular Messaging telephone user interface to retrieve message. You must administer parameters for offline access to determine if call answer messages on the MAS will be kept up-to-date in its offline message store and how long and how often they will be kept up-to-date.

Notes:

- When the MAS is offline and offline access to call answer messages is configured, the Call Me feature does not operate.

- If a subscriber modifies the Find me rule for his or her mailbox but the subscriber’s mailbox does not subsequently receive any messages prior to the MAS going offline, the Find me feature in offline mode will operate using the Find me rule that existed prior to the subscriber’s modifications.

- Offline access is not available when using the AUDIX TUI.

To configure offline access:

1. In the Voice Mail Configuration window, click the voice mail domain.

2. Double-click **Messaging**.

   The system displays the **Messaging - Voice Mail Domain** window, with the **General** tab active.

3. Configure the following fields on the **Offline Access** tab, as required:

   - **Enable offline access to messages**  Select this check box to allow the MAS to provide service for offline access to messages.

     **Note:** If this check box is cleared, all other options on this tab are inactive.

   - **Synchronize offline messages with remote store**  To allow the MAS to update the offline access message store with the current call answer messages, select this check box.

     **Note:** If this check box is cleared, the **Offline Message Store** option is inactive.

   - **Offline Message Store**  (Available only if **Synchronize offline messages with remote store** is selected)  Enter the directory path of
the offline access message store. If you need help determining where the message store should be, click **Browse**.

If you want your offline message store to reside on a machine other than an MAS, do the following before entering the directory path:


2. From the **Tools** menu, select **Map Network Drive...**

3. In the **Folder:** field, type the name of the network machine and shared directory where you want offline access messages to be stored (for example: `\machineName\shareName`)

4. Click **Connect using a different user name**.

5. In the **Connect As...** dialog box, enter a user name and password for an account that has permissions to the network shared directory you specified in Step 3.

6. Click **OK**.

7. Click **Finish**.

Now you can use the **Browse** button to select the directory path for the network shared directory you just mapped.

- **Time to store offline messages (Hours)** Enter the length of time, in hours, that the MAS should keep call answer messages in the offline message store. The default is 24 hours.

  **Note:** This time is extended if the MAS remains offline for longer than the configured time.

- **Time to store empty mailboxes (Hours)** Enter the length of time, in hours, that the MAS should save space for an empty mailbox in the message store. An empty mailbox indicates no message activity, but the mailbox still requires allocated space. The default is 72 hours.

- **Message store full synchronization interval (Minutes)** Enter the length of time, in minutes, that the MAS should wait between synchronization updates between the MAS and the message store.

- **Allow subscribers to access messages using the TUI** Select this check box to allow subscribers to access their messages using the TUI when the message store is offline.
Configuring serviceability

Serviceability in Avaya Modular Messaging refers, among other things, to the ability of the MAS to generate logs and notifications related to system errors and alarms. The error and alarm logs can be accessed using a command line interface tool. Notifications can be sent out automatically to a designated support site, either Avaya Services, your own network management station (NMS), or a trusted business partner. The system sends these notifications out using either the Avaya Initialization and Administration System (INADS) or by means of SNMP traps to a network management server.

Notes:

- Serviceability in Avaya Modular Messaging also refers to many other things, such as the ability to generate system error and alarm logs and notifications related to the MSS and controlling voice port service on the MAS.
- Notifications can be sent only to one designated support site, not more than one.

For more information about error logs, see Displaying the MAS event and error logs on page 15-3. For more information about alarm logs, see Displaying the MAS alarm logs on page 15-5.

If you are using INADS for sending and receiving error and alarm notifications, then you must configure the system at both the voice mail domain and the MAS level. For information about serviceability administration at the MAS level, see Configuring MAS serviceability on page 8-16.

Use the following tabs of the Serviceability - Voice Mail Domain dialog box to configure alarm notifications at the voice mail domain level:

- **General**
  
  Use this tab to configure general alarm notification settings.
  

- **SNMP**
  
  Use this tab to configure alarm notification settings when an SNMP network management tool is being used to collect and view alarms.
  
  See Configuring Serviceability - VoiceMail Domain, SNMP properties on page 5-41.
Configuring Serviceability - Voice Mail Domain, General properties

To configure general alarm notification settings, use the General tab of the Serviceability - Voice Mail Domain dialog box.

To display the Serviceability - Voice Mail Domain dialog box, General tab:

1. In the Voice Mail System Configuration window, click the voice mail domain.

2. Double-click Serviceability.

The system displays the Serviceability - Voice Mail Domain dialog box, with the General tab active.

To configure alarm notification General settings, configure the following fields:

- **Send alarms using**: Use this drop-down menu to select whether you want to send alarms using:

  - **None**  Selecting this causes no alarms to be sent at all.

    If you select this option, no alarm notifications are sent out. You can still, however, view alarm logs on the MAS.

  - **SNMP**  Selecting this option allows you to have alarm traps sent to a network management station using SNMP.

  Note: If you select this option, it is your responsibility to provide and provision your SNMP network management station and configure it to receive the traps from the MAS.

  - **INADS**  Selecting this option allows you to use the INADS tool to send alarm notifications to an alarm collection server for analysis and corrective action. If you select this option, you must also configure the individual MASs for INADS (see Configuring MAS serviceability on page 8-16).

- **Suppress alarm notifications**  This option should be selected primarily when you are engaged in maintenance and/or repair activities that will likely result in the generation of additional alarms and errors. In this case, you do not want more notifications being sent out, so you would use this option to temporarily suppress alarm notifications.

  Note: Be sure, when using this option in a maintenance or repair situation, that you remember to clear this check box when you are done, or alarm notifications will not resume.

The default is for this check box is to be cleared.
- **Send notification when all alarms are cleared**: Use this option if you want to be notified when all alarms on the system are corrected and cleared. The default is for this option to be selected.

- **Send alarm at this level or higher**: Use this drop-down box to determine at what level alarm notifications will be sent out. If **Minor** is selected, both Minor and Major alarm notifications will be sent out. If **Major** is selected, only Major alarm notifications will be sent out. The default setting is **Minor**.

- **Product identifier**: This is a unique 10-digit number used to identify your particular Modular Messaging system. It is assigned at system installation. This may also be NULL.

- **When stopping the MAS service**: This section determines how the system will behave when the MAS service is being stopped:

  - **Wait for ports to become idle**: Selecting this option allows ports that are in use to become idle before being taken offline. As ports become idle, then they are taken offline. This allows for a more graceful shutdown of the system and should be used whenever possible. If this option is selected, you have two further options:

    - **Wait indefinitely**: When this option is selected, the system waits until all ports are idle. As a result, some length of time may pass before service is actually stopped. During this period, while ports are becoming idle, your Windows operating system may display a timeout error 1053. Ignore this error. The stopping process is unaffected by this message and MAS service will stop according to the parameters you have set.

    - **Wait for (minutes)**: This option allows you to set a number of minutes that the system will wait before breaking port connections and shutting down, whether ports are in use or not. In this case, ports that become idle within the time limit are taken offline, but ports that are still busy at the end of the time limit are forcibly taken offline. The default is **10** minutes.

  - **Stop straight away**: This option causes all ports that are in use when the MAS service is being stopped to immediately be taken offline. This should only be used as a last resort, as it interrupts any calls that may be in progress. This is the default setting for stopping the MAS service.
Configuring Serviceability - Voice Mail Domain, SNMP properties

To configure SNMP-specific alarm notification settings, use the SNMP tab of the Serviceability - Voice Mail Domain dialog box.

**Note:** You should configure the fields on this tab only if you are using SNMP to send traps to an SNMP Network Management Station (NMS).

To display the Serviceability - Voice Mail Domain dialog box, SNMP tab:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Double-click Serviceability.
   
   The system displays the Serviceability - Voice Mail Domain dialog box, with the General tab active.
3. On the General tab, select **Send alarms using: SNMP**.
4. Click the SNMP tab.

To configure general alarm notification settings, configure the following fields:

- **Network Management Station:** Enter in this field the fully qualified domain name or IP address of the NMS to which you want to send alarm notification traps.

- **Context (Community):** Enter in this field the name of the context or community to which the NMS belongs.

  For more information about how to configure this field, see the documentation for your SNMP NMS.

- **Acknowledgement type:** The Avaya Modular Messaging system offers two methods for you to get acknowledgement from the SNMP NMS that the alarm notification traps have been received:
  - **Return trap** This acknowledgement type is potentially better and more reliable, because it means that, when an alarm trap is received by your NMS, it is configured to send a trap of its own back to the MAS, acknowledging that it has received the alarm notification. It is also more complicated to set up and requires that you configure your NMS to generate such return traps.
Ping surround This acknowledgement type is easier to implement but inherently less informative and makes certain assumptions. When this option is selected, and an alarm trap is ready to be sent to the NMS, a ping command is first generated to the NMS. Only if the MAS receives a ping response does it go ahead and send the trap. Then it sends another ping request. If it receives another ping response from the NMS, the assumption is that the trap was received on the NMS.

If no initial ping response is received from the NMS, then the MAS waits 5 minutes before trying again. It keeps trying at 5-minute intervals, then, until it receives a response from the NMS. If after 16 tries there is still no response from the NMS, then the MAS stops trying and raises a warning alarm against the alarming system.

If the first ping is successful and the trap is sent, but the second ping is not successful, then the assumption is that the trap was not sent successfully. In this case, the trap is rescheduled to be sent at 5-minute intervals until it is successfully sent. If after 16 tries there is still no response from the NMS, then the MAS stops trying and raises a warning alarm against the alarming system.
Viewing and configuring licensing

Avaya Modular Messaging systems are priced according to:

- The number of voice-enabled mailboxes the customer wants
- The platform the customer wants to use for the “back-end” servers (Avaya S3400 family, Microsoft Exchange, or Lotus Domino)
- The number of telephone ports in the system
- The maximum number of concurrent Text-to-Speech (TTS) sessions the customer wants to provide for

Avaya controls the use and access of some of these features using a license that the customer must purchase. The features that Avaya controls using licensing include:

- The platform
- The number of seats (voice mail-enabled mailboxes)
- The maximum number of TTS sessions allowed for each TTS engine installed

From the Licensing entry of the Voice Mail System Configuration application, you can do the following:

- View licensing information for your system (see Viewing licensing information on page 5-44).
- Distribute Text-to-Speech (TTS) licenses across two or more MASs (see Distributing TTS licenses across MASs on page 5-45).
- Install a license file for the voice mail domain (see Installing a license file on page 5-46).
Viewing licensing information

You can view the licensing for your system using the Licensing utility in the Voice Mail System Configuration application.

To view licensing information:

1. In the Voice Mail System Configuration window, click the voice mail domain for which you want to view licensing information.

   You may need to expand the tree to see all options for the voice mail domain.

2. Double-click Licensing.

   The system displays the Licensing - Voice Mail Domain window, with the General tab active. This tab displays a field listing the features licensed on the system. It also includes information about each licensed feature, including:

   - What platform is licensed
   - How many voice-enabled mailboxes are licensed
   - The maximum number of concurrent TTS sessions allowed

   If you do not yet have a valid license, the display at the bottom of this window notifies you of that fact.

   **Note:** This notice at the bottom of the window will appear if the license is invalid because an integrity check on it has failed or because the license has expired. The latter case happens only if you did not import and install a license within 30 days of installation. (At system installation and setup, the system installs a temporary license with limited capabilities; if your license was not installed at the time of installation, you must either install it or have it installed within 30 days.)

3. To view more detailed information about your system’s TTS licensing, click the Text-to-Speech tab (see Distributing TTS licenses across MASs on page 5-45).
Distributing TTS licenses across MASs

If you have more than one MAS in your system, you can distribute your TTS licenses across any or all of them. This is done on a per-TTS-engine basis. Say, for example, you have two MASs in your voice mail domain. You also have eight licenses for the ScanSoft RealSpeak TTS engine. Using the Voice Mail System Configuration Licensing utility, you can allocate three of those licenses to one MAS and five to the other.

Note: If, in this example, you also had another TTS engine installed on your system, you could not use any of these licenses for the other TTS engine.

To distribute TTS licenses across two or more MASs:

1. In the **Voice Mail System Configuration** window, click the voice mail domain for which you want to view licensing information.
   
   You may need to expand the tree to see all options for the voice mail domain.

2. Double-click **Licensing**.
   
   The system displays the **Licensing - Voice Mail Domain** window, with the General tab active.

3. Click the **Text-to-Speech** tab.
   
   The system displays a list of all the MASs in your system, with the number of TTS licenses installed on each MAS (in the Value column).

4. Double-click the TTS entry under the MAS to which you want to allocate TTS licenses.
   
   The system displays the **Edit Sessions** dialog box.

5. Enter the number of TTS licenses you want to assign to the selected MAS, or use the spin-box arrows to select the number.

6. Click **OK**.

7. Repeat steps 4 and 5 for all other MASs in the system to which you want to allocate TTS licenses.

   Note: The total number of TTS sessions assigned across all MASs cannot exceed the number TTS sessions licensed for your system.

8. Click **OK**.
Installing a license file

When your system is initially installed and set up, a temporary license file is automatically installed. This temporary license sets up the system with ten mailboxes and one TTS session. It is only good for 30 days. If a license file is not installed within that period, the system writes a warning into the Windows event log ten days, three days, and one day before the temporary license is set to expire. If, at the time the temporary license expires, a license is still not installed, the system writes an error to the Windows event log every 90 minutes until the license is installed. This also causes an alarm to be raised.

Normally, at the time of system installation the service technician installs the permanent license, so you should not have to use the following procedure. However, in some cases, for instance, when you upgrade your system by adding more mailboxes or TTS sessions, you may need to install a new license file.

Before installing the permanent license file, you must first obtain the file from your technical or service representative. Before the technical or service representative can provide you the permanent license file, you must supply the representative with the following:

- An identification code for the voice mail domain
- The platform on which you are running your system (MSS, )
- The number of mailboxes (seats) you require
- The number of TTS sessions you want enabled

**Note:** To obtain the identification code:

1. In the Voice Mail System Configuration tool window, right-click the **Licensing** icon.

2. From the pop-up menu, select **Copy host ID to clipboard.**
   
   The system copies the host ID number to the system clipboard.

3. Paste the host ID number into an email or word-processing document, which you can then pass on to your technical support representative.

- The platform on which you are running your system (MSS, )
- The number of mailboxes (seats) you require
- The number of TTS sessions you want enabled

**To install a license file:**

1. Copy the license file to a temporary location on the MAS or to another location accessible from the Voice Mail System Configuration application.

2. Start Voice Mail System Configuration.
For the procedure to start Voice Mail System Configuration, see Starting the Voice Mail System Configuration application on page 5-4.

3. Under Voice Mail Domains, select the voice mail domain for which you want to install the license file.
   
   You may need to expand the voice mail domain tree hierarchy to see the Licensing entry.

4. Right-click Licensing.

5. From the pop-up menu, click Import License...
   
   The system starts the License Import Wizard.

6. Follow the on-screen instructions in the License Import Wizard...

7. (Only if your license files have changed your TTS session settings) Stop and restart the MAS.
   
   For information about TTS session settings, see Distributing TTS licenses across MASs on page 5-45. For the procedures to stop and restart the MM Messaging Application Server service, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

8. Verify that the file has been installed correctly by viewing licensing information and verifying that the values have changed (see Viewing licensing information on page 5-44).
Configuring the tracing system

**Note:** The tracing system is a Windows 2000 service where information about voice mail system activity (operation history events) is logged. Operation history events are dynamically stored in the operation history database. Periodically, this database is purged and summarized information is stored in the transaction database. If, for any reason, you find it necessary to re-install the tracing software after the initial system installation, you must first stop all Avaya Modular Messaging (MM) services on the MAS before installing it. Remember to restart the MM services when the software installation is complete. For the procedures to stop and restart the MM services, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

You can view the operation history database using the Operation History Viewer. For information, see Chapter 13, “Operation History Events”.

You can generate a number of reports from the transaction database using the Reporting Tool. For information, see Chapter 12, “Reports”.

**Important:** It is recommended that one tracing system is installed per voice mail domain. If you install a second tracing system in a voice mail domain, it replaces the original tracing system. This means that, if your system has more than one MAS, you should install tracing on only one MAS.

Use the following tabs to configure the tracing system for a voice mail domain.

- **General**
  
  Use this tab to configure general tracing system properties.

  See Configuring Tracing System, General properties on page 5-49.

- **Operation History Collection**
  
  Use this tab to configure operation history database properties for event logging.

  See Configuring Tracing System, Operation History Collection properties on page 5-50.

- **Transaction Generation**
  
  Use this tab to configure transaction database properties for transaction logging.

Configuring Tracing System, General properties

Use the General - Tracing System tab to configure general properties for the tracing system.

**Note:** If you have not installed a tracing system, Tracing System is not displayed in the Voice Mail System Configuration Window.

To display the Tracing System dialog box, General tab:

1. In the **Voice Mail System Configuration** window, click the voice mail domain.

2. Double-click **Tracing System**.

The system displays the **Tracing System** dialog box, with the **General** tab active.

To configure general tracing system properties, configure the following fields:

- **MAS Tracing Server Machine Name** Displays the name of the computer running the tracing system.

- **Home Message Application Server** Enter the home MAS for the tracing system. This is the first MAS that the tracing system connects to in order to perform its operation. The default is the home MAS for the voice mail domain. For more information on the home MAS, see **Changing the home MAS** on page 2-5.
Configuring Tracing System, Operation History Collection properties

Use the Operation History Collection tab to specify operation history database properties for a voice mail domain.

To display the Tracing System dialog box, Operation History Collection tab:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Double-click Tracing System.
   The system displays the Tracing System dialog box, with the General tab active.
3. Click the Operation History Collection tab.

To configure operation history collection properties, configure the following fields:

---

**Note:** The Windows 2000 Schedule service must be started on the tracing system machine for the configuration settings to take effect.

- **Enable Operation History Collection** Select to log events in the operation history database. This check box is selected by default.

- **Retry Period when Connecting to a Message Application Server (secs)** Enter the time, in seconds, between retries when connecting to an MAS. The range is 1 through 999 and the default is 30.

- **Number of Days before Events Expire** Enter the number of days after which events are set to expire. If you enter 0, events are set to expire immediately and are deleted at the time specified in the Delete Expired Events box. The range is 0 through 999 and the default is 3.

  The number of days should be based on how many events your voice mail system is generating. It is recommended that you monitor the generation of events over a period of time and update the expiration time as appropriate.

- **Delete Expired Events:**
  - **Never** Select to never delete expired events. This check box is cleared by default. When cleared, expired events are deleted daily at the time you specify in the Delete Expired Events box.
  - **At time** Enter the time of day the operation history database deletes expired events. It is recommended that you schedule this for at least 2 hours before transaction generation. For more information, see To configure transaction generation properties, configure the following fields; on page 5-51.
Configuring Tracing System, Transaction Generation properties

To configure transaction database properties for the voice mail domain, use the Transaction Generation tab.

To display the Transaction Generation tab:

1. In the Voice Mail System Configuration window, click the voice mail domain.
2. Double-click Tracing System.
   
   The system displays the Tracing System dialog box, with the General tab active.
3. Click the Transaction Generation tab.

To configure transaction generation properties, configure the following fields:

Note: The Windows 2000 Schedule service must be started on the tracing system machine for the configuration settings to take effect.

- **Enable Transaction Generation** Select to log voice mail system transactions in the transaction database. When using Reporting Tool, transaction generation must be enabled for the time period you want to report on. This check box is selected by default.

- **Time to Generate Transactions** Enter the time of day to generate transactions.

- **Transaction Expiry: Number of Days before Transactions Expire** Enter the number of days after which transactions are set to expire. If you enter 0, transactions are set to expire immediately and are deleted at the time specified in the Delete Expired Transactions box. The range is 0 through 999 and the default is 30.

- **Delete Expired Transactions:**
  - **Never** Select to never delete expired transactions. This check box is cleared by default. When cleared, expired transactions are deleted daily at the time you specify in the Delete Expired Events box.
  - **At time** Enter the time of day the transaction database deletes expired events. It is recommended that you schedule this for at least 2 hours before transaction generation.
Telephony Interface Configuration

This chapter describes how to configure the telephony interface for a messaging application server (MAS).

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to configuring the telephony interface</td>
<td>6-2</td>
</tr>
<tr>
<td>Configuring the analog telephony interface</td>
<td>6-3</td>
</tr>
<tr>
<td>Configuring the telephony interface for IP H.323</td>
<td>6-5</td>
</tr>
<tr>
<td>Configuring the telephony interface for QSIG or set emulation</td>
<td>6-6</td>
</tr>
<tr>
<td>Configuring automatic call distribution (ACD)</td>
<td>6-8</td>
</tr>
</tbody>
</table>
Introduction to configuring the telephony interface

You can configure the telephony interface to support analog or digital voice boards. Depending on the type of integration or the voice boards you are using, you can configure one of the following telephony interface types:

- **Analog**
  To configure ports for Controlled LAN (C-LAN), Digital Multiplexed Interface - 4 (DMI-4), inband, and Serial RS-232 integration, use the Telephony Interface (Analog) dialog box.
  
  See Configuring the analog telephony interface on page 6-3.

- **IP H.323**
  To configure ports for H.323-based IP integration, use the Telephony Interface (IP H.323) dialog box.
  
  See Configuring the telephony interface for IP H.323 on page 6-5.

- **QSIG or set emulation**
  To configure ports for Q-Signaling (QSIG) integration or digital set emulation (DSE) integration, use the Telephony Interface (QSIG or set emulation) dialog box.
  
  See Configuring the telephony interface for QSIG or set emulation on page 6-6.

You can also configure the system for automatic call distribution (ACD). For more information, see Configuring automatic call distribution (ACD) on page 6-8.

**Notes:**

- You may be prompted to stop and restart the MAS after you make changes to a property in Voice Mail System Configuration. If so, the changes do not take effect until you stop and restart the MAS.
- You must configure the telephony interface for each MAS in your system.

**Before you begin**

Ensure you have read Chapter 2, “Introduction to Voice Mail System Configuration”. That chapter introduces you to the Voice Mail System Configuration application used to perform the configuration.

Start the Voice Mail System Configuration application from the Modular Messaging software folder.
Configuring the analog telephony interface

To configure ports, use the Telephony Interface dialog box, Analog tab.

To configure analog telephony interface properties:

1. In the Voice Mail System Configuration window, click Message Application Servers.
2. Click the MAS you want to configure.
3. Double-click Telephony Interface.

Tip: To make the analog telephony interface active, click the down arrow and click Make Active. If the analog telephony interface is already active, this field does not appear.

The system displays the Telephony Interface dialog box, which has only one tab, the Analog tab.

To configure ports, configure the following fields:

- **Playback Volume** Enter a value for the playback volume. The range is –8 through 8. We recommend that you enter 2 for 30-port, 24-port, 8-port, or 4-port cards. For Controlled LAN (C-LAN) and Inband integrations, the default value is 2.

- **Number of Ports** Enter the number of ports that connect the MAS with the PBX. The default is set during installation. The range is 0 through 999.

If you increase the number of ports, you must restart the MAS before you can administer them.

**Note:** The AUDIX TUI supports only up to 24 ports for analog telephony.

- Configure the port fields.

  — Enable or disable ports as required, by selecting or clearing the check boxes to the left of each port. All ports are selected by default.
### Telephony Interface Configuration

**Tip:** You can also enable/disable a port using the Port Monitor application. Any changes made there are reflected in the Voice Mail System Configuration application and vice versa. For more information on Port Monitor, see Chapter 14, “System Performance Monitoring.”

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extension</td>
<td>Enter the port extension number. You can enter up to 10 digits. This field is blank by default.</td>
</tr>
<tr>
<td>Incoming Ring Count</td>
<td>Enter a number to specify the number of rings before a call on the port is answered. The range is 1 through 9, and the default is 1.</td>
</tr>
<tr>
<td>Primary Id</td>
<td>Enter the first part of the PBX integration identifier, known as the logical terminal number (LTN), for serial integration only. You can enter up to 10 characters and digits (including &amp; * # and ,). This field is blank by default.</td>
</tr>
<tr>
<td>Secondary Id</td>
<td>Enter the second part of the PBX integration identifier, known as the message desk number (MD), for serial integration only. You can enter up to 10 characters and digits (including &amp; * # and ,). This field is blank by default.</td>
</tr>
</tbody>
</table>

**Note:** This field is applicable to DMI-4 and RS-232 integrations only. Leave this field blank for C-LAN and inband integrations.

To activate the new settings, you must restart the MAS.

**Note:** You can restart the MAS at this point, or you can continue with configuring PBX integration and then restart the MAS.
Telephony Interface Configuration

Configuring the telephony interface for IP H.323

To configure telephony ports for IP H.323, use the Telephony Interface dialog box.

To configure IP H.323 telephony interface properties:

1. In the Voice Mail System Configuration window, click Message Application Servers.
2. Click the MAS you want to configure.
3. Double-click Telephony Interface.

The system displays the Telephony Interface dialog box, with the General tab active.

To configure ports for IP H.323, configure the following fields:

- **Playback Volume** Enter a value for the playback volume. The range is –8 through 8, and the default is 2.
- **Maximum Concurrent Calls** Enter the maximum number of ports that connect the MAS to the PBX. This is the maximum number of concurrent calls that the MAS can support. The default is set during installation. The range is from 0 to 999.

**Tip:** To make the IP H.323 telephony interface active, click the down arrow and click Make Active. If the IP H.323 telephony interface is already active, this field does not appear.

**Note:** The AUDIX TUI supports only up to 20 ports for IP H.323 telephony.

- **Port** Enable or disable ports as required, by selecting or clearing the check boxes to the left of each port. All ports are selected by default.

To activate the new settings, you must restart the MAS.

**Note:** You can restart the MAS at this point, or you can continue with configuring PBX integration and then restart the MAS.
Configuring the telephony interface for QSIG or set emulation

To configure ports for QSIG or set emulation, use the Telephony Interface tab.

To configure QSIG or set emulation telephony interface properties:

1. In the Voice Mail System Configuration window, click **Message Application Servers**.
2. Click the MAS you want to configure.
3. Double-click **Telephony Interface**.

The system displays the Telephony Interface dialog box, **General (QSIG or set emulation)** tab.

**Tip:** To make the QSIG or set emulation telephony interface active, click the down arrow and click **Make Active**. If the QSIG or set emulation telephony interface is already active, this field does not appear.

**Note:** The Agent Based ACD dialog box is available only with NT M-1 switches using set emulation. For more information, see **Configuring automatic call distribution (ACD)** on page 6-8.

To configure ports for QSIG or set emulation, configure the following fields:

- **Playback Volume** Enter a value for the playback volume. The range is –8 through 8, and the default is 2. We recommend that you enter 2 for 30-port, 24-port, 8-port, or 4-port cards.

- **Concurrent Calls** Enter the number of ports that connect the MAS to the PBX. The default is set during installation. The range is from 0 to 999.

**Note:** The AUDIX TUI supports only up to 24 ports for set emulation, 23 ports for T1 cards, and 30 ports for E1 cards.

- **Port** Enable or disable ports as required, by selecting or clearing the check boxes to the left of each port. All ports are selected by default.

- **Extension Number** Enter the extension number associated with the MAS port. The extension number is required only if you are using linear chain integration with set emulation. You can enter up to ten digits. The Extension Number field is available only with set emulation.

**Note:** The Extension Number field is not available with the QSIG telephony interface.

To activate the new settings, you must restart the MAS.
Note: You can restart the MAS at this point, or you can continue with configuring PBX integration and then restart the MAS.
Configuring automatic call distribution (ACD)

Automatic call distribution (ACD) is a form of integration available with NT M-1 switches only. On the ACD dialog box, you can configure ACD settings for agent-based ACD and position-based ACD.

To configure ACD:

1. In the Voice Mail System Configuration window, click Message Application Servers.
2. Click the MAS you want to configure.
3. Double-click Telephony Interface.
4. Click the ACD (set emulation) tab.

To configure ACD, configure the following fields:

- **Enable ACD**  Select to enable the voice mail system to use ACD as the form of integration. This check box is cleared by default.

- **Outcall Key**  Select the key that must be pressed to make an outgoing call. You can select from characters A through H, and the default is B.

- **Incall Key**  Select the key that must be pressed to answer a call. You can select from characters A through H, and the default is A.

- **MSB Key**  Select the key that must be pressed for ‘make set busy’. You can select from characters A through H, and the default is C.

- **MSB Lamp**  Select a value that identifies the lamp on the handset associated with ‘make set busy’. You can select a digit from 0 through 7, and the default is 2.

- **Agent ID**  Enter the ACD agent login IDs for ports that you have configured on the switch. You can enter up to thirty digits for each agent ID.
This chapter describes how to configure private branch exchange (PBX) integration for a messaging application server (MAS).

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to configuring PBX integration</td>
<td>7-2</td>
</tr>
<tr>
<td>Configuring PBX integration general properties</td>
<td>7-6</td>
</tr>
<tr>
<td>Configuring serial general properties</td>
<td>7-8</td>
</tr>
<tr>
<td>Configuring serial NEC/Ericsson/DMID properties</td>
<td>7-10</td>
</tr>
<tr>
<td>Configuring inband properties</td>
<td>7-12</td>
</tr>
<tr>
<td>Configuring remote properties</td>
<td>7-19</td>
</tr>
<tr>
<td>Configuring QSIG and set emulation properties</td>
<td>7-20</td>
</tr>
<tr>
<td>Configuring C-LAN properties</td>
<td>7-22</td>
</tr>
<tr>
<td>Configuring PBX integration properties for IP H.323</td>
<td>7-24</td>
</tr>
</tbody>
</table>
Introduction to configuring PBX integration

Integration is accomplished when a call is forwarded to the MAS, and the PBX passes information about the call to the MAS. This information includes calling party identification (if known), called party identification, and a call type code. This call information can be transmitted in several ways, depending on the integration type. With PBX integration, callers who are forwarded to the MAS can leave a message for the called party or can transfer to another extension.

You can configure the following PBX integration properties for each MAS in the voice mail domain.

- **General**
  
  Use this tab to select the type of PBX integration for an MAS. Depending on the telephony interface, some PBX integration types may not be available.

  See Configuring PBX integration general properties on page 7-6.

- **Serial General**
  
  Use this tab to configure serial PBX integration for an MAS. With serial integration, the MAS receives incoming call information by means of a serial link. Configure serial PBX integration if your PBX supports digital multiplexed interface - 4 (DMI-4) integration or serial RS-232 integration.

  See Configuring serial general properties on page 7-8.

- **Serial NEC/Ericsson/DMID**
  
  Use this tab to configure serial integration for NEC, Ericsson, and DMID protocols.

  See Configuring serial NEC/Ericsson/DMID properties on page 7-10.

- **Inband**
  
  Use this tab to configure inband PBX integration for an MAS. With inband integration, the MAS receives incoming call information in the form of dual tone multi-frequency (DTMF) digits.

  See Configuring inband properties on page 7-12.
PBX Integration

- **Remote**

  Use this tab to configure remote PBX integration for an MAS. With remote integration, the MAS receives its incoming call information through another MAS that has a serial integration.

  See [Configuring remote properties](#) on page 7-19.

- **QSIG/SE**

  Use this tab to configure an MWI port group for QSIG and set emulation PBX integration.

  See [Configuring QSIG and set emulation properties](#) on page 7-20.

- **Avaya C-LAN**

  Use this tab to configure C-LAN integration. C-LAN integration is available with Avaya DEFINITY®, IP600, MultiVantage™, and Communication Manager switches only.

  See [Configuring C-LAN properties](#) on page 7-22.

- **IP Configuration**

  Use this tab to configure H.323-based IP integration. H.323-based IP integration is available with Avaya DEFINITY®, IP600, MultiVantage™, and Communication Manager switches only.

  See [Configuring PBX integration properties for IP H.323](#) on page 7-24.

**Notes:**

- You may be prompted to stop and restart the MAS after you make changes to a property in Voice Mail System Configuration. If so, the changes do not take effect until you stop and restart the MAS.

- You must configure the PBX integration for each MAS in your system.

For more information on configuring your PBX, see the PBX configuration notes. Configuration notes are available from the Avaya Support Center at [http://support.avaya.com](http://support.avaya.com).

**Before you begin**

Ensure you have read [Introduction to Voice Mail System Configuration](#) on page 2-2. That chapter introduces you to the Voice Mail System Configuration application used to perform the configuration.

Start the Voice Mail System Configuration application from the Modular Messaging Software folder.
Before you can configure PBX integration, ensure that you have selected the correct PBX type.
Selecting a PBX type

You must select a PBX type for an MAS when you physically change the PBX connected to an MAS, or add an MAS to a voice mail domain.

To select a PBX type:

1. In the Voice Mail System Configuration window, click **Message Application Servers**.

   **Note:** You may need to expand the tree to see the MAS you want.

2. Click the MAS you want to configure.

3. Double-click **PBX Type**.

   The system displays the **PBX Type** dialog box, which has only one tab, the **General** tab.

4. From the **Telephony Type:** drop-down list, select the type of PBX you require.

5. Click **OK**.
Configuring PBX integration general properties

To select the type of PBX integration for an MAS, use the PBX Integration dialog box, General tab. The integration type determines how the PBX provides the MAS with additional information about incoming calls.

Note: Depending on the telephony interface, some PBX integration types may not be available.

To configure general integration properties:

1. In the Voice Mail System Configuration window, click Message Application Servers.
   
   You may need to expand the tree to see the all the MASs in the voice mail domain.

2. Click the MAS you want to integrate.
   
   You may need to expand the tree to see the available PBXs.

3. Double-click PBX Integration.
   
   The system displays the PBX Integration dialog box for that MAS, with the General tab active.

4. From the Integration Type list, select the one you want from the following:
   
   Note: Depending on the PBX type you selected (see To select a PBX type: on page 7-5), some of the following options may not be available (grayed out).

   - **None**  Select this if the PBX does not support integration. This is the default.

   - **IP**  Select this to specify H.323-based IP integration. The MAS receives incoming call information in the form of QSIG messages embedded in the H.323 packet, over an IP network. Use the IP Configuration tab to configure the PBX integration.

   - **Serial**  Select this to specify serial integration. The MAS receives incoming call information through a serial link. Use the Serial General tab to configure the PBX integration.

   - **Inband**  Select this to specify inband integration. The MAS receives incoming call information in the form of DTMF digits. Use the Inband tab to configure the PBX integration.
Remote  Select this to specify remote PBX integration. The MAS receives incoming call information through another serial integration server. Use the Remote tab to configure the PBX integration.

QSIG  Select this to specify Q-Signaling (QSIG) integration. The MAS receives incoming call information by means of QSIG.

Set Emulation  Select this to specify set emulation integration.

CLAN  Select this to specify CLAN integration.

5. In the **Max time to Wait for Serial and Remote Integration Data (sec)** spin box, enter or select the maximum amount of time, in seconds, that an incoming call waits to receive integration information before going off hook. This field is available with remote and serial integrations only. The default is 18.

6. If you are finished, click **OK**. If you need to do more specific configuration for your PBX type, click the appropriate tab.
Configuring serial general properties

To configure serial PBX integration for an MAS, use the Serial General tab. With serial integration, the MAS receives incoming call information by means of a serial link.

To display the PBX Integration dialog box, Serial General tab:

1. In the Voice Mail System Configuration window, click Message Application Servers.

2. Click the MAS you want to configure.

   You may need to expand the tree to see all the MASs in the voice mail domain.

3. Double-click PBX Integration for that MAS.

   The system displays the PBX Integration dialog box, with the General tab active.

4. In the Integration Type column, click Serial.

5. In the Max Time to Wait for Serial and Remote Integration Data (sec) field, type the maximum time, in seconds, that an incoming call waits to receive integration information before going off hook. This field is available with remote and serial integrations only. The default is 18.

6. Click the Serial General tab.

To configure serial general integration properties, configure the following fields:

- Packet Format  Select the PBX serial integration data packet format from the list. Depending on your PBX type, select SMDI, Intecom, DMID, NEC-2400, or Ericsson MD110. If you are using NEC-2400, Ericsson MD110, or DMID, use the Serial NEC/Ericsson/DMID tab to configure the protocol type. For more information, see Configuring serial NEC/Ericsson/DMID properties on page 7-10.

- Extension Field Length in Packet  Enter the number of digits in the packet sent from the integration device. The range is 2 through 10, and the default is 4.

- Maximum Number of Remote Service Sessions  Enter the maximum number of remote MASs that are dependent on the primary server for integration. The range is 0 through 999, and the default is 0.

- Log Serial Packets  Select to log the serial integration data in the operation history database. This check box is selected by default.

7. Click Serial Settings.
The system displays the **Serial Settings** dialog box, where you can configure the serial line settings.

**To configure serial settings, configure the following:**

- **Line Speed (Bits per Second)** Enter the serial line speed in bits per second. The range is 110 through 115200, and the default is 9600.

- **Data Bits** Select the number of data bits for the serial line. The default is 8.

- **Stop Bits** Select the number of stop bits for the serial line. The default is 1.

- **Parity: None, Odd, Even, Space** Select to specify the type of parity for the serial line. The default is Odd.

- **Flow Control: None, DTR/DSR, RTS/CTS, Xon/Xoff** Select to specify None, DTR/DSR, RTS/CTS, or Xon/Xoff flow control for the serial line. The default is Xon/Xoff.

- **Connector** Select the serial port for the line. The default is COM1.

If you are using NEC-2400, Ericsson MD110, or DMID, you must also configure the serial properties for these cards. For more information and the procedures, see [Configuring serial NEC/Ericsson/DMID properties](#) on page 7-10.

After making these settings, you must stop and restart the MAS service for the settings to take effect.
Configuring serial NEC/Ericsson/DMID properties

To configure serial integration for NEC, Ericsson, and DMID protocols, use the Serial NEC/Ericsson/DMID dialog box.

To display the PBX Integration dialog box, Serial NEC/Ericsson/DMID tab:

1. In the Voice Mail System Configuration window, click Message Application Servers.

2. Click the MAS you want to configure.

   You may need to expand the tree to see all the MASs in the voice mail domain.

3. Double-click PBX Integration for that MAS.

   The system displays the PBX Integration dialog box, with the General tab active.

4. Click the Serial NEC/Ericsson/DMID tab.

---

**Note:** The options available on this tab depend on the packet format selected in the Serial General tab. For more information, see Configuring serial general properties on page 7-8.

---

To configure serial integration properties for NEC, Ericsson and DMID, configure the following fields:

- For the NEC-2400:
  - **Tenant Number** Enter the tenant number used by NEC integration. The range is 1 through 99, and the default is 1.

- For the Ericsson MD110:
  - **Filler Character** Enter the filler character used by Ericsson integration. The filler character can be zero or space. The default is space.
  - **Port Field Length** Enter the length of the port number field. The range is 2 through 5, and the default is 2.
  - **Tenant Number** Enter the tenant number used by Ericsson integration. The range is 1 through 99, and the default is 1.
  - **First Port Number** Enter the number of the first port to receive incoming calls. The range is 1 through 250, and the default is 1.

- For the DMID:
— **Enable Full Error Logging from DMID Integration Device** Select to place any errors reported by the DMID integration device in the Windows 2000 Significant Event Log. This check box is cleared by default.

— **Extension of First Port in DMID Hunt Chain** Enter the extension number of the port that is the first directory number in the hunt chain programmed for the DMID device. This must be a valid extension number. This field is blank by default.
PBX integration establishes communication between the PBX and the voice mail system. The PBX supplies information such as who is calling on internal calls and the extension that the caller is trying to reach.

With inband integration, the MAS receives information about an incoming call from the PBX in a call information packet. The call information packet contains DTMF digits indicating the type of call (known as the call packet type), the called party ID, the calling party ID, and the trunk ID.

To configure inband PBX integration for an MAS, use the Inband tab.

To display the PBX Integration dialog box, Inband tab:

1. In the Voice Mail System Configuration window, click Message Application Servers.
2. Click the MAS you want to configure.
   
   You may need to expand the tree to see the all the MASs in the voice mail domain.
3. Double-click PBX Integration for that MAS.
   
   The system displays the PBX Integration dialog box, with the General tab active.
4. Click the Inband tab.

To configure PBX integration inband properties, configure the following fields:

- **Maximum Inter-digit Gap (ms)** Enter the time, in milliseconds, for the delay between each DTMF digit in the call information packet. This setting does not apply to the delay until the first DTMF digit arrives in a call information packet. The range is 16 through 999, and the default is 48.

- **Pause before Inband Digits (ms)** Enter the maximum time, in milliseconds, to wait after taking the voice port off hook before the first DTMF digit arrives in a call information packet. The range is 100 through 9999, and the default is 2500.

- **DTMF On Time (ms)** Enter the length (duration), in milliseconds, of a DTMF digit in a call information packet. The range is 32 through 999, and the default is 32.

- **Search Entire String for Reason Code** Select to allow the integration service to search the entire call information packet for the call packet type (also known as the reason code). The call packet type is a string of DTMF digits that form a code for the type of call received, such as a direct call, a forwarded call, or a diverted call. If this field is cleared, the integration service looks for the call packet type at the digit position specified in the
Location of Inband Reason Code field. This check box is cleared by default.

- **Location of Inband Reason Code** Enter the position within the call information packet of the first DTMF digit in the call packet type (also known as the reason code). The call packet type is a string of DTMF digits that form a code for the type of call received, such as a direct call, a forwarded call, or a diverted call. Each call information packet must have a call packet type.

  For example, if the call packet type is the first field in the call information packet, enter 1. If the call packet type is the second field in the call information packet and follows a field that is 6 DTMF digits in length, enter 7. In this case, the first DTMF digit in the call packet type is the 7th DTMF digit in the call information packet.

  The range is 1 through 99, and the default is 1. This field is not available if **Search Entire String for Reason Code** is selected.

- **Log Inband Packets** Select to log the inband call information packets in the operation history database. When selected, inband call information can be viewed in Operation History Viewer. This check box is cleared by default.

- **Fixed Length Packets** Select if your PBX sends out call information packets of a fixed length. Within fixed length call information packets, each piece of call information, that is, the call packet type, the calling party ID, the called party ID, and the trunk ID, is in a fixed position.

  In the following example, the call packet type starts at position 1 (the first DTMF digit in the packet), the called party ID starts at position 4 (the 4th DTMF digit in the packet), the calling party ID field starts at position 11 (the 11th DTMF digit in the packet), and the trunk ID field starts at position 18 (the 18th DTMF digit in the packet). The total fixed packet length is 21.

<table>
<thead>
<tr>
<th>Call packet type</th>
<th>Called party ID field</th>
<th>Calling party ID field</th>
<th>Trunk ID field</th>
</tr>
</thead>
<tbody>
<tr>
<td>AAA</td>
<td>XXXXXXXX</td>
<td>XXXXXXXX</td>
<td>XXX</td>
</tr>
<tr>
<td>Start position = 1</td>
<td>Start position = 4</td>
<td>Start position = 11</td>
<td>Start position = 18</td>
</tr>
</tbody>
</table>

  You define the length and position of fields in call information packets using settings in the **Inband Protocol Settings** dialog box (see Configuring inband properties on page 7-12).

  If this check box is cleared, the packet length is variable. This check box is cleared by default.
Tip: To define the length and position of fields in call information packets, click Protocol Settings... and use the settings in the Inband Protocol Settings dialog box.

- **Filler Character** Select the filler character used in the call information packet. A filler character is required if your PBX sends out fixed length call information packets. The filler character is the character that is used to fill in blanks in a fixed length field, if the number of DTMF digits received is less than the fixed number defined.

For example, if the fixed length of a called party ID field is 7 (as defined in the Inband Protocol Settings dialog box), but only 4 DTMF digits are received, 3 filler characters are required to maintain the fixed length of the call information packet. These are added after the DTMF digits in the called party id field.

You can select from *, #, A, B, C, D, 0, or <NONE>. 0 is available only if the Right Alignment of Digits in a Field check box is selected. Note that the filler character cannot be the same as the delimiter character.

In the following example, hash (#) is used as the filler character.

```
Call packet type | Called party ID | Calling party ID | Trunk ID
---|---|---|---
3 digits | 7 digits | 7 digits | 4 digits
11# | 4001### | 6783000 | 3008
```

The default is asterisk (*).

- **Delimiter Character** Select the delimiter character used in call information packets to distinguish between different fields. For example, in the following call information packet, * is used to distinguish between the call packet type, called party ID, calling party ID, and trunk ID:

```
1000*4001234*6009*1200
```

You can select from *, #, A, B, C, D, or <NONE>. <NONE> is available only if the Fixed Length Packets check box is selected. The default is #. Note that the delimiter character cannot be the same as the filler character.

- **Right Alignment of Digits in a Field** Select to indicate that in a fixed length call information packet, the DTMF digits in each field are to be right aligned. This check box is cleared by default.

- **Request String Supported** Select if your PBX requires the MAS to send it a request string before it can send the call information packet. If selected, two fields are enabled, Inband Request Digit String and Pause before Request String.

- **Inband Request Digit String** Enter the sequence of DTMF digits that the MAS must send to the PBX when requesting a call information packet. The range is 0 through 99, and the default is blank. This field is available only if the Request String Supported check box is selected.

- **Pause before Request String (ms)** Enter the time, in milliseconds, before the MAS sends the request string to the PBX after going off hook. The PBX
may require this time to stabilize. The range is 0 through 10000, and the default is 500.

5. Click **Protocol Settings**...

   The system displays the Inband **Protocol Settings** dialog box, where you can configure inband protocol types. For more information, see Configuring inband protocol types on page 7-16.

6. To close the **Inband Protocol Settings** dialog box and return to the Inband tab, click **OK**.

7. Click **MWI Settings**.

   The system displays the **MWI Settings** dialog box, where you can configure message waiting indicator (MWI) settings. For more information, see Configuring MWI settings on page 7-18.

8. To close the **MWI Settings** dialog box, click **OK**.

After making these settings, you must stop and restart the MAS service for the settings to take effect.
Configuring inband protocol types

Configure inband protocol types in the Inband Protocol Settings dialog box. To reach
this dialog box, you must click Protocol Settings... on the Inband tab of the PBX
Integration dialog box (see Configuring inband properties on page 7-12).

To configure inband protocol settings, configure the following fields:

- **Show Advanced Call Packet Type** Select to configure the following call
  packet types:

  - An **Auto Logon** call packet type is used by Alcatel PBXs to identify
    the calling party in a direct internal call. In a regular direct internal
    call, the calling party is not identified. With an Auto Logon call, if the
    extension of the calling party is identified as a subscriber, the caller is
    prompted to enter a password.

  - A **Check Mailbox** call packet type is used by Matra PBXs when an
    extension is forwarded to a voice mail port on a ring-no-answer
    condition, a busy condition, or on always. It contains the call packet
    type (Check Mailbox) followed by the extension number of the
    telephone that is forwarded.

  - A **Confirm Mailbox** call packet type is sent by Modular Messaging
    software when it receives a Check Mailbox call information packet. It
    is required for the forwarding operation to continue.

  - A **Transfer Initiate** call packet type is sent by Matra PBXs when an
    attempt is made to transfer a call to an extension that has been
    forwarded to a voice mail port.

- **Call Packet Type** Select the call packet type you want to configure. The
  call packet type represents the type of call that is received. You can select
  Divert, No Answer Extension, Busy Extension, Direct Call, or Immediate
  Transfer.

  Certain switches, such as Matra and Alcatel, may also require you to
  configure the following call packet types: Auto Logon, Check Mailbox,
  Confirm Mailbox, and Transfer Initiate. To configure these call packet
  types, select the **Show Advanced Call Packet Type** check box.

  Once you have selected the call packet type, and entered information
  about the call packet type in the remaining fields, you can select another
  call packet type to configure.

  To enable your PBX to do this, you must configure the DTMF digit
  strings for each code. As an example, in a No Answer Extension call, an
  external no-answer call may be A1, and an internal no-answer call may
  be B1.

  Codes can have up to five characters including the digits 0–9, *, #, A, B,
  C, or D. Note that if you are configuring Check Mailbox, only one code is
available since the PBX uses just one code for a Check Mailbox call information packet.

The required DTMF codes are already defined in your PBX. See your PBX documentation for information.

- **Packet Length** Enter the total length of the selected call information packet. This field is available only if the **Fixed Length Packets** check box is selected in the Inband tab. The range is 0 through 255.

- **Codes for Call Type, Code 1 through Code 4** A PBX can send up to four different codes for each call packet type. For example, for a No Answer Extension call, the PBX may send three different codes: one for an internal call, one for an external call, and one for an external trunk call.

- **Field Type Settings** Use the fields in this area to determine the format of call information packets in the selected call packet type. If your call information packets are of fixed length, you can define starting position and field length for each field in the selected call information packet. This may be different for each call information type. For example, in a No Answer Extension call, the starting position of the called party ID field may be 9 (the 9th DTMF digit in the call information packet), whereas in a Divert call it may be 7 (the 7th DTMF digit in the call information packet.)

If your call information packets are of variable length, you can define the sequence of each field in the selected call packet type.

---

**Note:** You cannot configure field type settings for Confirm Mailbox and Check Mailbox call packet types.

- **Starting Position** Enter the starting position for the corresponding field in a fixed length call information packet. For example, if the first DTMF digit of the called ID is the 4th digit in a call information packet, enter 4 opposite Called Id.

- This field is available only if the **Fixed Length Packets** check box is selected in the Inband tab. The range is 1 through 99.

- **Fixed Field Length** Enter the fixed field length for the corresponding field in a fixed length call information packet. This field is enabled only if the **Fixed Length Packets** check box is selected in the Inband tab. The range is 1 through 20.

- **Sequence Number** Enter the sequence number of the corresponding field type. For example, if the fields are in the following order: call packet type, called ID, calling ID, and trunk ID, enter 2 opposite Called Id (second position), 3 opposite Calling Id (third position), and 4 opposite Trunk Id (fourth position).
Configuring MWI settings

Configure message waiting indicator (MWI) settings in the **MWI Settings** dialog box. To reach this dialog box, you must click **MWI Settings**... on the **Inband** tab of the **PBX Integration** dialog box (see Configuring inband properties on page 7-12).

To configure MWI settings, configure the following fields:

- **Port Group Name** Select the port group to be used for MWI. The Default port group is selected by default. Port groups are defined in the Port Usage tab. For more information, see Configuring port groups on page 8-11.

- **Max MWI Sessions** Enter the maximum number of MWI sessions allowed at one time. The maximum number cannot exceed the maximum number of ports in the selected port group.

- **Indicator On/Off signals must use the same port** Select if your PBX has port affinity. This check box is cleared by default.

- **Indicator On:**
  - **Prefix** Enter the DTMFs, if any, that the MAS must dial before the subscriber’s extension to turn on the message waiting indicator.
  - **Suffix** Enter the DTMFs, if any, that the MAS must dial after the subscriber’s extension to turn on the message waiting indicator.

- **Indicator Off:**
  - **Prefix** Enter the DTMFs, if any, that the MAS must dial before the subscriber’s extension to turn off the message waiting indicator.
  - **Suffix** Enter the DTMFs, if any, that the MAS must dial after the subscriber’s extension to turn off the message waiting indicator.
Configuring remote properties

To configure remote PBX integration for an MAS, use the Remote tab. With remote integration, the MAS receives incoming call information through another MAS that has a serial integration connection. You can specify a primary and secondary remote server for the MAS to use.

A secondary remote server would typically be used, for example, in the case of SMDI from a Centrex, where the integration data is sent to both the primary and secondary remote server, and the secondary server is accessed if the primary server is unavailable.

To display the PBX Integration dialog box, Remote tab:

1. In the Voice Mail System Configuration window, click Message Application Servers.

2. Click the MAS you want to configure.

   You may need to expand the tree to see the all the MASs in the voice mail domain.

3. Double-click PBX Integration for that MAS.

   The system displays the PBX Integration dialog box, with the General tab active.

4. Click the Remote tab.

To configure PBX integration remote properties, configure the following fields:

- **Primary Remote Server Name**  Enter the name of the primary server from which the MAS can get integration data for an incoming call. The default is the first server in the voice mail domain server list.

- **Secondary Remote Server Name**  Enter the name of the secondary server from which the MAS can get integration data for an incoming call. The default is the first server in the voice mail domain server list.

After making these settings, you must stop and restart the MAS service for the settings to take effect.
Configuring QSIG and set emulation properties

To configure a port group for MWI, use the QSIG/SE tab.

To display the QSIG/SE tab:

1. In the Voice Mail System Configuration window, click Message Application Servers.
2. Click the MAS you want to configure.
   You may need to expand the tree to see all the MASs in the voice mail domain.
3. Double-click PBX Integration for that MAS.
   The system displays the PBX Integration dialog box, with the General tab active.
4. Select one of the following Integration Types:
   - Set Emulation for digital set emulation (DSE) integration
   - QSIG for Q.signaling (QSIG) integration
5. Click the QSIG/SE tab.

To configure QSIG and set emulation properties, configure the following fields:

- **Port Group Name** Select the port group to be used for MWI. The Default port group is selected by default. Port groups are defined in the Port Usage tab. For more information, see Configuring port groups on page 8-11.

- **Max MWI Sessions** Enter the maximum number of MWI sessions allowed at one time. The maximum number cannot exceed the maximum number of ports in the selected port group.

- **Indicator On/Off signals must use the same port** Select this if your PBX has port affinity. This check box is cleared by default.

  **Note:** Do not select this check box for Avaya switches supporting QSIG integration.

- **MWI On** Enter the dial string required to switch on a subscriber’s MWI light. You can enter up to 50 characters. The default is ^O,%s,^O for NT M-1, and *4%s for G3. The system substitutes %s with the subscriber’s extension number. This field is not available with QSIG integrations.

- **MWI Off** Enter the dial string required to switch off a subscriber’s MWI light. You can enter up to 50 characters. The default is ^F,%s,^F for NT M-1, and
PBX Integration

#4%s for G3. The system substitutes %s with the subscriber’s extension number. This field is not available with QSIG integrations.

After making these settings, you must stop and restart the MAS service for the settings to take effect.
Configuring C-LAN properties

C-LAN is an Avaya proprietary TCP/IP protocol that provides voice integration to Avaya DEFINITY®, IP600, MultiVantage™, and Communication Manager switches. With C-LAN, switch integration is performed using a local area network.

To configure the C-LAN link, use the Avaya C-LAN tab.

Note: C-LAN is available with analog telephony only.

To display the PBX Integration dialog box, Avaya C-LAN tab:

1. In the Voice Mail System Configuration window, click Message Application Servers.
2. Click the MAS you want to configure.
   
   You may need to expand the tree to see the all the MASs in the voice mail domain.
3. Double-click PBX Integration for that MAS.
   
   The system displays the PBX Integration dialog box, with the General tab active.
4. Click C-LAN in the Integration Type column.
5. Click the Avaya C-LAN tab.
   
   The system displays the Avaya C-LAN tab. This tab supports administration of the nodes with which the messaging server communicates.

To configure Avaya C-LAN properties, configure the following fields:

- **Message Server Number**  Enter the identification number of the Message Server. The Message Server number is set on the switch, and is normally the same value as the switch number. The default is 1.

- **Switch Number**  Enter the identification number of the switch that communicates with the MAS. The default is 1.

- **Switch Host Address**  Do one of the following:
  - Click Name, and enter the domain name of the switch on the network. For example, pbx.avaya.com.
  - Click IP Address, and enter the IP address of the switch on the network.
TCP Port  Enter the TCP number of the port on the switch that is used to communicate with the MAS. By default, the TCP number is 5002.

Notes  Enter notes associated with the C-LAN integration. For example, you may find it useful to enter a description of the switch you are using.

Maximum Number of Remote Service Sessions  Enter the maximum number of remote MASs that are dependent on the primary server for integration. The range is 0 through 999, and the default is 0.

Connect Link / Disconnect Link  Do one of the following:

— To connect the C-LAN link, click Connect Link. This button is only displayed when the link between the MAS and switch is disconnected.

— To disconnect the C-LAN link, click Disconnect Link. This button is only displayed when the link between the MAS and switch is connected.

Note: If the MAS is unable to establish a connection with the switch, a link connection down event is logged in the Windows event log. The source of the error is gv_vserver, and the category is PBX Integration.

After making these settings, you must stop and restart the MAS service for the settings to take effect.
Configuring PBX integration properties for IP H.323

H.323-based IP integration provides voice integration to Avaya DEFINITY® (Release 10 or later), IP600, MultiVantage™ (Release 1.2), and Communication Manager switches. H.323-based IP integration provides IP connectivity between the MAS and the Avaya PBX.

In a Definity PBX, IP network connectivity is established using C-LAN and MedPro circuit packs on the PBX and the network interface card (NIC)/Ethernet card on the MAS. In a MultiVantage or Communication Manager PBX, IP network connectivity is established using the PROCR on the PBX and the NIC/ethernet card on the MAS.

In H.323-based IP integration, signaling or call information, message waiting indicator (MWI) information, and voice data are transmitted over the IP network. H.323 connectivity between the MAS and the Avaya PBX is accomplished by means of H.323 trunk groups configured as tie trunks supporting Q-Signaling (QSIG) features. Q-SIG is a standards-based, private networking protocol, based on Q.931 standards (ISDN). Signaling information and MWI information are transmitted using QSIG messages embedded in an H.323 packet.

To configure the IP link, use the IP Configuration tab.

To display the PBX Integration dialog box, IP Configuration tab:

1. In the Voice Mail System Configuration window, click Message Application Servers.
2. Click the MAS you want to configure.
   You may need to expand the tree to see the all the MASs in the voice mail domain.
3. Double-click PBX Integration for that MAS.
   The system displays the PBX Integration dialog box, with the General tab active.
4. In the Integration Type column, click IP.
5. Click the IP Configuration tab.

To configure IP PBX integration properties, configure the following fields:

- **MAS Corporate IP Address**: Enter the IP address of the MAS. This is the IP address that the MAS uses to connect to the corporate LAN.

- **PBX IP Address**: Enter the IP address assigned to the device that is terminating the H.323 signaling link. For a Definity PBX, this is the IP address of the PBX C-LAN card and for a MultiVantage or Communication Manager PBX, this is the IP address of the PROCR.
- **Port**: Enter the port number on the MAS that would be used for transmission of signaling information and MWI information. By default, the port number is 1720.

- **UDP Port Range**: Enter a minimum and maximum port number to specify a block of user datagram protocol (UDP) port numbers to be used for audio connections. The H.323 call setup protocol dynamically negotiates the UDP ports within the specified range that are available for use. The voice channels use the available ports from this UDP port range for transmission of voice data. The default range is 5000 through 5999.

- **Packet size (ms)**: Enter, in milliseconds, the size of the real time protocol (RTP) packets that are used to transmit H.323 media over the IP network. The packet size represents the amount of voice data sent per packet. The value you enter here should match the packet size sent by the PBX. Packet size is typically 30 milliseconds.

  The packet size sent by the PBX is configured at the time of administering the codec type on the PBX. See the IP Codec screen on the PBX to check the packet size value configured on the PBX. For more information on configuring your PBX, see the PBX configuration note.

- **Enable Tunneling**: Select to enable tunneling. Tunneling is the encapsulation of protocols that are at the same layer, into one another. When you enable tunneling, the QSIG message set, which contains call information and MWI information, is encapsulated in H.323 packets. This check box is selected by default.

- **Enable Fast Start**: Select to enable Fast Start. Fast Start, also known as Fast Connect, is a call setup method that bypasses some initial steps in order to reduce the connection setup time. This feature makes the call setup faster as the voice data transmission can start immediately after sending a Fast Start message. This check box is selected by default.

- **Silence Suppress**: Select to enable silence suppression. Enabling silence suppression prevents the transmission of voice packets during silence. Silence suppression ensures that no bandwidth is used during periods of silence.

- **Max MWI Sessions**: Enter the maximum number of MWI sessions allowed at one time. The maximum number cannot exceed the maximum number of ports in the port group that will be used for MWI.

- **Port Group Name**: Select the port group to be used for MWI. The Default port group is selected by default. Port groups are defined in the Port Usage tab. For more information, see Messaging Application Server Configuration on page 8-1.

- **IP Supported Codecs**: Enter the supported codec standards, in descending order of priority. An IP codec is the voice line coding algorithm that is used for communication between the MAS and the PBX. IP H.323 integration supports A-law and u-law codecs.
To add a codec to the list of supported codec standards, click **Add...** and select the codec.

To remove a codec from the list, select the codec that you want to remove and click **Remove**.

To increase or decrease the priority of a codec in the list, select the codec and click **Move Up** and **Move Down**, respectively.

After making these settings, you must stop and restart the MAS service for the settings to take effect.
This chapter describes how to configure a messaging application server (MAS) in a voice mail domain.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to configuring a messaging application server</td>
<td>8-2</td>
</tr>
<tr>
<td>Configuring messaging</td>
<td>8-4</td>
</tr>
<tr>
<td>Configuring text-to-speech</td>
<td>8-6</td>
</tr>
<tr>
<td>Viewing languages installed on the MAS</td>
<td>8-10</td>
</tr>
<tr>
<td>Configuring port groups</td>
<td>8-11</td>
</tr>
<tr>
<td>Configuring MAS serviceability</td>
<td>8-16</td>
</tr>
<tr>
<td>Configuring the tracing file size</td>
<td>8-18</td>
</tr>
<tr>
<td>Adding or removing MASs</td>
<td>8-19</td>
</tr>
</tbody>
</table>
Introduction to configuring a messaging application server

You can configure the following properties for an MAS:

- **Messaging**
  
  You can configure the peer electronic mail server and directory server.
  
  See Configuring messaging on page 8-4.

- **Text-to-Speech**
  
  You can configure the maximum number of concurrent text-to-speech (TTS) conversions allowed on an MAS.
  
  See Configuring text-to-speech on page 8-6.

- **Languages**
  
  You can view a list of the languages installed on an MAS and set multilingual TTS properties.
  
  See Viewing languages installed on the MAS on page 8-10.

- **Port Groups**
  
  You can set up group ports for use by PC client applications, the telephone user interface (TUI), Call Me, and fax.
  
  See Configuring port groups on page 8-11.

- **Tracing file size**
  
  You can configure the size of the tracing file that stores operation history events before they are sent to the tracing server.
  
  See Configuring the tracing file size on page 8-18.

- **MAS additions or removals**
  
  You can add MASs to or remove MASs from your system.
  
  See Adding or removing MASs on page 8-19.
Notes:

- The system may prompt you to stop and restart the MAS after you make changes to a property in Voice Mail System Configuration. If so, the changes do not take effect until you stop and restart the MAS.

- You must configure each MAS in your system.

For information on configuring properties shared across MASs in a voice mail domain, see Chapter 5, “Voice Mail Domain Administration”.

Selecting an MAS for the first time

When you select an MAS in a voice mail domain for the first time, the system prompts you to run the Telephony Configuration Wizard. This wizard enables you to quickly configure the telephony interface, add PBXs, configure a PBX type, and configure the number of ports or time slots for the MAS.

For more information on the Telephony Configuration Wizard, see the chapter on post-installation in the installation guide for your system.

Before you begin

Ensure you have read Chapter 2, “Introduction to Voice Mail System Configuration”. That chapter introduces you to the Voice Mail System Configuration application used to perform the configuration.

Start the Voice Mail System Configuration application from the Modular Messaging Software folder.
Configuring messaging

You configure messaging by specifying the following servers:

- **Peer Mail Server**

  This is the mail server that MASs communicate with when sending and receiving voice messages. The peer electronic mail server is initially selected at installation.

  For more information, see Configuring the primary peer server and directory server on page 8-5.

- **Directory Server**

  This is the server that contains information about subscribers. The directory server is initially selected at installation.

  For more information, see Configuring the primary peer server and directory server on page 8-5.
Configuring the primary peer server and directory server

To select the peer mail server and directory server, use the Messaging dialog box, General tab.

To configure messaging:

1. In the Voice Mail System Configuration window, click Message Application Servers.

   **Note:** You may need to expand the tree to see the MAS you want.

2. Under that MAS, double-click Messaging.

   The system displays the Messaging dialog box, with the General tab active.

3. In the Mail Server Name field, enter the domain name of the MAS.

   The tab display automatically updates with the MAS domain details.

4. In the Primary Directory Server field, enter the mail path and name of the directory server on which the voice mail domain object is installed.

   By default, this is the directory server specified when the MAS was installed.

5. Click OK.
Configuring text-to-speech

Text-to-speech (TTS) conversion enables subscribers to hear their e-mail messages read over the telephone. To use TTS, you must have a license that includes TTS sessions for your system (see Viewing and configuring licensing on page 5-43). You must also configure the general properties for TTS (see General properties - text-to-speech on page 8-7).

You can customize text-to-speech pronunciation using the Scansoft RealSpeak TTS engine (see Customizing TTS pronunciation with Scansoft® RealSpeak™ on page 8-8).
General properties - text-to-speech

Use the General - Text-to-Speech tab to set the maximum number of concurrent TTS conversions for an MAS.

To display the Text-to-Speech dialog box, General tab:

1. In the Voice Mail System Configuration window, click Message Application Servers.

   Note: You may need to expand the tree to see the MAS you want.

2. Double-click Text-to-Speech under that MAS.

   The system displays the Text-to-Speech dialog box, which has only one tab, the General tab.

To configure TTS properties, configure the following fields:

Note: Depending on your system’s configuration, you may not see both of these fields.

- **English** Enter a number to specify the maximum number of English TTS conversions allowed at any one time on the current server. The number cannot exceed the number of English TTS licenses purchased. The range is 2 through 24, and the default is 2.

- **Non-English** Enter a number to specify the maximum number of non-English TTS conversions allowed at any one time on the current server. The number cannot exceed the number of non-English TTS licenses purchased. The range is 2 through 24, and the default is 2.

Important: Running multiple concurrent TTS conversions on a single MAS may have a detrimental effect on the MAS's performance.
Customizing TTS pronunciation with Scansoft® RealSpeak™

With Scansoft RealSpeak, you can customize English and non-English language text-to-speech pronunciation by adding the following:

- Proper names
- Unpronounceable sequences, such as uppercase initials
- Application-specific words
- Culture-specific or language-specific terms

To customize text-to-speech pronunciation:

1. Run RSUDE.EXE by double-clicking it.

   This file is located in the RealSpeak directory from the Avaya Modular Messaging base directory, for example:

   ```
   C:\Program Files\Avaya Modular Messaging\Vserver\RealSpeak\RSUDE.EXE
   ```

2. Click File > Open.

3. In the Open file dialog box, Files of Type: field, use the drop-down list to select: Text Files (*.tdc, *.txt)

4. If necessary, navigate to the C:\Program Files\Avaya Modular Messaging\VServer\RealSpeak directory, and then select the dictionary file for your system's language.

   At system installation, each dictionary file, except the US English file (which has one entry for “Avaya”), is empty. We have provided these files so you can simply modify the existing file for your system’s language. For the dictionary file name for your system’s language see the following table:

<table>
<thead>
<tr>
<th>Language</th>
<th>Dictionary file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chinese (Mandarin, traditional)</td>
<td>RSUserDict_MandarinB5.txt</td>
</tr>
<tr>
<td>Chinese (Mandarin, simplified)</td>
<td>RSUserDict_MandarinGB.txt</td>
</tr>
<tr>
<td>Dutch</td>
<td>RSUserDict_Dutch.txt</td>
</tr>
<tr>
<td>French</td>
<td>RSUserDict_French.txt</td>
</tr>
<tr>
<td>German</td>
<td>RSUserDict_German.txt</td>
</tr>
<tr>
<td>Italian</td>
<td>RSUserDict_Italian.txt</td>
</tr>
<tr>
<td>Japanese</td>
<td>RSUserDict_Japanese.txt</td>
</tr>
</tbody>
</table>
5. Click **Open**.

6. Customize TTS pronunciation as required and add it to the dictionary file.

   If you need help performing this step, see the RealSpeak documentation that came with your system.

7. When you are finished making your changes, click **File > Save**.

8. Repeat this procedure for all MASs in the voice mail domain.

<table>
<thead>
<tr>
<th>Language</th>
<th>Dictionary file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portuguese</td>
<td>RSUserDict_Portuguese.txt</td>
</tr>
<tr>
<td>Spanish</td>
<td>RSUserDict_Spanish.txt</td>
</tr>
<tr>
<td>U.S. English</td>
<td>RSUserDict_USEnglish.txt</td>
</tr>
</tbody>
</table>
Viewing languages installed on the MAS

You can view a list of languages installed on the MAS. This is useful if you are configuring languages in the voice mail domain.

To view languages installed on the MAS:

1. In the Voice Mail System Configuration window, click Message Application Servers.

   Note: You may need to expand the tree to see the MAS you want.

2. Click the MAS for the language list you want to view.

3. Double-click Languages.

   The system displays a list of all languages installed on the MAS in the Languages display window, which has only one tab, the Server Languages tab.

   Note: You can only view a list of the languages installed on this MAS from this window. You cannot administer languages here.
Configuring port groups

You can configure the port groups for use by PC client applications, the TUI, Call Me, and fax.

You can configure the following port group properties for each MAS in the voice mail domain.

- **General**
  
  Use this tab to set up port groups.
  
  See Configuring general properties for port groups on page 8-13.

- **Usage**
  
  Use this tab to define port group usage for PC client applications and the TUI.
  
  See Configuring usage properties for port groups on page 8-15.

For more general information about port groups, see the following:

- Guidelines for port group usage on page 8-11
- About port groups on page 8-12

Guidelines for port group usage

The following guidelines are to assist you in allocating ports:

- **PC Client group**
  
  One or more ports on the MAS must be configured in the PC Client group.

- **Telephone User Interface group**
  
  One or more ports on the MAS must be configured in the Telephone User Interface group.
About port groups

The following port groups can be administered using the **Port Groups** dialog box:

- **PC client applications**  The ports in the PC Client group must allow outgoing calls. You need to set up the port group usage on the **Usage** tab.

- **Telephone user interface**  The ports in the Telephone User Interface group must allow incoming calls. You need to set up the port group usage on the **Usage** tab.

- **Call Me**  The ports in the Call Me group must also be in the Telephone user interface port group. You must set up the port group usage on the **Usage** tab.

- **Fax**  The ports in the Fax group are used for outgoing faxes. You need to set up the port group usage on the **Usage** tab.

- **MWI**  The ports in the MWI group are used with inband integration, IP H.323 integration, QSIG or set emulation. You configure the port group in the **MWI Settings** dialog box.

For more information on configuring port groups for inband integration, see [Configuring message waiting indicator (MWI)](page) on page 5-16.

[Configuring PBX integration properties for IP H.323](page) on page 7-24, [Configuring QSIG and set emulation properties](page) on page 7-20
Configuring general properties for port groups

To display the Port Groups dialog box, General tab:

1. In the Voice Mail System Configuration window, click Message Application Servers.

   **Note:** You may need to expand the tree to see the MAS you want.

2. Click the MAS you want to configure.

3. Double-click Port Groups under that MAS.

   The system displays the Port Groups dialog box, with the General tab active.

To configure port group general properties, configure the following fields:

- **Port Group** Select from the drop-down list the port group that you want to configure. The default is Default Group.

- **Port Group Members** Lists the ports available on the current MAS. Select a port to add it to the selected port group. Clear a port’s check box to remove it from the selected port group. All ports are selected by default when the system is installed. Ports installed after installation are not automatically included in a port group. You must add these ports to a port group for use by the MAS.

   **Note:** Ports referenced in the port group that no longer exist are marked with an exclamation mark (!).

- **Port Group Usage**
  
  — **Incoming** Select this to permit the port group to receive incoming calls to the MAS. By default, this check box is selected.

  — **Outgoing** Select this to permit the port group to send outgoing calls from the MAS. By default, this check box is selected.

- **Add Group** Clicking this button opens the Add New Group dialog box, where you can create a new port group. For more information, see To add a port group: on page 8-14.

- **Remove Group** Clicking this button removes the current port group. The system prompts you to confirm your decision before it deletes the port group.
Adding a port group

To add a port group:

1. Click **Add Group**.
   
   The system displays the **Add New Group** dialog box.

2. In the **Port Group Name** field, enter a unique port group name.

3. Click **OK**.

4. On the **Port Groups** dialog box, **General** tab, select the appropriate port group members and port group usage settings.

5. On the **Usage** tab, define the port group usage.
Configuring usage properties for port groups

Define the port group usage on the Usage tab.

To display the Port Groups dialog box, Usage tab:

1. In the Voice Mail System Configuration window, click Message Application Servers.

   Note: You may need to expand the tree to see the MAS you want.

2. Click the MAS you want to configure.

3. Double-click Port Groups.

   The system displays the Port Groups dialog box, with the General tab active.

4. Click the Usage tab.

To configure port usage properties, complete the following fields:

- **PC Clients**:
  - **Number of Instances** Enter the number of ports that can be accessed simultaneously by PC clients. This is limited to the number of ports configured for the port group. The range is 0 through the maximum number of ports available in the system, and the default is the maximum number of ports.
  - **Port Group** Select the port group to be used by the PC client applications. The default is Default Group.

- **Telephone User Interface: Port Group** Select the port group to be used by the TUI. The default is Default Group.

- **Call Me: Port Group** Select the port group to be used for Call Me. Ports in this group must also be in the Telephone User Interface port group. The default is Default Group.

- **FAX: Port Group** Select the port group to be used for outgoing Fax calls. The default is Default Group.

   Note: You only need to set up port groups for fax if you want to dedicate specific ports for faxing. For normal fax functionality, you can use the Default Group.
Configuring MAS serviceability

Serviceability in Avaya Modular Messaging refers, among other thing, to the ability of the MAS to generate logs and notifications related to system errors and alarms. Notifications can be sent out automatically to a designated support site, either Avaya Services, your own network management station (NMS), or a trusted business partner. These notifications are sent out using either the Avaya Initialization and Administration System (INADS) or by means of SNMP traps to a network management server.

If you are using INADS for sending and receiving error and alarm notifications, then you must configure the system at both the voice mail domain level and the MAS level. For information about serviceability administration at the voice mail domain level, see Configuring serviceability on page 5-38.

Use the Serviceability - [MAS] dialog box to configure alarm notifications for INADS at the MAS level.

To display the MAS Serviceability dialog box:

1. In the Voice Mail System Configuration window, click Message Application Servers.

   **Note:** You may need to expand the tree to see the MAS you want.

2. Click the MAS you want to configure.

3. Double-click Serviceability.

   The system displays the Serviceability - [MAS] dialog box, which has only one tab, the General tab.

To configure MAS (INADS) serviceability properties, configure the following fields:

- **COM port:** Select from the drop-down menu the COM port you want to use for sending and receiving alarm notifications.

- **Phone number:** Enter the telephone number of the INADS system to which you want to send alarm notifications.

Valid values for this field include:

- Numerals 0 through 9
- W, which instructs the system to wait for a dial tone
- , (comma), which creates a pause
- * (asterisk) or (#) pound sign, both of which signal trunk or feature access codes
- **Modem setup:** Enter the modem initialization (setup) string required for the modem to make the alarm notification calls. If you do not know what this is, consult your modem documentation or contact your technical service representative.
Configuring the tracing file size

The tracing file stores operation history events before they are sent to the tracing server. You can change the default size of the tracing file for an MAS. You may need to increase the size of the tracing file, particularly if heavy traffic is expected or if you expect the tracing server to be out of service for an extended period of time.

To configure the tracing file size:

1. In the Voice Mail System Configuration window, click Message Application Servers.

   Note: You may need to expand the tree to see the MAS you want.

2. Click the MAS you want to configure.

3. Double-click Trace File Size.

   The system displays the Trace File Size dialog box, which has only one tab, the Operation History File Size tab.

4. In the Size of Operation History Trace File (MB) field, enter the desired file size, in megabytes.

   The range is 1 through 99, and the default is 4.
Adding or removing MASs

If necessary, you can add or remove an MAS from a voice mail domain.

Adding an MAS

Before you add an MAS, you must ensure that it has been removed from its old voice mail domain, if applicable.

**Note:** If you are adding the first MAS in a voice mail domain, you must select the primary language to be used by the TUI.

To add an MAS to a voice mail domain:

1. Open the Voice Mail System Configuration window.
2. In the tree hierarchy, click the Message Application Servers branch.
3. Click **Edit > Add Message Application Server**.
   
   The system displays the Add New Message Application Server dialog box.
4. In the Message Application Server Name field, enter a name for the MAS.

   **Note:** The MAS must be running.

5. Click **OK**.
6. Select the PBX type for the MAS.
7. Stop and restart the MAS Service.

   For the procedure to stop and restart the MAS service (MM Messaging Application Server), see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.
Removing an MAS

This section describes how to remove an MAS from a voice mail domain. We recommend that you remove the MAS from the voice mail domain before uninstalling MAS software from the machine.

For information on removing the MAS software, see the installation guide for your system.

**Important:** After removing the last MAS that does not support multiple languages from a voice mail domain, you must refresh the domain languages. To do this, click *Edit > Refresh Domain Languages*.

To remove an MAS from the voice mail domain:

1. Open the *Voice Mail System Configuration* window.
2. Navigate to the MAS list in the tree hierarchy and click the MAS you want to remove.
3. Click *Edit > Remove Message Application Server*.

   The system prompts you to confirm the deletion.
4. Click *OK*.
Voice Mail Domain Management

This chapter describes how to manage voice mail domains.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to managing voice mail domains</td>
<td>9-2</td>
</tr>
</tbody>
</table>
Introduction to managing voice mail domains

This section describes how to perform the following tasks:

- Rename a voice mail domain.
  See Renaming a voice mail domain on page 9-3.
- Add a PBX type.
  See Adding a PBX type on page 9-4.
- Remove a PBX type.
  See Removing a PBX type on page 9-5

Before you begin

Ensure you have read Chapter 2, "Introduction to Voice Mail System Configuration". That chapter introduces you to the Voice Mail System Configuration application used to perform the configuration.

Start the Voice Mail System Configuration application from the Modular Messaging Software folder.
Renaming a voice mail domain

This task is performed in the **Voice Mail System Configuration** window. For information on how to open the **Voice Mail System Configuration** window, see Chapter 2, "Introduction to Voice Mail System Configuration".

**To rename a voice mail domain:**

1. Open the **Voice Mail System Configuration** window.
2. From the tree hierarchy, click the voice mail domain you want to rename.
3. Click **Edit > Rename Voice Mail Domain**.
   
   The system displays the **Rename Voice Mail Domain** dialog box.
4. In the **Voice Mail Domain Name** field, enter the new name for the domain. You can use up to sixteen characters.
5. Click **OK**.
Adding a PBX type

This task is performed in the **Voice Mail System Configuration** window. For information on how to open the **Voice Mail System Configuration** window, see Chapter 2, "Introduction to Voice Mail System Configuration".

**To add a PBX type**

1. Open the **Voice Mail System Configuration** window.
2. In the tree hierarchy, click the PBX’s branch.
3. Click **Edit > Add PBX Type**.
   
   The system displays the **Add New PBX** dialog box.
4. From the drop-down list, select the telephony type.
5. Select one or more PBX types to be added.
6. Click **OK**.
7. Configure the PBX type to communicate with the voice mail system.
   
   For more information, see Chapter 4, "PBX Configuration".
Removing a PBX type

This task is performed in the Voice Mail System Configuration window. For information on how to open the Voice Mail System Configuration window, see Chapter 2, "Introduction to Voice Mail System Configuration".

To remove a PBX type:

1. Open the Voice Mail System Configuration window.
2. Click the PBX you want to remove.
3. Click Edit > Remove PBX Type.
   - The system prompts you to confirm the deletion.
4. Click OK.
5. Select a new PBX type for any MASs that were using the PBX type you have just removed.
This chapter describes how to use the Visual Voice Editor application to customize prompts for use by the system Automated Attendant.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to customizing prompts</td>
<td>10-2</td>
</tr>
<tr>
<td>Creating a working copy of the prompt file</td>
<td>10-6</td>
</tr>
<tr>
<td>Working with Visual Voice Editor</td>
<td>10-8</td>
</tr>
<tr>
<td>Setting up customized prompts</td>
<td>10-11</td>
</tr>
<tr>
<td>Copying changes across MASs</td>
<td>10-20</td>
</tr>
<tr>
<td>Configuring customized prompts</td>
<td>10-21</td>
</tr>
<tr>
<td>Importing and exporting recordings</td>
<td>10-26</td>
</tr>
</tbody>
</table>
Introduction to customizing prompts

Avaya Modular Messaging systems ship with a set of standard, pre-recorded prompts for the system Automated Attendant. You can use these generic prompts, but, to make them work better for you, we recommend that you customize the following prompts for use by the Automated Attendant:

- **Auto Attendant Main Menu prompt**
  This prompt is the main prompt that the auto attendant voices.
  For more information, see Auto Attendant Main Menu prompt on page 10-4.

- **Morning, afternoon, evening and closed prompts**
  These prompts greet callers during designated business hours.
  For more information, see Morning, afternoon, evening, and closed prompts on page 10-4.

- **Holiday prompts**
  These prompts greet callers on days specified as holidays.
  For more information, see Holiday prompts on page 10-5.

- **Custom language selection greeting**
  This prompt asks callers to select the language they require.
  For more information, see Custom language selection greeting on page 10-5.

To customize prompts, you must perform the following tasks:

- **Make a working copy of the prompt file.**
  Customized prompts are stored in a prompt file, called CustomPrompts.OVF, in the MAS directory. Before setting up customized prompts, you must create a working copy of this file. For information on creating a working copy of the prompt file, see Creating a working copy of the prompt file on page 10-6.

- **Start Visual Voice Editor.**
  Visual Voice Editor provides a graphical interface for setting up customized prompts using local multimedia or a telephone. For information on Visual Voice Editor, see Working with Visual Voice Editor on page 10-8.

- **Set up your customized prompts.**
You set up customized prompts in Visual Voice Editor. Once you have recorded a customized prompt, you can play back the recording and, if necessary, edit the customized prompt. For information on setting up customized prompts, see Setting up customized prompts on page 10-11.

- Copy changes across MASs.

Once you have set up your customized prompts, you must copy the changes across all the MASs in the voice mail domain. For information on copying changes to MASs, see Copying changes across MASs on page 10-20.

- Configure your customized prompts.

When you have copied your changes across all MASs in the voice mail domain, you must configure the prompts using Voice Mail System Configuration. For information on configuring customized prompts, see Configuring customized prompts on page 10-21.

**Note:** You can also import sound files created using other audio software or export sound files you create to a different application. For information on importing and exporting sound files, see Importing and exporting recordings on page 10-26.
Custom Prompts

Auto Attendant Main Menu prompt

You can record the main menu prompt used by the system Automated Attendant. The purpose of this prompt is to help callers navigate the telephone user interface by prompting them on how to proceed. For example, “For Sales, press 1. For Technical Support, press 2. For Accounting, press 3”.

If the Auto Attendant Main Menu Prompt is not customized, the default is:

“When you enter the mailbox number of the person you are calling. If you have a mailbox on this system, press #. For assistance, press 0.”

Then, if callers are allowed to use Dial by Name:

“If you do not know the mailbox number, press * to spell the name.”

Followed by:

“If you do not have a touchtone telephone or require assistance, please stay on the line.”

Morning, afternoon, evening, and closed prompts

You can customize the following prompts:

- Morning prompt

  Greets callers during morning business hours. For example, “Good morning, thank you for calling Avaya…” If you do not customize this prompt, callers hear “Welcome to Avaya Messaging.”

- Afternoon prompt

  Greets callers during afternoon business hours. For example, “Good afternoon, thank you for calling Avaya…” If you do not customize this prompt, callers hear “Welcome to Avaya Messaging.”

- Evening prompt

  Greets callers during evening business hours. For example, “Good evening, thank you for calling Avaya…” If you do not customize this prompt, callers hear “Welcome to Avaya Messaging.”

- Closed prompt

  Greets callers after business hours. For example, “Thank you for calling Avaya. Our business hours are between 9.00 A.M. and 5.30 P.M., Monday through Friday. Please leave a message after the tone and we’ll return your call as soon as possible.” If you do not customize this prompt, callers hear “Welcome to Avaya Messaging.”
Holiday prompts

You can configure up to 18 holiday prompts for a voice mail domain. The TUI plays holiday prompts to callers on days you specify as holidays. For example: “Seasons Greetings from Avaya. Our offices will reopen on Monday. Please leave a message at the tone and we’ll be sure to return your call then.” If you do not create any holiday prompts, the system treats all days as the same.

Custom language selection greeting

If your system supports multiple languages, you can customize the prompt that asks callers to select the language they require. If you do not customize this prompt, callers hear the following default language selection greeting:

“For <language 1> press 1, for <language 2> press 2...”

You use the Language/Key Association Auto Attendant in Voice Mail System Configuration to assign keypad digits to each language supported by the TUI.

Note: You can configure up to three languages.
Creating a working copy of the prompt file

You store customized prompts in the prompt file in the MAS directory. This file is called CustomPrompts.OVF. Before you record customized prompts, you must create a working copy of this file. Avaya strongly recommends that you create a backup of the working copy before you record or edit your customized prompts. That way, you can recover from any editing mistakes by using the backup file.

Important: CustomPrompts.OVF contains prompts that you can modify. All other files with the OVF extension contain standard system prompts. These files should not be modified.

Note: If you are upgrading from an earlier version of the software, English3.OVF is renamed CustomPrompts.OVF. Any changes that you made to English3.OVF are retained.

To create a working copy of CustomPrompts.OVF:

1. Locate an MAS in the voice mail domain.
2. Stop operation of the MAS.
   For the procedure to stop the MAS service (MM Messaging Application Server), see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.
3. Locate and make a working copy of the CustomPrompts.OVF file.
   The MAS directory containing the prompt files is specified at installation.
4. If required, change the audio format.
   For more information, see Changing the audio format on page 10-7.
5. Make a backup of the working copy.
   We recommend that you name the file CustomPrompts.OLD.
6. Restart the MAS:
   For the procedure to restart the MAS service (MM Messaging Application Server), see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.
Changing the audio format

By default, the audio format for CustomPrompts.OVF is Brooktrout’s ADPCM. If you are using a PCM audio format for recording prompts, you can change the format accordingly. You can select one of the following:

- PCM CCITT A-Law (*.ovf)
- PCM CCITT Mu-Law (*.ovf)

To change the audio format:

1. Start Visual Voice Editor.
   
   For the procedure, see Starting Visual Voice Editor on page 10-8.

2. Locate and open your working copy of the CustomPrompts.OVF file.

3. Click File > Save As.

4. In the Save as type field, select one of the following formats:
   
   - PCM CCITT A-Law (*.ovf)
   - PCM CCITT Mu-Law (*.ovf)

5. Click Save.
Working with Visual Voice Editor

You use Visual Voice Editor to customize the prompts used by the system Automated Attendant to greet callers to your organization. This section describes how to start Visual Voice Editor and provides an overview of Visual Voice Editor screen areas and controls.

Starting Visual Voice Editor

To run Visual Voice Editor, click Start > Programs > Avaya Modular Messaging > Visual Voice Editor.

Screen areas and controls

Read this section to familiarize yourself with the Visual Voice Editor screen areas and controls. Figure 10-3 shows the Visual Voice Editor main window.

Figure 10-3. Visual Voice Editor main window.
Custom Prompts

View tips

- Use the View menu commands to display or hide a view as required.
- Click in a view or use the Window menu to make a view active.
- Resize a view to focus on a particular task.

Main toolbar

Provides standard file management options.

From left to right, the options are Open prompt file, Save prompt file, Cut selection, Copy selection, Paste clipboard contents, Print prompt list.

Figure 10-4. Main toolbar

Waveform toolbar

Provides options for performing operations on audio data in the Waveform view.

From left to right, the options are Zoom in, Zoom out, Increase amplitude after recording, Decrease amplitude after recording, Force to silence, Insert silence.

To display or hide the Waveform toolbar as required, use the View menu.

Figure 10-5. Waveform toolbar

Waveform infobar

Provides information about the current edit position and the size of the detailed waveform current selection, in seconds. Use the Waveform infobar to guide you when selecting a section of a prompt to edit.

Prompt view

Use this view to select a prompt with which to work. This view lists all the prompts that are stored in the prompt file in three columns showing the prompt number (Prompt), the duration of prompt playback in seconds (Length), and a textual description of the prompt (Comment).

Note: To print the prompt list, click the Print icon on the main toolbar. This option is available in Prompt view only.
Waveform view

Use this view to edit audio data. The currently selected prompt is graphically represented as a waveform.

**Figure 10-6. Waveform view**

1. Overview of waveform
2. Detailed waveform
3. Voice Player

**Overview of waveform** This shows the entire recording. A white frame indicates the extent of the recording in the Detailed waveform view. Once zooming is applied to the view, you can drag the frame to move around the recording.

**Detailed waveform** This allows you to do precise editing of audio data. A white vertical bar indicates the current edit point. Use the mouse or keyboard to select audio data in a similar way to selecting text in a word processor.

**Voice Player** This utility allows you to play, pause, record, fast forward, and rewind a recording using standard CD player-type controls. It shows the length of the recording in seconds and indicates the currently selected audio device, whether telephone or local multimedia.

**Comment view**

Use this view to create or edit text descriptions of prompts. This view also allows you to review the description of the currently selected prompt.

**Status bar**

The status bar provides useful information, for example, about toolbar icons and progress during an operation. To toggle between displaying or hiding the status bar, use the Status Bar command on the View menu.
Setting up customized prompts

Make sure you read the introduction to this chapter for more information about the prompts you are about to set up.

To set up customized prompts, perform the following tasks:

- Set up the appropriate audio device.
  
  For more information, see Setting up the audio device on page 10-12.

- Record the customized prompt.
  
  For more information, see Recording customized prompts on page 10-13.

- Play back the customized prompt, if required.
  
  For more information, see Playing customized prompts on page 10-15.

- Edit the customized prompt, if required.
  
  For more information, see Editing customized prompts on page 10-16.
Custom Prompts

Setting up the audio device

You can record customized prompts using local multimedia or a telephone. For ease of recording and editing, we recommend that you use the multimedia option. However, in some situations, you may find that you can achieve higher quality recordings using the telephone, especially if you are in an environment where a microphone would pick up background noise.

The current audio device is indicated on the Voice Player by the following icons:

- Telephone icon
- Multimedia icon

To set up telephone recording in Visual Voice Editor:

1. Click **Sound > Preferences**
   
   The system displays the Media Setup dialog box.

2. In the **When composing voice messages** field, click **Telephone**.

3. Click **Configure**.
   
   The system displays the Telephone Properties screen.

4. In the **Extension number** field, enter your extension or telephone number.

5. In the **Message application server name** field, enter the name of the MAS.

6. Click **OK**.
   
   The system displays the telephone icon in the Voice Player.

7. For the configuration changes to take effect, close and restart Visual Voice Editor.

To set up multimedia recording in Visual Voice Editor:

1. Click **Sound > Preferences**.
   
   The system displays the Media Setup dialog box.

2. In the **When composing voice messages** field, click **Multimedia**.

3. Click **OK**.
   
   The system displays the multimedia icon in the Voice Player.
Recording customized prompts

Before you can record a customized prompt, you must create a working copy of the CustomPrompts.OVF file. For more information, see Creating a working copy of the prompt file on page 10-6.

Important: Use the working copy of CustomPrompts.OVF when recording and editing your customized prompts. Ensure that the OVF file is saved in the audio format that you are using.

To record a customized prompt in Visual Voice Editor:

1. Click File > Open, or click the Open icon.
2. Locate and open your working copy of the CustomPrompts.OVF file.
   For more information, see Creating a working copy of the prompt file on page 10-6.
3. Click Edit > Insert.
   The system displays the Goto/Insert Prompt dialog box.
4. Enter a unique number for the prompt.
5. Click OK.

   Note: You will need the prompt number when you configure the prompt for the voice mail domain as described in Configuring customized prompts on page 10-21.

6. Click Comment and type the prompt text. Edit the text as you would with a word processor.
   You can use the Cut, Copy and Paste commands on the Edit menu.
7. Verify that the correct audio device is selected.
   For more information, see Setting up the audio device on page 10-12.

   Note: To quickly change the audio device for recording customized prompts, right-click the telephone or multimedia icon, and click 1 Multimedia, or 2 Telephone.
8. Click **Sound > Record**, or click 🎧 on the Voice Player.

9. Record your prompt, as follows.
   - If using local multimedia, begin speaking into the microphone.
   - If using the telephone, pick up the receiver when the telephone rings, and record the prompt after the tone.

10. When you are finished, click **Sound > Stop**, or click 🎧 on the Voice Player.

11. Play back your recording to verify that it is what you want.
    For more information, see Playing customized prompts on page 10-15.
    - If you want to re-record the prompt, repeat Steps 7 through 10.
    - If you want to edit the prompt, see Running an edit command on page 10-17 and Adjusting amplitude and silence on page 10-18.

12. Once you are satisfied with the recording, click **File > Save**, or click the **Save** icon.

13. If you want to record more prompts, repeat Steps 3 through 11.

**Note:** When you have finished a recording or editing session, click **File > Compact**. This removes extra data and unused space in the file that may result from some editing operations.

14. Copy the changes to the prompt file across all MASs in the voice mail domain.
    For more information, see Copying changes across MASs on page 10-20.

15. Configure the customized prompts for the voice mail domain.
    For more information, see Configuring customized prompts on page 10-21.
Playing customized prompts

You can play (to review) any of the customized prompts that you have recorded.

To play a customized prompt in Visual Voice Editor:

1. Click **Sound > Play**, or click the **Play** icon on the Voice Player.

   **Note:** If a range of audio data is selected in Waveform view, the system plays only that range. For more information, see Editing customized prompts on page 10-16.

2. If necessary, adjust the playback using one of the commands listed below.

<table>
<thead>
<tr>
<th>Action</th>
<th>Sound menu command</th>
<th>Voice Player button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip back 5 seconds</td>
<td>Skip Back</td>
<td>[ ]</td>
</tr>
<tr>
<td>Skip forward 5 seconds</td>
<td>Skip Forward</td>
<td>[ ]</td>
</tr>
<tr>
<td>Pause playback</td>
<td>Pause</td>
<td>[ ]</td>
</tr>
<tr>
<td>Stop playback</td>
<td>Stop</td>
<td>[ ]</td>
</tr>
<tr>
<td>Increase playback volume</td>
<td>Volume Up</td>
<td>N/A</td>
</tr>
<tr>
<td>Decrease playback volume</td>
<td>Volume Down</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Note:** You can also use the slider bar to move backward and forward in the prompt.
Custom Prompts

Editing customized prompts

This section describes how to edit a customized prompt in Visual Voice Editor. This process involves the following procedures:

- Selecting a range of audio data on page 10-16
- Running an edit command on page 10-17
- Adjusting amplitude and silence on page 10-18

Selecting a range of audio data

Most of the Visual Voice Editor editing functions require that you select the section or “range” of the prompt that you want to edit. Selecting audio data is similar to selecting text in a word processor.

Using the mouse

Click the desired edit start point in Waveform view, drag to the desired edit end point, and then release. The selected range is highlighted.

Using the keyboard

Click the desired edit start point in Waveform view, hold down the \texttt{Shift} key, and then use the left arrow or right arrow key to highlight your selection. Using the keyboard enables more precise data selection.

Figure 10-7 shows a selected range in Waveform view.

Figure 10-7. Waveform view

![Waveform view with selected range]

Selection tips

- For greater accuracy, you can zoom in to see even more detail of the waveform. To zoom in, click the Zoom icon \texttt{Zoom} on the Waveform toolbar.
- For fine control, use the Current Position and Selection Size markers on the Waveform infobar to guide you.
- To select the whole prompt, click \texttt{Edit} > \texttt{Select All}. 
Running an edit command

You can edit audio data. The method is similar to editing text in a word processor:

1. Select the range you want to edit.
2. Click the required Edit menu item.

To cut a section of a prompt:

1. Select the range of the prompt that you want to remove.
2. Click Edit > Cut, or click the Cut icon.

Visual Voice Editor cuts the section from the prompt and places it on the Clipboard. Visual Voice Editor then shifts the rest of the prompt back to fill in the gap, similar to deleting text in a word processor.

To copy a section of a prompt:

1. Select the range of the prompt that you want to copy.
2. Click Edit > Copy, or click the Copy icon.

Visual Voice Editor places a copy of the prompt section on the Clipboard.

Tips:

- To move quickly to a specified prompt, click Edit > Goto.
- To toggle an edit on or off in order to see its effect, click Edit > Undo.
- To remove any extra data or unused space in the prompt file when finishing a recording or editing session, click File > Compact.
Custom Prompts

To paste the contents of the Clipboard into a prompt:

Pasting audio data applies to the Waveform and Comment views only. Visual Voice Editor prevents pasting data not intended for that view. For example, you cannot paste text into Waveform view.

1. Select the prompt in which you want to paste the Clipboard contents.
2. Select the point where you want to paste.
3. Click Edit > Paste, or click the Paste icon.

The Clipboard contents are inserted at the desired point. Data after that point is shifted to the right, similar to inserting text in a word processor.

To trim a prompt:

Trimming a prompt deletes all data except the selected range. This is useful for eliminating leading or trailing silence at the beginning and end of a prompt:

1. Select the range of prompt, excluding any unwanted data at the beginning and end.
2. Click Edit > Trim.

Visual Voice Editor deletes all data except for the selected range. Nothing is placed on the Clipboard.

Adjusting amplitude and silence

When recording, you can increase or decrease the audio level, overwrite a range with silence to remove background noise, and insert silence to add pauses.

**Note:** Adjusting amplitude and silence is only possible when the Waveform view is active and an audio selection has been made.

To increase amplitude by 10%:

You can select a range or increase the amplitude of the whole prompt.

1. Select the range, if required.
2. Click Waveform > Increase Amplitude, or click 📊.

To decrease amplitude by 10%:

You can select a range or decrease the amplitude of the whole prompt.

1. Select the range, if required.
2. Click Waveform > Decrease Amplitude, or click 📊.
To overwrite a range with silence:

1. Select the range you want to overwrite with silence.
2. Click **Waveform > Overwrite Silence**, or click 🎧.

To insert silence into a recording:

1. Place the current edit point where you want to insert the silence.
2. Select the range equivalent to the length of silence you want to insert.
3. Click **Waveform > Insert Silence**, or click 🎧.
Copying changes across MASs

Once you have made changes to the prompt file, you must copy the changes across all MASs in the voice mail domain.

To copy changes across MASs:

1. Locate an MAS in the voice mail domain.

2. Stop operation of the MAS.

   For the procedure to stop the MAS service (MM Messaging Application Server), see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

3. Copy the modified prompt file to the MAS directory containing the prompt files.

4. Restart the MAS service.

   For the procedure to restart the MAS service (MM Messaging Application Server), see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

5. Repeat Steps 1 through 4 for all other MASs in the voice mail domain.

6. Configure the prompts for the voice mail domain using the Voice Mail System Configuration application.

   For more information, see Configuring customized prompts on page 10-21.
Configuring customized prompts

You configure the customized prompts for a voice mail domain using the Voice Mail System Configuration application. Make sure you make a note of the prompt numbers before beginning the configuration. For the procedures, see one of the following:

- Configuring the Auto Attendant Main Menu prompt on page 10-22
- Configuring holiday prompts on page 10-23
- Configuring morning, afternoon, evening, and closed prompts on page 10-24
- Configuring the custom language selection greeting on page 10-25

For more information on setting up customized prompts, see Setting up customized prompts on page 10-11.
Custom Prompts

Configuring the Auto Attendant Main Menu prompt

To configure the Auto Attendant Main Menu prompt:

1. Start the Voice Mail System Configuration application.

2. In the Voice Mail System Configuration window, click the desired Voice Mail Domain.

3. Double-click Auto Attendant.

   The system displays the Auto Attendant - Voice Mail Domain dialog box.

4. Click the Attendant Main Menu Editor tab (if it is not already the active tab).

5. In the Auto Attendant Main Menu Prompt field, enter the prompt number.

6. Click OK.

Note: If you configure multiple languages, you cannot enter the Auto Attendant Main Menu prompt. Instead, you must configure the Main Menu prompt for each language in the Language / Key Association tab.
Configuring holiday prompts

To configure holiday prompts:

1. Start the Voice Mail System Configuration application.

2. In the **Voice Mail System Configuration** window, click the desired voice mail domain.

3. Double-click **Auto Attendant**.
   
The system displays the **Auto Attendant - Voice Mail Domain** dialog box.

4. Click the **Holidays** tab.

5. Enter the prompt numbers and corresponding dates in the relevant fields.

6. Click **OK**.
Configuring morning, afternoon, evening, and closed prompts

To configure morning, afternoon, evening, and closed prompts:

1. Start the Voice Mail System Configuration application.

2. In the Voice Mail System Configuration window, click the desired voice mail domain.

3. Double-click Auto Attendant.

   The system displays the Auto Attendant - Voice Mail Domain dialog box.

4. Click the Time of Day tab.

5. Enter the prompt numbers in the relevant fields.

6. Click OK.
Configuring the custom language selection greeting

To configure the custom language selection greeting:

1. Start the Voice Mail System Configuration application.

2. In the Voice Mail System Configuration window, click the desired voice mail domain.

3. Double-click Auto Attendant.

   The system displays the Auto Attendant - Voice Mail Domain dialog box.

4. Click the Language / Key Association tab.

5. In the Custom Language Selection Greeting field, enter the appropriate prompt number.

6. Click OK.
You can import WAV files created using other audio software, for example, Microsoft Sound Recorder or the Voice Recorder. You can also save a recording created in Visual Voice Editor as a WAV file for use with other audio applications. For the procedures, see one of the following:

- Importing a recording on page 10-27
- Exporting a recording on page 10-28
Importing a recording

To import a recording in Visual Voice Editor:

Before importing a WAV file, verify that you have saved it in the audio format that you are using.

1. Do one of the following:
   - To insert a new prompt, click **Edit > Insert**.
   - To replace a selected prompt with an imported recording, click **File > Import**.

2. Locate and select the WAV file you want to import, using the standard **Windows Open** dialog box.

3. Click **OK**.

**Note**: Importing a recording applies to the entire prompt only. If the **Waveform** view is active and a range is selected, the range is ignored.
Exporting a recording

To export a recording in Visual Voice Editor:

1. Click the prompt you want to save in WAV format.
2. Click File > Export.
3. Using the standard Windows Save As dialog box, enter a name for the file and select where you want to save it.
4. Click OK.
This chapter describes caller applications—what they are, how to use them, and how to use Caller Applications Editor to create and deploy caller applications.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to caller applications</td>
<td>11-2</td>
</tr>
<tr>
<td>About the Caller Applications software</td>
<td>11-3</td>
</tr>
<tr>
<td>Creating caller applications (process overview)</td>
<td>11-6</td>
</tr>
<tr>
<td>Using the Caller Applications Editor</td>
<td>11-11</td>
</tr>
<tr>
<td>Administering caller applications</td>
<td>11-17</td>
</tr>
<tr>
<td>Creating a caller application node</td>
<td>11-18</td>
</tr>
<tr>
<td>Adding application (action) nodes to a caller application</td>
<td>11-22</td>
</tr>
<tr>
<td>Assigning actions</td>
<td>11-26</td>
</tr>
<tr>
<td>Administering prompts</td>
<td>11-35</td>
</tr>
<tr>
<td>Caller application deployment</td>
<td>11-42</td>
</tr>
<tr>
<td>Deploying caller applications across a voice mail domain</td>
<td>11-44</td>
</tr>
<tr>
<td>Creating an association for the caller application</td>
<td>11-46</td>
</tr>
<tr>
<td>Analyzing caller applications</td>
<td>11-50</td>
</tr>
</tbody>
</table>
Introduction to caller applications

Modular Messaging Caller Applications software enables you to enhance and extend the telephone user interface (TUI) by creating and deploying caller applications, which may contain additional menus and prompts. Caller applications allow you to extend or even replace the system Automated Attendant, depending on your organization’s needs.

You can create caller applications to perform functions like the following:

- Automate call handling and route incoming calls directly to departments within your organization.
- Use them to create daily “bulletin board” announcements for your callers and subscribers.
- Create an automated fax attendant.
- Allow for greater flexibility and more options with respect to system and personal greetings.

**Note:** If you are familiar with or are migrating from an Intuity AUDIX environment, you should realize that, in the Modular Messaging environment, caller applications can be used to accomplish most of the same functions as “automated attendants” (including “nested automated attendants”) in AUDIX. In fact, you will find that you can actually accomplish many of the same ends easier using caller applications.

Depending on how your system and your caller applications are set up, callers can reach these caller applications in any of the following ways, often without even realizing they are doing so:

- From the Automated Attendant:
  - By entering an ID number that is associated with a caller application. In this case, the caller enters this ID number as a mailbox number (although the caller application itself does not require a mailbox for its existence).
  - By pressing an Automated Attendant menu choice associated with a caller application.

- By calling a specified direct dial number (such as a pilot number) or telephone extension number.

- By transferring to a mailbox with an associated caller application.

- From another caller application.

For a more comprehensive discussion of how to create and use caller applications, including examples, see Appendix B, Examples of Caller Applications.
About the Caller Applications software

The Caller Applications software consists of two components, both of which are installed and added to the Avaya Modular Messaging menu during system installation:

- Caller Applications Editor
- Caller Applications Runtime

Caller Applications Editor

The Caller Applications Editor software consists of Microsoft Management Console (MMC) snap-ins and extensions. You can run this tool either strictly within the MAS environment or you can install and use it as a standalone development tool on another machine outside the voice mail domain. If you choose to use it as a standalone development tool on a machine other than an MAS, then you must have network connectivity to the MAS before you can deploy and use them. You must also be logged in as an MM System Administrator.

For the procedure to install the Caller Applications Editor on a standalone PC, see Installing the Caller Applications Editor on a PC on page 11-4. For more general information about using the Caller Applications software, see Using the Caller Applications software on page 11-5. For more information on using the Caller Applications Editor to create and deploy caller applications, see Using the Caller Applications Editor on page 11-11.

Caller Applications Runtime

Caller Applications Runtime is an MAS subsystem that executes caller applications. Before the system can use caller applications, this software must be installed on all MASs in the voice mail domain.
Installing the Caller Applications Editor on a PC

The Caller Applications Editor is normally installed on MASs as part of the MAS software installation process. It can be used on the MAS then create and deploy caller applications.

It can, however, also be installed and used on a standalone PC to create caller applications, which can then be deployed in the voice mail domain from the standalone PC—if the voice mail domain is accessible to the PC in the network—or by transporting the caller application back to the MAS and deploying it from there.

The Caller Applications Editor software can be installed on any desktop or laptop PC running the Windows 2000 or Windows XP operating system. Avaya recommends also that you verify that the most recent service packs and security patches are installed on the PC.

To install the Caller Applications Editor on a standalone PC:

1. Insert the installation DVD, labeled *Avaya Modular Messaging Application Software*, into the DVD drive.

   The system should automatically start the Modular Messaging Installation Wizard. If it does not, you must locate on the DVD the file named setup.exe and double click it to start the wizard.

2. When the Modular Messaging Installation Wizard starts, select the option labeled *Caller Applications Editor*. Make sure that no other options are selected.

3. Click **Install** and follow the installation wizard prompts.
Using the Caller Applications software

To use the Caller Applications software:

- Verify that the Caller Applications software is installed on every MAS in the voice mail domain.

  **Note:** Before installing the Caller Applications software on an MAS, you must first make sure that all Modular Messaging services have been stopped on that MAS. After installing the software, verify that the services are restarted. For the procedure to install the Caller Applications software, see [Installing the Caller Applications Editor on a PC](#) on page 11-4. For the procedure to stop and restart Modular Messaging services, see [Appendix C, Stopping and (re)starting Modular Messaging (MM) services](#).

- Use the Voice Mail System Configuration tool to verify that caller applications are enabled for the voice mail domain. For information on enabling caller applications for the voice mail domain, see [Configuring TUI general properties](#) on page 3-4.
Creating caller applications (process overview)

The recommended process of creating caller applications for use on your system is a six-step process:

1. **Plan carefully!**
2. **Set up your targets.**
3. **Build the caller application(s).**
4. **Record and assign prompts.**
5. **Deploy the application.**
6. **Analyze the application.**

---

Notes:

- This section gives a broad overview of the caller application process, to give you a general feel for the process flow. The rest of this chapter provides more detailed information about these six general steps.

- For examples of this process in action and for additional ideas on how you can use caller applications, see Appendix B, Examples of Caller Applications.

---

**Plan carefully!**

Absolutely nothing is more important than careful planning when designing and setting up caller applications for your system. The following are several techniques you can use to help plan your system’s use of caller applications:

- **List the desired behaviors for your system.**

  Exactly what do you want your system to do and how you want it to behave? What do you want callers who reach your system to experience? What kinds of choices do you want to give them, and at what level? How many menu levels do you want to offer?

- **Make a flow chart or diagram of the caller application(s).**

  One of the best ways to plan your system’s behavior is to visualize it by creating a flow chart or diagram. This enables you to trace the caller experience and all possible options. It also helps you determine where you will and will not need to record and use prompts. For examples of call flow charts, see Appendix B, Examples of Caller Applications.

- **Plan your prompts.**
Create a chart or spreadsheet to list and describe the prompts you think you will need.

**Note:** Only one prompt can be assigned to a given node. This means that, if you have a node in which you want to make several menu options available to callers, you must include the information for all those options in a single prompt to be assigned to that node.

You can always add to your list of prompts later if and as the caller application design changes, but it is good to try to list as many in advance of the actual execution of the plan as possible. Make sure you leave a place to assign an ID number to each prompt, either now or later.

Once you have planned your system’s operation, the next step is to **Set up your targets**.

**Set up your targets**

If you know that one or more of your caller options will be redirecting the caller to an extension or mailbox within the system, it is especially important that you do this step. You cannot actually build this functionality into your caller application until you do.

For example, one of the options you may want to provide your callers is the option to talk with someone in the technical support department. You can set up your caller application to do this, but if you have not first set up the extension for your technical support department, you will not be able to provide that extension number when building the caller application.

If you know that your caller application will be redirecting the caller to another caller application, it is also a good idea to create the secondary caller application first. Again, you can create a node to redirect the caller, but until you have actually created (and deployed) the secondary caller application, you cannot actually implement the transfer in the primary caller application. It is a good idea to keep this in mind when designing a system that uses multiple caller applications.

Once you have set up all your targets, then you are ready to **Build the caller application(s)**.

**Build the caller application(s)**

To build the actual caller application, you must use the Caller Applications Editor. The Caller Applications Editor is a GUI software tool provided as part of your Avaya Modular Messaging system. It is designed specifically to allow you to create and deploy your own caller applications.

You can use the Caller Applications Editor either directly on the MAS where you intend to use the caller application or as a standalone tool on a machine outside the voice mail domain. If you choose to develop your applications on a separate machine, you must remember to import the caller application (*.uma) file to the MAS before you can install and deploy it.
Caller applications are built around a “node” concept. That is, you start with a base caller application node that acts as the gateway into the caller application, and then (if required) add nodes under it to perform additional functions. These additional nodes are called application, or action, nodes.

A caller application can consist of many nodes at many levels or a single node. It may provide callers with many options at multiple levels, or it could play a simple greeting and automatically transfer the caller to an extension. It all depends on what you want or need the caller application to do, as determined by your design plan.

**Note:** What follows is a general description of the process to build a caller application using the Caller Applications Editor. It assumes that you have already planned your caller application design (see Plan carefully! on page 11-6) and created the necessary targets (see Set up your targets on page 11-7). For more specific information about how to use the Caller Applications Editor itself or to perform a specific step in the process, follow the appropriate links in the text.

To build the caller application:

1. Open the Caller Applications Editor.
   
   For the procedure, see Starting the Caller Applications Editor on page 11-11.

2. Create the caller application node and set the properties for the caller application.
   
   For the procedure, see Creating a caller application node on page 11-18.

3. Add the application action nodes required to enable the caller application to perform all the functions called for in your plan. Be sure to set all the appropriate properties for each action node. Remember too that you can assign only one prompt per node.

   For the procedure to add application action nodes and set their properties, see Adding application (action) nodes to a caller application on page 11-22.

   For more ideas on how to incorporate and use application action nodes see Appendix B, Examples of Caller Applications.

   **Note:** As you are adding nodes, and especially if you find yourself modifying your caller application, we recommend that you also remember to update your list of prompts as you go along.

4. Save the caller application.

   For the procedure, see Saving a caller application on page 11-41.
If you have not been saving your work as you go along, you should save your caller application before recording and assigning your prompts. Once you have saved the application, then you are ready to Record and assign prompts.

**Record and assign prompts**

If you have been keeping a list of all the prompts you will need for your caller application, it will be easy to record them (or have them recorded) and then assign them where they belong within the caller application.

There are two ways you can get prompts recorded and onto the MASs in your system. You can:

- Record them yourself (or have someone else within your organization record them)
- Have them professionally recorded by someone else.

In the first case, you can record the prompts directly onto the MAS, using either a telephone or a multimedia CD equipped with a microphone and speakers. For the procedures to record your own prompts, see Recording application prompts on page 11-37. This approach has the advantage of being easier, but the recording quality may suffer as a result.

For this reason, many organizations prefer to have their prompts professionally recorded and then import the prompts into the caller application. The Caller Application Editor makes this easy to do, because “wave” (*.wav) files can be dragged and dropped into the application. For the procedure to do this, see Importing prompts on page 11-39.

Whether you record your own prompts or have them recorded and import them, after they are on the MAS, you must still assign them to the appropriate nodes in your caller application. For the procedure to do this, see Assigning prompts to nodes on page 11-40.

Once you are done assigning all the prompts to the appropriate nodes in your caller application, save it again. At this point, you are done creating the caller application, but you must still Deploy the application in the voice mail domain to place it into service.

**Deploy the application**

Simply creating and saving a caller application does not automatically place it into service and make it available to callers. Once the caller application is finished, you must still deploy (install) it on the voice mail domain before it is considered “live” and available to callers.

In cases where the application is designed for callers to access it using a key press or combination of key presses, you must also create an association as part of the deployment process.
For more information about deploying caller applications and associations, including the procedures for them, see Caller application deployment on page 11-42.

Once the caller application has been deployed, technically it is finished. However, there is one more step in the process that you should not overlook, as it will help you discover and correct any design problems with your caller applications before your customers do. After deploying the application, you should Analyze the application, using the Application analysis tool, to discover and help troubleshoot any problems that may exist within your application.

Analyze the application

The Caller Applications Editor contains within it a tool, called the Application analysis tool, which can be very helpful in testing and locating errors within your deployed caller applications. When you use this tool, it analyzes all caller applications deployed within a selected voice mail domain and flags any errors it finds. This allows you to repair problems (hopefully!) before callers have a chance to encounter them. That is why we recommend strongly that you use this tool immediately after deploying any caller application.

For more information about the Application analysis tool, see Troubleshooting deployed caller applications on page 11-55.
Using the Caller Applications Editor

The Caller Applications Editor is the primary tool used to create and deploy (install) caller applications on your system.

Starting the Caller Applications Editor

To start the Caller Applications Editor, click Start > Programs > Avaya Modular Messaging > Caller Applications.

The systems displays the Modular Messaging Caller Applications window (see Figure 11-1).

Figure 11-1. Modular Messaging Caller Applications window

1 Tree pane
2 Action menu
3 Modular Messaging Caller Apps node
4 Caller application node
5 Application action nodes

Caller applications are represented in a hierarchical tree structure in the left (Tree) pane of the window. The system displays objects in this pane at the following levels:
Caller Applications

- **Modular Messaging Caller Apps level**
  
The top level of the tree is the Modular Messaging Caller Apps node. All caller applications form branches off this node.

  This is the level at which you can make settings that affect all caller applications you create (see Configuring preferences and general caller application properties on page 11-16).

- **Caller application level**

  Just beneath the Modular Messaging Caller Apps node are the nodes for the caller applications that you have created or opened. Each caller application has its own node.

- **Application (action) node level**

  Beneath the caller applications are the application action nodes, which typically represent the menu items and other caller options in a caller application. A caller application can have many action nodes. If submenus are required, it may have several levels of action nodes.

**Understanding and using the Action menu**

The Action menu is context-sensitive. That is, the contents of this menu vary according to the node level selected in Caller Application Editor.

You can reach this menu by either:

- Clicking a node to select it and then clicking the Action menu option.
- Right-clicking a node. This method accesses the Action menu as a pop-up menu.

The following tables list the Action menu options for each level:

**Action menu options - Modular Messaging Caller Apps level**

<table>
<thead>
<tr>
<th>Action menu option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Application</td>
<td>Displays the standard Windows Open dialog box listing all the caller applications that are available for editing.</td>
</tr>
</tbody>
</table>
Caller Applications

Action menu options - Modular Messaging Caller Apps level

<table>
<thead>
<tr>
<th>Action menu option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New - Caller Application</td>
<td>Creates a new caller application node below the <strong>Modular Messaging Caller Apps</strong> node.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the <strong>Modular Messaging Software Caller Apps Properties</strong> dialog box. Use this dialog box to set preferences for all caller applications you create (see Configuring preferences and general caller application properties on page 11-16).</td>
</tr>
</tbody>
</table>

Action menu items - Caller application level

<table>
<thead>
<tr>
<th>Action menu option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Application</td>
<td>Saves the caller application with the same application name and embedded ID, and also increments its revision number.</td>
</tr>
<tr>
<td>Save Application as</td>
<td>Saves the caller application with a new application name and embedded ID. On the next deployment, this caller application will be treated as a new application by the MASs in the voice mail domain.</td>
</tr>
<tr>
<td>Close Application</td>
<td>Closes the caller application. The system prompts you to save any changes made since the last save.</td>
</tr>
<tr>
<td>New - Application Node</td>
<td>Creates a new application action node below the selected caller application node.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the <strong>Properties</strong> dialog box for the selected caller application. Use this dialog box to set properties that apply to the caller application (see Configuring the caller application properties on page 11-19).</td>
</tr>
</tbody>
</table>

Action menu items - Application action node level

<table>
<thead>
<tr>
<th>Action menu option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change access key</td>
<td>Displays the <strong>Change Key</strong> dialog box, which allows you to change the key press the caller must use to access that application action node.</td>
</tr>
<tr>
<td>New - Application Node</td>
<td>Creates a new application action node below the currently selected application action node as a sub-level to it.</td>
</tr>
</tbody>
</table>
Understanding the toolbar icons

The icons displayed in the Caller Applications Editor toolbar vary according whatever is selected in the Tree pane, both in which icons are displayed and whether icons are displayed as active or inactive. Many of these icons duplicate actions available from the Action menu.

The following icons are used in the Caller Applications Editor toolbar:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅</td>
<td>Moves back to the previous display in the history.</td>
</tr>
<tr>
<td>✅</td>
<td>Moves forward to the next display in the history.</td>
</tr>
<tr>
<td>✅</td>
<td>Moves the display up one level (available only at caller application node level).</td>
</tr>
<tr>
<td>✅</td>
<td>Displays/Hides the hierarchical Tree pane.</td>
</tr>
<tr>
<td>✅</td>
<td>Displays the Properties dialog box for the active level. At the Modular Messaging Software Caller Apps level, use this dialog box to set preferences for all caller applications you create (see Configuring preferences and general caller application properties on page 11-16). At the caller application level, use this dialog box to set properties that apply to the caller application (see Configuring the caller application properties on page 11-19). At the caller application node level, use this dialog box to set properties that apply to the selected action node (see Configuring application (action) node properties on page 11-23).</td>
</tr>
<tr>
<td>✅</td>
<td>Exports the contents of the Name field to a text file, using the Windows Save As dialog box.</td>
</tr>
<tr>
<td>✅</td>
<td>Refreshes the display.</td>
</tr>
</tbody>
</table>
## Caller Applications

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Accesses the online help for the Caller Applications Editor.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>(Available only at the <strong>Modular Messaging Software Caller Apps</strong> node level) Creates a new caller application.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>(Available only at caller application node level) Creates a new application action node.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>(Available only at the <strong>Modular Messaging Software Caller Apps</strong> node level) Opens an existing caller application.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>(Available only at the <strong>Associations</strong> level, under <strong>Modular Messaging Software Caller Apps &gt; Deployed Applications &gt; [MAS]</strong>) Opens the <strong>Add Association</strong> dialog box, which allows you to create a caller application association.</td>
</tr>
</tbody>
</table>
Configuring preferences and general caller application properties

You must configure Caller Application Editor properties at the Modular Messaging Caller Apps level (that is, the Modular Messaging Software Caller Apps node must be selected). These properties signify your preferences and are applied to any caller applications you create.

To configure Caller Application Editor properties:

1. Click the Modular Messaging Caller Apps node.
2. From the Action menu, click Properties.
   
   The system displays Modular Messaging Software Caller Apps Properties dialog box, which has only one tab, the General tab.
3. Under Media Setup, click Telephone or Multimedia.
4. If you clicked:
   
   — Multimedia, skip ahead to Step 7.
   
   — Telephone, click Configure to set up telephone properties.
      
      The system displays the Telephone Properties dialog box.
      
      ■ In the Extension number: field, enter the number of the extension that will be used for recording and playing prompts.
      
      ■ In the Message Application Server name: field, enter the name of an MAS in the voice mail domain. If necessary, use the Browse button to locate the desired MAS.
6. Click OK.
7. (Only if you selected Telephone as the media type) Select the appropriate digital telephony type for your region. If you are in a country that uses a digital telephone network other than that used in the United States or Japan, select International regions including Europe.
8. To automatically display dialog boxes when you create a new application (action) node, select Display properties when creating new application nodes.
   
   We recommend selecting this option, as it helps to streamline and speed up the caller application building process.
9. To enable users to select the language for a caller application or add another language to the caller application, select Allow Language Selection.
10. Click OK.
Administering caller applications

This section provides information on how to administer caller applications on your system.

**Note:** You can configure your preferences for using the Caller Applications Editor and properties to be applied by default to caller applications you create. For more information, see Configuring preferences and general caller application properties on page 11-16.

Sub-topics include the procedures to:

- Create a caller application node and configure its properties.
  
  For more information, see Creating a caller application node on page 11-18.

- Add application (action) nodes to the caller application and configure their properties.
  
  For more information, see Adding application (action) nodes to a caller application on page 11-22.

- Administer prompts, including selecting prompt types and recording or importing prompt files.
  
  For more information, see Administering prompts on page 11-35.

- Save a caller application.
  
  For more information, see Saving a caller application on page 11-41.

- Open a caller application.
  
  For more information, see Opening a caller application on page 11-41.
Creating a caller application node

The first step in creating a caller application is to add the base caller application node. This is a top-level node, added just below the Modular Messaging Caller Apps node.

Typically, this base node is set up as a menu of options presented to the caller (“For product information, press 1. For technical support, press 2.” Etc.), but it does not need to be. It can also be used to:

- Transfer the caller automatically to an extension or mailbox within the system.
- Go to another node or caller application within the system.
- Route calls according to the time of day at which the call is received.
- Allow callers to send a message without having to listen to the dialed party’s greetings.
- Terminate the call.

There are two basic steps to create a caller application node:

- Adding the base caller application node
- Configuring the caller application properties

You may also want to add application (action) nodes as sub-nodes to provide other options or actions to the caller (see Adding application (action) nodes to a caller application on page 11-22).

Adding the base caller application node

To add a basic caller application node and create the caller application:

1. Start the Caller Applications Editor, if it is not already running.
   
   For the procedure to start the Caller Applications Editor, see Starting the Caller Applications Editor on page 11-11.

2. Click Action > New > Caller application, or click the New ( ) icon.
   
   The system displays the New Caller Application dialog box.

3. Complete the following fields:
   
   - **Application name**  Enter the name of the caller application. The Editor displays this name in the list of deployed applications when the application is deployed.
   
     - **Application description**  (Optional, but recommended) Enter a short description of the caller application. This description provides the text that the system displays with the application properties.
Caller Applications

- **Language** Select the language to use for the caller application. The display lists all the languages installed with the system.

- **Design for VMD** (Optional) Select this if you want to specify the voice mail domain where the caller application will be deployed. When selected, voice mail domain-specific values, such as the mailbox length, will be applied to the caller application. This information is not a prerequisite for building a caller application but is useful if you are editing caller applications offline and cannot easily access voice mail domain information.

4. Click **OK**.

The system displays the caller application as a node under Caller Apps.

---

**Note:** At this point, the system displays the caller application node icon in red ( weekdays), signifying that it is not yet viable. Once you add one or more application (action) nodes underneath the base node or change the action type in the **Properties** dialog box, the system changes the display to signify that the caller application is viable ( weekdays).

---

**Configuring the caller application properties**

**To configure caller application properties:**

1. Right-click the caller application node and select **Properties** from the pop-up menu.

2. In the **[Caller Application] Properties** dialog box, click the **General** tab.

3. On the **General** tab, complete the following fields:

   - **Name** Displays the current name of the caller application. You can change the name of the caller application if you want.

     The Caller Application Editor displays this name in the list of deployed applications when the application is deployed.

   - **Description** (Optional, but recommended) Displays the description, if any, you entered when creating the node. If you want, you can modify this short description of the caller application.

     This description provides the text that the system displays with the application properties and can be very useful, especially when designing large applications.

   - **Action type** Select from this menu the type of action you want to assign to the caller application node. **Menu** is the default action type. The choice you make here determines options that appear to the right of this menu. For more information, see **Assigning actions** on page 11-26.
4. Click the **Prompts** tab.

5. On the **Prompts** tab:

   - If you do not want to use a prompt with this node, then verify that the **Play entry prompt** check box is cleared and skip ahead to the next step.

   - If you want to use a prompt with this node, then select the **Play entry prompt** check box and complete the remaining fields (which become active when you select this option).

     For more information about these and the remaining prompt options, see **Administering prompts** on page 11-35.

6. Click the **Application** tab.

   **Note:** The settings you make in this tab apply to the entire caller application.

7. On the **Application** tab, complete the following fields:

   - **Operator options** These options allow you to determine where the call will be redirected if the caller presses the Operator key (0).

     - **Default operator** Select this to route the call to the default operator as defined for the voice mail domain.

       To use this option, you must ensure that you have configured a default receptionist mailbox number for the voice mail domain. For more information, see **Configuring TUI receptionist properties** on page 3-6.

     - **Custom operator** Select this to route the call to a custom operator defined for the caller application. Enter the extension number for the custom operator.

       This option might be used, for instance, in the case of an executive who does not want calls re-routed to the system operator, but rather to a personal executive assistant.

   - **Default cancel** Select a node for the call to transfer to if a caller presses the cancellation key (usually the * key) at this node. The default destination is the parent node.
- **Default cancel key** Select the key the caller must press to cancel any operation within the caller application.

  Typically, the star (*) key is used for this purpose, but you can, if you wish, change it to something else.

- **Languages in caller application** (Display only) This display lists all the languages used in the caller application.

- **Design for VMD** (Optional) Select this if you want to specify the voice mail domain where the caller application will be deployed. When selected, voice mail domain-specific values, such as the mailbox length, will be applied to the caller application. This information is not a prerequisite for building a caller application but is useful if you are editing caller applications offline and cannot easily access voice mail domain information.

8. Click **OK** or **Apply**.
Adding application (action) nodes to a caller application

An application, or action, node is always a child node of a caller application or another application node. Application nodes allow callers to interact with the system in a more complex fashion than a simple menu.

Application nodes can be used to accomplish a variety of actions. They can:

- Present a menu of options to the caller ("For Sales, press 1, for Technical Support, press 2, etc.")
- Transfer the caller automatically to an extension or mailbox within the system.
- Go to another location, such as another node or caller application, within the system.
- Route calls according to the time of day at which the call is received.
- Allow callers to send a message without having to listen to the dialed party's greetings.
- Terminate the call.

A caller application may have thousands of application action nodes. However, for reasons of usability, we recommend that you limit a caller application to three or four menu levels.

There are two basic steps to create a caller action node:

- Adding the application action node
- Configuring application (action) node properties

Adding the application action node

To add an application action node to a caller application:

1. In the Tree pane, click the node to which you want to attach the new application node (and under which it will appear in the tree).
   
   You can attach an action node either to a caller application node or to another application (action) node.

2. Click Action > New > Application node, or click the New (new) icon.
The system displays the Add Node dialog box.

**Note:** This procedure assumes you have configured the system to automatically display dialog boxes when adding application nodes (see Configuring preferences and general caller application properties on page 11-16). If not, the system creates the node without allowing you to configure any properties at this point. If this is the case, the system displays the node’s icon in the Tree pane as not viable ( ). To configure properties for the node in this case, see Configuring application (action) node properties.

3. In the Add Node dialog box, complete the following fields:

- **Name** Enter a name for the node. The Caller Application Editor uses this name to identify the node in various node and application displays.

- **Action type** Select from this menu the type of action you want to assign to the node. Menu is the default action type. The choice you make here determines other options available on the General tab of the node’s Properties dialog box. For more information, see Assigning actions on page 11-26.

- **Key press** Displays the touchtone key (also known as the access key) that callers must press to activate the action assigned to this action node.

  **Note:** You can change the access key at any time. For more information, see Changing the access key assigned to an application node on page 11-25.

- **Description** (Optional, but recommended) Enter a short description of the caller application. This description provides the text that the system displays with the application properties and can be very useful, especially when designing large applications.

4. Click OK.

The system displays the new application node ( ) under the selected caller application or application action node.

**Configuring application (action) node properties**

**To configure application (action) node properties:**

1. Right-click the action node and select Properties from the pop-up menu.

2. In the [Application Node] Properties dialog box, click the General tab.
3. On the **General** tab, complete the following fields:

- **Name** Enter the name of the caller application. The Caller Application Editor uses this name to identify the node in various node and application displays.

- **Description** (Optional, but recommended) Enter a short description of the caller application. This description provides the text that the system displays with the application properties and can be very useful, especially when designing large applications.

- **Action type** Select from this menu the type of action you want to assign to the caller application node. **Menu** is the default action type. The choice you make here determines other options available on this tab. For more information, see **Assigning actions** on page 11-26.

  **Note:** If you have assigned an invalid action to the application node, the application node icon indicates that the action is invalid ( ). You cannot save a caller application that contains invalid application nodes.

- **[Action] options** The content of and options for this field are determined by the choice you make in the **Action type** menu. For more information, see **Assigning actions** on page 11-26.

- **Cancel destination node** Select a node for the call to transfer to if a caller presses the cancellation key (usually the * key) at this node. The default destination is the parent node.

4. Click the **Prompts** tab.

5. On the **Prompts** tab:

- If you do not want to use a prompt with this node, then verify that the **Play entry prompt** check box is cleared and skip ahead to the next step.

- If you want to use a prompt with this node, then select the **Play entry prompt** check box and complete the remaining fields (which become active when you select this option).

  For more information about these and the remaining prompt options, see **Administering prompts** on page 11-35.
Changing the access key assigned to an application node

You can change the access key assigned to an application (action) node. The access key is the touchtone key that callers must press to access the application node.

To change an access key in Caller Application Editor:

1. Click the application node for which you want to change the access key.
2. Click **Action > Change access key**.
   
   The system displays the **Change Key** dialog box.
3. Select one of the following:
   
   - **Change access to this key to use**  Changes the selected access key for a different access key. You can only select a key that has not already been used at this level.
   
   - **Swap access key with key**  Swaps the selected access key with another node’s access key. You can only select a key that has already been used at this level.
4. Click **OK**.
Assigning actions

When you create a caller application or application (action) node, by default the system assigns it a Menu action type. If required, you can assign a different action type. For example, you can assign an action that transfers the caller to an operator or assign an action that terminates the call.

You assign actions to a node using the General tab of the [Caller Application] Properties or [Application Node] Properties dialog box.

For descriptions of the action types and their corresponding options, select from among the following:

- Menu actions
- Transfer actions
- Goto actions
- Conditional goto actions
- Send message actions
- Termination actions
Menu actions

All Menu action types present the caller with a menu. A menu usually plays a prompt and then provides the caller with a series of numbered choices. For example:


When you select Menu from the Action type list, the General tab display automatically updates itself to present the following options:

- **Menu options**

  - **Menu only**  This option presents callers with a list of single-digit keypress choices. The system considers only keys that are defined for the node as valid. The system plays an “invalid response” prompt to all other key presses.

    For example, suppose you have a menu with five choices on it, numbered from 1 through 5. You also want to use the 0 key for the operator, the # key to repeat the menu prompt, and the * key to cancel out. This means that, if the caller were to press any key 6 through 9, the system would respond that it is an invalid response and prompt the caller to try again.

  - **Menu with extension**  Like the Menu only option, this option presents callers with a list of single-digit keypress choices. However, if the caller presses any key other than the keys defined for the node, the system attempts to locate it as an extension in the system and transfer the caller to that extension. Only if the system cannot find an extension with that number does it respond that the key press is an invalid response.

    So, to continue and expand on the previous example, suppose that all the extensions in your system consisted of five digits, always beginning with 7. If this option is selected, then, in addition to the system responses described above, if the caller enters a five-digit number beginning with 7, the system will try to locate that number as an extension on the system. If it finds the extension, it automatically transfers the caller to that extension. If it does not find the extension on the system, then it plays the “invalid response” prompt. In addition, the digits 6, 8, and 9 would also receive the “invalid response” prompt.

**Note:** When this option is selected, the # key is automatically reserved for use by the Dial by Name feature. This means that callers can enter extensions, and they can also press # to access the Dial by Name feature. If you want to encourage your callers, therefore, to use the Dial by Name feature, we recommend that you include it in the prompt for the node.
— **Menu with mailbox**  This option is very similar to the **Menu with extension** option, except that, instead of transferring the caller to an extension, this option looks for and transfers the caller to the appropriate mailbox.

**Note:** When this option is selected, the # key is automatically reserved for use by the Dial by Name feature. This means that callers can enter extensions, and they can also press # to access the Dial by Name feature. If you want to encourage your callers, therefore, to use the Dial by Name feature, we recommend that you include it in the prompt for the node.

— **Menu with caller application**  This option is also very similar to the **Menu with extension** option. The difference in this case is that, instead of transferring the caller to an extension or a mailbox, the system looks for a caller application with an association ID that matches the five-digit number. If it finds such a caller application, it transfers the caller to that caller application. If not, it responds with the “invalid response” prompt.

- **Cancel destination node**  This drop-down list allows you to select the node to which the caller application will go if the caller cancels the operation at this node. The default is the parent node, and in most cases, this is the recommended option.
Transfer actions

When a caller presses the associated key, the **Transfer** action transfers the caller to either the operator, a mailbox, or an extension number.

When you select **Transfer** from the **Action type** list, the **General** tab display automatically updates itself to present the following options:

- **Operator**  This option transfers the caller to the operator.
  
  The operator can be either the default system operator or a personal (custom) operator. Caller application properties determine which operator is used here (see [Configuring the caller application properties](#) on page 11-19).

- **Mailbox**  This option transfers the caller to a specified mailbox number. You must enter the mailbox number in the adjacent field.

- **Extension**  This option transfers the caller to a specified extension number. You must enter the extension number in the adjacent field.
Goto actions

**Goto** actions route the caller directly to another application (action) node or caller application. This can be especially useful when you have a common action that you want to reuse in your system.

For example, you may want to give the caller the option at any point to transfer to the operator for assistance. But before transferring the call, you want to play the prompt: “Please wait while your call is transferred to the operator.” You can create this either as a node at the top level of your caller application, or even as a separate caller application. To redirect the caller to the operator, then, all you need to do is use a **Goto** action node anywhere you want that to be an option for the caller.

For an example of this use of the **Goto** action, see Appendix B, Examples of Caller Applications.

When you select **Goto** from the **Action type** list, the **General** tab display automatically updates itself to present the following options:

- **Node**  This option routes the caller to another application node in the same caller application. You must select the application node from the drop-down list.

- **Caller application**  This option routes the caller to another caller application. Select the caller application from the drop-down list of caller applications already deployed in the voice mail domain.

**Note:** You can use the **Goto** action to direct the call only to caller applications that have been deployed on the system. Caller applications that have not been deployed do not appear on the drop-down list.
Conditional goto actions

**Conditional goto** actions route calls according to a schedule. For example, you may want calls that come into the system during business hours to be directed to a live receptionist. After business hours, however, you want calls directed to a special mailbox. You can use the **Conditional goto** action to accomplish this.

When you select **Conditional goto** from the **Action type** list, the **General** tab display automatically updates itself to present the following options:

**Notes:**

- The Conditional goto action cannot be used as the entry (top) level node in an application, because to use it, you must have nodes to which you can direct it, and you cannot attach sub-nodes to this action type.

- Each of the following nodes must be within the currently active caller application. This means that you must dedicate two nodes for this purpose, or create one node with two sub-nodes that you can use.

- **During hours node**  Select the application node to which you want to route callers when the associated schedule is active.

- **After hours node**  Select the application node to which you want to route callers when the associated schedule is not active.

- **Weekly schedule**  Click this to display the schedule grid.

Use the schedule grid to set the blocks of time when the schedule is active. For more information, see **Tips for using the schedule grid** on page 11-32.
Tips for using the schedule grid

The schedule grid has the weekdays along the y-axis and the time of day along the x-axis. Cells on the grid represent a time interval, either 1 hour, 15 minutes, or 5 minutes, depending on the current selection.

A cell can have one of two states, on (blue) or off (white). Clicking a cell toggles its state.

- To toggle the state of the first cell in the row and set all of the other cells in the row to the same state, click inside a row header.

- To toggle the state of the first cell in the column and set all of the other cells in the column to the same state, click inside a column header.

- To change the other cells to the same state as the first, click and hold inside a cell and drag the mouse cursor over other cells.

- To change all cells to the same state as the top left cell, click inside the top left cell.

- To show cells enabled for the full hour or as partially selected, use the 5 minutes, 15 Minutes, or 1 Hour icons.

Figure 11-2. Conditional goto Schedule Grid

1 Select all cells in the grid
2 Column headers
3 Row headers
Send message actions

The Send message action type allows callers to send a message to a subscriber without having to listen to the subscriber’s greeting.

When you select Send message from the Action type list, the General tab display automatically updates itself to present the following options:

- **Mailbox** Enter the mailbox number to which the recorded message is to be sent. The mailbox must be in the voice mail domain in which the caller application is deployed.

- **Provided by runtime** Select this option to have the system automatically enter the mailbox number provided by the caller application's association or by the mailbox to which the caller application has been bound using the Subscriber Administration tool. If this option is selected, the Mailbox field is disabled.

- **Next node** This drop-down list allows you to select the node to which the caller will be routed after recording and sending the message.

- **Cancel destination node** This drop-down list allows you to select the node to which the caller application will go if the caller cancels the operation at this node. The default is the parent node, and in most cases, this is the recommended option.
Termination actions

The **Termination** action is used to terminate the current caller application and either disconnect the caller from the system or re-route the caller back to the system Automated Attendant.

When you select **Termination** from the **Action type** list, the **General** tab display automatically updates itself to present the following options:

- **Disconnect**  Disconnects the caller from the system.
- **Automated attendant**  Routes the caller to the system Automated Attendant.
- **Logon to mailbox**  Routes the caller to the Automated Attendant, which then behaves as if the caller has pressed # to log in to the mailbox.
Administering prompts

You can configure each node in a caller application, whether a caller application node or an application (action) node, to either use a prompt or not use a prompt. If you use a prompt, you may use only one prompt per node. Any action to be taken by the node occurs after the prompt has played. Therefore, careful planning of prompts is required when designing caller applications.

The administration of prompts in a caller application is done from the Prompt tab of the applicable Properties dialog box.

To get to the Prompt tab of the Properties dialog box:

1. Click the node for which you want to administer a prompt.
2. Click Action > Properties.
   The system displays the Properties dialog box for the node.
3. Click the Prompt tab.

Configuring prompt properties

The process of configuring prompts consists largely of making a series of decisions about whether and how to use prompts.

To prompt or not to prompt?

The first option on the Prompt tab is whether to assign a prompt to the node or not:

- If you do not want to use a prompt with the node, clear the Play entry prompt check box. Performing this action de-activates all other options on this tab.
- If you want to use a prompt with the node, select the Play entry prompt check box. Performing this action activates the other options on this tab.

Application prompt or Announcement?

If you decide to assign a prompt to the node, the next decision is whether to make the prompt an Application prompt or an Announcement:

- Application prompts are embedded in the caller application and can only be changed by changing the application itself. For this reason, it is not a good idea to use application prompts for prompts that you know will need to be changed on a regular or frequent basis.

  If you want to create the prompt as an application prompt, you must create a prompt entry for it. See Creating prompt entries on page 11-36.

- Announcements are recorded from within a mailbox, and although they are called by the caller application, they are not embedded within it. These are somewhat harder to set up, but if you know you will need to change a
recording on a regular basis (such as a daily announcement or bulletin board type of arrangement), then this is likely the better choice.

Mailboxes can be set up to allow authorized individuals to record announcements using the TUI, and the system stores them in these mailboxes. You must set up this authorization in Subscriber Options.

You can use Caller Applications Editor to display a list of announcements available for use by an application, but you cannot edit the content of these prompts. For information about viewing the list of announcements, see Displaying a list of announcements on page 11-38.

Record your own or import professionally recorded prompts?

This choice applies almost exclusively to application prompts. You can, if you want, record your own prompts, using either a telephone or a multimedia PC to record them directly within the Prompt tab. For the procedures to do this, see Recording application prompts on page 11-37.

However, recording your own prompts can be hazardous. Microphones and telephones do not do a good job of filtering out unwanted background noise, or of producing high quality recordings. The internal recording device also does not allow you to edit your finished recording, for instance, to trim out unwanted silences at the beginnings or ends of your recordings.

Therefore, if quality is an issue for you, you may prefer to have your prompts professionally recorded, or at least record them using a digital audio recording software package. You can then import them into your caller application. For the procedures to do this, see Importing prompts on page 11-39.

Creating prompt entries

If you know you are planning to use a prompt for a given node, but you are not yet ready to record the prompt, you can create a prompt entry in the Prompt tab. Then later you can come back and record the prompt or import a prompt (*.wav) file. This can be a good way to keep track of the prompt recordings you will need for your caller application.

To create a prompt entry:

1. On the Prompt tab of any Properties dialog box, select the Play entry prompt check box.

   This activates all the other options on the Prompt tab.

2. Select Application prompt.

3. Click the New ( ) icon.

   The system creates a list entry for the prompt and automatically assigns it an ID number.
4. Under **Comments**, enter a brief name or description for the prompt.

   This is especially important if you are not recording the prompt right away, as this will help you remember later what the prompt is to be.

**Recording application prompts**

You can record application prompts using either a telephone or a properly equipped multimedia PC. If you choose to use a PC, it must be equipped with a microphone and a set of speakers (or headphones).

You can set up the default audio recording device (telephone or multimedia PC) when you set up your general Caller Application Editor preferences (see Configuring preferences and general caller application properties on page 11-16).

**To record application prompts:**

1. On the **Prompt** tab of any **Properties** dialog box, select the **Play entry prompt** check box.

   This activates all the other options on the **Prompt** tab.

2. Select **Application prompt**.

3. Do one of the following:

   - To record a prompt that has already been created but not recorded, click to highlight the prompt entry in the prompt list. Then skip to Step 5.
   - To add a new prompt, click the **Add** icon.

   The system creates a list entry for the prompt and automatically assigns it an ID number.

4. Under **Comments**, enter a brief name or description for the prompt.

   **Note:** To change the audio device for recording the prompt “on the fly,” right-click the telephone or multimedia icon, and click **1 Multimedia** or **2 Telephone**.

5. Click the **Record** icon.

   If you are using a multimedia PC with a microphone, you may begin recording immediately.

   If you are using a telephone to record the prompt, you must wait for the system to dial the telephone and the telephone to ring. When it does, pick up the handset and proceed to the next step.
6. Record the prompt.

**Note:** Be aware that the built-in recording device does not allow you to edit your recordings after you make them, for instance, to trim out any unwanted silence at the beginning or end of the recording. This is another reason you may want to have your prompts professionally recorded, or at least to record your prompts using a digital audio recording software package, and then import the finished recordings into your caller application. For more information on importing prompts, see [Importing prompts](#) on page 11-39.

7. Click **OK** or **Apply**.

### Displaying a list of announcements

Although you cannot record or edit announcements in the Prompt tab, you can view a list of announcements that are available. You can then use this list to select the announcements you want to use in your caller applications.

**To display a list of announcements:**

1. On the **Prompt** tab of any **Properties** dialog box, select the **Play entry prompt** check box.

   This activates all the other options on the **Prompt** tab.

2. Click **Announcement**.

3. Enter a value for the mailbox number or set it to `<default>`.

   If the mailbox number is set to `<default>`, the system does not allocate the mailbox number until the caller application runs. The mailbox number is supplied by an association.

4. Click the **Add** icon.

   The system displays an area for entering comments on the **Announcement** screen.

5. Under **Comments**, enter a comment, if desired.

6. Click **OK**.

   If there is no mailbox allocated to this application, the system displays the **Add a Mailbox Prompt** dialog box.
Importing prompts

The Caller Applications Editor makes it easy to import prompt recordings. This is useful when you have recorded your own prompts using a digital audio recording software package or you have had the prompts recorded professionally.

Recordings that you want to import must be in the form of 8 kHz, 8 bit, mono, G.711 PCM μ-law (mu-law) encoded *.wav files. Therefore, if you are having your prompts recorded professionally, make sure that whoever is doing them for you can save them to these specifications.

To import a prompt into a caller application:

1. On the Prompt tab of any Properties dialog box, select the Play entry prompt check box.

   This activates all the other options on the Prompt tab.

2. Click Application prompt.

3. Open a second (Windows Explorer) window and verify that your recording files are located in a directory accessible from the machine where you are developing your caller application, by displaying them in that window.

4. Click a prompt entry in the Application prompts list for which you want to import the recording.

5. Drag and drop the desired *.wav file into the recording device area of the Prompt tab.

6. Click OK.
Assigning prompts to nodes

It is possible to create a node that requires a prompt but not create the prompt, or even an entry for it at the time you create the node. When this is the case, you will need to go back later and assign a prompt to the node (possibly after creating it).

To assign a prompt to a node:

1. Right-click the node and select Properties from the pop-up menu.
2. Click the Prompt tab.
3. Select the Play entry prompt check box, if it is not already selected.
4. Select Application prompt, if it is not already selected.
5. Do one of the following:
   - Enter the number of the prompt to assign to the node in the field next to the Application prompt radio button.
   - Scroll down the list of application prompts, if necessary, to find the prompt you want, and then click it.
6. Click OK.
Saving a caller application

To save a caller application in Caller Application Editor:

1. In the Tree pane, click the caller application that you want to save.
2. Click Action > Save Application.
3. Enter a name, and path if required, for the caller application.
4. Click OK.

The system saves the application as a *.uma file.

Opening a caller application

To open a caller application in Caller Application Editor:

1. In the Tree pane, click Modular Messaging Software Caller Apps.
2. Click Action > Open Application.
3. In the Open dialog box, click the caller application that you want to open.
   Caller applications end with the extension .uma. By default, caller applications are saved to the directory C:\Program Files\Avaya Modular Messaging\Vserver\CallerApps, where C:\ represents the root drive of the server.
4. Click OK.

The system displays the Open Caller Application dialog box.
5. From the drop-down language list, select the language in which you want to edit the application.
6. (Optional, only if other languages are available) Select a different language using the Add language check box and Edit content as language: drop-down list.
7. (Optional) If you do not want the Caller Applications Editor to prompt you for language selection in the future, clear the Always let me select the language I would like to edit check box.

Note: Clearing this check box resets the default language selection value for all applications. If you later decide you again want to be able to select languages when opening applications, you must select the Allow language selection when opening caller applications option in the Modular Messaging Software Caller Apps Properties dialog box (see Configuring preferences and general caller application properties on page 11-16).
Caller application deployment

To fully deploy a caller application, you must:

- Deploy (distribute) the caller application across the voice mail domain.

  To use a caller application, it must be present on every MAS in the voice mail domain. Deployment distributes the caller application to all the MASs in a voice mail domain.

  For the procedure, see Deploying caller applications across a voice mail domain on page 11-44.

- Create an association.

  Although not required in every case, in many cases you will need to create an association for the caller application, in order for callers to be able to access it.

  For more information, see Creating an association for the caller application on page 11-46.

In addition, you can perform the following tasks related to caller application deployment:

- Use deployed caller applications in several ways using multiple associations.

  For more information, see Using deployed caller applications with multiple associations on page 11-48.

- Delete associations.

  For more information, see Deleting associations on page 11-49.

- Test the deployed application and analyze it for possible bugs.

  For more information, see Analyzing caller applications on page 11-50.

- Remove a deployed caller application from the voice mail domain.

  For more information, see Removing deployed caller applications from a voice mail domain on page 11-53.

Note: This release of Avaya Modular Messaging does not support deployment of caller applications using Terminal Services. Caller applications can be deployed by running the Caller Applications Editor on an MAS and using it locally, or by running it remotely and using dial-up networking or virtual private networking to connect to the Windows domain containing the voice mail domain for deployment.
Re-deploy caller applications.

For more information, see *Re-deploying caller applications* on page 11-54.

Troubleshoot deployed caller applications.

For more information, see *Troubleshooting deployed caller applications* on page 11-55.

**Before you begin**

Before deploying (or removing) a caller application or creating an application association, verify that:

- The person using Caller Applications Editor is logged in to the domain as a System Administrator.
  
  The System Administrator list is configured in Voice Mail System Configuration. For more information, see *Configuring voice mail domain security* on page 5-25.

- The Caller Applications software is installed on every MAS in the voice mail domain.

- Caller applications are enabled on all the MASs in the voice mail domain.
  
  For a deployed caller application to run, the caller application feature must be enabled for the voice mail domain using Voice Mail System Configuration. For more information, see *Configuring TUI general properties* on page 3-4.

- No other instances of Caller Applications Editor are deploying applications at the same time.
Deploying caller applications across a voice mail domain

Before callers can use a caller application, it must be present on every MAS in the voice mail domain. Deployment distributes the caller application to all the MASs in a voice mail domain.

If one or more MASs in the domain are not running during deployment, the caller application is transferred to the MASs that are running. In this case, according to the Caller Application Deployment Wizard, the deployment will fail. Although deployment fails, a subsequent attempt to deploy the same caller application skips the transfers already completed and transfers the caller application only to the remaining MASs.

Once a caller application has been deployed, a repeat deployment may appear to be successful, but no data is transferred since the MASs already have this version of the caller application.

Note: This release of Avaya Modular Messaging does not support deployment of caller applications using Terminal Services. You can deploy caller applications by running the Caller Applications Editor on an MAS and deploying your applications from there. Alternately, you can deploy applications by running the Caller Applications Editor remotely and deploy them using a dial-up network or virtual private network to connect to the Windows domain containing the voice mail domain on which you want to deploy the application.

When a new MAS is installed into a voice mail domain where caller applications are already deployed, or it moves from one domain to another, the system automatically transfers the caller applications deployed in the voice mail domain to the new MAS.

To deploy caller applications to a voice mail domain:

1. In the Tree pane of the Caller Applications Editor, click the caller application you want to deploy.

2. Click Action > All Tasks > Deploy caller application. The system displays the Caller Application Welcome Wizard.

3. Click Next. The system displays the Deployment Details window.

4. If necessary, use the drop-down list to select the voice mail domain where the caller application is to be deployed.

5. Click Next. While the caller application is being deployed, the system displays the Deployment in Progress window (though on fast systems, you may never really see it). This window displays the progress of the deployment as it transfers the application to each MAS in turn.
When the deployment process is done, the system displays the Completed the Caller Application Deployment Wizard window.

6. Click Finish.
Creating an association for the caller application

Although not required in every case, in many cases you will need to create an association for the caller application, in order for callers to be able to access it.

About associations

Associations are the links between a deployed caller application and the information from the TUI used to access the caller application. Associations enable the system to launch a caller application if one or both of the following launch conditions are met:

- A caller enters an identifying number (ID number) when prompted by the Automated Attendant or another caller application. The ID number appears to the caller as a mailbox number.
- A caller dials a specified direct-dial number or extension number (the called number).

When you create an association, you must configure at least one of these launch conditions. If you configure both, meeting either condition will launch the caller application.

Any given association can launch only one specified caller application. To help identify the association, you assign a name to the association.

In this section, you will find information and procedures for the following:

- Create associations (see Creating associations on page 11-46).
- Assign ID numbers for each association (see Using ID numbers for associations on page 11-48).
- Re-use deployed caller applications for different situations (see Using deployed caller applications with multiple associations on page 11-48).
- Delete associations (see Deleting associations on page 11-49).

Creating associations

To create associations, you must use the Caller Applications Editor.

To create an association:

1. In the Tree pane, expand the Deployed applications node and appropriate voice mail domain node, until you can see the Associations “node.”
2. Click Associations.

The system displays a list of existing associations for the voice mail domain in the right pane.
3. Click **Action > New > Association**.

   The system displays the **Add Association** dialog box.

4. Complete the following fields, as appropriate:

   - **Association name** Enter a name for the association.
   - **Caller application** Select the name of the caller application that will be launched when the conditions of the association are met.
   - **Association ID** Enter the sequence of digits that callers are prompted to enter (as a mailbox number) in the automated attendant or caller application. This is the number used to launch the caller application. If you do not configure this ID number, you must specify a **Called number**.

   **Note:** An ID number cannot be longer than the mailbox length specified in the voice mail domain. However, if the ID number has fewer digits than a mailbox number, the caller must enter [#] at the end of the association number to replace the missing digits or wait for a time-out period. For more information, see **Using ID numbers for associations** on page 11-48.

5. Click **OK**.
Using ID numbers for associations

The numbers used to identify caller application associations (ID numbers) can be any length, from one digit up to the maximum number of digits used for mailbox numbers in the voice mail domain. This means that it is possible for you to create an association ID number that is identical to two other types of numbers in the voice mail domain:

- A valid mailbox number
- A single-digit Automated Attendant menu option

Therefore, care must be taken when assigning association ID numbers to a caller application. Consider the following:

Identical association ID and mailbox numbers

If an association ID number is identical to a valid mailbox number, when a caller enters that number, the association ID number is used and the associated caller application runs. This can be useful if you want to prevent caller access to a mailbox.

Automated Attendant menu options

If you set up a single-digit association ID number that requires the same key press as an Automated Attendant menu option, the Automated Attendant menu option will always be used. This is because the association ID number is only recognized if it is followed by a time-out or terminated with a [#]. For this reason, we recommend that you do not use a single-digit number as the association ID number.

Using deployed caller applications with multiple associations

You can re-use a deployed caller application by specifying multiple associations, with different ID numbers, for the same caller application. This means that the deployed caller application is the same, but different mailbox numbers or Automated Attendant menu choices can be used to access it. For example, this might be useful, for example, if you wanted to launch multiple bulletin board type applications using different mailbox numbers.

For an example of this use of multiple associations, see the bulletin board example in Appendix B, Examples of Caller Applications.

Note: In this scenario, though callers cannot leave messages, subscriber access to the mailbox is not affected.
Deleting associations

If you find you no longer want to use a particular association with a deployed caller application, you can delete the association without removing the caller application from the voice mail domain. This can allow you to create and use new associations without having to re-deploy the caller application.

To delete an association:

1. In the Tree pane, expand the Deployed applications node and appropriate voice mail domain node, until you can see the Associations node ( ).

2. Click Associations.

   The system displays a list of existing associations for the voice mail domain in the right pane.

3. In the right pane, select the association you want to delete.

4. Click Action > Delete.

   The system displays the Delete Association confirmation dialog box.

5. Click Yes.
Analyzing caller applications

After deploying a caller application across the voice mail domain, Avaya strongly recommends that you analyze the application using the Application analysis tool provided within the Caller Applications Editor. This tool allows you to test and debug your caller applications, which makes it easier for you to find any problems with the application before your callers do.

To analyze caller applications:

1. In the Tree pane, expand the Deployed applications node and appropriate voice mail domain node, until you can see the Application analysis node ( ).

   Note: You may need to refresh the voice mail domain node under Deployed Applications to be able to view and use the Application analysis tool. In any case, the Application analysis tool is not available until you deploy one or more applications, and it acts only on deployed applications. So, before attempting to use this tool, verify that you have deployed all caller applications you want to include in the analysis.

2. Double click the Application analysis node.

   The Application analysis tool analyzes all deployed caller applications in the voice mail domain. Depending on the number of applications deployed, this can take some time to complete.

   When the analysis has finished, the system lists all the deployed caller applications in the voice mail domain in the right pane. If an icon is green ( ), it indicates that there were no detected problems with the caller application. If an icon is red ( ), it indicates a problem with the caller application.

3. To view the details of the analysis for a specific caller application, right-click the caller application in the right pane, and then click Properties.
4. Use the information in the **Results** tab to diagnose problems with the deployed caller application. The analysis information falls into five categories:

- **Application deployment**
  
  Identifies MASs in a voice mail domain that are running different versions of the same caller application.

- **Association references**
  
  Identifies associations to mailboxes that no longer exist within the voice mail domain.

- **Mailbox references**
  
  Identifies references to mailboxes that no longer exist within the voice mail domain.

- **References from application**
  
  Identifies non-existent caller applications to which the caller application is attempting to transfer.

- **References to application**
  
  Lists the associations and mailboxes that refer to the caller application ("Front Door" mailboxes). This is useful for identifying caller applications that are not in use.

---

**Note:** If a caller application is used only by “Front Door” mailboxes, mailboxes used by the caller application are not identified unless you include “Front Door” applications in the analysis.

---

**Application analysis and “Front door” applications**

By default, when analyzing caller applications, the Caller Applications Editor excludes subscriber mailboxes that refer to caller applications (known as “Front door” applications.) This is because the task of analyzing all subscriber mailboxes that refer to caller applications can take a considerable amount of time. If you want to include “Front door” applications in the analysis, you can change the analysis setting before running the **Application analysis** tool.

**To include “Front door” applications in the analysis:**

1. In the **Tree** pane, right-click the **Application analysis** node.

2. Click **Properties**.

3. Select the **Include “Front Door” application analysis** check box.
4. Click **OK**.
Removing deployed caller applications from a voice mail domain

If you find you no longer need or use a deployed caller application, or you want to replace it with a different one, you can remove the caller application from the voice mail domain using the Caller Applications Editor.

Any callers using the caller application at the time of undeployment continue to interact with it for as long as they remain connected to the caller application.

Removing a deployed application:

- Deletes copies of the file from all MASs in the voice mail domain.
- Removes the entry from the list of deployed applications in the Caller Applications Editor.

To remove a deployed caller application from a voice mail domain:

1. In the Tree pane, expand the Deployed applications node until you can see the voice mail domain in which the caller application is deployed.

2. Click the voice mail domain icon ( ).

   In the right pane, the system displays a list of the caller applications deployed in the voice mail domain. Deployed caller applications are identified by the icon.

3. Right-click the caller application you want to remove, and select Delete from the pop-up menu.

   The system displays the Caller Application Undeployment confirmation box.

4. Click Yes.

   The system displays the Caller Application Undeployment Wizard window.

5. Click Next.

   The system displays a list of the associations that will be automatically removed. You can view information about an association by moving the mouse cursor over it.

6. Click Next.

   While the caller application is being deployed, the system displays the Undeployment in Progress window (though on fast systems, you may never really see it). This window displays the progress of the undeployment as it removes the application from each MAS in turn.

   When the undeployment process is done, the system displays the Completed the Caller Application Undeployment Wizard window.
7. Click Finish.

**Note:** When you have bound a caller application to a subscriber mailbox using the Subscriber Administration tool, if you remove the caller application and then re-deploy it, the caller application will remain bound to the mailbox.

---

**Re-deploying caller applications**

If you have made changes to a caller application, it can be deployed again. When re-deployment succeeds, new callers have access to the updated version of the caller application immediately. Any callers using the existing version of the caller application at the time it is re-deployed continue to interact with the old version as long as they remain connected to the caller application. Temporarily, therefore, more than one version of the caller application can be stored and running on an MAS.

Each caller application contains an embedded identifier and a revision number. The revision number is incremented each time that the caller application is saved.

Even if a caller application’s *.uma file is renamed or copied by Windows Explorer, the application’s embedded identifier does not change and the MAS treats it as the same application.

An MAS that is contacted by the Caller Applications Editor and asked to deploy an application checks to see if it already has a copy of the application deployed. If the MAS already has an application with the same embedded identifier and the same or a higher version number, it does not accept the re-deployment, regardless of the file name on the application.

If, however, you use the **Save as** option from Caller Applications Editor to rename an application, the new version of the *.uma file has a new embedded identifier and revision number, so the application is treated as a different application, and you can successfully deploy it.
Troubleshooting deployed caller applications

You can use the Application analysis tool to help diagnose problems with caller applications that do not work as expected or discover problems before callers experience them. For example, you can identify mailbox associations to mailboxes that no longer exist in the voice mail domain and identify MASs in a voice mail domain that are running different versions of the same caller application.

For more information about how to use this tool, see Analyzing caller applications on page 11-50.
This chapter describes how to use the Reporting Tool to help you monitor the voice mail system usage.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to reports</td>
<td>12-2</td>
</tr>
<tr>
<td>Enabling transaction generation</td>
<td>12-4</td>
</tr>
<tr>
<td>Selecting a data source</td>
<td>12-5</td>
</tr>
<tr>
<td>Specifying options for report generation</td>
<td>12-8</td>
</tr>
<tr>
<td>Generating an Hourly Statistics report</td>
<td>12-9</td>
</tr>
<tr>
<td>Generating a Login Failures report</td>
<td>12-12</td>
</tr>
<tr>
<td>Generating a Port Statistics report</td>
<td>12-15</td>
</tr>
<tr>
<td>Generating a System Usage report</td>
<td>12-18</td>
</tr>
<tr>
<td>Generating a User Mailbox Statistics report</td>
<td>12-23</td>
</tr>
<tr>
<td>Generating a Basic Metrics report</td>
<td>12-27</td>
</tr>
<tr>
<td>Zooming in on reports</td>
<td>12-30</td>
</tr>
<tr>
<td>Exporting reports</td>
<td>12-31</td>
</tr>
<tr>
<td>Printing reports</td>
<td>12-34</td>
</tr>
</tbody>
</table>
Introduction to reports

You can use the Reporting Tool to generate reports for monitoring voice mail system usage, planning capacity, and tracking system security. Report information is taken from the transaction database and generated for the voice mail domain. Some reports can also generate voice-server-specific or user-specific information.

Once you have generated a report, you can zoom it on the screen or print it for easy reference. You can also export a report to different file formats or attach it to a message sent using a MAPI enabled e-mail system.

For the procedure to run the Reporting Tool, see Running the Reporting Tool on page 12-3.

You can generate the following reports:

- **Hourly Statistics**

  This report records information about the number of incoming and outgoing calls for each hour in a specified time period.

  For more information, see Generating an Hourly Statistics report on page 12-9.

- **Login Failures**

  This report records information about unsuccessful mailbox logins due to an incorrect password or invalid mailbox number being entered.

  For more information, see Generating a Login Failures report on page 12-12.

- **Port Statistics**

  This report records incoming and outgoing call information for each port configured in the voice mail domain.

  For more information, see Generating a Port Statistics report on page 12-15.

- **System Usage**

  This report records call and messaging statistics for the voice mail domain.

  For more information, see Generating a System Usage report on page 12-18.

- **User Mailbox Statistics**

  This report records information about telephone calls and messages received by each subscriber in the voice mail domain.
For more information, see Generating a User Mailbox Statistics report on page 12-23.

**Basic Metrics**

This report records statistics on messaging activity in the voice mail domain.

For more information, see Generating a Basic Metrics report on page 12-27.

**Before you begin**

Before you generate reports, you should ensure that:

- Transaction generation is enabled for the time period you want to report on (transaction generation is disabled by default). For more information, see Enabling transaction generation on page 12-4.

- Reporting Tool data source (TrxDB) references the transaction database on the tracing system machine. For more information, see Selecting a data source on page 12-5.

- The machine on which Reporting Tool is running has a configured printer.

**Running the Reporting Tool**

To run the Reporting Tool, click **Start > Programs > Avaya Modular Messaging > Reporting Tool.**
Enabling transaction generation

The system extracts report information from the transaction database. This means that transaction generation must be enabled for the voice mail domain and for the time period on which you want to report. By default, transaction generation is disabled.

The transaction database is part of the tracing system. For more information about the tracing system, see Chapter 5, “Voice Mail Domain Administration”.

To enable transaction generation:

1. Start Voice Mail System Configuration.
2. Click the voice mail domain.
3. Double-click Tracing System.
4. Click the Transaction Generation tab.
5. Click Enable Transaction Generation.
6. Click OK.

By default, transactions are generated at midnight.

For more information about configuring transaction generation for a voice mail domain, see Chapter 5, “Voice Mail Domain Administration”.

Selecting a data source

If Reporting Tool and the tracing system are not installed on the same machine, you must select a system data source that references the transaction database on the tracing system machine.

To select a data source:

1. In the Reporting Tool window, click File > Data Source from the Reporting Tool.
   
   The system displays the standard Windows ODBC Data Source Administrator dialog box.

2. Click the System DSN tab.

3. In Data Source Name, click TrxDB.

4. Click Add.
   
   The system displays the Create New Data Source dialog box.

5. Click Microsoft Access Driver.

6. Click Finish.
   
   The system displays the ODBC Microsoft Access Setup dialog box.

7. On the MAS that is running the Tracing Server software, share out the directory in which the Reporting Tool Transaction database resides:

   Note: If you have already shared out this directory, (for example, for the Operation History database), then you may skip all of Step 7.

   a. In Windows Explorer, locate the directory in which the Transaction database (named trxdb.mdb) resides. By default the path to this directory is: C:\Program Files\Avaya Modular Messaging\Tracing\n
   b. Right-click the Tracing directory and, from the pop-up menu, select Sharing...

      The system displays the Tracing Properties dialog box.

   c. On the Sharing tab, select the Share this folder option.

   d. Click Permissions.

      The system displays the Permissions for Tracing dialog box.
e. Select **Everyone** and make sure that at least **Read** permissions is set.

**Note:** The other settings may be set at your discretion.

f. In the **Permissions for Tracing** dialog box, click **OK**.

g. In the **Tracing Properties** dialog box, click **OK**.

h. Right-click the **Tracing** directory and, from the pop-up menu, select **Properties**.

i. Select the **Security** tab.

j. Verify that any users who will be using the Reporting Tool have the following permissions set:

- **Read & Execute**
- **List Folder Contents**
- **Read**

k. Click **OK**.

l. Right-click the **trxdb.mdb** file and, from the pop-up menu, select **Properties**.

m. Verify that any users who will be using the Reporting Tool have the following permissions set:

- **Read & Execute**
- **List Folder Contents**
- **Read**

n. Click **OK**.

8. In the Reporting Tool window (back on the MAS running the Reporting Tool software), click **Select**.

   The system displays the standard **Select Database** dialog box.

9. Map a drive to the Transaction (trxdb.mdb) database:

   a. Click **Network...**

   b. In the **Drive:** field, select a drive letter that has not already been used on this MAS.

   c. Enter the path to the Transaction (trxdb.mdb) database by doing one of the following:
In the Folder: field, type the pathname using the format

\servername\Tracing

where servername is the domain name of the MAS on which the Tracing Server software is running.

Use the Browse... button to locate the Tracing directory on the MAS on which the Tracing Server software is running.

d. Click Finish.

10. In the Select Database dialog box, set the Drives field to the drive you mapped in the previous step.

The system displays in the Dababase Name field a list of one or more databases on the mapped drive. The Transaction (trxdb.mdb) database should be among them.

11. Select trxdb.mdb.

12. Click OK.

13. In the ODBC Microsoft Access Setup dialog box, click OK.

14. In the ODBC Data Source Administrator dialog box, click OK.
Specifying options for report generation

You can specify whether you want a generated report to be displayed on the screen, sent to a printer, or both.

This section also describes how to cancel report generation, should this be necessary.

To specify options for report generation:

1. Click File > Options.

   The system displays the Options dialog box.

2. Do one of the following:

   - If you want to display the generated report on screen, click Displayed on screen.

   - If you want to send the generated report to a printer, click Printed. The system displays the standard Windows Print dialog box each time a report starts to generate, allowing you to select the print settings.

3. To save the option settings, click OK.

To cancel report generation:

   Click Cancel in the dialog box that the system displays while a report is being generated.
Generating an Hourly Statistics report

The Hourly Statistics report records information about the number of incoming and outgoing calls for each hour in a specified time period. This information is useful for monitoring incoming and outgoing call patterns for the voice mail domain.

For a description of the contents of this report, see Hourly Statistics report contents on page 12-10.

To generate an Hourly Statistics report:

1. Click Reports > Hourly Statistics.

   The system displays the Hourly Statistics dialog box.

2. In the From, Date field, enter the first date for which report information is to be generated.

   This field defaults to the To, Date value of the previous report run. Use the pull-down calendar for easy selection.

3. In the From, Time field, enter the first hourly time for which report information is to be generated.

   This field defaults to the To, Time value of the previous report run.

4. In the To, Date field, enter the last date for which report information is to be generated. For easy selection, use the drop-down calendar list.

5. In the To, Time field, enter the last hourly time for which report information is to be generated.

6. To generate the report, click OK.

Note: Generating another report closes the currently displayed report. If you want to save the report, see Zooming in on reports on page 12-30.
Hourly Statistics report contents


The Hourly Statistics report provides the following information:

- **Date** Displays the date for which report information is generated.

- **Time Periods Starting** Displays the hourly time periods for which report information is generated.

- **Incoming Calls** Displays the number of incoming calls for each hourly time period.

- **Failed Outgoing Calls** Displays the number of failed outgoing calls for each hourly time period. For intercom paging, this refers to a busy or ring-no-answer extension. For calls placed on behalf of a client, this refers to a busy or ring-no-answer extension.

  **Note:** This count does not include calls placed on behalf of a client for the following:

  - Playing messages
  - Recording greetings
  - Recording names
  - Outcalling when the call goes to the called extension’s mailbox coverage

- **Outgoing Calls** Displays the number of outgoing calls for each hourly time period.
Sample Hourly Statistics Report

The following is an example of an Hourly Statistics report:

<table>
<thead>
<tr>
<th>Date</th>
<th>Time Periods Starting</th>
<th>Incoming Calls</th>
<th>Failed Outgoing Calls</th>
<th>Outgoing Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>20/01/2003</td>
<td>11:00</td>
<td>17</td>
<td>0</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>12:00</td>
<td>9</td>
<td>0</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>13:00</td>
<td>23</td>
<td>1</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>14:00</td>
<td>32</td>
<td>0</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>15:00</td>
<td>27</td>
<td>0</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>16:00</td>
<td>11</td>
<td>2</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>17:00</td>
<td>6</td>
<td>1</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>18:00</td>
<td>4</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>19:00</td>
<td>2</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>20:00</td>
<td>3</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>21:00</td>
<td>2</td>
<td>0</td>
<td>3</td>
</tr>
</tbody>
</table>
Generating a Login Failures report

The Login Failures report records information about unsuccessful mailbox logins due to an incorrect password or incorrect mailbox number being entered. You specify the time period for which you want to generate this information. Use this report to help monitor voice mail system security for the voice mail domain.

For a description of the contents of this report, see Login Failures report contents on page 12-13.

To generate a Login Failures report:

1. Click Reports > Login Failures.

   The system displays the Login Failures dialog box.

2. In the From, Date field, enter the first date for which report information is to be generated.

   This field defaults to the To, Date value of the previous report run. Use the pull-down calendar for easy selection.

3. In the From, Time field, enter the first time for which report information is to be generated.

   This field defaults to the To, Time value of the previous report run.

4. In the To, Date field, enter the last date for which report information is to be generated. For easy selection, use the drop-down calendar list.

5. In the To, Time field, enter the last time for which report information is to be generated.

6. To generate the report, click OK.

Note: Generating another report closes the currently displayed report. If you want to save the report, see Zooming in on reports on page 12-30.
Login Failures report contents

For an example of a Login Failures report, see Sample Login Failures report on page 12-14.

The Login Failures report provides the following information:

Individual Mailboxes

- **Mailbox Number**  The mailbox number for which an unsuccessful login is recorded.
- **Mailbox Name**  The mailbox name for which an unsuccessful login is recorded.
- **Last Failed Login**  The date and time of the last unsuccessful mailbox login due to an incorrect password being entered three consecutive times on the same call.
- **Total Failed Logins**  The total number of unsuccessful mailbox logins due to an incorrect password being entered three consecutive times on the same call.

System-Wide

- **Number of Invalid Mailbox Numbers Entered**  The total number of unsuccessful mailbox logins due to an invalid mailbox number being entered.
Sample Login Failures report

The following is an example of a Login Failures report:

<table>
<thead>
<tr>
<th>Mailbox Number</th>
<th>Mailbox Name</th>
<th>Last Failed Login</th>
<th>Total Failed Logins</th>
</tr>
</thead>
<tbody>
<tr>
<td>1234</td>
<td>Paul Ryder</td>
<td>2003-02-10 14:08:34</td>
<td>1</td>
</tr>
<tr>
<td>5678</td>
<td>Marshall Raber</td>
<td>2003-02-09 14:11:22</td>
<td>1</td>
</tr>
<tr>
<td>9012</td>
<td>Penny Lee</td>
<td>2003-02-09 16:08:02</td>
<td>1</td>
</tr>
<tr>
<td>3456</td>
<td>J Frankel</td>
<td>2003-02-09 18:31:47</td>
<td>1</td>
</tr>
</tbody>
</table>

Number of invalid mailbox numbers entered: 4
Generating a Port Statistics report

The Port Statistics report records incoming and outgoing call information for each port configured in the voice mail domain. You specify the time period, ports and MASs for which you want to generate this information. You can use this report for monitoring port usage.

For a description of the contents of this report, see Port Statistics report contents on page 12-16.

To generate a Port Statistics report:

1. Click Reports > Port Statistics.
   
   The system displays the Port Statistics dialog box.

2. Under Server Selection, select the MAS or MASs for which report information is to be generated.
   
   You can quickly select all servers in the database by selecting All Servers. Report generation is quicker when this option is selected.

3. Under Port Numbers, specify the port numbers for which report information is to be generated. To specify all ports, click All Available. To specify certain ports, click Selection, and enter the port numbers using a comma separator.
   
   You can enter a range of port numbers, for example, 1-8,16-24. No negative numbers or spaces are allowed in a range. The first number in a range must be less than the last number in a range.

4. In the From, Date field, enter the first date for which report information is to be generated.
   
   This field defaults to the To, Date value of the previous report run. Use the pull-down calendar for easy selection.

5. Enter the first time for which report information is to be generated in the From, Time field.
   
   This field defaults to the To, Time value of the previous report run.

6. In the To, Date field, enter the last date for which report information is to be generated. For easy selection, use the drop-down calendar list.

7. In the To, Time field, enter the last time for which report information is to be generated.

8. To generate the report, click OK.
Note: Generating another report closes the currently displayed report. If you want to save the report, see Zooming in on reports on page 12-30.

Port Statistics report contents

Note: The report only includes MASs for which port statistics are recorded.

For an example of a Port Statistics report, see Sample Port Statistics report on page 12-17.

The Port Statistics report provides the following information:

Individual Port Statistics

- **Server Name** The server for which port statistics are reported.
- **Port Number** The port for which incoming and outgoing call statistics are reported.
- **Incoming Calls** The number of incoming calls to the port.
- **Outgoing Calls** The number of outgoing calls from the port.
- **Time Busy (seconds)** The total time, in seconds, that the port was not idle.
- **Percentage** The percentage of time that the port was not idle.

All Ports Statistics

- **Total Number of Incoming Calls** The total number of incoming calls to all ports.
- **Total Number of Outgoing Calls** The total number of outgoing calls from all ports.
- **Time Port Availability Below Optimum** The total time during which many ports were too busy to make any more outgoing calls.
- **Time All Voice Ports Simultaneously Busy** The total time during which all ports were simultaneously busy. This field displays “0” if all incalling ports are busy while outcalling only ports are idle.
Sample Port Statistics report

The following is an example of a Port Statistics report:

![PORT STATISTICS]

Information on each port configured in the VMD

<table>
<thead>
<tr>
<th>Server Name</th>
<th>Port Number</th>
<th>Incoming Calls</th>
<th>Outgoing Calls</th>
<th>Time Busy (seconds)</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALASTOR</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>ALASTOR</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>ALASTOR</td>
<td>3</td>
<td>1</td>
<td>0</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>ALASTOR</td>
<td>4</td>
<td>1</td>
<td>0</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>ALASTOR</td>
<td>5</td>
<td>1</td>
<td>0</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>ALASTOR</td>
<td>6</td>
<td>1</td>
<td>0</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>ALASTOR</td>
<td>7</td>
<td>1</td>
<td>0</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>ALASTOR</td>
<td>8</td>
<td>1</td>
<td>1</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>ALASTOR</td>
<td>9</td>
<td>1</td>
<td>1</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>ALASTOR</td>
<td>10</td>
<td>1</td>
<td>1</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>ALASTOR</td>
<td>11</td>
<td>1</td>
<td>1</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>ALASTOR</td>
<td>12</td>
<td>1</td>
<td>1</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>MUSES</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>MUSES</td>
<td>3</td>
<td>1</td>
<td>1</td>
<td>120</td>
<td>1.888 %</td>
</tr>
<tr>
<td>MUSES</td>
<td>12</td>
<td>1</td>
<td>0</td>
<td>120</td>
<td>1.888 %</td>
</tr>
</tbody>
</table>

**ALL PORTS STATISTICS**

- Total number of incoming calls: 24
- Total number of outgoing calls: 9
- Time port availability below optimum: 0
- Time all voice ports simultaneously busy: 0
Generating a System Usage report

The System Usage report records call and messaging statistics for the voice mail domain. You specify the time period for which you want to generate this information. Use this report to help monitor usage of the system.

For a description of the contents of this report, see System Usage report contents on page 12-19.

To generate a System Usage report:

1. Click Reports > System Usage.
   The system displays the System Usage dialog box.

2. In the From, Date field, enter the first date for which report information is to be generated.
   This field defaults to the To, Date value of the previous report run. Use the pull-down calendar for easy selection.

3. In the From, Time field, enter the first time for which report information is to be generated.
   This field defaults to the To, Time value of the previous report run.

4. In the To, Date field, enter the last date for which report information is to be generated. Use the drop-down calendar list for easy selection.

5. In the To, Time field, enter the last time for which report information is to be generated.

6. To generate the report, click OK.

Note: Generating another report closes the currently displayed report. If you want to save the report, see Zooming in on reports on page 12-30.
System Usage report contents

Note: If you are using a nonintegrated MAS, you do not receive information on the calling party.

For an example of a System Usage report, see Sample System Usage report on page 12-22.

The System Usage report provides the following information:

General Call Information

- **Number of Incoming Calls**  The total number of incoming calls received by the voice mail domain.
- **Number of Times Users Logged On**  The total number of subscribers who successfully entered their mailbox number and password.
- **Time All Ports Busy (seconds)**  The total time, in seconds, during which all ports were simultaneously busy.
- **Time All Text-to-Speech Ports Busy (seconds)**  The total time, in seconds, during which all text-to-speech ports were simultaneously busy.
- **Number of Successful Calls to Fax Gateway**  The number of fax calls successfully passed from the MAS to the fax server.
- **Number of Failed Calls to Fax Gateway**  The number of fax calls that failed to pass from the MAS to the fax server.

Callers Actions

- **Dialed Extension**  The number of times callers to the voice mail domain requested the Automated Attendant to transfer them to an extension.
- **Defaulted to Assistance**  The number of times callers were transferred to operator assistance by default, for example, callers using rotary telephones.
- **Dialed 0 for Assistance**  The number of times callers to the voice mail domain pressed [0] for operator assistance.
- **Left a Message for a Subscriber**  The number of times callers to the voice mail domain left a message for a subscriber.
- **Pressed # to Log On**  The number of times callers to the voice mail domain pressed [#] to log on. This records the number of attempted logins.
- **Asked to Leave a Quick Message**  The number of times callers were asked to leave a voice message using the Quick Message service, as set in the Automated Attendant. For information about configuring the Automated Attendant, see Chapter 5, "Voice Mail Domain Administration".
Incoming Call Summary

**Note:** Some PBX integration devices do not provide sufficiently detailed reason codes. If this is the case, the System Usage report may not show the number expected in Due to Busy and Due to RNA.

- **Due to Busy** The number of calls handled by the voice mail domain because an extension was busy. This refers to calls placed directly to a busy extension using direct inward dialing (DID) and calls transferred to a busy extension by the voice mail system.

- **Due to RNA** The number of calls handled by the voice mail domain because an extension was not answered. This refers to calls placed directly to an unanswered extension using direct inward dialing (DID) and calls transferred to an unanswered extension by the voice mail system.

- **Direct Calls** The number of times that a subscriber dialed the access number of the voice mail system from that subscriber’s own extension.

- **Diverted Calls** The number of times that calls to an extension were automatically forwarded to the voice mail domain.

- **Unknown Calls** The number of times that calls to an extension were automatically transferred to the voice mail domain but for none of the reasons given in the Incoming Call Summary section of the report.

Outgoing Calls Summary

- **Number of Calls Placed that Were Not Answered** The number of calls placed on behalf of a client that were transferred to an unanswered extension.

- **Number of Calls Placed to Busy Extensions** The number of calls placed on behalf of a client that were transferred to a busy extension.

- **Number of Calls that Got Connected** The number of calls successfully transferred to an extension on behalf of a client.

- **Total Number of Outgoing Calls Excluding Calls to Clients** The total number of calls that were due to intercom paging.

- **Number of Failed Outgoing Calls Excluding Calls to Clients** The number of unsuccessful calls that were due to intercom paging.

- **Number of Connected Outgoing Calls Excluding Calls to Clients** The number of successful calls that were due to intercom paging.

Message Summary

- **Busy** The number of voice messages left because an extension was busy.
- **RNA**  The number of voice messages left because of a ring no answer response.

- **Direct**  The number of voice messages left when calling the system directly, when the Automated Attendant is disabled.

- **Subscriber**  The number of messages left from another subscriber.

- **Quick Message**  The number of voice messages left using the Quick Message service, as set in the Automated Attendant. For information about configuring the Automated Attendant, see Chapter 5, “Voice Mail Domain Administration”.

- **Transfer to Mailbox**  The number of calls transferred directly to the mailbox of a subscriber, as set in the Automated Attendant. For information about configuring the Automated Attendant, see Chapter 5, “Voice Mail Domain Administration”.
Sample System Usage report

The following is an example of a System Usage report:

**SYSTEM USAGE**

02/10/2003  VMD side call and messaging statistics  1

**GENERAL CALL INFORMATION**

- Number of Incoming Calls: 15
- Number of Times Users Logged On: 1
- Time All Ports Busy (seconds): 0
- Time All Text-to-Speech Ports Busy (seconds): 1
- Number of Successful Transfers to Fax Gateway: 0
- Number of Failed Transfers to Fax Gateway: 1

**CALLERS ACTIONS**

- Dialed Extension: 4
- Defaulted to Assistance: 1
- Dialed 0 for Assistance: 1
- Left a Message for a Subscriber: 4
- Pressed # to Logon: 3
- Asked to Leave a Quick Message: 2

**INCOMING CALL SUMMARY**

- Due to Busy: 2
- Due to RNA: 2
- Direct Calls: 2
- Diverted Calls: 2
- Unknown Calls: 2

**OUTGOING CALLS SUMMARY**

- Number of Calls That Were Not Answered: 1
- Number of Calls Placed to Busy Extensions: 1
- Number of Calls that Got Connected: 1
- Total Number of Outgoing Calls Excluding Calls to Clients: 4
- Number of Failed Outgoing Calls Excluding Calls to Clients: 2
- Number of Connected Outgoing Calls Excluding Calls to Clients: 2

**MESSAGE SUMMARY**

- Busy: 1
- RNA: 1
- Direct: 1
- Subscriber: 5
- Quick Message: 1
- Transfer to Mailbox: 1
Generating a User Mailbox Statistics report

The User Mailbox Statistics report records information about calls made and messages left in each mailbox in the voice mail domain. This excludes messages sent to the mailbox by the Voice Form application. You specify the time period and mailbox for which you want to generate this information. Use this report to help monitor mailbox usage.

Note: Before you print a User Mailbox Statistics report, make sure the page orientation is set to landscape.

For a description of the contents of this report, see User Mailbox Statistics report contents on page 12-24.

To generate a User Mailbox Statistics report:

1. Click Reports > User Mailbox Statistics.

   The system displays the User Mailbox Statistics dialog box.

2. In the To, Date field, enter the first date for which report information is to be generated.

   This field defaults to the To, Date value of the previous report run. Use the drop-down calendar list for easy selection.

3. In the From, Time field, enter the first time for which report information is to be generated.

   This field defaults to the To, Time value of the previous report run.

4. In the To, Date field, enter the last date for which report information is to be generated. For easy selection, use the drop-down calendar list.

5. In the To, Time field, enter the last time for which report information is to be generated.

6. Under Mailbox Numbers, specify the mailbox numbers for which report information is to be generated. To specify all mailboxes, click All Available. To specify certain mailboxes, click Selection and enter the mailbox numbers using a comma separator.

   You can enter a range of mailbox numbers, for example, 1000-1050, 2000-2025. No negative numbers or spaces are allowed in a range. The first number in a range must be less than the last number in a range.

7. Under Sort By, specify how the report information is to be sorted, either by mailbox number or by user's name. The mailbox number information is sorted in ascending order. The user's name is sorted in alphabetical order.
8. To generate the report, click **OK**.

**Note:** Generating another report closes the currently displayed report. If you want to save the report, see **Zooming in on reports** on page 12-30.

### User Mailbox Statistics report contents

The User Mailbox Statistics report only includes mailboxes that have voice messaging activity during the specified time period.

**Note:** If you are using a nonintegrated MAS, you do not receive information on the calling party.

For an example of a User Mailbox Statistics report, see **Sample User Mailbox Statistics report** on page 12-26.

The User Mailbox Statistics report provides the following information to help you monitor mailbox usage:

- **Mbox #** The mailbox number for which report information is generated.
- **MailboxName** The mailbox name for which report information is generated.

**Incoming Calls Xferred to Ext**

- **Total** The total number of incoming calls to the extension associated with the mailbox.

**Messages Left for User**

- **Ext. Busy** The number of voice messages left in the mailbox because the extension was busy.
- **Direct** The number of voice messages left when calling the system directly, when the Automated Attendant is disabled.
- **Ext. RNA** The number of voice messages left in the mailbox because the extension was not picked up.
- **By Subscribers** The number of voice messages left by other subscribers.
- **Via QuickMsg** The number of voice messages left using the Quick Message service, as set in the Automated Attendant. For information about configuring the Automated Attendant, see Chapter 5, **“Voice Mail Domain Administration”**.
- **Via Xfer to MB** The number of calls transferred directly to the mailbox of a subscriber, as set in the Automated Attendant. For information about
configuring the Automated Attendant, see Chapter 5, “Voice Mail Domain Administration”.

Other

- **Logons**  The total number of successful logons to the mailbox.

- **Abandoned**  The number of calls disconnected after reaching an unavailable extension without leaving a voice message, calling another extension, or transferring to the operator.

**Note:** There is one case in which an abandoned call is counted as successful. This is when a caller is put through to an extension but just before the recipient of the call has had the time to answer the call, the caller hangs up.
Sample User Mailbox Statistics report

The following is an example of a User Mailbox Statistics report:

### USER MAILBOX STATISTICS

2/10/03

| Mailbox Name | Mailbox ID | Total Answered | RTHD | B calls | Voice | Fax | Data | Mail | Messages Left | Messages Sent | Messages Accepted | Messages Rejected | Messages Confirmed | Messages Forwarded | Messages Abandoned |
|--------------|------------|----------------|------|---------|-------|-----|------|------|-------------|---------------|-------------------|------------------|-------------------|-------------------|-------------------|-------------------|
| 1005 L Cole  | 1005       | 0              | 0    | 0       | 1     | 1   | 1    | 0    | 4           | 1             | 0                 | 0                | 0                 | 0                 | 0                 |
| 1007 K Brown | 1007       | 0              | 0    | 0       | 0     | 0   | 0    | 0    | 0           | 0             | 0                 | 0                | 0                 | 0                 | 0                 |
| 1003 J Hall  | 1003       | 4              | 2    | 1       | 1     | 0   | 0    | 0    | 0           | 0             | 0                 | 0                | 0                 | 0                 | 0                 |
| 1009 S Grant | 1009       | 0              | 0    | 0       | 1     | 1   | 1    | 0    | 0           | 0             | 0                 | 0                | 0                 | 0                 | 0                 |
| 1010 P Grey  | 1010       | 5              | 4    | 0       | 1     | 0   | 0    | 0    | 2           | 0             | 0                 | 0                | 0                 | 0                 | 0                 |
| 1011 L Almon | 1011       | 1              | 1    | 0       | 1     | 1   | 0    | 2    | 0           | 0             | 0                 | 0                | 0                 | 0                 | 1                 |

Information found between the following dates:
2003/02/10 12:00 - 2003/02/10 24:00
Selected Mailbox Numbers:
1005 - 1011
Generating a Basic Metrics report

The Basic Metrics report records statistical information on activity in the voice mail domain. It includes general information on TUI usage and statistical information on subscriber TUI logons.

For a description of the contents of this report, see Basic Metrics report contents on page 12-28.

To generate a Basic Metrics report:

1. Click Reports > Basic Metrics.

   The system displays the Basic Metrics dialog box.

2. In the From, Date field, enter the first date for which report information is to be generated.

   This field defaults to the To, Date value of the previous report run. Use the drop-down calendar list for easy selection.

3. In the From, Time field, enter the first hourly time for which report information is to be generated.

   This field defaults to the To, Time value of the previous report run.

4. In the To, Date field, enter the last date for which report information is to be generated. For easy selection, use the drop-down calendar list.

5. In the To, Time field, enter the last hourly time for which report information is to be generated.

6. To generate the report, click OK.

Note: Generating another report closes the currently displayed report. If you want to save the report, see Zooming in on reports on page 12-30.
Basic Metrics report contents

For an example of a Basic Metrics report, see Sample Basic Metrics report on page 12-29.

The Basic Metrics report provides the following information:

General information

- **Total Incoming Calls** Displays the total number of incoming calls answered by the system.
- **Total UM Messages Processed** Displays the total number of voice messages submitted for delivery.
- **Total Subscriber Logon (TUI) Attempts** Displays the total number of times that subscribers attempted to log onto the TUI.
- **Total Subscriber Logon (TUI) Successes** Displays the total number of times that subscribers successfully logged onto the TUI.

Analysis

- **Percentage of Incoming Calls resulting in Messages** Displays the number of incoming calls answered, which resulted in the caller leaving a voice message, as a percentage of the total number of incoming calls answered. This percentage does not include Notify Me messages.
- **Subscriber Logons (TUI) as a percentage of Incoming Calls** Displays the number of times subscribers successfully logged onto the TUI, as a percentage of the total number of incoming calls answered by the system.
- **Subscriber Logons (TUI) as a percentage of Logon Attempts** Displays the number of times that subscribers successfully logged onto the TUI, as a percentage of the total number of times that subscribers attempted to log onto the TUI.
- **Percentage of Failed Logon Attempts** Displays the number of TUI logon attempts by subscribers that failed due to subscriber action or disconnection before the retry count was reached, as a percentage of the total number of times that subscribers attempted to log onto the TUI.
- **Percentage of Subscriber Logon Failures** Displays the number of TUI logon attempts by subscribers that failed due to the subscriber entering an invalid password or mailbox number, as a percentage of the total number of times that subscribers attempted to log onto the TUI.
Sample Basic Metrics report

The following is an example of a Basic Metrics report:

<table>
<thead>
<tr>
<th>BASIC METRICS</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/10/2003</td>
</tr>
<tr>
<td>GENERAL INFORMATION</td>
</tr>
<tr>
<td>Total Incoming Calls:</td>
</tr>
<tr>
<td>Total Messages Processed:</td>
</tr>
<tr>
<td>Total Subscriber Logon (TUI) Attempts:</td>
</tr>
<tr>
<td>Total Subscriber Logon (TUI) Successes:</td>
</tr>
<tr>
<td>ANALYSIS</td>
</tr>
<tr>
<td>Percentage of Incoming Calls resulting in Messages:</td>
</tr>
<tr>
<td>Subscriber Logons (TUI) as a percentage of incoming Calls:</td>
</tr>
<tr>
<td>Completed Logons (TUI) as a percentage of Logon Attempts:</td>
</tr>
<tr>
<td>Percentage of Failed Logon Attempts:</td>
</tr>
<tr>
<td>(Client hanging up and system failures)</td>
</tr>
<tr>
<td>Percentage of Subscriber Logon Failures:</td>
</tr>
<tr>
<td>(Incorrect PW or Incorrect Mailbox #s)</td>
</tr>
</tbody>
</table>
Zooming in on reports

You can zoom in on the currently displayed report or zoom out to adjust the report magnification.

This section also describes how to move between the pages of a report.

To zoom in on an active report:

- Do one of the following:
  - Click View > Zoom.
  - Click the icon.

To change the zoom level:

- Do one of the following:
  - Click View > Zoom.
  - Click the icon.

To move between report pages

You can move between the pages of a report displayed on the screen so that you can view all of the report information.

- To display the next page, click on the toolbar.
- To display the previous page, click on the toolbar.
Exporting reports

You can export a report when you want to save the report information or work with it using alternative tools. The export facility supports a number of popular spreadsheet, word processor, and data interchange formats. You can also attach an exported report file to a message sent using a MAPI-enabled e-mail system. The message displays an icon to indicate a report is attached.

For more information, see Export formats supported on page 12-33.

To export an active report:

1. Click File > Export, or click the icon.
   The system displays the Export dialog box.

2. In the Format field, click the export file format.

3. In the Destination field, select the export file destination, either disk file or Microsoft Mail MAPI.

4. To start the export process, click OK.

5. Do one of the following:
   - To use the Character Separated Values dialog box, continue with Steps 6 and 7.
   - To use the Number and Date Format dialog box, continue with Steps 8 and 9.
   - To use the Export File dialog box, continue with Step 10.
   - To use the Send Mail dialog box, continue with Steps 11 through 13.

6. In the Separator field of the Character Separated Values dialog box, enter the character to separate the field data.

7. In the Quote field of the Character Separated Values dialog box, enter double or single quotation marks to enclose alphanumeric field data.

8. In the Number and Date Format dialog box, click Same number formats as in report to export number formats as they appear in the report.

9. In the Number and Date Format dialog box, click Same date formats as in report to export date formats as they appear in the report.

10. In the Export File dialog box, select a file name and directory location for the report file using this standard Windows Export dialog box. If you need more information, see your Microsoft Windows documentation.
11. In the Send Mail dialog box, complete the **Address** and **Subject** fields in the standard way.

   You can search for and select a recipient by clicking **Address**. This opens the standard Windows Address Book. If you want to validate the address details, click **Check Names**.

12. In the **Message** field of the Send Mail dialog box, enter your message text.

13. In the Send Mail dialog box, click **Send** to send the message and attached report.
# Export formats supported

The export facility supports the following formats:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character Separated Values</td>
<td>Encloses alphanumeric field data in quotes and separates fields with the character of your choice.</td>
</tr>
<tr>
<td>Comma Separated Values</td>
<td>Encloses alphanumeric field data in quotes and separates fields with commas.</td>
</tr>
<tr>
<td>Crystal Reports (RPT)</td>
<td>Native Crystal Reports format.</td>
</tr>
<tr>
<td>Data Interchange Format (DIF)</td>
<td>Often used for the transfer of data between different spreadsheet programs.</td>
</tr>
<tr>
<td>Excel 2.1 (XLS), Excel 3.0 (XLS), Excel 4.0 (XLS), Excel 5.0 (XLS)</td>
<td>Microsoft Excel Spreadsheet.</td>
</tr>
<tr>
<td>Record style (columns of values)</td>
<td>Table-like format.</td>
</tr>
<tr>
<td>Rich Text Format (RTF)</td>
<td>Standard RTF format.</td>
</tr>
<tr>
<td>Tab separated text</td>
<td>Saves the data in ASCII text format with all values separated by tabs.</td>
</tr>
<tr>
<td>Tab separated values</td>
<td>Presents data in tabular form. Encloses alphanumeric field data in quotes and separates fields with tabs.</td>
</tr>
<tr>
<td>Text</td>
<td>Saves the data in ASCII text format with all values separated by spaces. This style looks most like the printed page.</td>
</tr>
</tbody>
</table>

**Note:** Click Outline view when viewing a report. Word does not display report headings in Normal view. You can print a report while using any view.
Printing reports

You can print a report displayed on the screen. You can print most of the reports using portrait or landscape orientation. The User Mailbox Statistics report, however, must be printed in landscape.

**Note:** You can specify whether you want a generated report to be sent to a printer automatically. For more information, see [Specifying options for report generation](#) on page 12-8.

**To print a report:**

1. Open the report you want to print.
2. Click **File > Print**, or click the **Print** icon.
3. In the standard Windows **Print** dialog box, specify the print settings, such as the orientation, that you want.

   If you need more information, click **Help** in the **Print** dialog box, or see your Microsoft Windows documentation.
13 Operation History Events

This chapter describes how to use the Operation History Viewer to view operation history events generated by the voice mail system.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to viewing operation history events</td>
<td>13-2</td>
</tr>
<tr>
<td>Enabling collection of operation history events</td>
<td>13-4</td>
</tr>
<tr>
<td>Selecting a data source</td>
<td>13-5</td>
</tr>
<tr>
<td>Creating sessions</td>
<td>13-8</td>
</tr>
<tr>
<td>Viewing a session</td>
<td>13-13</td>
</tr>
<tr>
<td>Saving sessions</td>
<td>13-16</td>
</tr>
<tr>
<td>Opening sessions</td>
<td>13-17</td>
</tr>
<tr>
<td>Displaying or changing session properties</td>
<td>13-18</td>
</tr>
<tr>
<td>Displaying event properties</td>
<td>13-19</td>
</tr>
<tr>
<td>Exporting operation history events</td>
<td>13-20</td>
</tr>
<tr>
<td>Setting new session defaults</td>
<td>13-22</td>
</tr>
</tbody>
</table>
Introduction to viewing operation history events

An event is any significant occurrence in the voice mail system that is of interest to an administrator for diagnostic or reporting purposes. Events are generated by the various MAS components, for example, a Call Waiting state generated by the telephone user interface.

The tracing system includes the following storage areas:

- **Operation history database**
  A temporary storage area for events that are generated by the voice mail system. The database is purged periodically. The Operation History Viewer is used for viewing events in this database.

- **Transaction database**
  A more permanent storage area for voice mail system activity. The Reporting Tool is used for extracting information from this database. For more information on the Reporting Tool, see Reports on page 12-1.

**Before you begin**

Ensure that operation history collection is enabled for the voice mail domain. For more information, see Enabling collection of operation history events on page 13-4.

**Understanding session files**

You create a session to restrict the number of events displayed by the Operation History Viewer to only those that meet your criteria. You can use Operation History Viewer to view:

- Live events as they are generated and added to the operation history database
- Historical events stored in the operation history database

You can create two types of session files:

- **Session file (.ssn)**
  You create a session file when you want to save only a session's properties. You can modify the properties to create different event viewing scenarios.

- **Snapshot file (.snp)**
  You create a snapshot file when you want to save a session's properties and the event data matching these properties. The system purges the
operation history database periodically. However, by creating a snapshot file, you can keep the event data for as long as you require.

Starting Operation History Viewer

To start the Operation History Viewer, click Start > Programs > Avaya Modular Messaging > Operation History Viewer.

If most menus and commands in Operation History Viewer are unavailable on starting, you may need to select a data source. For more information, see Selecting a data source on page 13-5.

Note: We recommend that you do not run multiple instances of Operation History Viewer at the same time to access the operation history database for a single voice mail domain. This has a detrimental effect on the performance of all Operation History Viewer applications that you are running.
Enabling collection of operation history events

Before you can view operation history events, you must enable operation history collection for the voice mail domain.

To enable collection of operation history events:

1. Start the Voice Mail System Configuration application.
2. Click the voice mail domain.
3. Double-click **Tracing System**.
4. Click the **Operation History Collection** tab.
5. Click **Enable Operation History Collection**.

For more information on configuring operation history collection for the voice mail domain, see **Messaging Application Server Configuration** on page 8-1 **Chapter 8, “Messaging Application Server Configuration”**.
Selecting a data source

If the Operation History Viewer is installed on the tracing system machine, a data source is created automatically. If not, you need to select a system data source before you can run the application.

To select a data source:

1. In the Operation History Viewer window, click File > Data Source from the Operation History Viewer.

   The system displays the standard Windows ODBC Data Source Administrator dialog box.

2. Click the System DSN tab.

3. Click Add.

   The system displays the standard Create New Data Source dialog box.

4. Click Microsoft Access Driver and click Finish.

   The system displays the standard ODBC Microsoft Access Setup dialog box.

5. In the Data Source Name field, type OperationHistory

6. On the MAS that is running the Tracing Server software, share out the directory in which the Operation History Viewer database resides:

   a. In Windows Explorer, locate the directory in which the Operation History database (named ophist.mdb) resides. By default the path to this directory is: C:\Program Files\Avaya Modular Messaging\Tracing\n
   b. Right-click the Tracing directory and, from the pop-up menu, select Sharing...

      The system displays the Tracing Properties dialog box.

   c. On the Sharing tab, select the Share this folder option.

   d. Click Permissions.

      The system displays the Permissions for Tracing dialog box.

Note: If you have already shared out this directory, (for example, for the Transaction database), then you may skip all of Step 6.
e. Select **Everyone** and make sure that at least **Read** permissions is set.

---

**Note:** The other settings may be set at your discretion.

f. In the **Permissions for Tracing** dialog box, click **OK**.

g. In the **Tracing Properties** dialog box, click **OK**.

h. Right-click the **Tracing** directory and, from the pop-up menu, select **Properties**.

i. Select the **Security** tab.

j. Verify that any users who will be using the Operation History Viewer have the following permissions set:

   - **Read & Execute**
   - **List Folder Contents**
   - **Read**

k. Click **OK**.

l. Right-click the **ophist.mdb** file and, from the pop-up menu, select **Properties**.

m. Verify that any users who will be using the Operation History Viewer have the following permissions set:

   - **Read & Execute**
   - **List Folder Contents**
   - **Read**

n. Click **OK**.

7. In the Operation History Viewer window (back on the MAS running the Operation History Viewer software), click **Select**.

   The system displays the standard **Select Database** dialog box.

8. Map a drive to the Operation History (ophist.mdb) database:

   a. Click **Network...**

   b. In the **Drive**: field, select a drive letter that has not already been used on this MAS.

   c. Enter the path to the Operation History (ophist.mdb) database by doing one of the following:
In the Folder: field, type the pathname using the format
\servername\Tracing

where servername is the domain name of the MAS on which the
Tracing Server software is running.

Use the Browse... button to locate the Tracing directory on the
MAS on which the Tracing Server software is running.

d. Click Finish.

9. In the Select Database dialog box, set the Drives field to the drive you
mapped in the previous step.

The system displays in the Database Name field a list of one or more
databases on the mapped drive. The Operation History (ophist.mdb)
database should be among them.

10. Select ophist.mdb.

11. Click OK.

12. In the ODBC Microsoft Access Setup dialog box, click OK.

13. In the ODBC Data Source Administrator dialog box, click OK.
Creating sessions

You can create two types of session in Operation History Viewer:

- A live session
  
  For more information, see Creating live sessions on page 13-9.

- An historical session
  
  For more information, see Creating historical sessions on page 13-11.
Creating live sessions

You create a live session when you want to view events as they are fed to the operation history database. While viewing events in a live session, you can pause the live event feed.

To create a live session:

2. In the Viewer window, click File > New, or click the New icon .
   The system displays the Session Properties dialog box.
3. In the Session Name field, enter the name of the session, if required.
4. In the Message Application Server field, enter or click the MAS for which you want to display events. If you want to display events for all the MASs in the voice mail domain, click All Servers.
5. Click Live Mode.
6. Under Select Types, select the event severity type or types to display. You must select either Error, Warning or Information.
7. Under Selection Activities, select the event criteria to display. To quickly select all activities, select All Activities.
   If you select All Activities, any mailbox or port number values you enter are ignored.
   You can further restrict the display of mailbox and port activity events by entering a range of mailbox or port numbers in the Value field, using a comma separator. No negative numbers or spaces are allowed in a range. The first number in a range must be less than the last number in a range, for example, port numbers, 1-8,16-24.
8. Click OK.

Note: To avoid slowing down the tracing server, Operation History Viewer displays the most recent events only. You can view older events in an historical session.

If you want to change the number of events displayed in a live session, please contact your Avaya Modular Messaging support representative.

Scrolling events in a live session

If you do not pause a live feed view when scrolling events in a live session, the viewer moves to the end of the event list each time a new event comes in.
To scroll events in a live session:

1. Click File > Pause, or click the Pause/Resume icon.
2. Scroll through the events you want to view.
3. When you have finished scrolling, click File > Resume, or click the Pause/Resume icon.

Live event feed is resumed without any loss of events generated during scrolling.

Notes:

- You can pause a live view for a maximum of 200 seconds. If you exceed this time, then you must restart the live view session.
- When you click New, Open, Save, Save As, Session Properties, or Event Properties, the application automatically pauses the event feed. Once the action is complete, the application resumes event feed without any loss of events generated during the action.
Creating historical sessions

Create an historical session when you want to view events already stored in the operation history database.

To create an historical session:


2. In the Viewer window, click File > New, or click the New icon .

   The system displays the Session Properties dialog box.

3. In the Session Name field, enter the name of the session, if required.

4. In the Message Application Server field, enter or click the MAS for which you want to display events. If you want to display events for all the MASs in the voice mail domain, click All Servers.

5. Do one of the following:

   a. If you want to restrict the display of events by date and time, continue with Steps 6 through 10.

   b. If you do not want to restrict the display of events by date and time, click Clear and continue with Steps 7 through 10.

6. In the From and To fields, under Date and Time, enter the first and last date and time for session creation.

   If you want to modify the session properties later to create different event viewing scenarios, we recommend that you select one of the relative date values in the Date field, for example, Today. This saves you from reentering an absolute date for each scenario you create.

   Note: To retrieve the default times and dates, click Default. Note that the defaults are the application defaults unless you have set up your own. Setting up your own default dates is described in the section Setting new session defaults on page 13-22.

7. Under Select Types, select the event severity type or types to display. You must select at least one of Error, Warning or Information.

8. Under Selection Activities, select the event criteria to display by selecting the appropriate boxes. You can quickly select all activities by selecting All Activities.

   If you select All Activities, the application ignores any mailbox or port number values you enter.

   You can further restrict the display of mailbox and port activity events by entering a range of mailbox or port numbers in the Value field, using a comma separator. No negative numbers or spaces are allowed in a
range. The first number in a range must be less than the last number in a range, for example, port numbers, 1-8, 16-24.

9. Under **Sort By**, select the type of value by which you want events to be sorted. **None** is selected by default.

   This means that events are sorted in the order in which they were entered in the database.

10. Click **OK**.
Viewing a session

The Operation History Viewer window lists the events matching the current session properties. The system displays event details in columns.

- For a list of columns, see Understanding event columns in the Viewer window on page 13-13.

- For information on how to change the column settings, see Changing column settings on page 13-14.

- For information on how to copy and paste event details to a word processing or other application, see Copying and pasting event details on page 13-15.

Understanding event columns in the Viewer window

The table below describes the event columns in the Operation History Viewer window.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Date the event occurred</td>
</tr>
<tr>
<td>Time</td>
<td>Time the event occurred</td>
</tr>
<tr>
<td>Object</td>
<td>System component that generated the event, for example, the telephone user interface (TUI)</td>
</tr>
<tr>
<td>Event</td>
<td>Event identifier</td>
</tr>
<tr>
<td>Type</td>
<td>Severity of the event</td>
</tr>
<tr>
<td>Call-ID</td>
<td>Call identifier</td>
</tr>
<tr>
<td>Message Application Server</td>
<td>Name of the MAS on which the event occurred</td>
</tr>
<tr>
<td>Information</td>
<td>Description of the event</td>
</tr>
<tr>
<td>Port</td>
<td>Port identifier, if any, associated with the event</td>
</tr>
<tr>
<td>Mailbox</td>
<td>Mailbox identifier, if any, associated with the event</td>
</tr>
<tr>
<td>Directory Search Key</td>
<td>Directory search key identifying a user’s mailbox on an e-mail server</td>
</tr>
</tbody>
</table>
Changing column settings

You can modify how event information in the system displays the Viewer window.

To change column settings:

1. Click File > Options.
2. Click the Columns tab.
3. Do one or more of the following:
   - To transfer columns between the Selected list and the Not Selected list, select one or more columns and use the Move icon or double-click. The direction of the arrow changes to point from the side that has one or more items selected.

   **Note:** To select all columns in the list to which the arrow of the Move icon is currently pointing, click Select All.

   - To move a selected column in the Selected list up one position, click the up arrow icon.
   - To move a selected column in the Selected list down one position, click the down arrow icon.

   **Note:** To reset the columns to the original application defaults, click Reset.

4. Click OK.

To Resize Columns

- Use the mouse to resize the columns. On starting, Operation History Viewer remembers the last resized position of each column.
Copying and pasting event details

You can copy event details displayed in the Operation History Viewer window to an alternate application. For example, you might want to copy event details to a Microsoft Word document.

To copy and paste event details:

1. In the Event window, highlight the events you want to copy.
2. Click Edit > Copy, or press CRTL+C.
   The information is copied to the Clipboard.
3. In the destination application, to paste the event details, click Edit > Paste, or press CRTL+V.

Note: You can also export operation history events to a text file or to a database file. For more information, see Exporting operation history events on page 13-20.
Saving sessions

Depending on how you want to work with a session, you can save it in one of the following file formats:

- **Session file (.ssn)**
  
  Create a session file when you want to save only a session's properties. You can modify the properties to create different event-viewing scenarios.

- **Snapshot file (.snp)**
  
  Create a snapshot file when you want to save a session's properties and the event data matching these properties. The system purges the operation history database periodically. However, creating a snapshot file means that you can keep the event data for as long as you require.

**Note:** When you save a live session, the application pauses the event feed. Once the save is complete, the application resumes the event feed without any loss of events generated during the save action.

**To save a session:**

1. Click **File > Save**, or click the **Save** icon.
   
   The system displays the **Session Save As** dialog box.

2. In the **File name** field, enter a file name.

3. In the **Save as type** field, select:
   
   - **Session files (*.ssn)**
   - **Snapshot files (*.snp)**
   - **All files (*.*)**

4. Select the location where you want to save the file.

5. Click **OK**.
Opening sessions

You can open a previously saved session file or snapshot file.

To open a session:

1. In the Viewer window, click File > Open, or click the Open icon.
   The system displays the Open Session dialog box.

2. In the Files of Type field, select the type of file you want to retrieve:
   - Session files (*.ssn)
   - Snapshot files (*.snp)
   - All files (*.*)

3. Locate the file using Directories and Drives.

4. Click OK.
Displaying or changing session properties

You can view a session’s properties or change them, for example, if you want to populate the session with a different set of events.

To display or change session properties:

1. Click File > Session Properties, or click the Properties icon .
   The system displays the Session Properties dialog box.

2. Do one of the following:
   - If you want to view the session properties without changing them, click Cancel when you are finished viewing the properties in the Session Properties dialog box.
   - If you want to change the session properties, continue with Steps 3 and 4.

3. Make your changes in the Session Properties dialog box. If you need more information, click Help in the Session Properties dialog box.

4. Click OK.
   The system repopulates the current session with events matching the new session properties.

To change session selection activities:

You can change session selection activities using the Selection menu commands rather than having to display the Session Properties dialog box.

<table>
<thead>
<tr>
<th>Source of events</th>
<th>Selection menu command</th>
</tr>
</thead>
<tbody>
<tr>
<td>All voice mail system activities</td>
<td>All Activities.</td>
</tr>
<tr>
<td>Mailbox activity</td>
<td>Mailbox Activity. You can enter a range of mailbox numbers in the Values dialog box.</td>
</tr>
<tr>
<td>Port activity</td>
<td>Port Activity. You can enter a range of port numbers in the Values dialog box.</td>
</tr>
<tr>
<td>PBX Integration activity</td>
<td>PBX Integration Activity.</td>
</tr>
</tbody>
</table>

New events are then retrieved for the newly selected selection activities or values.
Displaying event properties

For detailed information on an event, you can view its properties. For example, you can view the time, date, and severity of an event.

To display event properties:

1. In the Operation History Viewer window, click the event.

2. Do one of the following:

   - Click File > Event Properties.
   - Click the Properties icon .
   - Double-click the event.

The system displays the Event Properties dialog box.

The Event Properties dialog box shows the following information.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>Event identifier</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Date and time the event occurred</td>
</tr>
<tr>
<td>Object</td>
<td>Name of the system component that generated the event</td>
</tr>
<tr>
<td>Message Application</td>
<td>MAS on which the object that generated the event</td>
</tr>
<tr>
<td>Server</td>
<td>resides</td>
</tr>
<tr>
<td>Type</td>
<td>Severity of the event</td>
</tr>
<tr>
<td>Port</td>
<td>Port number, if any, associated with the event</td>
</tr>
<tr>
<td>Mailbox</td>
<td>Mailbox number, if any, associated with the event</td>
</tr>
<tr>
<td>Message</td>
<td>Detailed description of the event</td>
</tr>
</tbody>
</table>
Exporting operation history events

You can export operation history events to view, query and search the data using alternate tools, for example, text editors and database querying tools. You can export the event data in two formats:

- **Text file (.txt)**
  
  Records in a text file, with field separators and text envelope characters. The text file contains event information for the currently selected columns only.

- **Database file (.mdb)**
  
  Open Database Connectivity (ODBC)-compliant database with the same columns as the operation history database.

**Notes:**

- You cannot export events in a snapshot file. When a snapshot file is loaded, the system disables the Export command.

- Before you can export events in a live session, you must pause the event feed. Once the export is complete, the system resumes the event feed automatically without any loss of events generated during the export.

To export operation history events:

1. Do one of the following:
   - If you are exporting events in a live session, continue with Steps 2 through 7.
   - If you are exporting events in an historical session, continue with Steps 3 through 7.

2. Click **File > Pause**, or click the **Pause/Resume** icon.

3. Click **File > Export**, or click the **Export** icon.

   The system displays the **Export Operation History Events** dialog box.

4. In the **File Name** field, enter a file name, or, if you want to overwrite an existing file, click that file.

5. In the **List Files of Type** field, select either **.txt** format for a text file or **.mdb** format for a database file.
If you are exporting a text file and want to specify characters to separate and surround text fields, click Options to open the Text Export tab. For more information, see “To set text export options” (below).

6. Select the location where you want to save the file in Directories and Drives.

7. Click OK.

To set text export options:

**Note:** You can specify characters to separate and surround text fields when exporting operation history events to a text file.

1. Click File > Options.

2. Click the Text Export tab.

3. Select the character you want the system to use to separate text fields. The options are comma, space, semicolon, or tab. Comma is the default.

4. Select the character you want the system to use to surround text fields. The options are single quotes, double quotes, or none. Double quotes is the default.

5. Click OK.
Setting new session defaults

You can set up your own default MAS and dates and times to use for a new session. You can also get Operation History Viewer to automatically open a new session using these defaults whenever you start the application.

To set new session defaults:

1. Click File > Options.
2. Click the Events View tab.
3. In the Default MAS field, enter or select the name of the default MAS to use. If you want to display events for all the MASs in the voice mail domain, click All Servers.
4. Under Default Date and Time, enter the first and last default date for session creation in the From and To fields.
5. Under Default Date and Time, enter the first and last default time for session creation in the From and To fields.
6. Click OK.

To open a new session with default options on start of application:

1. Click File > Options.
2. Click the Events View tab.
3. Click Open new session with default options on start of application.
4. Click OK.

When Operation History Viewer starts, an untitled session opens displaying events that meet all the default values.
System Performance Monitoring

This chapter describes how to monitor the voice mail system.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to monitoring</td>
<td>14-2</td>
</tr>
<tr>
<td>Using Performance Monitor</td>
<td>14-3</td>
</tr>
<tr>
<td>Using Port Monitor</td>
<td>14-8</td>
</tr>
<tr>
<td>Testing Dialogic lines</td>
<td>14-16</td>
</tr>
</tbody>
</table>
Introduction to monitoring

Monitoring the voice mail system involves checking the performance of the MASs. Proper monitoring can help you to find and fix problems before they have an impact on your organization.

You can use the following tools to monitor MAS performance:

- **Performance Monitor**
  
  You can make use of all the monitoring capabilities of this Windows tool to check the performance of a particular MAS. For more information, see *Using Performance Monitor* on page 14-3.

- **Port Monitor**
  
  This provides a graphical user interface for checking and changing the status of ports on an MAS. For more information, see *Using Port Monitor* on page 14-8.
Using Performance Monitor

You use Microsoft Performance Monitor to check the performance of a particular MAS. To monitor MAS objects in the MAS software, a number of counters were added to Performance Monitor.

You should be familiar with using Performance Monitor. For information about Performance Monitor, see your Microsoft Windows documentation.

Performance Monitor provides a large number of counters for monitoring the performance of MASs. You use each counter to monitor a different activity. For example, you can monitor inbound or outbound calls to the MAS or check the number of ports currently in use. For the procedure to do this, see Monitoring the performance of MASs on page 14-4.

You can use the counters to monitor the performance of five separate objects:

- **Modular Messaging Software Voice Port**
  Use these counters to monitor voice port activity.

- **Modular Messaging Software Service**
  These counters display internal information about the state of the system, for use by Avaya Modular Messaging administration tools.

- **Modular Messaging Software**
  Use these counters to monitor the current status of calls processed by MAS.

- **Modular Messaging Software MWI**
  Use these counters to monitor message waiting indicator activity.

For tables listing the performance counters, see Modular Messaging Software performance counters on page 14-5.
Monitoring the performance of MASs

The following steps describe how to monitor the performance of an MAS in chart view (the default view). For information about using alert view, log file view, and report view, see your Windows 2000 Server or Windows 2000 documentation. For tables listing the performance counters, see Modular Messaging Software performance counters on page 14-5.

To monitor the performance of MASs:

1. If it is not already running, start Performance Monitor by clicking Start > Programs > Administrative Tools > Performance.

2. On the toolbar, click the Plus icon.

   The system displays the Add Counters dialog box.

3. In the Select counter from this computer field, click the MAS you want to monitor.

4. In the Performance object field, click the MAS object you want to monitor.

5. In the Select counters from list field, select the counter you require. The counters available depend on the object that you have chosen.

6. Click Add.

7. If you want to add another MAS to the chart, repeat Steps 3 through 6.
## Modular Messaging Software performance counters

### Modular Messaging Software Voice Port counters

<table>
<thead>
<tr>
<th>Counter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbound calls counter</td>
<td>The number of incoming calls to the port</td>
</tr>
<tr>
<td>Outbound calls counter</td>
<td>The number of outbound calls from the port</td>
</tr>
<tr>
<td>Port status</td>
<td>The current status of the port</td>
</tr>
<tr>
<td>Port status time</td>
<td>The time the port has been in its current state</td>
</tr>
<tr>
<td>Total calls counter</td>
<td>The total number of calls processed by the port</td>
</tr>
</tbody>
</table>

### Modular Messaging Software Service counters

<table>
<thead>
<tr>
<th>Counter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State counter</td>
<td>The current status of the service object</td>
</tr>
</tbody>
</table>

### Modular Messaging Software counters

<table>
<thead>
<tr>
<th>Counter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% Delayed Calls</td>
<td>The percentage of calls today that have experienced a delay of more than 4 seconds</td>
</tr>
<tr>
<td>% Time offline</td>
<td>The percentage of time today that the MAS was offline</td>
</tr>
<tr>
<td>Active ports</td>
<td>The number of currently active ports</td>
</tr>
<tr>
<td>Active TUI sessions</td>
<td>The number of currently-active TUI sessions</td>
</tr>
<tr>
<td>All TUI Sessions Active</td>
<td>The number of times that all TUI sessions were active</td>
</tr>
<tr>
<td>Calls to non-Modular Messaging-Software-enabled users</td>
<td>The number of calls diverted to Modular Messaging Software for which there is no corresponding subscriber for the extension</td>
</tr>
<tr>
<td>Calls while offline</td>
<td>The number of calls received while server was offline</td>
</tr>
<tr>
<td>Failed TUI Password Validations</td>
<td>The number of invalid passwords entered today</td>
</tr>
</tbody>
</table>
## Modular Messaging Software Counters (Continued)

<table>
<thead>
<tr>
<th>Counter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incoming calls</td>
<td>The number of active incoming calls</td>
</tr>
<tr>
<td>Integration data missing</td>
<td>The number of calls that were missing switch integration data</td>
</tr>
<tr>
<td>Integration Unknown</td>
<td>The number of calls that were missing the switch integration type</td>
</tr>
<tr>
<td>Logons aborted after delay</td>
<td>The number of aborted TUI logons today due to delays opening the subscriber mailbox</td>
</tr>
<tr>
<td>Logon failures (Offline)</td>
<td>The number of times subscribers could not complete a logon because a mail server was unavailable</td>
</tr>
<tr>
<td>Non-delivery messages</td>
<td>The number of non-delivery messages in the default mailbox</td>
</tr>
<tr>
<td>Number of message store Enabled Users</td>
<td>The number of users enabled for the message store</td>
</tr>
<tr>
<td>Outgoing calls</td>
<td>The number of active outgoing calls</td>
</tr>
<tr>
<td>Size of TUI port group</td>
<td>The number of channels in the TUI port group</td>
</tr>
<tr>
<td>Spooler queue length</td>
<td>The number of messages queued for delivery to the message server(s)</td>
</tr>
<tr>
<td>System Problems</td>
<td>The number of times any call has been terminated because the MAS could not contact a messaging server</td>
</tr>
<tr>
<td>Timeout obtaining greeting</td>
<td>The number of times a timeout occurred when trying to obtain a subscriber greeting</td>
</tr>
<tr>
<td>Total calls today</td>
<td>The total number of calls handled by Modular Messaging Software today</td>
</tr>
<tr>
<td>TUI average logon time</td>
<td>The average time (in milliseconds) taken for TUI logins</td>
</tr>
<tr>
<td>TUI average message delete time</td>
<td>The average time (in milliseconds) taken to complete deletion of TUI messages</td>
</tr>
<tr>
<td>TUI average message playback time</td>
<td>The average time (in milliseconds) taken for TUI message playback to start</td>
</tr>
</tbody>
</table>
### Modular Messaging Software MWI counters

<table>
<thead>
<tr>
<th>Counter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total MWI Busy Failures</td>
<td>The number of times the MAS has failed to trigger subscribers’ message waiting indicators due to a lack of resources, such as ports, trunks, or network availability</td>
</tr>
<tr>
<td>Total MWI Errors</td>
<td>The number of times the MAS has detected an error while trying to trigger subscribers’ message waiting indicators</td>
</tr>
<tr>
<td>Total MWI Set Attempts</td>
<td>The number of times the MAS has attempted to turn a subscriber’s message waiting indicator on since call processing began</td>
</tr>
<tr>
<td>Total MWI Reset Attempts</td>
<td>The number of times the MAS has attempted to turn a subscriber’s message waiting indicator off since call processing began</td>
</tr>
</tbody>
</table>
Using Port Monitor

Port Monitor provides a graphical user interface for checking the current status of ports on an MAS.

To run the Port Monitor application, click Start > Programs > Avaya Modular Messaging > Port Monitor.

See the following sections for information on using Port Monitor:

- Selecting an MAS for port state viewing on page 14-9
- Viewing port states on page 14-10
- Managing port states on page 14-12
- Disabling ports on page 14-13
- Enabling ports on page 14-14
- Disabling a port immediately on page 14-15
Selecting an MAS for port state viewing

You must select the MAS for which you want to view port states.

To select an MAS:

From the **Messaging Application Servers** dialog box, click the MAS in the list and then click **Select**. Alternatively, double-click the MAS.

**Note:** The dialog box lists the MASs in the voice mail domain associated with the computer running the Port Monitor application.

To view the status of multiple MASs:

Start multiple copies of the Port Monitor application, selecting a different MAS from the Message Application Servers dialog box each time.

To select another MAS:

Once you have started Port Monitor, you can select a different MAS without quitting the application.

1. Do one of the following:
   - Click the **Select Another Server** icon.
   - From the **Options** menu, click **Select Another Server**.

   The system displays the **Message Application Servers** dialog box.

2. Select the MAS in the usual way (see above).
Viewing port states

The Port States window lists each port for the selected MAS and describes its current status. Each port can have one of the following states, represented by an icon:

- **Disabling**
  An administrator requested to disable a busy port, but the port has not yet been released by the call.

- **Disabled**
  The port is unavailable.

- **Busy**
  The port is in use by incoming or outgoing calls.

- **Idle**
  The port is available.

Additionally, the following states can appear simultaneously with one of the first three states:

- **Disconnected**
  The call has been disconnected, but the port is still off hook.

- **Offhook**
  The port has been taken off hook from the idle state.

- **Dialtone**
  Dialtone has been detected on this port for an outgoing call.

- **Connected**
  The call on this port is connected.

- **Call Failed**
  The outgoing call on this port failed.

- **In Transfer**
  The first stage of a transfer on this port is completed.

- **Transfer Failed**
  The transfer of the call on this port failed.
- **Waiting for Call**
  The port is waiting for an incoming ring.

- **Ringing In**
  The port is ringing with an incoming call.

- **Ringing Out**
  The outgoing call on this port is ringing the targeted line.

- **Dialing**
  The port is dialing an outgoing call.

- **Waiting for Call (Pending)**
  The port has been requested to go into the Wait For Ring state.

- **Bad port**
  The port is out of service.

- **Playing**
  Audio is playing.

- **Recording**
  Audio is being recorded.
Managing port states

If you detect any port usage problems, you can change the status of a port as appropriate. If you have system administrator privileges, you can:

- **Disable a port**
  
  Make the port unavailable for incoming or outgoing calls. If the port is busy, this is not done until it is released.
  
  If the **Go off hook when port disabled** option in the Voice Mail System Configuration application (**General - PBXs** tab) is selected, the port is taken off hook when it is disabled.

- **Enable a port**
  
  Bring the port on hook and make it available for incoming or outgoing calls.

- **Disable a port immediately**
  
  Force the port to be disabled immediately, regardless of the activity currently taking place on that port.

Considerations

When using Port Monitor, keep the following considerations in mind:

- To use Port Monitor, you must have administrator privileges at a Windows 2000 level on the MAS, and you must be a member of the System Administrators access control list (ACL).

  For information on setting up voice mail domain privileges, see [Configuring voice mail domain security](#) on page 5-25.

- An administrator can also enable or disable a port using the **General - Port** page in the Voice Mail System Configuration application. Any changes made there are reflected in the Port Monitor application and vice versa.

- If two administrators attempt to change the status of a port on the same MAS at the same time, only one change takes effect, and automatically overrides the other attempt. To avoid this situation, we recommend that you allocate a single machine for changing port states.
Disabling ports

Disabling a port means that it cannot be used for outgoing calls, and incoming calls on that port are not answered. If the Go off hook when port disabled option in the Voice Mail System Configuration application (General - PBXs page) is selected, the port is taken off hook when it is disabled.

Before you can disable a port, it must be Idle. If the port is busy, it is disabled the next time it becomes idle.

To disable a port:

1. In the Port States window, select the port.

   You can select multiple ports by holding down the Shift key or Control (Ctrl) key and clicking on the ports you require.

2. Do one of the following:

   - Click the Disable icon.
   - From the Change State menu, click Disable.
   - Right-click the port and then, from the pop-up menu, click Disable.
Enabling ports

Enabling a port means bringing it back into service so that it is available for incoming or outgoing calls.

To enable a port:

1. In the Port States window, select the port.
   
   You can select multiple ports by holding down the Shift key or Control (Ctrl) key and clicking on the ports you require.

2. Do one of the following:
   
   - Click the Enable icon.
   - From the Change State menu, click Enable.
   - Right-click the port and then, from the pop-up menu, click Enable.
Disabling a port immediately

It may be necessary to force a port to become disabled at once, irrespective of its current status.

**Important:** Disabling a port immediately will instantly disconnect any users of the port.

To disable a port immediately:

1. In the **Port States** window, select the port.
   
   You can select multiple ports by holding down the **Shift** key or **Control** key and clicking on the ports you require.
   
2. Do one of the following:
   
   - Click the **Disable Immediately** icon.
   
   - From the **Change State** menu, click **Disable Immediately**.
   
   - Right-click the port and then, from the pop-up menu, click **Disable Immediately**.
Testing Dialogic lines

The Dialogic Line Test Application verifies that the voice ports are correctly configured and connected to the PBX. Your service technician uses this tool as part of testing the installation of your system. However, you may also use it as a troubleshooting tool. It tests analog, DSE, and QSIG ports.

**Note:** Stop the Messaging Application Server service before you use this tool.

Run the Dialogic Line Test Application from the Modular Messaging Software folder.

The system displays the Dialogic Analog-Line Test Application window.

The Status column tells you the status of the channel.

**To test a port:**

1. Click a port in the list.
2. Dial the number of the port from a telephone.
   - The status of the port should change to **Receiving call**.
3. Hang up the telephone, and wait until the port changes to **Waiting for call**.
4. Click the port again.
5. Type a real telephone number into the **Dial Number** field, and click **Dial Number**.
   - The status of the port should change to **Dialing number**. Other status changes may follow.
   - If a channel has an error, it changes to a flashing red color. If a channel is in error or locked in a state inappropriately, you can reset the channel.

**To correct a port problem:**

Click the channel, then click **Reset**, or if multiple channels have problems, click **Reset All**.

The channel returns to the **Waiting for call** state. If not, you may need to reconfigure or replace the voice card.

**To modify QSIG parameters if the card handles the QSIG protocol:**

1. Click **Tools > Options**.
   - The system displays the **QSIG Options** dialog box.
2. In the **Layer 1 Protocol** field, click **G.711 A-Law** or **G.711 u-Law**.

3. In the **Number Type** field, click **Unknown**, **International**, **National**, or **Local**.

4. In the **Number Plan** field, click **Unknown**, **ISDN/Telephony(E.164/E.163)**, or **Private**.
This chapter describes how to display and view event, error, and alarm logs on the MAS.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of event, error, and alarm logs on the MAS</td>
<td>15-2</td>
</tr>
<tr>
<td>Displaying the MAS event and error logs</td>
<td>15-3</td>
</tr>
<tr>
<td>Displaying the MAS alarm logs</td>
<td>15-5</td>
</tr>
</tbody>
</table>
Overview of event, error, and alarm logs on the MAS

The Avaya S3420 Messaging Application Server provides logs and notifications for events, errors, and alarms similar to those available on the Avaya S3400 family of message store servers.

The alarm subsystem provides mechanisms for sending alarm notifications to support personnel in a timely manner. These notifications can be sent using the Avaya Initialization and Administration System (INADS) and through the use of SNMP traps. Administration for these notifications is covered in Configuring serviceability on page 5-38 and Configuring MAS serviceability on page 8-16.

Each MAS also provides a set of event, error, and alarm logs, accessible to support personnel for analysis. You can access the following logs using a set of command line interface tools:

- The **event log** contains events and errors generally of interest only to technical services and development personnel.

- The **administrator log** contains events and errors that will likely be of interest to system administrators. For more information, see Displaying the MAS event and error logs on page 15-3.

- The **active alarms log** contains information about alarms that are currently active on the system and is one of your primary lines of attack when problems occur. For more information, see Displaying the MAS alarm logs on page 15-5.

- The **resolved alarms log** contains a history of and information about alarms that have been raised and then resolved on the system. This log can be useful in analyzing problems and trends in the system. For more information, see Displaying the MAS alarm logs on page 15-5.

For more information about the alarms and events displayed in these logs, see Appendix A, MAS Alarms.
Displaying the MAS event and error logs

The Avaya 3420 Messaging Application Server provides two system logs related specifically to events and errors. The **event log** contains events and errors generally of interest only to technical services and development personnel. The **administrator log** contains events and errors that will likely be of more interest to system administrators.

To display an event and error log on the MAS:

1. On the desktop taskbar, click **Start**.
2. From the **Start** menu, click **Run**.
   
   The system displays the **Run** dialog box.
3. In the **Open** field, type **command** or **cmd**.
4. Click **OK**.
   
   The system displays the **MS-DOS Prompt** window.
5. At the DOS prompt, enter one of the following commands, depending on the event and error log you want to view:
   
   - To view the administrator log, enter **displog -l admin**
   - To view the maintenance events log, enter **displog -l maint**

When using these commands, it is often helpful to limit the number of entries the system displays by only requesting the entries for a certain period of time. Otherwise, you may have to sift through hundreds or even thousands of entries to find the ones that you are interested in.

To do this, you can modify the displog command to retrieve records for designated days or times, for example:

- If you wanted to view the events log for today from 3:00 p.m. to the current time, you would enter: **displog -l maint -d15:00**

- If you wanted to view the administrator log for all of today, starting from midnight, you would enter: **displog -l admin -dmm/dd/yy**

  where *mm/dd/yy* is today’s date.

- If you wanted to view the events log for all events starting from a certain day at 8:00 a.m. to the present, you would enter: **displog -l maint -d”mm/dd/yy 08:00"**

  where *mm/dd/yy* is the starting date for the records you want to view.
Event, Error, and Alarm Logs

For more information about the alarms and events displayed in these logs, see Appendix A, MAS Alarms.
Displaying the MAS alarm logs

The Avaya 3420 Messaging Application Server provides two system logs related specifically to alarms. The **active alarms log** contains information about alarms that are currently active on the system and is one of your primary lines of attack when problems occur. The **resolved alarms log** contains a history of and information about alarms that have been raised and then resolved on the system. This log can be useful in analyzing problems and trends in the system.

**To display an alarm log on the MAS**

1. On the desktop taskbar, click **Start**.
2. From the **Start** menu, click **Run**.
   
   The system displays the **Run** dialog box.
3. In the **Open** field, type **command** or **cmd**.
4. Click **OK**.
   
   The system displays the MS-DOS Prompt window.
5. At the DOS prompt, enter one of the following commands, depending on the alarm log you want to view:
   
   - To view active alarms, enter `displog -l act`
   - To view resolved alarms, enter `displog -l res`

When using these commands, it is often helpful to limit the number of entries the system displays by only requesting the entries for a certain period of time. Otherwise, you may have to sift through hundreds or even thousands of entries to find the ones that you are interested in.

To do this, you can modify the `displog` command to retrieve records for designated days or times, for example:

- If you wanted to view the resolved alarms log for today from 3:00 p.m. to the current time, you would enter: `displog -l res -d15:00`
- If you wanted to view the resolved alarms log for all of today, starting from midnight, you would enter: `displog -l res -d mm/dd/yy`

where `mm/dd/yy` is today’s date.
If you wanted to view the resolved alarms log for all events starting from a certain day at 8:00 a.m. to the present, you would enter:

```
displog -l res -d"mm/dd/yy 08:00"
```

where `mm/dd/yy` is the starting date for the records you want to view.

**Note:** These time limiters are not generally useful for the active alarms log, but you can use them if you so wish.

For more information about the alarms and events displayed in these logs, see Appendix A, MAS Alarms.
Appendix A: MAS Alarms

An alarm indicates a hardware, software, or environmental problem that could affect system operation.

The system displays MAS alarms in the MAS alarm logs. For information about how to access these alarm logs, see Displaying the MAS alarm logs on page -5.

How to find information about a specific alarm

The alarm descriptions and resolution procedures in this section are organized by the alarm application identifier (ID), which is the two-letter code used to identify the application or subsystem for which an alarm is being generated.

For example, the application ID for the MT ABS_PROC 1 alarm is MT. If you want to find information about the MT ABS_PROC 1 alarm, see the MT (Maintenance) Alarms information.

Notes:

- To display alarm and event IDs, use the command line interface and the following commands:
  - For active alarm IDs, enter `displog -l act`
  - For resolved alarm IDs, enter `displog -l res`
  - For maintenance event IDs, enter `displog -l maint`

- In each of the following alarm descriptions, the “System descriptor” is the message displayed when you enter the command `displog -l <option>` in the command line interface.
MAS Alarms

MAS alarm information is organized as follows:

- **CM (Call Me) alarms** on page A-3
- **MM (Mailbox Monitor) alarms** on page A-4
- **MT (Maintenance) alarms** on page A-6
- **MW (Message Waiting Indicator) alarms** on page A-15
- **TS (tracing server) alarms** on page A-17
- **VB (Avaya Voice Browser) alarms** on page A-18
- **VS (Voice server, MAS-specific) alarms** on page A-23
CM (Call Me) alarms

The following alarm is generated by the Call Me service on the affected MAS:

- **CM CALLME 1**

**CM CALLME 1**

**Level:**
Minor

**System descriptor:**
CallMe is having trouble.

**Description:**
This alarm indicates that there is a problem with the Call Me service.

The system generates this alarm whenever the “CallMe Failures” KPI (event ID 120) is incremented more than five times at an average rate faster than once every five minutes.

**Repair Procedure:**
If there is no new alarm generated within a 15-minute period, then the system considers the alarm resolved and generates a resolved-alarm event.

If the system does not resolve the alarm automatically within a period of a few hours, contact your Modular Messaging service or technical support representative for assistance.
MM (Mailbox Monitor) alarms

The following alarms are generated by the Mailbox Monitor application and indicate a problem with the Mailbox Monitor on the affected MAS:

- **MM IMAPI 1**
- **MM PERF 17**
- **MM PERF 18**

**MM IMAPI 1**

**Level:**
Major

**System descriptor:**
Mailbox Monitor failed to access MSS via IMAPI.

**Description:**
This alarm indicates that the Mailbox Monitor application failed to access the Message Store Server (MSS) using the Intuity Messaging application program interface (IMAPI). This alarm can be raised by having a wrong IP address or password administered for a trusted server.

When this alarm is raised, you will typically see a number of trusted server login failures in the mmserver log.

**Repair Procedure:**
To correct the conditions which caused this alarm, you must determine what IP address or password has been administered incorrectly and correct it.

To find more detailed information about what caused this alarm to be generated, you can check the Windows event log. For the procedure to check the Windows event log, see Displaying the MAS event and error logs on page -3.

**MM PERF 17**

**Level:**
Minor

**System descriptor:**
Performance counter (virtual byte) for mailbox monitor server process greater than 1.6GB

**Description:**
This alarm indicates that the performance counter (virtual byte) for the Mailbox Monitor server process is greater than 1.6 GB. This means that the Mailbox Monitor process has exceeded the recommended virtual memory usage.

This problem is typically caused by memory leaks in the system. When this happens, the system can become unstable, and one or more processes or services can begin to fail.
Repair Procedure:
To recover from this alarm, you must stop and restart the Mailbox Monitor (MM Mailbox Monitor) service. For the procedure to stop and restart this service, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

**MM PERF 18**

**Level:**
Major

**System descriptor:**
Performance counter (virtual byte) for mailbox monitor server process greater than 1.8GB

**Description:**
This alarm indicates that the performance counter (virtual byte) for the Mailbox Monitor server process is greater than 1.8 GB. This means that the Mailbox Monitor process has exceeded the recommended virtual memory usage.

This problem is typically caused by memory leaks in the system. When this happens, the system can become unstable, and one or more processes or services can begin to fail.

**Repair Procedure:**
To recover from this alarm, you must stop and restart the Mailbox Monitor (MM Mailbox Monitor) service. For the procedure to stop and restart this service, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.
MT (Maintenance) alarms

The following alarms are generated by the MT application and indicate a problem with the maintenance system on the affected MAS:

- **MT ABS_PROC 1**
- **MT ABS_PROC 2**
- **MT ABS_PROC 3**
- **MT ABS_PROC 4**
- **MT ABS_PROC 5**
- **MT ABS_PROC 6**
- **MT ABS_PROC 7**
- **MT PERF 6**
- **MT PERF 10**
- **MT PERF 19**
- **MT ALARM_ORIG 0**
- **MT ALARM_ORIG 1**
- **MT PERF 6**
- **MT PERF 19**

**MT ABS_PROC 1**

**Level:**
Major

**System descriptor:**
vserver process not running

**Description:**
This alarm indicates that the MM Messaging Application Server service is not running.

**Repair Procedure:**
When the MM Messaging Application Server service restarts successfully, then the system considers the alarm resolved and generates a resolved-alarm event.

If you see this alarm, you can do the following:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click **Start > Programs > Administrative Tools > Services.**

2. In the **Tree** pane, select **Services (Local).**

3. In the services list pane, locate the service **MM Messaging Application Server,** and verify that:
   - The **Status** column entry reads **Started.**
     If the Status column does not indicate that the service is started, you can try to start it manually by double-clicking the service entry and then clicking **Start.**
   - The **Startup Type** column reads **Automatic.**

If the system display does not meet these conditions, or if the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.
MT ABS_PROC 2

Level:
Warning

System descriptor:
Tracing server not running

Description:
This alarm indicates that the MM Tracing Server service is not running.

Repair Procedure:
When the MM Tracing Server service restarts successfully, then the system considers the alarm resolved and generates a resolved-alarm event.

If you see this alarm, you can do the following:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. In the Tree pane, select Services (Local).

3. In the services list pane, locate the service MM Tracing Server, and verify that:
   - The Status column entry reads Started.
     If the Status column does not indicate that the service is started, you can try to start it manually by double-clicking the service entry and then clicking Start.
   - The Startup Type column reads Automatic.

If the system display does not meet these conditions, or if the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.

MT ABS_PROC 3

Level:
Minor

System descriptor:
MWI server not running

Description:
This alarm indicates that the MM Messaging Waiting Indicator Server service is not running.
**MAS Alarms**

**Repair Procedure:**

When the MM Message Waiting Indicator Server service restarts successfully, then the system considers the alarm resolved and generates a resolved-alarm event.

If you see this alarm, you can do the following:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.
2. In the Tree pane, select Services (Local).
3. In the services list pane, locate the service MM Message Waiting Indicator Server, and verify that:
   - The Status column entry reads Started.
     - If the Status column does not indicate that the service is started, you can try to start it manually by double-clicking the service entry and then clicking Start.
   - The Startup Type column reads Automatic.
     - If the system display does not meet these conditions, or if the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.

**MT ABS_PROC 4**

**Level:**
- Minor

**System descriptor:**
- mailbox monitor process not running

**Description:**
- This alarm indicates that the MM Mailbox Monitor Server service is not running.

**Repair Procedure:**
- When the MM Mailbox Monitor Server service restarts successfully, then the system considers the alarm resolved and generates a resolved-alarm event.

If you see this alarm, you can do the following:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.
2. In the Tree pane, select Services (Local).
3. In the services list pane, locate the service **MM Mailbox Monitor Server**, and verify that:

- The **Status** column entry reads **Started**.
  
  If the Status column does not indicate that the service is started, you can try to start it manually by double-clicking the service entry and then clicking **Start**.
  
- The **Startup Type** column reads **Automatic**.
  
  If the system display does not meet these conditions, or if the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.

### MT ABS_PROC 5

**Level:**

Minor

**System descriptor:**

call me server not running

**Description:**

This alarm indicates that the MM Call Me Server service is not running.

**Repair Procedure:**

When the MM Call Me Server service restarts successfully, then the system considers the alarm resolved and generates a resolved-alarm event.

If you see this alarm, you can do the following:

1. Start the services Monitor application by doing one of the following:
   
   - Double-click the **Monitor.msc** icon on your desktop.
   
   - Click **Start > Programs > Administrative Tools > Services**.

2. In the **Tree** pane, select **Services (Local)**.

3. In the services list pane, locate the service **MM Call Me Server**, and verify that:
   
   - The **Status** column entry reads **Started**.
     
     If the **Status** column does not indicate that the service is started, you can try to start it manually by double-clicking the service entry and then clicking **Start**.

   - The **Startup Type** column reads **Automatic**.
     
     If the system display does not meet these conditions, or if the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.
MT ABS_PROC 6

**Level:**
Minor

**System descriptor:**
Event monitor server not running

**Description:**
This alarm indicates that the MMEventLogMonitor service is not running.

**Repair Procedure:**
When the MMEventLogMonitor service restarts successfully, then the system considers the alarm resolved and generates a resolved-alarm event.

If you see this alarm, you can do the following:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click **Start > Programs > Administrative Tools > Services**.
2. In the **Tree** pane, select **Services (Local)**.
3. In the services list pane, locate the service **MMEventLogMonitor**, and verify that:
   - The **Status** column entry reads **Started**.
     
     If the Status column does not indicate that the service is started, you can try to start it manually by double-clicking the service entry and then clicking **Start**.
   - The **Startup Type** column reads **Automatic**.

If the system display does not meet these conditions, or if the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.

MT ABS_PROC 7

**Level:**
Minor

**System descriptor:**
Performace Counter server not running

**Description:**
This alarm indicates that the MM Performance Counter Monitor service is not running.
Repair Procedure:
When the MM Performance Counter Monitor service restarts successfully, then the system considers the alarm resolved and generates a resolved-alarm event.

If you see this alarm, you can do the following:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. In the Tree pane, select Services (Local).

3. In the services list pane, locate the service MM Performance Counter Monitor, and verify that:
   - The Status column entry reads Started.
     If the Status column does not indicate that the service is started, you can try to start it manually by double-clicking the service entry and then clicking Start.
   - The Startup Type column reads Automatic.

If the system display does not meet these conditions, or if the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.

MT ALARM_ORIG 0

Level: Minor
System descriptor: Event/Module ID not in module’s rules file
Description: This alarm indicates that there was an event or module identified in the alarming service that is not defined in the alarming service’s rules file.
Repair Procedure: When this alarm is generated, if you have a valid service contract, the system automatically sends a notification to Avaya technical services. No further action is required on your part.

If you do not have a valid service contract, then you should contact your Modular Messaging service or technical support representative for assistance.

MT ALARM_ORIG 1

Level: Warning
System descriptor:
Too many call attempts

Description:
This alarm indicates that the system has been trying unsuccessfully to send alarm notifications for an extended period of time. When trying to send alarm notifications, if the first attempt is unsuccessful, then the system tries again at five-minute intervals. If still unsuccessful after 16 tries, then the system stops trying and generates this warning alarm.

Repair Procedure:
The recommended repair action for this alarm depends on which method you are using to send alarm notifications:

- If you are using INADS:
  1. Verify that your modem is connected, powered up, and running properly.
  2. Verify that your system is properly configured for INADS.

    For information about INADS configuration, see Configuring MAS serviceability on page -16.

- If you are using SNMP:
  1. Verify that your MAS can communicate with your SNMP network management station.
  2. Verify that your system is properly configured for SNMP notifications.

    For information about SNMP configuration, see Configuring Serviceability - Voice Mail Domain, SNMP properties on page -41.

If you have completed these steps and the problem still exists, then run the testaom command in a Command Prompt window. This command provides more detailed diagnostic information, which may help you resolve the problem.

Once you have resolved the problem, to clear this warning alarm from the system and verify that the problem no longer exists, run the testaom command again.

If you have tried all this, and the problem still exists, then you should contact your Modular Messaging service or technical support representative for assistance.

---

MT PERF 6

Level:
Warning

System descriptor:
MAS CPU occupancy > 90%

Description:
This warning alarm indicates that the CPU of the MAS has run at greater than 90% of its capacity more than four times within an hour.
Repair Procedure:
Once this alarm has been raised, the system continues monitoring. If the occupancy rate subsequently falls below 70% and remains there for at least an hour, then the problem is considered resolved and the system automatically generates a resolved-alarm event.

If the system does not automatically resolve this alarm, you can open the Windows Task Manager and see what processes are putting significant demands on the CPU. If the processes are unrelated to Modular Messaging and you can safely stop them, then do so. If the processes are related to Modular Messaging, then it may indicate a more serious problem requiring in-depth attention. If that is the case, contact your Modular Messaging service or technical support representative for assistance.

MT PERF 10

Level: Major

System descriptor: MAS disk space > 90%

Description: This alarm indicates that the MAS disk space is 90% or more full.

Repair Procedure: Once this alarm has been raised, the system continues monitoring. If the disk space usage subsequently falls below 90%, then the problem is considered resolved and the system automatically generates a resolved-alarm event.

If you see this alarm, you can check your system for excessively large files. The log files can become excessively large if not managed properly, and you may need to reconfigure your system to limit the size of these files. For the procedure to do this, see the installation guide for your system.

Also, if you have other files which seem to be consuming a large amount of space, see if you can eliminate or compress them.

MT PERF 19

Level: Major

System descriptor: UMROOT\Serviceability\StopServiceMP.exe*:“MAS disk space < 250MB

Description: This alarm indicates that the available disk space on the MAS is less than 250 MB. When this happens, the system runs a maintenance procedure (MP) that stops the primary MAS. If the option to shut down gracefully is selected, then it does so according to the rules of a graceful shutdown.
MAS Alarms

Repair Procedure:
To correct the condition that causes this alarm, you must free some disk space or add more disk space to the system. To free up disk space, you can

- Use the Windows system Disk Cleanup tool.
- Run the Window system Disk Defragmenter tool.
- Run the chkdsk command.

If the alarm persists after these actions have been taken, then contact your Avaya technical support representative for assistance.
MW (Message Waiting Indicator) alarms

The following alarms are generated by the Message Waiting Indicator (MWI) application and indicate a problem with the MWI server process on the affected MAS:

- MW PERF 15
- MW PERF 17

MW PERF 15

Level:
Minor

System descriptor:
Performance counter (virtual byte) for mwi server process greater than 1.6GB

Description:
This alarm indicates that the performance counter (virtual byte) for the MWI server process is greater than 1.6 GB. This means that the MWI server process has exceeded the recommended virtual memory usage.

This problem is typically caused by memory leaks in the system. When this happens, the system can become unstable, and one or more processes or services can begin to fail.

Repair Procedure:
To recover from this alarm, you must stop and restart the MWI (MM Message Waiting Indicator Server) service. For the procedure to stop and restart this service, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

MW PERF 16

Level:
Major

System descriptor:
Performance counter (virtual byte) for mwi server process greater than 1.8GB

Description:
This alarm indicates that the performance counter (virtual byte) for the MWI server process is greater than 1.8 GB. This means that the MWI server process has exceeded the recommended virtual memory usage.

This problem is typically caused by memory leaks in the system. When this happens, the system can become unstable, and one or more processes or services can begin to fail.

Repair Procedure:
To recover from this alarm, you must stop and restart the MWI (MM Message Waiting Indicator Server) service. For the procedure to stop and restart this service,
MAS Alarms

service, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.
TS (tracing server) alarms

The following alarms are generated by the tracing server application and indicate a problem with the tracing server application on the affected MAS:

- **TS PERF 13**

  **Level:**
  Minor

  **System descriptor:**
  Performance counter (virtual byte) for tracing server process greater than 1.6GB

  **Description:**
  This alarm indicates that the performance counter (virtual byte) for the tracing server process is greater than 1.6 GB. This means that the tracing server process has exceeded the recommended virtual memory usage.

  This problem is typically caused by memory leaks in the system. When this happens, the system can become unstable, and one or more processes or services can begin to fail.

  **Repair Procedure:**
  To recover from this alarm, you must stop and restart the tracing (MM Tracing Server) service. For the procedure to stop and restart this service, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

- **TS PERF 14**

  **Level:**
  Major

  **System descriptor:**
  Performance counter (virtual byte) for tracing server process greater than 1.8GB

  **Description:**
  This alarm indicates that the performance counter (virtual byte) for the tracing server process is greater than 1.8 GB. This means that the tracing server process has exceeded the recommended virtual memory usage.

  This problem is typically caused by memory leaks in the system. When this happens, the system can become unstable, and one or more processes or services can begin to fail.

  **Repair Procedure:**
  To recover from this alarm, you must stop and restart the tracing (MM Tracing Server) service. For the procedure to stop and restart this service, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.
VB (Avaya Voice Browser) alarms

The following alarms are generated by the Avaya Voice Browser application and indicate a problem with the Avaya Voice Browser application on the affected MAS:

- **VB VB 1**
- **VB VB 1a**
- **VB VB 202**
- **VB VB 203**
- **VB VB 204**
- **VB VB 205**
- **VB VB 209**
- **VB VB 210**
- **VB VB 212**
- **VB VB 999**

### VB VB 1

**Level:**
Minor

**System descriptor:**
Avaya Voice Browser: Unable to initialize

**Description:**
This alarm indicates that the Avaya Voice Browser application was unable to initialize.

**Repair Procedure:**
When this alarm is generated, the system runs a maintenance procedure (MP) to attempt to restart the Avaya Voice Browser. If the Voice Browser software starts, then the system generates a resolved alarm event.

If the system cannot start the Voice Browser, it may indicate that there is a coding problem, that the Voice Browser cannot communicate with other parts of the system, or that the MAS configuration has become corrupted. The repair action will depend on the cause of the problem. If this alarm keeps being generated, contact your Avaya technical support representative for assistance.

### VB VB 2

**Level:**
Major

**System descriptor:**
Restarting Avaya Voice Browser

**Description:**
This alarm indicates that a serious error has occurred with respect to the Avaya Voice Browser application. As a result, a maintenance procedure (MP) has stopped and restarted the Voice Browser software.
Repair Procedure:
This alarm is considered self-repairing and indicates that the system is attempting to resolve it itself. If you see this alarm repeatedly or persistently, contact your Avaya technical support representative for assistance.

VB VB 202

Level:
Major

System descriptor:
Avaya Voice Browser: Out Of Memory

Description:
The system raises this alarm when the Avaya Voice Browser application requests memory and the return code says there is none. Therefore, the Avaya Voice Browser cannot start.

Repair Procedure:
To correct this error, try rebooting the system. If that does not correct the problem, contact your Avaya technical support representative for assistance.

VB VB 203

Level:
Minor

System descriptor:
Avaya Voice Browser: Bad URI fetch

Description:
This alarm indicates that an attempt by the Avaya Voice Browser application for a Universal Resource Identifier (URI) resulted in an error response from the web server. The system Internet Information Server (IIS) software generates this alarm when one of the following conditions exists:

- The web content contains coding errors.
- There is an internal conflict within the IIS software itself.
- The MAS cannot contact the message store server (MSS).
- When the configuration of our web application has been altered.

In the first three cases, when this alarm is generated, the system terminates the phone call in which it was generated, with a prompt to the effect that “I’m sorry, but this call is experiencing difficulty.” Other calls should be unaffected. If, however, an application configuration problem is causing it, then all calls coming in will experience the same response.

Repair Procedure:
The repair/recovery procedure for this alarm depends on the initial cause:
If the cause is that the web content contains coding errors, then this error will be generated for any call that attempts to access that web content. This will continue until the coding error has been corrected.

If there is an internal conflict within the IIS software, in most cases, the problem will correct itself with the next call. If not, then it may be necessary to reboot the system, which should correct the problem.

If the MAS cannot contact the message store server, in most cases, the problem will correct itself with the next call. If not then it may be necessary to reboot the system, which should correct the problem.

If the configuration of our web application has been altered, and all calls are having problems, then you must reinstall the system software.

If none of these actions correct the problem, then contact your Avaya technical support representative for assistance.

**VB VB 204**

**Level:**
Minor

**System descriptor:**
Avaya Voice Browser: Cannot read from URI

**Description:**
This alarm indicates that a connection to the Internet Information Server (IIS) software has been made, but the response to the request cannot be read. When this happens, the system terminates the phone call in which it was generated, with a prompt to the effect that “I'm sorry, but this call is experiencing difficulty.” Other calls should be unaffected.

**Repair Procedure:**
In most cases, the problem will correct itself with the next call. If not, then it may be necessary to reboot the system, which should correct the problem. If that still does not correct the problem, then contact your Avaya technical support representative for assistance.

**VB VB 205**

**Level:**
Minor

**System descriptor:**
Avaya Voice Browser: Cannot parse content from URI

**Description:**
This alarm indicates that the Avaya Voice Browser application successfully returned the Universal Resource Identifier (URI), but returned malformed VoiceXML. This indicates some sort of error in the web content code. When this
happens, Voice Browser cannot parse the content from the URI, and the call is terminated.

**Repair Procedure:**
Any call that attempts to access the URI will generate this alarm until the error in the web content code is corrected.

---

**VB VB 209**

**Level:**
Minor

**System descriptor:**
Avaya Voice Browser: Caught fatal exception

**Description:**
This alarm indicates that the Avaya Voice Browser application contains an error in the code. When this alarm is raised, the system terminates the call.

**Repair Procedure:**
Debug the application to locate and fix the error in the code. Contact your Avaya technical support representative to report the problem and get assistance.

---

**VB VB 210**

**Level:**
Minor

**System descriptor:**
Avaya Voice Browser: Surpassed maximum loop iterations

**Description:**
The Avaya Voice Browser contains a mechanism that prevents out-of-control web content in the form of pages that jump to other pages without human intervention in a never-ending loop. When this occurs, the system raises this alarm and terminates the call.

**Repair Procedure:**
Investigation is required to find out what caused the condition to occur and correct it. You may need to contact your Avaya technical support representative for assistance.

---

**VB VB 212**

**Level:**
Minor

**System descriptor:**
Avaya Voice Browser: Caught JavaScriptError exception
MAS Alarms

Description:
This alarm indicates that the Avaya Voice Browser application caught a JavaScriptError exception. This indicates a coding error in the JavaScript of the web page being called. When this alarm is raised, the system terminates the call.

Repair Procedure:
Any call that attempts to access the web page will generate this alarm until the error in the JavaScript code is corrected.

VB VB 999

Level:
Minor

System descriptor:
Avaya Voice Browser: Internal Voice Browser error

Description:
This alarm indicates that the Avaya Voice Browser application experienced an internal voice browser error. It indicates an error in the code. When this alarm is raised, the system terminates the call.

Repair Procedure:
Debug the application to locate and fix the error in the code. Contact your Avaya technical support representative to report the problem and get assistance.
VS (Voice server, MAS-specific) alarms

The following alarms are generated by the VS application and indicate a problem specific to the affected MAS:

- VS COM 1
- VS COM 2
- VS DOMEX 1
- VS EXCEPTION 1
- VS EXCEPTION 2
- VS EXCEPTION 3
- VS FEDB 1
- VS FEDB 2
- VS FEDB 3
- VS MAILBOX 1
- VS MSS 1
- VS MWI 1

- VS Octel Analog Networking 1
- VS OPHIST 1
- VSPERF 1
- VSPERF 2
- VSPERF 3
- VSPERF 4
- VSPERF 11
- VSPERF 12
- VSPERF 1
- VSPERF 2
- VSPERF 3
- VSPERF 4
- VSPERF 11
- VSPERF 12

- VS PORT 3
- VS PORT 4
- VS PORT 5
- VS RHETORIX 1
- VS SERVICE 6
- VS SPOOL 1
- VS SWLINK 1
- VS VOICE 1
- VS VOICE 2
- VS VOICE 3
- VS VOICE 4

VS COM 1

Level:
Major

System descriptor:
Voice Server Framework unable to load COM Configuration Manager. See windows event log for details.

Description:
This alarm is raised when Voice Server Framework is unable to load the COM Configuration Manager. This problem typically occurs during boot-up. It means that the MAS software is not running correctly.

Repair Procedure:
When this alarm is raised, the MAS automatically reboots (forcibly, not gracefully) to correct the problem. This alarm typically occurs during initial boot-up, and the automatic reboot usually resolves the problem.

If after rebooting, the problem still exists, the system raises the alarm again, but the system does not automatically reboot again within 30 minutes. For more details about what is going on, you can check the event log (see Displaying the MAS event and error logs on page -3).

If this happens, contact your Modular Messaging service or technical support representative immediately, as this alarm indicates that you have no messaging server functions.
VS COM 2

Level:
Major

System descriptor:
Failed to initialize COM security for voice server. See windows event log for details.

Description:
This alarm indicates that the system has failed to initialize the COM Security module for the affected MAS. When this alarm is raised, the system runs an application that automatically and immediately busies all ports, thus effectively stopping all communications on the MAS and rendering it non-functional.

Repair Procedure:
This problem requires a manual fix by qualified technical support personnel. If you see this alarm, contact your Modular Messaging service or technical support representative immediately, as this alarm indicates that your MAS is not allowing any communications at all.

Once the manual fix has been applied, the repair procedure requires a reboot of the system, which should clear and resolve this alarm.

VS DOMEX 1

Level:
Warning

System descriptor:
Inaccessible Domino/Exchange server(s)

Description:
This alarm indicates that the affected MAS cannot communicate with one or more Microsoft Exchange or IBM Lotus Domino back-end servers.

Repair Procedure:
If you see this alarm, attempt to locate the cause of the problem and resolve it by doing the following:

1. Verify that the affected Exchange/Domino servers are running properly (using your Exchange/Domino system documentation as necessary).

2. If they are running, verify that the connections between the MAS and the Exchange/Domino servers are good by running ping commands.

3. If the servers are able to communicate, use the services Monitor application (Monitor.msc) to check that the Modular Messaging services are configured and running properly on the MAS, by doing one of the following:

   ■ Double-click the Monitor.msc icon on your desktop.

   ■ Click Start > Programs > Administrative Tools > Services.
For more information about the configuration of Modular Messaging services, see the installation guide for your system.

If none of these steps identifies and resolves the cause of the problem and the alarm persists, then you should contact your Modular Messaging service or technical support representative for assistance.

VS EXCEPTION 1

**Level:**
Major

**System descriptor:**
1299/1300 exception - the voice server has terminated the thread that caused the error.

**Description:**
This alarm indicates that the MM Messaging Application Server service has terminated the thread that caused the error.

The system generates this alarm whenever the MM Messaging Application Server service generates more than ten exceptions with no specific handling code at an average rate faster than one every five minutes. When this alarm is generated, the system attempts to restart the MM Messaging Application Server service.

**Repair Procedure:**
If the MM Messaging Application Server service restarts successfully, then the system considers the alarm resolved and generates a resolved-alarm event.

If you see this alarm, you can do the following:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. In the Tree pane, select Services (Local).

3. In the services list pane, locate the service MM Messaging Application Server, and verify that:
   - The Status column entry reads Started.
   - The Startup Type column reads Automatic.

4. Manually (stop and) restart the MM Messaging Application Server service:

For the procedures to stop and restart the MAS service (MM Messaging Application Server), see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

If the system does not resolve the alarm automatically within a period of a few minutes and manually stopping and restarting it also does not resolve the alarm,
then contact your Modular Messaging service or technical support representative for assistance.

**VS EXCEPTION 2**

**Level:**
Warning

**System descriptor:**
An exception was caught and handled. The caller/subscriber was disconnected.

**Description:**
This alarm indicates that the MM Messaging Application Server service has caught and handled an exception. The system disconnected the caller or subscriber.

This alarm is generated by a Windows NT warning event 1772 or 1773.

**Repair Procedure:**
There is no repair procedure for this alarm. In most cases, it indicates that the system has handled the problem and recovered without intervention.

In the event that this is caused by a software bug, then this alarm may be generated repeatedly. In this case, the bug must be identified and repaired before the alarm stops being generated.

**VS EXCEPTION 3**

**Level:**
Major

**System descriptor:**
An exception was caught and handled. The caller/subscriber was disconnected. A MP was run.

**Description:**
This alarm indicates that the MM Messaging Application Server service has caught and handled an exception. The system disconnected the caller or subscriber. The system also ran a maintenance procedure (MP) to stop and restart the MM Messaging Application Server service.

This alarm is generated by a Windows NT warning event 1772 or 1773. It generally indicates a software bug.

**Repair Procedure:**
If the MM Messaging Application Server service restarts successfully, then the system considers the alarm resolved and generates a resolved-alarm event. Regardless, if this alarm is generated, you should contact your Avaya technical support representative and let them know about it.
VS FEDB 1

Level:
Minor

System descriptor:
A registry value in HKEY_LOCAL_MACHINE is incorrect. See windows event log for details.

Description:
This alarm indicates that the system had trouble reading a registry key in HKEY_LOCAL_MACHINE, or that the registry key is errant.

Repair Procedure:
Although there is no repair procedure for this alarm, you can identify the registry key that caused the problem by checking the Event Viewer Application log:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. In the Tree pane, select Event Viewer (Local), expanding the tree if necessary.

3. Double-click Application.
   The system displays the Application log.

4. Locate the most recent entry for a 1436 event.

If subsequent attempts to read the errant registry key succeed, then the system considers the alarm resolved and generates a resolved-alarm event. If the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.

VS FEDB 2

Level:
Minor

System descriptor:
FEDB resynchronization failed.

Description:
This alarm indicates that the system failed to synchronize with the front end database (FEDB).
Repair Procedure:
Although there is no repair procedure for this alarm, you can locate and view more detailed information about the failure by checking the Event Viewer Application log:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. In the Tree pane, select Event Viewer (Local), expanding the tree if necessary.

3. Double-click Application.
   The system displays the Application log.

4. Locate the most recent entry for a 1447 event.

If subsequent attempts to synchronize with the FEDB succeed, then the system considers the alarm resolved and generates a resolved-alarm event. If the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.

VS FEDB 3

Level:
Minor

System descriptor:
FEDB resynchronization started. All Ports will be disabled.

Description:
This alarm indicates that a full synchronization of the back end LDAP database with the front end database (FEDB) has been started. During a full synchronization, all necessary records from the LDAP store are copied to the FEDB (as opposed to normal operations in which only changed records are copied over).

While a full synchronization is in progress, all ports are disabled. When the synchronization has completed, the system again enables all ports.

Repair Procedure:
There is no repair or recovery procedure for this alarm, as it is considered a notification only. When the synchronization is complete, the system automatically re-enables all applicable ports.
VS MAILBOX 1

Level:
Major

System descriptor:
Voice Server failed to create the monitor mailbox. See windows event log for details.

Description:
This alarm indicates that the system failed to create the Monitor Mailbox. When this alarm is raised, the system runs an application that automatically and immediately busies all ports, thus effectively stopping all communications on the MAS and rendering it non-functional.

Repair Procedure:
This problem requires a manual fix by qualified technical support personnel. If you see this alarm, contact your Modular Messaging service or technical support representative immediately, as this alarm indicates that your MAS is not allowing any communications at all.

Once the manual fix has been applied, the repair procedure requires a reboot of the system, which should clear and resolve this alarm.

VS MSS 1

Level:
Major

System descriptor:
Inaccessible MSS server(s)

Description:
This alarm indicates that the affected MAS cannot communicate with the Avaya S3400-family Message Store Server (MSS back-end server). This can be caused, among other things, by taking the MSS offline for scheduled maintenance or updates.

Notes:
- If you have a multiple-MAS system, each MAS that is in communication with the affected MSS should generate this alarm.
- If you have a planned outage on the MSS (for a software update, for example), Avaya recommends that you manually disable MAS alarming for each MAS until the MSS is back online. For details about manually disabling MAS alarming, see Configuring Serviceability - Voice Mail Domain, General properties on page -39.
**MAS Alarms**

**Repair Procedure:**
If you see this alarm, attempt to locate the cause of the problem and resolve it by doing the following:

1. Verify that the affected MSS is running properly and is not in offline mode.
   
   For information on how to check your MSS for proper operation, see the MSS documentation for your system.

2. If the MSS is running, verify that the connections between the MAS and the MSS are good by running ping commands for both public and private IP addresses.

3. If the servers are able to communicate, use the services Monitor application (Monitor.msc) to check that the Modular Messaging services are configured and running properly on the MAS, by doing one of the following:

   - Double-click the **Monitor.msc** icon on your desktop.

   - Click **Start > Programs > Administrative Tools > Services**.

   For more information about the configuration of Modular Messaging services, see the installation guide for your system.

If none of these steps identifies and resolves the cause of the problem and the alarm persists, then you should contact your Modular Messaging service or technical support representative for assistance.

**VS MWI 1**

**Level:**
Minor

**System descriptor:**
MWI is having trouble.

**Description:**
This alarm indicates that there is a problem with the Message Waiting Indicator service.

The system generates this alarm whenever the MWI Failures KPI (event ID 1434) is incremented more than five times at an average rate faster than once every five minutes.

**Repair Procedure:**
The system is designed to restart the service whenever there is a failure. If it does so, and there is no new alarm generated within a 15-minute period, then the system considers the alarm resolved and generates a resolved-alarm event.
Although there is no repair procedure for this alarm, you can locate and view more detailed information about the failure by checking the Event Viewer Application log:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. In the Tree pane, select Event Viewer (Local), expanding the tree if necessary.

3. Double-click Application.
   The system displays the Application log.

4. Locate the most recent entry for a 1434 event.

If the system does not resolve the alarm automatically within a period of a few hours, contact your Modular Messaging service or technical support representative for assistance.

**VS OCTELNET 1**

**Level:**
Minor

**System descriptor:**
Can't restart Octel Analog Networking service or no telephone number found for destination node. See windows event log for details.

**Description:**
This alarm indicates that:
- The system cannot start or restart the Octel Analog Networking service.
- The system cannot find a valid telephone number for an Octel Analog Networking destination node.

**Repair Procedure:**
Although there is no repair procedure for this alarm, you can locate and view more detailed information about the failure by checking the Event Viewer Application log:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. In the Tree pane, select Event Viewer (Local), expanding the tree if necessary.
3. Double-click **Application**.
   
The system displays the Application log.

4. Locate the most recent entry for a 1393 or 1394 event.

If subsequent attempts to start the OctelAN service succeed, then the system considers the alarm resolved and generates a resolved-alarm event. If the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.

**VS OPHIST 1**

**Level:**
Warning or Minor

**System descriptor:**
Operation History Buffer is 40 percent full.

   OR

Operation History Buffer is 80 percent full.

**Description:**
If a warning, it indicates that the Operation History Buffer is more than 40% full.

If a minor alarm, it indicates that the Operation History Buffer is more than 80% full.

**Repair Procedure:**
Clear out space in the Operation History Buffer.

If the indication persists or recurs frequently, then you should contact your Modular Messaging service or technical support representative for assistance.

**VS PERF 1**

**Level:**
Warning

**System descriptor:**
Delayed Interaction Alarm

**Description:**
This alarm indicates that too many callers are experiencing delays while interacting with the system. An internal monitor checks the system every 15 minutes, and if three of these checks within an hour indicate that more than 1% of calls have experienced delays, the system generates this warning.

**Repair Procedure:**
There is no repair procedure for this warning. This alarm could be generated simply as a result of heavier than normal system traffic. Once the system indicates that fewer than 1% of calls are experiencing delays again, then the problem is
considered resolved and the system automatically generates a resolved-alarm event.

If you are seeing an excessive number of these warnings or they are not resolved within a reasonable amount of time, then you should contact your Modular Messaging service or technical support representative for assistance.

**VS PERF 2**

**Level:**
Warning

**System descriptor:**
Logons Aborted After Delay Alarm

**Description:**
The system generates this alarm when an excessive number of logon attempts are being aborted because of system delays. If more than five logon attempts are aborted at an average rate of more than one every five minutes, then the system generates this warning alarm.

**Repair Procedure:**
There is no repair procedure for this warning. Once this alarm has been raised, if the system then detects no new aborted logon attempts for 15 minutes, then the problem is considered resolved and the system automatically generates a resolved-alarm event.

If you are seeing an excessive number of these warnings or they are not resolved within a reasonable amount of time, then you should contact your Modular Messaging service or technical support representative for assistance.

**VS PERF 3**

**Level:**
Warning

**System descriptor:**
Spool queue length >= 200

**Description:**
This warning alarm indicates that the spool queue length is greater than or equal to 200. This means that the message spooler has 200 or more messages waiting to be delivered.

**Repair Procedure:**
There is no repair procedure for this warning. This condition can be caused simply by an excessive amount of message traffic during heavy traffic periods.

Once this alarm has been raised, if the system then detects that the spool queue length drops below 150, then the problem is considered resolved and the system automatically generates a resolved-alarm event.
If you are seeing an excessive number of these warnings or they are not resolved within a reasonable amount of time, then you should contact your Modular Messaging service or technical support representative for assistance.

VS PERF 4

Level: Warning

System descriptor: MAS active TUI ports greater than maximum number of ports

Description: This warning alarm indicates that the demand for active TUI ports exceeds the number of ports for which you are licensed.

This alarm may indicate that one or more ports is stuck. A stuck port is one that:

- Is not available to take or make calls
- Has been in its current Busy state for a period of time longer than the maximum allowable message time

To view and manage port status for the system, use the Port Monitor tool (see Using Port Monitor on page -8).

Repair Procedure:
When the system detects a stuck port, it automatically attempts to disable and re-enable the port. If it successfully does so, then the problem is considered resolved and the system automatically generates a resolved-alarm event.

If the system is not able to successfully disable and re-enable the stuck port, you can attempt to do so manually. For details on how to do this, see Managing port states on page -12.

As soon as a port becomes available, then the problem is considered resolved and the system automatically generates a resolved-alarm event.

If you are seeing these warnings on a regular basis, and there appears to be no problem with ports being stuck, it may indicate a need to increase the number of ports in your system.

If you are consistently having problems with stuck ports, or these alarms are not resolved within a reasonable amount of time, then you should contact your Modular Messaging service or technical support representative for assistance.

VS PERF 11

Level: Minor

System descriptor: Performance counter (virtual byte) for vserver process greater than 1.6GB
Description:
This alarm indicates that the performance counter (virtual byte) for the voice server process is greater than 1.6 GB. This means that the voice server process has exceeded the recommended virtual memory usage.

This problem is typically caused by memory leaks in the system. When this happens, the system can become unstable, and one or more processes or services can begin to fail.

Repair Procedure:
To recover from this alarm, you must stop and restart the voice server (MM Messaging Application Server service). For the procedure to stop and restart this service, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

VS PERF 12

Level:
Major

System descriptor:
Performance counter (virtual byte) for vserver process greater than 1.8GB

Description:
This alarm indicates that the performance counter (virtual byte) for the voice server process is greater than 1.8 GB. This means that the voice server process has exceeded the recommended virtual memory usage.

This problem is typically caused by memory leaks in the system. When this happens, the system can become unstable, and one or more processes or services can begin to fail.

Repair Procedure:
To recover from this alarm, you must stop and restart the voice server (MM Messaging Application Server service). For the procedure to stop and restart this service, see Appendix C, Stopping and (re)starting Modular Messaging (MM) services.

VS PORT 0

Level:
Minor

System descriptor:
Port maintenance is required on channel. See windows event log for details.

Description:
This alarm indicates that port maintenance is required on the indicated channel. The system generates this alarm whenever a port has been idle for 16 hours or more.
Repair Procedure:
There is no recovery/repair procedure for this alarm. When the system generates this alarm, a maintenance procedure (MP) is run to disable and re-enable the affected port. Therefore, this alarm is considered self-correcting.

To find more detailed information about what caused this alarm to be generated, you can check the Windows event log. For the procedure to check the Windows event log, see Displaying the MAS event and error logs on page -3.

VS PORT 1

Level:
Major

System descriptor:
An error occurred while restarting telephony board drivers. See windows event log for details.

Description:
This alarm indicates that the system was not able to start or restart one or more telephony board drivers. When this alarm is raised, the system runs an application that automatically and immediately busies all ports, thus effectively stopping all communications on the MAS and rendering it non-functional.

Repair Procedure:
This problem requires a manual fix by qualified technical support personnel. If you see this alarm, contact your Modular Messaging service or technical support representative immediately, as this alarm indicates that your MAS is not allowing any communications at all.

Once the manual fix has been applied, the repair procedure requires a reboot of the system, which should clear and resolve this alarm.

VS PORT 2

Level:
Minor

System descriptor:
Port configuration corrupt. Voice server will not start.

Description:
This alarm indicates that the MAS could not read the port configuration for inbound ports successfully. This may mean that the inbound ports are either not configured properly or that the port configuration information for the system has been corrupted.

Repair Procedure:
Verify that the inbound ports are properly configured for your system (see the installation guide for your system).

If subsequent attempts to read the configuration for inbound ports succeed, then the system considers the alarm resolved and generates a resolved-alarm event.
If reconfiguring the inbound ports does not correct the problem, or if subsequent attempts by the system to read the inbound port configuration fail, then you should contact your Modular Messaging service or technical support representative for assistance.

**VS PORT 3**

**Level:**
Major

**System descriptor:**
The number of failed ports is above a significant level.

**Description:**
This alarm indicates that more than two thirds of the ports in the system are stuck. A stuck port is one that:

- Is not available to take or make calls
- Has been in its current Busy state for a period of time longer than the maximum allowable message time

To view and manage the status of ports on the system, use the Port Monitor tool (see [Using Port Monitor](#) on page -8).

**Repair Procedure:**
When the system detects stuck ports, it automatically attempts to disable and re-enable them. If it successfully does so with the stuck ports in this situation, and the number of stuck ports falls below one third of the total number, then the problem is considered resolved and the system automatically generates a resolved-alarm event.

If the system is not able to successfully disable and re-enable the stuck ports, you can attempt to do so manually. For details on how to do this, see [Managing port states](#) on page -12.

If the system cannot successfully reset the stuck ports, you have tried manually disabling and re-enabling the stuck ports, and the problem is still not resolved, then contact your Modular Messaging service or technical support representative for assistance.

**VS PORT 4**

**Level:**
Warning

**System descriptor:**
A channel has been disabled. See windows event log for details.

**Description:**
This alarm indicates that a channel port has been disabled.

**Repair Procedure:**
There is no repair procedure for this alarm.
MAS Alarms

To find more detailed information about what caused the port to become disabled, you can check the Windows event log. For the procedure to check the Windows event log, see Displaying the MAS event and error logs on page -3.

VS PORT 5

Level:
Minor

System descriptor:
A channel has failed. See windows event log for details.

Description:
This alarm indicates that a port has failed. This may result from a problem in the system, or it may occur because the system has been manually taken out of service.

Repair Procedure:
The system is designed to automatically re-enable ports, if possible, when they fail. If the system does not enable the port automatically, you can attempt to enable it manually. For the procedure, see Enabling ports on page -14.

To find more detailed information about what caused the port to fail, you can check the Windows event log. For the procedure to check the Windows event log, see Displaying the MAS event and error logs on page -3.

If manual attempts to re-enable the port still do not resolve the problem, or you are seeing a great number of these warnings, it may indicate a more serious problem within the system. Contact your Modular Messaging service or technical support representative for assistance.

VS RHETORIX 1

Level:
Minor

System descriptor:
Failed to restart telephony board drivers.

Description:
This alarm indicates that the Rhetorix drivers have not started.

You can locate and view more detailed information about this failure by checking the Event Viewer Application log:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. In the Tree pane, select Event Viewer (Local), expanding the tree if necessary.
3. Double-click **Application**.
   The system displays the Application log.

4. Locate the most recent entry for a 1099 event.

**Repair Procedure:**
When this alarm is raised, the system responds by attempting to stop and restart
the Rhetorix drivers. If successful, then the system considers the alarm resolved
and generates a resolved-alarm event.

If the system cannot successfully stop and restart the Rhetorix drivers, you can try
performing a manual shutdown and reboot of the system.

If this still does not resolve the problem, contact your Modular Messaging service
or technical support representative for assistance.

**VS SERVICE 6**

**Level:**
Major

**System descriptor:**
Service experienced restart problem. See windows event log for details.

**Description:**
This alarm indicates that a Modular Messaging service has stopped repeatedly for
some reason, or it has failed to restart. When the service first fails unintentionally,
the system attempts to restart it automatically. This alarm is raised only after one
such system automatic restart of the indicated service has failed again within a 30
minute period.

**Repair Procedure:**
When this alarm is raised, you can locate and view more detailed information
about the failure by checking the Event Viewer Application log:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click **Start > Programs > Administrative Tools > Services**.

2. In the **Tree** pane, select **Event Viewer (Local)**, expanding the tree if
   necessary.

3. Double-click **Application**.
   The system displays the Application log.

4. Locate the most recent entry for a 1242 event.

If the system does not resolve the alarm automatically within a period of a few
minutes, contact your Modular Messaging service or technical support
representative for assistance.
VS SPOOL 1

Level:
Minor

System descriptor:
Message spool directory access failed.

Description:
This alarm indicates that the system is unable to access the message spool directory.

Repair Procedure:
There is no repair procedure for this alarm. Once the alarm has been raised, if the system is then able to access the message spool directory, then the problem is considered resolved and the system automatically generates a resolved-alarm event.

When this alarm is raised, you can locate and view more detailed information about the failure by checking the Event Viewer Application log:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. In the Tree pane, select Event Viewer (Local), expanding the tree if necessary.

3. Double-click Application.
   The system displays the Application log.

4. Locate the most recent entry for a 1527 or (unintentional) 1014 event.

   Note: A manual service shutdown currently results in a 1014 event being generated.

If the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.

VS SWLINK 1

Level:
Minor

System descriptor:
Switch link is down.

Note: A manual service shutdown currently results in a 1014 event being generated.

If the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.
**Description:**
This alarm indicates that the system cannot verify that a switch link is operational.

**Repair Procedure:**
Verify that the switch link is operational. When it is, then the problem is considered resolved and the system automatically generates a resolved-alarm event.

If the system does not resolve the alarm automatically within a period of a few minutes, or you are seeing a great number of these warnings on your system, contact your Modular Messaging service or technical support representative for assistance.

**VS VOICE 1**

**Level:**
Minor

**System descriptor:**
Voice server service startup problem. See windows event log for details.

**Description:**
This alarm indicates that the MM Messaging Application Server service has stopped repeatedly for some reason, or it has failed to restart. When the service first fails unintentionally, the system attempts to restart it automatically. This alarm is raised only after one such system automatic restart of the indicated service has failed within a 30 minute period.

This alarm is related to the MT ABS_PROC 1 alarm.

**Repair Procedure:**
When this alarm is raised, you can locate and view more detailed information about the failure by checking the Event Viewer Application log:

1. Start the services Monitor application by doing one of the following:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. In the Tree pane, select Event Viewer (Local), expanding the tree if necessary.

3. Double-click Application.

   The system displays the Application log.

4. Locate the most recent entry for a 1242 event.

If the system does not resolve the alarm automatically within a period of a few minutes, contact your Modular Messaging service or technical support representative for assistance.
VS VOICE 2

Level:
Minor

System descriptor:
The primary and secondary server names for remote integration are invalid.

Description:
This alarm indicates that the primary and/or secondary server names for remote integration are invalid.

Repair Procedure:
Verify that the system has the correct primary and secondary server names configured for remote integration.

Once the primary and secondary remote server names are recognized as being valid, then the problem is considered resolved and the system automatically generates a resolved-alarm event.

If the remote server names are configured properly and the alarm persists, contact your Modular Messaging service or technical support representative for assistance.

VS VOICE 3

Level:
Major

System descriptor:
The product license is invalid/expired. Please obtain a new license.

Description:
This alarm indicates that the Avaya Modular Messaging product license either is invalid or has expired.

Repair Procedure:
Contact your Modular Messaging service or technical support representative for a new product license.

VS VOICE 4

Level:
Minor

System descriptor:
The license does not refer to the existing platform.

Description:
This alarm indicates that the Avaya Modular Messaging product license does not refer to the existing platform.
Repair Procedure:
Contact your Modular Messaging service or technical support representative for assistance.
Appendix B: Examples of Caller Applications

This appendix provides examples of caller applications, including ideas on how to use them effectively, how to design and create them, and how to deploy them.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A word to AUDIX users</td>
<td>B-2</td>
</tr>
<tr>
<td>The caller application creation process</td>
<td>B-4</td>
</tr>
<tr>
<td>Examples of caller applications</td>
<td>B-5</td>
</tr>
</tbody>
</table>
A word to AUDIX users

Those who are coming from and familiar with an Intuity AUDIX environment should be aware that there are some fundamental differences between the way that AUDIX and the way that Modular Messaging handle call flows.

Automated attendants versus caller applications

In the AUDIX environment, caller interaction is controlled mostly through the use of “automated attendants,” and particularly “nested automated attendants.” Modular Messaging achieves the same kind of functionality—and often much more easily!—with the use of caller applications.

In the Modular Messaging environment, the term “automated attendant” is reserved strictly for the system Automated Attendant and has a much narrower use. The Automated Attendant in Modular Messaging is, generally speaking, a top-level menu that acts as a gateway into the system. Though the system Automated Attendant can be used in an even stricter sense to provide only one route into the system—such as a simple call transfer—, that is not the way it is designed to be used. In a case like this, a caller application would be much easier and more efficient to use.

Therefore, if you want to use multiple levels of menus and a wider range of caller options in Modular Messaging, you must use caller applications (which, again, are roughly analogous to nested automated attendants).

“Bottom-Up” versus “Top-Down”

System designers in the AUDIX environment are advised to plan their systems carefully, then start at the deepest level of menus (the “bottom”) and work their way up from there.

Although in real world practice there is some parallel in Modular Messaging (for instance, we also strongly recommend careful planning), Modular Messaging makes it much easier and often more practical to design and build from the top levels and work your way down. This aspect of Modular Messaging design also makes it somewhat easier to add on to your caller applications later, should you find the need.

A brief comparison of AUDIX versus Modular Messaging functionality

Although the end result is the same in many cases, AUDIX and Modular Messaging sometimes take different approaches to get there. The following is a brief summary of how AUDIX and Modular Messaging handle various functions or tasks, summarizing both the similarities and the differences:

Note: This is by no means an exhaustive list of the differences and similarities, but merely a representative sampling.
Examples of Caller Applications

<table>
<thead>
<tr>
<th>Intuity AUDIX</th>
<th>Modular Messaging</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uses “automated attendants” and “nested automated attendants”.</td>
<td>Uses caller applications and application nodes.</td>
</tr>
<tr>
<td>Must create the “main automated attendant” as the starting point.</td>
<td>May use the system (built-in) Automated Attendant or bypass it in favor of a caller application as the starting point.</td>
</tr>
<tr>
<td>Automated attendants are always treated as subscriber mailboxes. Automated attendants require no special treatment after being created, other than a special mailbox property designating them as automated attendants.</td>
<td>Caller applications may use ID numbers similar to subscriber mailbox numbers, but are not required to do so, and they are not necessarily treated as subscriber mailboxes. Also, caller applications must be deployed on the system after being created.</td>
</tr>
<tr>
<td>Automated attendants may have up to 10 options, corresponding with the touchtone keys 0 through 9.</td>
<td>Caller applications may have up to 11 menu options, corresponding with all touchtone keys, including the * and # keys (minus the key assigned for cancellation operations).</td>
</tr>
<tr>
<td>You may administer the automated attendant as an extension on the switch or solely in the AUDIX system (as an internal extension only).</td>
<td>You may administer caller application ID numbers on the switch or solely in the Modular Messaging system (as an internal extension only).</td>
</tr>
<tr>
<td>Requires * 8 for transfers.</td>
<td>Offers built-in transfer capability.</td>
</tr>
<tr>
<td>Allows up to 4 special (“holiday”) schedules to be defined and in use at one time.</td>
<td>Allows up to 18 special (“holiday”) schedules to be defined and in use at one time.</td>
</tr>
<tr>
<td>Multi-lingual options may be configured using system-wide and subscriber-specific settings or an automated attendant.</td>
<td>Multi-lingual options may be configured using either the system Automated Attendant, subscriber-specific settings, or a caller application.</td>
</tr>
<tr>
<td>Allows call routing based on a time-of-day schedule.</td>
<td>Allows call routing based on a time-of-day schedule.</td>
</tr>
<tr>
<td>Prompts are created as “mailbox greetings” (thus offering little quality control over recordings).</td>
<td>Prompts created either as recorded (*.wav) files embedded in caller application or as “mailbox greeting” (announcements).</td>
</tr>
</tbody>
</table>
The caller application creation process

The following is a brief overview of the basic process you should use to create and deploy caller applications. For a more thorough presentation and discussion of this process, see Creating caller applications (process overview) in Chapter 11.

The recommended process of creating caller applications for use on your system is a six-step process:

1. Plan carefully!
2. Set up your targets.
3. Build the caller application(s).
4. Record and assign prompts.
5. Deploy the application.
6. Analyze the application.

This basic process is illustrated in the first caller application example that follows. For the remaining examples, only the process of building the caller application (Step 3) and other significant considerations will be presented.
Examples of caller applications

To help you get a better feel for the caller application design and deployment process, we offer the following examples of some typical kinds of caller applications and their use:

- **Example 1: Alternative "Auto Attendant" Main Menu**
- **Example 2: Call transfer using Dial By Name**
- **Example 3: Automated fax attendant**
- **Example 4: Shared extension**
- **Example 5: Non-resident subscribers**
- **Example 6: Bulletin boards and daily announcements**
Example 1: Alternative “Auto Attendant” Main Menu

This example has been created to illustrate how you can use a caller application as an alternative to the system Automated Attendant. This caller application is designed to be the caller’s first contact with the system.

The scenario

XYZ Company has operations throughout North America, including Mexico and French-speaking areas of Canada. For this reason, they want their callers to have the option to continue in either Spanish or French. However, they also want to:

- Allow callers to reach the intended party’s extension at any time by entering the subscriber’s extension.
- Use a custom prompt before the transfer if a caller chooses to transfer to the operator.
- Allow callers to reach the Technical Support department, with the call being automatically directed either to the Help Desk live extension (during business hours) or to the Tech Support voice mailbox (after business hours).
- Give callers the option to hear the menu again, using the 9 key.

Since the system Automated Attendant does not perform any of these options, and since they are not concerned about using the call blocking, call screening, and intercom paging features, XYZ has decided to disable the system Automated Attendant and use a custom one instead, in the form of a caller application.

Planning the application

After discussing their business needs, XYZ Company devised the following caller application diagram.
Examples of Caller Applications

Figure B-3.

Menu with extension

- Thank you for calling...
- If you know the extension number of the party...
- To speak with an operator, press 0.
- To contact technical support, press 1.
- Para continuar en español, prensa 2.
- Pour continuer en français, pression 3.
- To hear this menu again, press #.

Legend

Node
Action type
Prompt
User or system response

System transfers caller to extension 5nnnn

Transfer to operator

Conditional goto by TOD

Goto Spanish caller app

Goto French caller app

Spanish caller app

Transfer to extension 50000

Transfer to mailbox 50000

Caller reaches MAS

Goto
(no prompt)

Goto
(no prompt)

Goto
(no prompt)

French caller app

During business hours

After hours
Examples of Caller Applications

Notes: With respect to this call flow, note the following:

- The yellow areas (boldface) indicate what type of action is assigned to the node. The blue areas indicate what the prompt is to say (if anything). The pink areas indicate some action or response taken by either the caller or the MAS.

- The caller application base node is of action type **Menu with extension**. This allows callers to dial a subscriber’s extension number, which on XYZ Company’s system must have 5 as the first digit.

- The **Conditional goto** node routes the caller to the Tech Support Help Desk or voice mailbox, depending on what time the call comes in. To accomplish this, though, you must reserve two other key presses, in this case the 7 and the 8. These keys were chosen so as to minimize the likelihood of a caller pressing the wrong key and getting one of these options by mistake.

- The caller can reach the Technical Support help desk or voice mailbox directly by pressing 7 or 8, respectively, but you do not want to include that as an option in the main menu prompt. This is indicated by the dotted lines.

- The multi-language options (2 and 3) both exit this caller application to access other caller applications. XYZ Company planned these applications during the planning phase, but they are not shown here.

- Key presses of 4, 6, other multi-digit key press combinations that are not valid extensions or mailboxes will result in an “invalid response” prompt from the system.

Setting up the targets

Before building the application, you must set up the following targets:

- System operator phone number (see Configuring TUI receptionist properties on page 3-6)

- Technical Support Help Desk extension number 50000

- Technical Support voice mailbox number 50000

- (Recommended, but not required) The Spanish language caller application
Building the application

The following table presents a step-by-step method for building the caller application. It assumes that you have already started the Caller Applications Editor. The Action(s) column gives a description of the step in the process, and the Location of procedure(s) column provides a link to the detailed procedure in the documentation that tells how to perform the step.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create the caller application base node. Name it <strong>Main Menu</strong>. Provide a brief description and select the language.</td>
<td>Adding the base caller application node on page 11-18</td>
</tr>
</tbody>
</table>
| 2    | Modify the caller application base node properties:  
- Select **Menu with extension** as the action type.  
- Select **Play entry prompt** and then select **Application prompt**.  
- Add a prompt and enter “Welcome and Main Menu” under Comments.  
**Note:** You will not actually record the prompt at this point, you are merely creating a placeholder for it.  
- Verify that the application is set to use the Default operator, <Parent node> as the Default cancel setting, and the * key as the Default cancel key. | Configuring the caller application properties on page 11-19 |
| 3    | Add an application (action) node to the base node. This node will transfer the caller to the operator.  
- Name it **Transfer to operator**.  
- Select **Transfer** as the action type.  
- Select 0 for the **Key press**.  
- Enter a brief description for it. | Adding the application action node on page 11-22 |
### Examples of Caller Applications

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
</table>
| 4    | Modify the application (action) node properties:  
- On the **General** tab, verify that **Operator** is selected.  
- Select **Play entry prompt** and then select **Application prompt**.  
- Add a prompt and enter “Please wait while I transfer you to the operator” under **Comments**.  
**Note:** You will not actually record the prompt at this point, you are merely creating a placeholder for it.  
|           | Configuring application (action) node properties on page 11-23 |
| 5    | Add another application (action) node to the base node. This node will be used by the **Conditional goto** node to transfer the caller to the Technical Support Help Desk during business hours.  
- Name the node **Transfer to Tech Support desk**.  
- Select **Transfer** as the action type.  
- Select 7 for the **Key press**.  
- Provide a brief description.  
|           | Adding the application action node on page 11-22 |
| 6    | Modify the application (action) node properties:  
- On the **General** tab, verify that **Extension** is selected and set **50000** as the extension number.  
- You do not need a prompt for this node, so verify that the **Play entry prompt** check box is cleared (**Prompt** tab).  
|           | Configuring application (action) node properties on page 11-23 |
### Examples of Caller Applications

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
</table>
| 7    | Add another application (action) node to the base node. This node will be used by the **Conditional goto** node to transfer the caller to the Technical Support voice mailbox after business hours.  
- Name the node **Transfer to Tech Support MB**.  
- Select **Transfer** as the action type.  
- Select 8 for the **Key press**.  
- Provide a brief description. | **Adding the application action node** on page 11-22 |
| 8    | Modify the application (action) node properties:  
- On the **General** tab, verify that **Mailbox** is selected and set 50000 as the mailbox number.  
- You do not need a prompt for this node, so verify that the **Play entry prompt** check box is cleared (**Prompt** tab). | **Configuring application (action) node properties** on page 11-23 |
| 9    | Add another application (action) node to the base node. This is the node that will actually transfer the caller to the appropriate Technical Support extension (during business hours) or voice mailbox (after business hours).  
- Name the node **Contact Technical Support**.  
- Select **Conditional goto** as the action type.  
- Select 1 for the **Key press**.  
- Provide a brief description. | **Adding the application action node** on page 11-22 |
### Examples of Caller Applications

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
</table>
| 10   | Modify the application (action) node properties:  
- On the **General** tab, select node 7 as the **During hours node**.  
- Select 8 as the **After hours node**.  
- Because XYZ Company wants the help desk available only during regular business hours, click **Weekly schedule**... and set the schedule grid to be active Monday through Friday from 8:00 a.m. to 6:00 p.m.  
You do not need a prompt for this node, so verify that the **Play entry prompt** check box is cleared (Prompt tab). | **Configuring application (action) node properties** on page 11-23  
**Tips for using the schedule grid** on page 11-32 |
| 11   | Add another application (action) node to the base node. This node will exit this caller application and transfer the caller to the Spanish language caller application.  
- Name the node **Continue in Spanish**.  
- Select **Goto** as the action type.  
- Select 2 for the **Key press**.  
- Provide a brief description. | **Adding the application action node** on page 11-22 |
| 12   | Modify the application (action) node properties:  
- On the **General** tab, verify that **Caller application** is selected.  
- If you have created and deployed the Spanish caller application, you can select that caller application from the drop-down list. Otherwise, you will have to create and deploy the Spanish caller application before you can complete this node.  
- You do not need a prompt for this node, so verify that the **Play entry prompt** check box is cleared (Prompt tab). | **Configuring application (action) node properties** on page 11-23 |
### Examples of Caller Applications

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
</table>
| 13   | Add another application (action) node to the base node. This node will exit this caller application and transfer the caller to the Spanish language caller application.  
- Name the node **Continue in French**.  
- Select **Goto** as the action type.  
- Select 3 for the **Key press**.  
- Provide a brief description. | Adding the application action node on page 11-22 |
| 14   | Modify the application (action) node properties:  
- On the **General** tab, verify that **Caller application** is selected.  
- If you have created and deployed the French caller application, you can select that caller application from the drop-down list. Otherwise, you will have to create and deploy the French caller application before you can complete this node.  
- You do not need a prompt for this node, so verify that the **Play entry prompt** check box is cleared (**Prompt** tab). | Configuring application (action) node properties on page 11-23 |
| 15   | Add another application (action) node to the base node. This is the final node in this application, and its job is simply to redirect the caller back through this menu.  
- Name the node **Repeat this menu**.  
- Select **Goto** as the action type.  
- Select 9 for the **Key press**.  
- Provide a brief description. | Adding the application action node on page 11-22 |
At this point, you are almost done with the caller application. If you have not already created and deployed the Spanish and French caller applications, you will still need to do that and make sure that they are called by the appropriate nodes in this application. You will also need to record the prompts.

### Recording and assigning the prompts

Although XYZ Company has decided to have their prompts recorded professionally, you can record the prompts for test purposes. This caller application requires only two prompts, but the **Main Menu** prompt, especially, must be carefully scripted, so as to provide the options in the correct order and form. We recommend that you write out all prompts before recording them, as this helps ensure that the prompts say exactly what you want them to say.

XYZ Company created the following script for the **Main Menu** prompt (numbered 1 in the application):

"Thank you for calling XYZ Company. We value your business, so please listen carefully to the following options.

"If you know the extension number of the party you are trying to reach, please enter it at any time.

"To speak to an operator, you can press 0 at any time.

"To reach Technical Support, please press 1.

"Para continuar en español, prensa 2.

"Pour continuer en français, pression 3.

"To hear this menu again, press 9."
Note: It is possible that you might want to present the options in a different order, but that is something you should decide during the planning phase. We recommend that you present the options in numerical order, and that this idea be central in your planning.

For the Transfer to Operator prompt, they created the following script:

“Please wait while I transfer you to the operator.”

While waiting for the prompts to be recorded by a professional studio, you can make your own temporary recordings. For the procedure to record your own prompts, see Recording application prompts on page 11-37. Once recorded, these prompts become part of the application.

After recording the prompts, (prompt 1 and 2, respectively) verify that you have the correct prompt assigned to the appropriate node.

Later on, when the professionally recorded *.wav files have been received, you can replace the existing prompt recordings with the new ones. For the procedure to do this, see Importing prompts on page 11-39.

Deploying the application

After saving the application again, you are ready to deploy the application. For the procedure to do this, see Deploying caller applications across a voice mail domain on page 11-44.

Analyzing the application

Immediately after deploying the application across the voice mail domain, we recommend that you analyze the application, which tests it for integrity and flags any errors it finds. This is a valuable tool for debugging your caller applications. For the procedure to analyze the application, see Analyzing caller applications on page 11-50.
Examples of Caller Applications

Example 2: Call transfer using Dial By Name

This example has been created to illustrate how you can use a caller application to allow callers to take advantage of the Dial by Name feature. This feature allows callers to “spell” the name of the party they are trying to reach, and the system automatically looks up and tries to match the number entered with a subscriber on the system.

Considerations

Normally, it is not necessary to use a caller application to access the Dial by Name feature. In most cases, the system Automated Attendant can access Dial by Name directly by assigning any numeric key press to Directory.

However, in cases where you do not want to use the system Automated Attendant, you can still access the Dial by Name feature using caller applications.

The key is to use a Menu with extension or Menu with mailbox action type (see Menu actions on page 11-27). In both these action types, the # key is reserved for the Dial by Name application.

This means that all you really have to do to make use of the Dial by Name feature with a caller application is create an application node with one of these two action types. You do not need to create a separate caller application to use Dial by Name.

The caller application design

The following is a possible call flow for this caller application. Note that this does not necessarily need to be an entire application by itself. In fact, it will more likely be used to best effect by simply creating an application node within an application (for instance, it could be used as an additional option in Example 1: Alternative “Auto Attendant” Main Menu). This example is intended primarily to illustrate how to set up the node.
Building the application

The following table presents a step-by-step method for building this caller application. It assumes that you have already started the Caller Applications Editor. The Action(s) column gives a description of the step in the process, and the Location of procedure(s) column provides a link to the detailed procedure in the documentation that tells how to perform the step.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create the caller application base node. Name it <strong>Transfer by Name</strong>.</td>
<td><strong>Adding the base caller application node</strong> on page 11-18</td>
</tr>
<tr>
<td></td>
<td>Provide a brief description and select the language.</td>
<td></td>
</tr>
</tbody>
</table>
## Examples of Caller Applications

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Modify the caller application base node properties: &lt;br&gt;  - Select <strong>Menu with extension</strong> as the action type.  &lt;br&gt;  - Select <strong>Play entry prompt</strong> and then select <strong>Application prompt</strong>.  &lt;br&gt;  - Add a prompt and enter “Transfer to Dial by Name” under <strong>Comments</strong>.  &lt;br&gt;  <strong>Note</strong>: You will not actually record the prompt at this point, you are merely creating a placeholder for it.  &lt;br&gt;  - Verify that the application is set to use the <strong>Default operator</strong>, &lt;Parent node&gt; as the <strong>Default cancel</strong> setting, and the * key as the <strong>Default cancel key</strong>.</td>
<td>Configuring the caller application properties on page 11-19</td>
</tr>
<tr>
<td>3</td>
<td>Save the application, if you have not already done so.</td>
<td>Saving a caller application on page 11-41</td>
</tr>
</tbody>
</table>

**Note**: Because you are using the **Menu with extension** action type, the # key is automatically reserved for the Dial by Name feature (as it is with the **Menu with mailbox** action type). This means that it is not available for other options.
**Example 3: Automated fax attendant**

This example has been created to illustrate how you can use a caller application to act as an auto attendant for relaying faxes to a subscriber’s fax-enabled extension.

**Considerations**

The advantage of this arrangement is that you can provide fax delivery for your subscribers without paying for additional Direct Inward Dialing (DID) lines or personal trunks for fax extensions. The disadvantage is that incoming calls cannot be automatically dialed, because the caller must enter touch tones to select from the caller application menu and then press the start key on the fax machine to begin transmitting the fax.

Essentially, when you set up an automated fax attendant, you are simply transferring the caller to a fax-enabled mailbox (which is set up using the Subscriber page). To send the fax, the caller needs to know only the pilot number of the Avaya Modular Messaging system and the fax-enabled mailbox number. Upon reaching the caller application (or application node) that will transfer them to the fax-enabled mailbox, callers hear a prompt instructing them to press the extension number and then press the start button on their fax machines after they hear the mailbox greeting to start or the fax tone (if no greeting is being used in the mailbox).

The subscriber must provide fax senders the system number to call (in this case, it might be xx3-7001) and the subscriber’s fax-enabled mailbox number (in this case, 51234).

**Important:** Setting up fax-enabled mailboxes with numbers that begin with trunk dial access codes could contribute to toll fraud. Always assign extensions that do not allow access to any outside lines.

**The caller application design**

The following is a possible call flow for this caller application. Note that this need not necessarily be an entire application by itself. In fact, it will more likely be used to best effect by simply creating an application node within an application (for instance, it could be used as an additional option in Example 1: Alternative “Auto Attendant” Main Menu). Also, the prompt does not need to be contained within the caller application; it could just as easily be created within the fax-enabled mailbox, as a greeting. (If the target mailbox is dedicated for fax only, then it might be better to place the instruction prompt within the mailbox. However, if the mailbox is also used for voice mail—as it will in most cases—then it might be better to place the instruction prompt within the caller application, as planned here.)
Building the application

The following table presents a step-by-step method for building the caller application. It assumes that you have already started the Caller Applications Editor and that you are creating this as a separate caller application, though it could be easily modified to treat as an application node within a caller application. The **Action(s)** column gives a description of the step in the process, and the **Location of procedure(s)** column provides a link to the detailed procedure in the documentation that tells how to perform the step.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create the caller application base node. Name it <strong>Auto fax attendant</strong>. Provide a brief description and select the language.</td>
<td><a href="#">Adding the base caller application node</a> on page 11-18</td>
</tr>
</tbody>
</table>
### Examples of Caller Applications

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
</table>
| 2    | Modify the caller application base node properties:  
  - Select **Menu with extension** as the action type.  
  - Select **Play entry prompt** and then select **Application prompt**.  
  - Add a prompt and enter “Enter extension or fax machine number” under **Comments**.  
  **Note:** You will not actually record the prompt at this point, you are merely creating a placeholder for it.  
  - Verify that the application is set to use the **Default operator, <Parent node>** as the **Default cancel** setting, and the * key as the **Default cancel key**. | **Configuring the caller application properties** on page 11-19                                                                                   |
| 3    | Save the application, if you have not already done so.                                                                                                                                                  | **Saving a caller application** on page 11-41                                             |
Example 4: Shared extension

It is possible for several subscribers to share a single telephone extension, using a caller application to set it up. An extension set up this way might, for instance, allow a caller to speak with a particular individual subscriber or leave a message that is available to anyone on the shared extension.

The following example has been created to illustrate how to set up a shared extension using a caller application. In this example, four individuals work in the sales department of a company. When the caller reaches the system by dialing the shared extension number, the system offers a menu to speak with any of the individuals or to leave a message in the group voice mailbox.

This sample application also allows the caller to reach a receptionist who works for the entire sales department, and to hear the menu again.

Considerations

In this example, only the caller application ID number (4350) is administered as an extension at the switch. Nonresident subscriber extensions—that is, extensions that are not administered at the switch—are used for each of the sharing subscribers. The caller application can transfer callers directly to these extensions or to the group mailbox, which is accessible to each of the shared extension subscribers.

In this case, if the individual subscriber is not available to answer the call, the system automatically transfers the caller to the individual’s voice mailbox.

After creating and deploying this caller application, you must remember to create an association with an ID number of 4350 for this application. This caller application ID number then overrides the extension 4350 when the caller reaches the system (so that you could still use the extension number of 4350 for the group’s receptionist).

The caller application design

The following is a possible call flow for a shared extension.
Figure B-6.

Caller transferred to caller application 4350

Menu only

Thank you for calling...
To speak with Adam, press 1.
To speak with Barbara, press 2.
To speak with Charlie, press 3.
To speak with Donna, press 4.
To leave a message for anyone at this extension, press 9.
To speak with a receptionist, press 0.
To hear this menu again, press #.

Goto
(no prompt)

Transfer to extension 4351
(no prompt)

Transfer to extension 4352
(no prompt)

Transfer to extension 4353
(no prompt)

Transfer to extension 4354
(no prompt)

Transfer to mailbox 4350
(no prompt)

Transfer to custom operator
(no prompt)

Legend

Node
Action type
Prompt
User or system response
Building the application

The following table presents a step-by-step method for building the caller application. It assumes that you have already started the Caller Applications Editor. The Action(s) column gives a description of the step in the process, and the Location of procedure(s) column provides a link to the detailed procedure in the documentation that tells how to perform the step.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create the caller application base node. Name it <strong>Shared extension</strong>. Provide a brief description and select the language.</td>
<td>Adding the base caller application node on page 11-18</td>
</tr>
</tbody>
</table>
| 2    | Modify the caller application base node properties:  
  - Select **Menu only** as the action type.  
  - Select **Play entry prompt** and then select **Application prompt**.  
  - Add a prompt and enter “Shared extension menu” under **Comments**.  
  - Note: You will not actually record the prompt at this point, you are merely creating a placeholder for it.  
  - Set the application to use the **Custom operator, 4350** as the **Custom operator** number, **<Parent node>** as the **Default cancel** setting, and the * key as the **Default cancel key**. | Configuring the caller application properties on page 11-19 |
| 3    | Add four application (action) nodes to the base node. These nodes will all be **Transfer** nodes used to transfer the caller to the desired sales person.  
  - Name the nodes **Transfer to Adam**, **Transfer to Barbara**, etc.  
  - Select **Transfer** as the action type.  
  - Select 1, 2, 3, and 4 for the **Key presses**.  
  - Provide brief descriptions. | Adding the application action node on page 11-22 |
### Examples of Caller Applications

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
</table>
| 4    | Modify the application (action) nodes’ properties:  
- On the **General** tab, verify that **Extension** is selected and set 4351, 4352, 4353, and 4354 as the extension numbers.  
- You do not need a prompts for these nodes, so verify that the **Play entry prompt** check boxes are cleared (**Prompt** tab). | Configuring application (action) node properties on page 11-23 |
| 5    | Add another application (action) node to the base node. This node will allow the caller to leave a message in the common (group) mailbox.  
- Name the node **Leave message**.  
- Select **Transfer** as the action type.  
- On the **General** tab, verify that **Mailbox** is selected and set 4350 as the mailbox number.  
- Select 9 for the **Key press**.  
- Provide a brief description. | Adding the application action node on page 11-22 |
| 6    | Modify the application (action) node properties:  
- On the **General** tab, verify that **Node** is selected.  
- From the drop-down box, select the caller application node for this caller application, **Main Menu**.  
- You do not need a prompt for this node, so verify that the **Play entry prompt** check box is cleared (**Prompt** tab). | Configuring application (action) node properties on page 11-23 |
### Examples of Caller Applications

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
</table>
| 7    | Add another application (action) node to the base node. This node will allow the caller to reach the sales department’s receptionist.  
- Name the node **Transfer to receptionist**.  
- Select **Transfer** as the action type.  
- Select 0 for the **Key press**.  
- Provide a brief description. | [Adding the application action node](#) on page 11-22 |
| 8    | Modify the application (action) node properties:  
- On the **General** tab, verify that **Operator** is selected.  
- You do not need a prompt for this node, so verify that the **Play entry prompt** check box is cleared (**Prompt** tab). | [Configuring application (action) node properties](#) on page 11-23 |
| 9    | Save the application, if you have not already done so. | [Saving a caller application](#) on page 11-41 |
Example 5: Non-resident subscribers

Non-resident subscribers are Modular Messaging subscribers who do not have an extension administered on a switch that is served by the Modular Messaging system. An example of a non-resident subscriber might be a sales representative who needs to receive messages from clients, but who does not have a “live” extension on the system. To accommodate this type of subscriber, a caller application (or node) can be set up to move callers directly to the non-resident subscriber’s mailbox. In this case, the caller needs to know only the number of the non-resident caller application ID (in this case, 73003) and the non-resident subscriber’s mailbox (in this case, 4222).

Considerations

After creating and deploying this caller application, you must remember to create an association with an ID number of 73003 for this application.

Important: Setting up nonresident subscribers with numbers that begin with trunk dial access codes could contribute to toll fraud. Always assign extensions that do not allow access to any outside lines.

The caller application design

The following is a possible call flow for this caller application. Note that this need not necessarily be an entire application by itself; it can be used as a node of a larger application (for instance, it could be used as an additional option in Example 1: Alternative “Auto Attendant” Main Menu).

Figure B-7.
### Building the application

The following table presents a step-by-step method for building the caller application. It assumes that you have already started the Caller Applications Editor. The **Action(s)** column gives a description of the step in the process, and the **Location of procedure(s)** column provides a link to the detailed procedure in the documentation that tells how to perform the step.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create the caller application base node. Name it <strong>Non-resident subscribers</strong>. Provide a brief description and select the language.</td>
<td>Adding the base caller application node on page 11-18</td>
</tr>
<tr>
<td>2</td>
<td>Modify the caller application base node properties:</td>
<td>Configuring the caller application properties on page 11-19</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>Menu with mailbox</strong> as the action type.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Select <strong>Play entry prompt</strong> and then select <strong>Application prompt</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Add a prompt and enter “Enter mailbox number” under <strong>Comments</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You will not actually record the prompt at this point, you are merely creating a placeholder for it.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Verify that the application is set to use the <strong>Default operator</strong>, <code>&lt;Parent node&gt;</code> as the <strong>Default cancel</strong> setting, and the <code>*</code> key as the <strong>Default cancel key</strong>.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Save the application, if you have not already done so.</td>
<td>Saving a caller application on page 11-41</td>
</tr>
</tbody>
</table>
Example 6: Bulletin boards and daily announcements

For situations in which you need to make daily or frequent announcements to all the callers or subscribers who reach the system, it is more efficient to set it up so that the announcements are created and recorded within a special mailbox, rather than embedding the prompt into the caller application.

For these “bulletin board” or daily announcement types of mailboxes, you can create a special single-node caller application that will play the announcement and then automatically transfer the caller or subscriber to the main menu, for instance.

Considerations

When used in this way, the mailbox that the caller application accesses must be enabled for announcements (see Subscriber Options). You must also remember to create and enable this mailbox before creating the caller application.

Then, instead of using an Application prompt for the caller application prompt, you assign an Announcement prompt to the base caller application node.

You will also need to create and deploy the Main Menu caller application with an association ID of 4000 before building this caller application.

After creating and deploying this caller application, you must remember to create an association with an ID number of 80071 for this application.

The caller application design

The following call flow is an example of how you can set up an announcement-enabled mailbox to be used as a daily announcement or bulletin board mailbox. When callers access this caller application by dialing xx8-0071, they hear the announcement recorded in the announcement-enabled mailbox and then are immediately transferred to the Main Menu caller application, which has an association ID of 4000.
### Building the application

The following table presents a step-by-step method for building the caller application. It assumes that you have already started the Caller Applications Editor. The **Action(s)** column gives a description of the step in the process, and the **Location of procedure(s)** column provides a link to the detailed procedure in the documentation that tells how to perform the step.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create the caller application base node. Name it <strong>Bulletin board</strong>. Provide a brief description and select the language.</td>
<td><a href="#">Adding the base caller application node</a> on page 11-18</td>
</tr>
</tbody>
</table>

**Figure B-8.**

![Diagram of caller application process](image-url)
<table>
<thead>
<tr>
<th>Step</th>
<th>Action(s)</th>
<th>Location of procedure(s)</th>
</tr>
</thead>
</table>
| 2    | Modify the caller application base node properties:  
  - Select **Goto** as the action type.  
  - Select **Caller application** and, from the drop-down menu select the Main Menu caller application, **4000**.  
  - Select **Play entry prompt** and then select **Announcement**.  
  - In the drop-down list, select **<default>**.  
  **Note:** You cannot record Announcement prompts. You can only view a list of the available Announcements, if any.  
  - Verify that the application is set to use the **Default operator, <Parent node>** as the **Default cancel** setting, and the * key as the **Default cancel key**. | Configuring the caller application properties on page 11-19  
Displaying a list of announcements on page 11-38 |
| 3    | Save the application, if you have not already done so. | Saving a caller application on page 11-41 |
Appendix C: Stopping and (re)starting Modular Messaging (MM) services

The action of installing new software on an MAS often requires that you stop and restart the Avaya Modular Messaging (MM) services. In addition, many troubleshooting and repair procedures require that you stop and restart these services and/or the voice server system software.

This appendix provides the procedures for these actions. Topics include:

- Stopping a Modular Messaging (MM) service
- Starting (Restarting) a Modular Messaging (MM) service
Stopping a Modular Messaging (MM) service

This section provides the procedures for stopping Avaya Modular Messaging (MM) services. These services must be stopped and restarted whenever you install or re-install software on the MAS and when performing various troubleshooting and repair actions (as instructed by the repair procedure).

The MM services you may need to stop include the following:

- MM Alarming Server
- MM Call Me Server
- MM Event Monitor Server
- MM Mailbox Monitor
- MM Message Waiting Indicator Server
- MM Messaging Application Server
- MM Performance Monitor Server
- MM Process Monitor Server
- MM Tracing Server

Notes:

- We recommend that you perform these operations during a scheduled down time of the system and voice mail domain, if at all possible.
- You must repeat these steps for each MM service you want to stop. You must stop all MM services before installing or re-installing software on the MAS.

To stop operation of an MM service, do the following:

1. Start the services Monitor application in one of the following ways:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. From the list in the Services dialog box, right-click the name of the service you want to stop.

3. On the pop-up menu, click Stop.

   After a short interval, the MM service stops.
Starting (Restarting) a Modular Messaging (MM) service

This section provides the procedures for starting (restarting) Avaya Modular Messaging (MM) services. For a list of MM services, see Stopping a Modular Messaging (MM) service.

To start (restart) the MM services, do the following:

1. Start the services Monitor application in one of the following ways:
   - Double-click the Monitor.msc icon on your desktop.
   - Click Start > Programs > Administrative Tools > Services.

2. From the list in the Services dialog box, right-click the name of the service you want to start (restart).

3. On the pop-up menu, click Start.

   After a short interval, the MAS service starts. A 1241 event confirms that the service has started.
Appendix D: Glossary

.UMA file
A file that contains a caller application. By default, the file type in which the Caller Applications Editor will choose to save applications is .UMA. Although the user can select any legal name type for the application, the internal format will always be the same.

.WAV
A file extension used for Windows multimedia format audio data.

access control list
A list of people in a voice mail domain who have access to Modular Messaging software applications and tools.

access number
The number you dial to get into your Modular Messaging software system.

AccuCall+
A utility for Microsoft Windows that allows you to build and edit tone tables.

Adaptive Differential Pulse Code Modulation (ADPCM)
A speech encoding method that produces a digital signal with a lower bit rate than standard pulse code modulation (PCM). ADPCM calculates the difference between two consecutive speech samples in standard PCM-coded telecom voice signals. The ADPCM encoding rate is 32 kilobit per second.

Automated Attendant
A service that greets callers and instructs them how to proceed. Using the Automated Attendant, you can also use other call handling features such as intercom paging and call screening. When enabled, callers are transferred to the subscriber’s extension. When disabled, callers are transferred directly to the subscriber’s mailbox where they can leave a message.
Glossary

**automatic notification**
If Notify Me is set to Automatic notification, you can determine whether you should be notified if callers have left a message in your mailbox or if callers have left urgent messages only.

**average hold time (AHT)**
The sum of the lengths of all telephone calls (in minutes or seconds) during the busiest hour of the day divided by the number of calls.

**busy hour**
A method used to calculate the number of ports required when sizing a system. It represents the busiest hour of the day, when the volume of calls generated by internal subscribers and external callers reaches its peak.

**call handling**
A feature that allows Modular Messaging software to screen or block calls and to specify what greetings are played when an extension is busy or not answered.

**call information packet**
A string of DTMF digits sent by the PBX to the MAS in inband integration. The call information packet contains information on the type of call received (known as the “call packet type”), the called party ID, the calling party ID, and the trunk ID.

**call management**
A component of the messaging application server that provides an interface between the voice cards and Modular Messaging software telephony applications.

**Call Me**
A feature that allows subscribers to be called at a designated telephone number, or telephone list, each time they receive a message that meets specified criteria. The subscriber is then invited to log onto Modular Messaging software in order to review the message. Subscribers can set up Call Me rules in Subscriber Options.

**call packet type**
A string of DTMF digits that form a code for the type of call received during inband integration, such as a direct call, a forwarded call, or a diverted call. Also known as a reason code.

**call screening**
A call answering option that requires callers to announce themselves before a subscriber answers the call. If a call is screened and the subscriber is not available to answer it, the caller has the choice of leaving a message, or being forwarded to a different extension or to the operator.

**caller requested notification**
If Notify Me is set to caller-requested notification, callers are asked if they wish to have you notified that they called.

**canonical addressing**
A method of addressing that specifies the full location, including country code and area code, in the following order:

+CountryCode [(AreaCode)] SubscriberNumber
For example, +1 (408) 345 800

**carried traffic**
The total busy hour traffic that was offered to the group of ports minus the blocked calls.

**Centum Call Second (CCS)**
A unit of measurement for call time. The formula for a CCS is the number of calls per hour multiplied by their average duration in seconds, all multiplied by 100. A CCS is 1/36th of an Erlang.

**deleted items folder**
A folder in your e-mail application that stores items that you have deleted. You can retrieve an item from the deleted items folder. You can set your e-mail application to delete items in this folder permanently when you quit the e-mail client.

**Dial by Name**
A method of addressing by which a caller spells the recipient's name on the telephone keypad when using the telephone user interface.

**DID**
See [direct inward dialing (DID)](#).

**Digital Meridian Integration Device (DMID)**
A device that provides integration with Nortel switches, such as the Meridian M-1. The DMID physically sits between the PBX and the messaging application server and appears as one or two digital telephones to the PBX, depending on the number of analog ports required. Analog line circuits for the voice path appear on the digital set of the DMID. When a call is received on the DMID, it simultaneously rings at the analog port. The DMID interprets the call display information and transmits it to the messaging application server, which answers the caller with the appropriate personal greeting.

**direct inward dialing (DID)**
A feature that allows callers to dial inside an organization to reach a telephone extension directly without going through a receptionist.

**distribution list**
A name assigned to a group of recipients. When you address a message to a distribution list, each recipient in the list receives the message.

**DMID**
See [Digital Meridian Integration Device (DMID)](#).

**dual tone multi-frequency (DTMF)**
A combination of two tones that uniquely identify each button on a telephone keypad.

**envelope information**
Information that shows who sent a message, the date and time sent, and message length.

**Erlang**
A unit of measurement for call time. One Erlang is equivalent to 60 call minutes or 36 Centum Call Seconds (CCS).
event
A significant occurrence in a voice mail system, which may be of interest to an administrator for diagnostic or reporting purposes.

fax routing address
An e-mail address consisting of a string of digits that uniquely identify the subscriber to the fax server.

Find Me
A feature that enables your mailbox to re-direct unanswered calls to a list of telephone numbers. Calls are directed to each telephone number in the list, unless you answer. If you do not answer at any telephone number in the list, callers are asked if they would like to leave a message.

firmware file
A file containing instructions that are permanently loaded into memory.

forward
A command that is used to forward a copy of a message. You can include your comments in the message by attaching a voice message.

Global System for Mobile Communications (GSM)
An audio encoding format with an encoding rate of approximately 13 kilobits per second. This is a format for storing sound files. Files encoded in this format can be opened using Microsoft Sound Recorder.

grade of service (GOS)
The probability, expressed as a percentage of callers who call during the busy hour, that an incoming call is blocked (the caller hears a busy signal) because all ports are in use.

greetings
A pre-recorded message that callers hear when your extension is busy or not answered, or you are away from the office.

GSM
See Global System for Mobile Communications (GSM).

home messaging application server
Any machine in the voice mail domain from which you administer a Modular Messaging software configuration.

hunt group
A group of telephone lines where the incoming calls are distributed according to a priority scheme.

in-band signaling
A method of connecting the messaging application server to the PBX as if it were a series of single-line telephones or a series of trunks in a hunt group. The term “in-band” is used because all of the call identification information is passed from the PBX to the messaging application server using DTMF signals on the same line as the voice connection.

inbox
The folder in which a subscriber normally receives new mail.
intercom paging
A method of automatically paging subscribers if they do not answer their telephones. If a subscriber does not respond to the page, the caller is transferred to the subscriber’s mailbox.

Integrated Services Digital Network (ISDN)
A set of standards for transmission of simultaneous voice, data, and video information over fewer channels than would otherwise be needed, through the use of out-of-band signaling.

IP telephony
The use of networks running Internet Protocol (IP) to send and receive messages, such as voice data.

local mailbox number
A method of addressing voice messages through the telephone user interface to recipients in a voice mail domain.

mailbox
A delivery location for incoming voice mail, e-mail, and fax messages.

message confirmation
A notice confirming that a message was delivered to a recipient.

message waiting indicator (MWI)
A method of alerting subscribers when messages meeting specified criteria arrive in their mailbox. Subscribers are alerted either by a lamp indicator on their telephone, or an audible tone (stutter dial-tone) when they pick up the receiver. The indicator is cleared when the message is opened in Outlook or saved or deleted using the TUI. Subscribers can set up rules for using MWI in Subscriber Options. For example, they may choose to be notified only when they receive urgent voice messages.

Microsoft Management Console (MMC)
A common console framework for Microsoft management applications. MMC does not provide any management functionality, but forms a common environment for modular management components called snap-ins.

Modular Messaging access number
The number you dial to get into your Modular Messaging software system.

Modular Messaging Subscriber Administration
An administration tool that allows administrators to enable subscribers, groups, or contacts to use Modular Messaging software.

multimedia
A PC has multimedia capabilities if it has a sound card, microphone, and speakers or headphones.

multi-part message
A message that consists of several parts. Every time you forward a voice message or reply to a voice message including the original, a new part is added to the original message.

MWI
See message waiting indicator (MWI).
Glossary

Name prompt  
A personalized prompt that states a subscriber’s name when that subscriber’s extension is busy or unanswered and he or she has not recorded a personal greeting.

Notify Me  
A feature that allows subscribers to use a pager, SMS-enabled digital telephone, or other device to alert them of calls to their Modular Messaging software inbox.

numeric address  
A string of digits that uniquely identifies a recipient or a distribution list across the organization. A numeric address is used by the telephone user interface as a means of addressing a message.

offered traffic  
The total traffic offered to a group of ports during the busy hour, including calls that are blocked.

operation history database  
A temporary storage area for events generated by Modular Messaging software. The Operation History Viewer is used for viewing events in this database.

Operation History Viewer  
A diagnostic tool that displays events generated by Modular Messaging software activity and logged in the operation history database. By creating a “session,” administrators can restrict the number of events to only those that meet their criteria. They can view live events as they are added to the operation history database, or view historical events.

operator  
The person to whom callers are transferred when they request to speak with an operator, exceed the maximum number of errors permitted on the system, or call from a rotary telephone. Individual mailboxes may have an operator that is different from the designated system operator, for example, a personal assistant.

optional greeting  
A personalized answering system for greeting callers if a subscriber’s extension is busy or unanswered, or if incoming calls are blocked.

password  
Subscribers must enter their passwords to gain access to Modular Messaging software through the telephone user interface. Subscribers can change their passwords using the TUI or Modular Messaging software.

PBX  
See private branch exchange (PBX).

PBX integration  
A method that establishes communication between the PBX and the voice mail system. The PBX supplies information such as who is calling on internal calls and the extension that the caller is trying to reach.
PC client applications
A group of applications that enable subscribers and administrators to access Modular Messaging software from their desktop PCs. PC client applications include Subscriber Options.

PC user interface
An interface through which subscribers can access the Modular Messaging software system from their PC.

peer e-mail server
The mail server that acts as host e-mail server for a Modular Messaging software messaging application server.

personal greeting
A personalized prompt that greets callers when they are transferred to a subscriber’s mailbox if the extension is busy or not answered.

playback controls
CD-type controls with which you can play, pause, forward, and rewind messages.

Please Hold prompt
A personalized prompt that informs callers of the extension they selected when they are transferred to an extension.

port group
A group of ports allocated to a specific application, such as the PC client, the telephone user interface, or Octel Analog Networking. Port groups are configured using the Voice Mail System Configuration application.

Port Monitor
A diagnostic tool that provides a graphical user interface for checking and changing the status of ports on a particular messaging application server.

private branch exchange (PBX)
A telephone exchange local to a particular organization that uses, rather than provides, telephone services. Also known as a switch.

private messages
Messages marked private. You cannot send private messages through the telephone user interface. However, you can reply to and forward private messages through the TUI.

prompt
A spoken greeting or instruction that directs callers whose calls have come through the Automated Attendant.

QSIG
A protocol for ISDN-based inter-PBX signaling based on the European Q.931, Q.9212, and DPNSS protocols.

read receipt
Notification indicating the date and time a message that you sent was opened by the recipients.

reason code
See call packet type.
replying
Use to reply to a message. Normally, the original message is not included in your reply.

Reporting Tool
A tool for generating reports for monitoring voice mail system usage, planning capacity, and tracking security. Once a report is generated, it can be viewed on screen or printed for easy reference. It can also be exported to many popular file formats or attached to a message sent using a MAPI-enabled e-mail system.

sent items folder
A folder in the subscriber’s e-mail application that normally stores a copy of each message sent.

set emulation
A digital protocol used to connect digital telephones to switches in order to emulate digital telephone sets.

Simplified Message Desk Interface (SMDI)
A protocol for sending PBX integration data, that does not require a caller to reenter the telephone number if the extension is busy or not answered.

spoken name
A personalized prompt that states your name when, for example, your extension is busy or unanswered and you haven’t recorded a personal greeting.

subscriber
A user whose profile is enabled for voice messaging. A subscriber can use both the telephone user interface and the graphical user interface of Subscriber Options.

Subscriber Options
An application that allows subscribers to configure their mailboxes using their PCs. Subscribers can record all personal greetings and prompts, personalize their call handling options, and select whether to use multimedia or the telephone for recording and playing back voice messages.

switch
See private branch exchange (PBX).

telephone user interface (TUI)
An interface through which callers and subscribers can access the Modular Messaging software system using the telephone. The TUI is also an automated attendant and voice messaging system that controls call handling. It greets incoming callers and instructs them on how to proceed.

telephony interface
An interface that enables communication between the voice boards and Modular Messaging software. Depending on the voice boards that you are using, you can configure Analog or Aculab T-1 telephony interface types.
text-to-speech (TTS)
The conversion of text into speech (speech synthesis). Using TTS, Modular Messaging software subscribers can listen to their e-mail messages over the telephone.

tone file
A file that enables the application to recognize the tones generated by a PBX.

tracing server
A separate server that records operational information about activity in the voice mail domain.

tracing system
A system that captures information related to the operation of the MAS, for both diagnostic and reporting purposes. The tracing system maintains connections with all messaging application servers in the voice mail domain and receives notification of events from each of them. These events are written to two storage areas: the Operation History and the transaction databases. An administrator can generate reports summarizing voice mail activity using the Reporting Tool.

transaction database
A storage area where information about voice messaging events in the voice mail domain is written. It is a permanent database containing summary information that is used by the Reporting Tool.

TTS
See text-to-speech (TTS).

TUI
See telephone user interface (TUI).

tutorial
Modular Messaging software’s setup tutorial that guides you through personalizing your mailbox. You only hear it the first time you dial into your mailbox.

unified mailbox
A Modular Messaging software subscriber mailbox where all voice, fax, telephone answering messages, e-mail, and data messages (including documents and forms) are stored. Messages can be viewed, listened to, or retrieved using the telephone or PC.

Visual Voice Editor
An administration tool that allows the recording of customized prompts used by Modular Messaging software. The tool allows recording using multimedia or the telephone user interface. When modifying a prompt, the user is presented with a graphical rendering of the sound, which allows precise editing of the audio data.

voice mail domain
A group of Modular Messaging software messaging application servers that share a common set of properties. All subscribers who are provided with telephone answering by these messaging application servers are said to "belong" to the same voice mail domain.
Voice Mail System Configuration
An administration tool used to configure the attributes of a voice mail domain or a group of messaging application servers.
A
Abandoned (User Mailbox Statistics report), 12-25
access codes (fax), configuring, 5-21
Access Codes dialog box (fax), displaying, 5-21
access control list (ACL)
  Subscriber Administration, 5-27
  System Administration, 5-26
access keys to application nodes, changing, 11-25
ACD, see automatic call distribution (ACD)
Acknowledgement type (SNMP tab, Serviceability - VMD), 5-41
ACL, see access control list (ACL)
Action menu, Caller Applications Editor, 11-12
actions, assigning, 11-26
active alarms log
  about, 15-2
  displaying, 15-5
Add Group (General tab, Port Groups dialog box), 8-13
adding
  attendant schedules, 3-16
  caller applications to new MASs, 11-44
  fax cover page, 5-22
  MASs, 8-19
  nodes to caller applications, 11-22
  PBX types, 9-4
  port groups, 8-14
Address Type (Fax - VMD dialog box), 5-19
administering
  access control lists
    Subscriber Administration, 5-27
    System Administration, 5-26
administrator log, about, 15-2
Advanced Fax dialog box
displaying, 5-23
After hours node option (Caller Applications Editor), 11-31
After Hours Receptionist Mailbox Number (Receptionist tab, TUI-VMD), 3-6
Afternoon prompt (Time of Day tab, Auto Attendant - VMD), 5-10
afternoon prompts
  about, 10-4
  configuring, 10-24
Agent ID (ACD tab, Telephony Interface dialog box), 6-8
alarm logs
  about, 15-2
  viewing, 15-5
alarms
  CallMe (CM), A-3
  CM CALLME 1, A-3
  configuring notifications
    MAS level, 8-16
    voice mail domain level, 5-38
  logs, 15-1
  Mailbox Monitor (MM), A-4
  maintenance (MT), A-6
  MAS-specific, A-23
  Message Waiting Indicator (MW), A-15
  MM IMAPI 1, A-4
  MM PERF 17, A-4
  MM PERF 18, A-5
  MT ABS_PROC 1, A-6
  MT ABS_PROC 2, A-7
  MT ABS_PROC 3, A-7
  MT ABS_PROC 4, A-8
  MT ABS_PROC 5, A-9
Allow subscribers to access messages using the TUI (Offline Access tab, Messaging - VMD), 5-37
analyzing calling applications, 11-50
announcement prompts, 11-37
announcements
   displaying list in Caller Applications Editor, 11-38
   recording in Caller Applications Editor, 11-37
Application description (New Caller Application dialog box), 11-18
Application name (New Caller Application dialog box), 11-18
application prompts, 11-37
Asked to Leave a Quick Message (System Usage report), 12-19
assigning
   actions, 11-26
      Conditional goto action (Caller Application Editor), 11-31
      Goto action (Caller Application Editor), 11-30
      Menu action (Caller Application Editor), 11-27
      Send message action (Caller Application Editor), 11-33
      Termination action (Caller Application Editor), 11-34
      Transfer action (Caller Application Editor), 11-29
   Association ID (Caller Applications Editor), 11-47
   Association name (Caller Applications Editor), 11-47
associations
   creating, 11-46
   deleting, 11-49
Attendant Main Menu Editor, displaying, 5-7
attendant schedule properties (TUI),
configuring, 3-16
attendant schedules
   adding, 3-16
   copying, 3-16
   deleting, 3-17
   editing, 3-17
   renaming, 3-17
   schedule grid, 3-18
audio data, selecting range for editing, 10-16
audio devices
   setting up to record prompts (Visual Voice Editor), 10-12
Index

audio encoding formats
changing, 10-7
configuring, 5-34
Auto Attendant Main Menu prompt
(Attendant Main Menu Editor tab, Auto Attendant - VMD), 5-7
(Auto Attendant - VMD dialog box), 10-22
about, 10-4
configuring, 10-22
Auto Logon (Inband Protocol Settings dialog box), 7-16
automated attendant
Attendant Main Menu Editor properties, 5-7
configuring, 5-5
holiday properties, 5-9
language/key association properties, 5-11
time of day properties, 5-10
Automated attendant option (Caller Applications Editor), 11-34
automatic call distribution (ACD), 6-8
Avaya C-LAN tab (PBX integration), 7-22
B
backing up system data, 1-3
backups, 1-3
Bad Port port state, 14-11
Basic Metrics report
contents, 12-28
generating, 12-27
sample, 12-29
BC Transfer Cap (Outgoing Calls tab, PBX Configuration - VMD), 4-21
Busy (System Usage report), 12-20
Busy port state, 14-10
By Subscribers (User Mailbox Statistics report), 12-24
C
Call Failed port state, 14-10
Call Me
configuring, 5-13
displaying properties, 5-13
enabling, 5-14
port groups, 8-12
Call Me Server (Call Me dialog box), 5-14
Call Packet Type (Inband Protocol Settings dialog box), 7-16
call transfer
codes, 4-9
properties, PBX analog telephony, 4-7
Called number (Caller Applications Editor), 11-47
Caller application
(Caller Applications Editor), 11-47
Caller application option (Caller Applications Editor), 11-30
caller applications, 11-1
about, 11-2
adding nodes, 11-22
analysis, Front door applications, 11-51
analyzing, 11-50
Automated Attendant menu options, 11-48
creating, 11-18
deploying, 11-42
deploying to voice mail domain, 11-44
eamples, B-1
ID numbers, 11-48
mailbox numbers, 11-48
opening, 11-41
re-deploying, 11-54
removing deployed applications from voice mail domain, 11-53
reusing deployed, 11-48
saving, 11-41
setting up, 11-17
troubleshooting after deployment, 11-55
Caller Applications Editor, 11-3
about, 1-2, 11-11
Action menu, 11-12
adding nodes to caller applications, 11-22
assigning actions, 11-26
associations, creating, 11-46
changing access keys to application nodes, 11-25
configuring properties, 11-16
creating applications, 11-18
deleting associations, 11-49
displaying list of announcements, 11-38
installing on standalone PC, 11-4
opening caller applications, 11-41
recording announcements, 11-37
recording prompts, 11-37
saving applications, 11-41
starting, 11-11
toolbar icons, 11-14
Caller Applications runtime software, 11-3
Caller Applications software, 11-2
using, 11-5
caller properties (TUI), configuring, 3-14
CallMe (CM), alarms, A-3
Cancel destination node (Caller Applications Editor), 11-28
Cancel destination node option (Caller Applications Editor), 11-33
canceling, report generation, 12-8
Canonical Addressing (Fax - VMD dialog box), 5-19
Change access to this key to use (Caller Application
changing
access keys to application nodes, 11-25
audio formats, 10-7
column settings in Operation History Viewer, 13-14
display language for MAS, 1-5
home MAS, 2-5
session properties (Operation History Viewer), 13-18
Check Mailbox (Inband Protocol Settings dialog box), 7-16
CLAN (PBX type) (General tab, PBX Integration dialog box), 7-7
CLAN properties (PBX integration), 7-22
Close (Time/Greeting tab, TUI-VMD), 3-9
Closed All Day (Time/Greeting tab, TUI-VMD), 3-8
Closed prompt (Time of Day tab, Auto Attendant - VMD), 5-10
closed prompts
about, 10-4
configuring, 10-24
CM alarms, A-3
CM CALLME 1, A-3
Codes for Call Type, Code 1 through Code 4 (Inband Protocol Settings dialog box), 7-17
COM port (General tab, Serviceability - MAS dialog box), 8-16
Company Address (Fax Cover Page dialog box), 5-22
Company Fax Number (Fax - VMD dialog box), 5-19
Company Name (Fax Cover Page dialog box), 5-22
Complete Transfer (Transfer/Outcall tab, PBX Configuration - VMD), 4-27
Concurrent Calls (General tab, Telephony Interface dialog box)
QSIG or set emulation, 6-6
Conditional goto action
(Caller Application Editor)
assigning, 11-31
configuring
access codes (fax), 5-21
advanced fax properties, 5-23
afternoon prompts, 10-24
alarm notification general settings, 5-39
alarm notification SNMP settings, 5-41
alarm notifications, 5-38
analog properties (PBX), 4-4
audio encoding formats, 5-34
Auto Attendant Main Menu prompt, 10-22
automated attendant, 5-5
automatic call distribution, 6-8
Call Me, 5-13
Caller Applications Editor properties, 11-16
CLAN properties (PBX integration), 7-22
closed prompts, 10-24
custom language selection greeting prompts, 10-25
customized prompts, 10-21
directory server, 8-5
evening prompts, 10-21
fax, 5-18
fax access codes, 5-21
fax general properties, 5-18
holiday prompts, 10-23
INADS alarm notification settings, 8-16
inband properties (PBX integration), 7-12
inband protocol types, 7-16
IP H.323 properties
(PBX integration), 7-24
(PBX), 4-13
languages, voice mail domain, 5-32
MAS properties, 8-1
message waiting indicator, 5-16
message waiting indicator port settings, 7-18
messaging, 8-4
morning prompts, 10-24
offline access to messages, 5-35 to 5-36
PBX integration, 7-1
PBX properties, 4-2
port groups, 8-11
general properties, 8-13
MWI, 7-20
usage properties, 8-15
primary peer server, 8-5
prompts, customized, 10-21
QSIG properties (PBX), 4-16
remote properties (PBX integration), 7-19
security
message stores, 5-28
voice mail domains, 5-25
serial general properties (PBX integration), 7-8
serial NEC/Ericsson/DMID properties (PBX integration), 7-10
serviceability
MAS level, 8-16
voice mail domain level, 5-38
set emulation properties (PBX), 4-25
telephone user interface (TUI) properties, 3-2
telephony interface
about, 6-1
analog properties, 6-3
IP H.323 properties, 6-5
QSIG properties, 6-6
set emulation properties, 6-6
text-to-speech
Index

about, 8-6
general properties, 8-7
time of day prompts, 10-24
tracing file size, 8-18
tracing system, 5-48
general properties, 5-49
operation history database properties, 5-50
transaction database properties, 5-51
voice mail domains, 5-1
voice mail system, 2-1
configuring port groups

QSIG and set emulation, 7-20
Confirm Mailbox (Inband Protocol Settings dialog box), 7-16
Connect Link / Disconnect Link (Avaya C-LAN tab, PBX integration), 7-23
Connected port state, 14-10
Connector (Serial Settings dialog box), 7-9
Context (Community) (SNMP tab, Serviceability - VMD), 5-41
controls, Visual Voice Editor, 10-8
copying
attendant schedules, 3-16
changes across MASs, 10-20
sections of prompts, 10-17
counters
MMS, 14-5
MMS MWI, 14-7
MMS performance, tables, 14-5
MMS Service, 14-5
MMS Voice Port, 14-5
cover page (fax), adding, 5-22
creating
associations (caller applications), 11-46
caller applications, 11-2, 11-18
historical sessions (Operation History Viewer), 13-11
live sessions (Operation History Viewer), 13-9
port groups, 8-14
prompts file, working copy, 10-6
sessions (Operation History Viewer), 13-8
Custom Language Selection Greeting (Language/Key Association tab, Auto Attendant - VMD), 5-12
custom language selection greeting prompts
about, 10-5
configuring, 10-25
Custom operator (Caller Applications Editor), 11-20
customizing
prompts

about, 10-1
setting up, 10-11
text-to-speech, 8-6
Scansoft RealSpeak (all languages), 8-8
CustomPrompts.OVF, 10-6

D
Daily Settings (Time/Greeting tab, TUI-VMD), 3-8
Data Bits (Serial Settings dialog box), 7-9
data sources for reports selecting, 12-5
Date
(Holiday tab, Auto Attendant - VMD), 5-9
(Hourly Statistics report), 12-10
Days before Password Expiry (Subscriber tab, TUI-VMD), 3-13
Default cancel (Caller Applications Editor), 11-20
Default cancel key (Caller Applications Editor), 11-21
Default Input Timeout in Seconds (General tab, TUI-VMD), 3-5
Default operator (Caller Applications Editor), 11-20
Default Receptionist Mailbox Number (Receptionist tab, TUI-VMD), 3-6
Defaulted to Assistance (System Usage report), 12-19
Delete Expired Events (Operation History Collection tab, Tracing System dialog box), 5-50
Delete Expired Transactions (Transaction Generation tab, Tracing System dialog box), 5-51
deleting
associations, 11-49
attendant schedules, 3-17
Delimeter Character (Inband tab, PBX integration), 7-14
deploying caller applications to a voice mail domain, 11-44
Design for VMD
(New Caller Application dialog box), 11-19, 11-21
diagnostic tools
about, 1-4
Microsoft Windows Performance Monitor, 1-4
monitoring tools, 1-4
opening, 1-5
Operation History Viewer, 1-4
Port Monitor, 1-4
Reporting Tool, 1-4
Dial by Name properties (TUI) configuring, 3-19
Dialed 0 for Assistance (System Usage
report), 12-19
Dialed Extension (System Usage report), 12-19
Dialing port state, 14-11
dialed string syntax, 4-29
Dialogic Analog-Line Test Application, 14-16
Dialogic lines, testing, 14-16
dialing string syntax, 4-29
Dialtone port state, 14-10
dictionaries
TTS (Scansoft RealSpeak), 8-8
Direct
(System Usage report), 12-21
(User Mailbox Statistics report), 12-24
Direct Calls (System Usage report), 12-20
directory server
about, 8-4
configuring, 8-5
Disabled port state, 14-10
disabling
ports immediately, about, 14-12
ports immediately, procedure, 14-15
ports, about, 14-12
ports, procedure, 14-13
Disabling port state, 14-10
Disconnect all Rotary Callers (Receptionist tab, TUI-VMD), 3-6
Disconnect option (Caller Applications Editor), 11-34
Disconnected port state, 14-10
disk maintenance, 1-3
display language, changing, 1-5
displaying
Access Codes dialog box (fax), 5-21
active alarms log, 15-5
Advanced Fax dialog box, 5-23
alarm notification general settings, 5-39, 5-41
alarm notification INADS settings, 8-16
Attendant Main Menu Editor tab (automated attendant), 5-7
Avaya C-LAN tab (PBX Integration dialog box), 7-22
Call Me dialog box, 5-13
error logs, 15-3
event logs, 15-3
Fax - Voice Mail Domain dialog box, 5-18
Fax Cover Page dialog box, 5-22
Holidays tab (automated attendant), 5-9
Inband tab (PBX Integration dialog box), 7-12
IP Configuration tab (PBX Integration dialog box), 7-24
Language/Key Association tab (automated attendant), 5-11
licensing information, 5-44
list of announcements in Caller Applications Editor, 11-38
message waiting indicator dialog box, 5-16
operation history event properties, 13-19
Port Groups dialog box, 8-13
QSIG/SE tab (PBX Integration dialog box), 7-20
Remote tab (PBX Integration dialog box), 7-19
resolved alarms log, 15-5
Serial General tab (PBX Integration dialog box), 7-8
Serial NEC/Ericsson/DMID tab (PBX integration), 7-10
session properties (Operation History Viewer), 13-18
Telephone User Interface - Voice Mail Domain dialog box
Attendant Schedules tab, 3-16
Caller tab, 3-14
Dial by Name tab, 3-19
General tab, 3-4
Message Timing tab, 3-10
Receptionist tab, 3-6
Subscriber tab, 3-12
Time/Greeting tab, 3-8
Time of Day tab (automated attendant), 5-10
tracing system
general properties, 5-49
operation history database properties, 5-50
transaction database properties, 5-51
dislog command
act (active alarms), 15-5
admin (administrator log), 15-3
maint (event log), 15-3
res (resolved alarms), 15-5
distributing TTS licenses across MASs, 5-45
Diverted Calls (System Usage report), 12-20
DMID (Serial NEC/Ericsson/DMID tab, PBX integration), 7-10
DMID properties, 7-10
Drop Call (Transfer/Outcall tab, PBX Configuration - VMD), 4-27
DTMF Inter-Digit Delay during Dialing (ms) (General tab, PBX Configuration - VMD)
analog, 4-5
QSIG, 4-18
set emulation, 4-26
DTMF Key: 1 through 3 (Language/Key Association tab, Auto Attendant - VMD), 5-12
DTMF Length during Detection (ms) (General tab, PBX Configuration - VMD)
analog, 4-5
QSIG, 4-18
set emulation, 4-26
DTMF Length during Dialing (ms) (General tab,
Avaya Modular Messaging with the Avaya MAS and MSS
MAS Administration Guide, Issue 1

Index

PBX Configuration - VMD
- analog, 4-5
- QSIG, 4-18
- set emulation, 4-26

DTMF Length during Play (ms) (General tab, PBX Configuration - VMD), 4-5

DTMF On Time (ms) (Inband tab, PBX integration), 7-12

Due to Busy (System Usage report), 12-20
Due to RNA (System Usage report), 12-20
During hours node option (Caller Applications Editor), 11-31

E
editing
- attendant schedules, 3-17
- audio data in Visual Voice Editor, 10-17
- copying sections of prompts, 10-17
- customized prompts, 10-16
- cutting sections of prompts, 10-17
- pasting content into prompts, 10-18
- trimming a prompt, 10-18

Educator for New Mailboxes (General tab, TUI-VMD), 3-5

E-mail Address (Dial by Name tab, TUI-VMD), 3-19

E-mail client support, 2-6

Enable ACD (ACD tab, Telephony Interface dialog box), 6-8

Enable Automated Attendant (General tab, TUI-VMD), 3-4

Enable Call Me (Call Me dialog box), 5-13

Enable Call Progress (Call Transfer tab, PBX Configuration - VMD), 4-8

Enable Caller Applications (General tab, TUI-VMD), 3-4

Enable Confirmation before Deleting Messages (Subscriber tab, TUI-VMD), 3-12

Enable Extended Password Security (Subscriber tab, TUI-VMD), 3-12

Enable Fast Start (IP Configuration tab, PBX integration), 7-25

Enable Full Error Logging from DMID Integration Device (Serial NEC/Ericsson/DMID tab, PBX integration), 7-11

Enable Intercom Paging (Intercom Paging tab, PBX Configuration - VMD)
- analog, 4-11
- QSIG, 4-23
- set emulation, 4-31

Enable Message Waiting Indicator (MWI) (Message Waiting Indicator dialog box), 5-17

Enable offline access to messages (Offline Access tab, Messaging - VMD), 5-36

Enable Operation History Collection (Operation History Collection tab, Tracing System dialog box), 5-50

Enable Password Expiry (Subscriber tab, TUI-VMD), 3-13

Enable Transaction Generation (Transaction Generation tab, Tracing System dialog box), 5-51

Enable Tunneling (IP Configuration tab, PBX integration), 7-25

enabling
- Call Me, 5-14
- message waiting indicator, 5-17
- operation history event collection, 13-4
- ports
  - about, 14-12
  - procedure, 14-14
  - transaction generation, 12-4

English3.OVF, 10-6

Ericsson MD110 (Serial NEC/Ericsson/DMID tab, PBX integration), 7-10

Ericsson properties, 7-10

error logs
- about, 15-2
- displaying, 15-3

Evening prompt (Time of Day tab, Auto Attendant - VMD), 5-10

evening prompts
- about, 10-4
- configuring, 10-24

event logs
- displaying, 15-3

events
- about, 13-2
- logs, 15-1

exporting
- operation history events, 13-20
- recordings, 10-28
- report formats supported, 12-33
- reports, 12-31

Ext. Busy (User Mailbox Statistics report), 12-24

Ext. RNA (User Mailbox Statistics report), 12-24

Extension (Analog tab, Telephony Interface dialog box), 6-4

Extension Field Length in Packet (Serial General tab, PBX Integration), 7-8

Extension number
- (General tab, Telephony Interface dialog box), 6-6

Extension of First Port in DMID Hunt Chain (Serial NEC/Ericsson/DMID tab, PBX integration), 7-11

Extension option (Caller Applications Editor), 11-31

July 2004
Failed Outgoing Calls (Hourly Statistics report), 12-10
failover peer servers, 8-4
fax
   access codes, configuring, 5-21
   adding cover page, 5-22
   configuring, 5-18
   configuring advanced properties, 5-23
   displaying properties, 5-18
   general properties, 5-18
   port groups, 8-12
   turning off confirmation feature, 5-24
Fax Cover Page dialog box, displaying, 5-22
Fax Enable (Fax - VMD dialog box), 5-19
Field Type Settings (Inband Protocol Settings dialog box), 7-17
Filler Character
   (Inband tab, PBX integration), 7-14
   (Serial NEC/Ericsson/DMID tab, PBX integration), 7-10
First Port Number (Serial NEC/Ericsson/DMID tab, PBX integration), 7-10
Fixed Field Length (Inband Protocol Settings dialog box), 7-17
Fixed Length Packets (Inband tab, PBX integration), 7-13
Flash Time Interval (ms) (Call Transfer tab, PBX Configuration - VMD), 4-8
Flow Control (Serial Settings dialog box), 7-9
Front door applications, 11-51

G
   general properties
   PBXs
      analog, 4-5
      QSIG, 4-18
      set emulation, 4-26
      telephone user interface, configuring, 3-4
   General tab
      PBX Integration dialog box, 7-6
      Serviceability - MAS dialog box, 8-16
      Serviceability - Voice Mail Domain dialog box, 5-39
generating
   Basic Metrics report, 12-27
   Hourly Statistics report, 12-9
   Login Failures report, 12-12
   Port Statistics report, 12-15
   reports, 12-1
   System Usage report, 12-18
   User Mailbox Statistics report, 12-23
   Go Off Hook when Port Disabled (General tab, PBX Configuration - VMD), 4-5
   Goto action (Caller Application Editor) assigning, 11-30
   greeting and time properties (TUI), configuring, 3-8
H
   hangup detection properties, PBX analog telephony, 4-10
   Hangup String (Hangup Detection tab, PBX Configuration - VMD), 4-10
   Hangup String Timeout (ms) (Hangup Detection tab, PBX Configuration - VMD), 4-10
   holiday prompts
      about, 10-5
      configuring, 10-23
   holiday properties, displaying, 5-9
   home MAS, 2-5
   Home Message Application Server (General tab, Tracing System dialog box), 5-49
   Hourly Statistics report
      contents, 12-10
      generating, 12-9
      sample, 12-11
I
   icons, Caller Applications Editor toolbar, 11-14
   Idle port state, 14-10
   importing recordings, 10-27
   In Transfer port state, 14-10
   INADS
      (General tab, Serviceability - VMD), 5-39
      configuring alarm notification settings, 8-16
   Inband (PBX type) (General tab, PBX Integration dialog box), 7-6
   inband properties, 7-12
      configuring protocol types, 7-16
   Inband Protocol Settings dialog box, 7-16
   Inband Request Digit String (Inband tab, PBX integration), 7-14
   Incall Key (ACD tab, Telephony Interface dialog box), 6-8
   Incoming (General tab, Port Groups dialog box), 8-13
   Incoming Calls
      (Hourly Statistics report), 12-10
      (Port Statistics report), 12-16
   Incoming Ring Count (Analog tab, Telephony Inter-
Index

face dialog box), 6-4
Indicator Off (MWI Settings dialog box), 7-18
Indicator On (MWI Settings dialog box), 7-18
Indicator On/Off signals must use the same port (MWI Settings dialog box), 7-18
(QSIG/SE tab, PBX integration), 7-20
Inform Subscriber Transfer is from Auto Attendant (Receptionist tab, TUI-VMD), 3-6
Initial Password for New Mailboxes (Subscriber tab, TUI-VMD), 3-13
Initiate Transfer (Transfer/Outcall tab, PBX Configuration - VMD), 4-27
installing
  Caller Applications Editor on standalone PC, 11-4
  license file, 5-46
Integration Type (General tab, PBX Integration dialog box), 7-6
Intercom Paging Code (Intercom Paging tab, PBX Configuration - VMD)
  analog, 4-11
  QSIG, 4-23
  set emulation, 4-31
intercom paging properties
  configuring for analog telephony, 4-11
  configuring for QSIG, 4-23
  configuring for set emulation, 4-31
International Code (Access Codes dialog box), 5-21
IP (PBX type) (General tab, PBX Integration dialog box), 7-6
IP Configuration tab (PBX integration), 7-24
IP H.323 properties (PBX integration), 7-24
IP Supported Codecs (IP Configuration tab, PBX integration), 7-25

K
Key press (Caller Application Editor), 11-23
Key Settings (Attendant Main Menu Editor tab, Auto Attendant - VMD), 5-8

L
Language (New Caller Application dialog box), 11-19, 11-21
language/key association properties (automated attendant), 5-11
Language: 1 through 3 (Language/Key Association tab, Auto Attendant - VMD), 5-12
languages
  configuring for voice mail domain, 5-32
  viewing, 8-10
Last Failed Login (Login Failures report), 12-13
Lastname, Firstname (Dial by Name tab, TUI-VMD), 3-19
Layer1 Protocol (Outgoing Calls tab, PBX Configuration - VMD), 4-21
Left a Message for a Subscriber (System Usage report), 12-19
licensing, 5-43
  about, 5-43
  distributing TTS across MASs, 5-45
  installing license file, 5-46
  viewing information, 5-44
Limit requests (Message Waiting Indicator dialog box), 5-17
Line busy retries (Call Me dialog box), 5-14
Line Speed (Bits per Second) (Serial Settings dialog box), 7-9
Location of Inband Reason Code (Inband tab, PBX integration), 7-13
Log Inband Packets (Inband tab, PBX integration), 7-13
Log Serial Packets (Serial General tab, PBX Integration), 7-8
logging in to messaging application server, 1-5
Login Failures before Lockout (Subscriber tab, TUI-VMD), 3-13
Login Failures report
  contents, 12-13
  generating, 12-12
  sample, 12-14
Logon to mailbox option (Caller Applications Editor), 11-34
Logons (User Mailbox Statistics report), 12-25
logs
  alarms, 15-1
  errors, 15-1
  events, 15-1
Long Distance Code (Access Codes dialog box), 5-21

M
Mailbox Monitor (MM) alarms, A-4
Mailbox Name
  (Login Failures report), 12-13
  (User Mailbox Statistics report), 12-24
Mailbox number
  (Caller Applications Editor), 11-47
  (Login Failures report), 12-13
Mailbox option (Caller Applications Editor), 11-29, 11-33
Main Menu Greeting: 1 through 3 (Language/Key
Association tab, Auto Attendant - VMD), 5-12
maintenance (MT) alarms, A-6
maintenance, preventive, 1-3
Make Call Prefix (Transfer/Outcall tab, PBX Configuration - VMD), 4-28
managing
port states, 14-12
MAS Corporate IP Address (IP Configuration tab, PBX integration), 7-24
MAS Fax Sender Server (Fax - VMD dialog box), 5-19
MAS MWI server (Message Waiting Indicator dialog box), 5-17
MAS Tracing Server Machine Name (General tab, Tracing System dialog box), 5-49
MAS, see messaging application server (MAS)
Max Concurrent Outgoing Calls (Advanced Fax dialog box), 5-23
Max MWI Sessions
(IP Configuration tab, PBX integration), 7-25
(MWI Settings dialog box), 7-18
(QSIG/SE tab, PBX integration), 7-20
Max no. retries (Advanced Fax dialog box), 5-23
Max Pages Per Fax (Advanced Fax dialog box), 5-23
Max Time to Wait for Serial and Remote Integration Data (sec) (General tab, PBX Integration dialog box), 7-7
Maximum Call Duration in Minutes (General tab, TUI-VMD), 3-5
Maximum Concurrent Calls (General tab, Telephony Interface dialog box)
IP H.323, 6-5
Maximum Continuous Tone before Hanging Up (ms) (Hangup Detection tab, PBX Configuration - VMD), 4-10
Maximum Inter-digit Gap (ms) (Inband tab, PBX integration), 7-12
Maximum Mailbox Prompt Length in Seconds (Message Timing tab, TUI-VMD), 3-10
Maximum number of concurrent calls (Call Me dialog box), 5-14
Maximum Number of Errors (Receptionist tab, TUI-VMD), 3-6
Maximum Number of No Entries (Receptionist tab, TUI-VMD), 3-7
Maximum Number of Remote Service Sessions (Avaya C-LAN tab, PBX integration), 7-23
(Serial General tab, PBX Integration), 7-8
Maximum requests per minute (Message Waiting Indicator dialog box), 5-17
Maximum Silence Before Hanging Up (ms) (Tone Detection (set emulation) tab, PBX Configuration - VMD), 4-30
Message Application Server Name (Add New Message Application Server dialog box), 8-19
Message Application Servers that support MWI (Message Waiting Indicator dialog box), 5-17
Message Server Number (Avaya C-LAN tab, PBX integration), 7-22
Message store full synchronization interval (Minutes) (Offline Access tab, Messaging - VMD), 5-37
message stores, configuring security, 5-28
message timing properties (TUI), configuring, 3-10
Message Waiting Indicator (MW) alarms, A-15
message waiting indicator (MW)
configuring, 5-16
configuring settings, 7-18
displaying properties, 5-16
enabling, 5-17
port groups, 8-12
messaging application server (MAS)
adding, 8-19
alarms
CM, A-3
MM, A-4
MT, A-6
MW, A-15
TS, A-17
VB, A-18
VS, A-23
basic information, 1-1
caller applications and adding, 11-44
configuring properties, 8-1
copying changes, 10-20
display language, 1-5
home server, 2-5
logging in, 1-5
monitoring performance, 14-4
opening applications, 1-5
removing, 8-20
selecting for port state viewing, 14-9
selecting for the first time, 8-3
system administration tools, 1-2
messaging, configuring, 8-4
Microsoft Windows Performance Monitor, 1-4
Minimum Duration for Drop in Loop Current (ms) (Hangup Detection tab, PBX Configuration - VMD), 4-10
Minimum Message Length in Seconds (Message Timing tab, TUI-VMD), 3-11
Minimum Password Length (Subscriber tab, TUI-VMD), 3-12
MM alarms, A-4
MM IMAPI 1, A-4
MM PERF 17, A-4
MM PERF 18, A-5
MMS counters, 14-5
MMS MWI counters, 14-7
MMS performance counters, 14-5
MMS Service counters, 14-5
MMS Voice Port counters, 14-5
Modem setup (General tab, Serviceability - MAS dialog box), 8-17
Modular Messaging (MM) services
starting, C-3
stopping, C-2
monitoring
about, 14-2
performance of MASs, 14-4
ports on MASs using Port Monitor, 14-8
tools, 14-2
using Performance Monitor, 14-3
monitoring tools
about, 1-4
Microsoft Windows Performance Monitor, 1-4
Port Monitor, 1-4
Morning prompt (Time of Day tab, Auto Attendant - VMD), 5-10
morning prompts
about, 10-4
configuring, 10-24
MSB Key (ACD tab, Telephony Interface dialog box), 6-8
MSB Lamp (ACD tab, Telephony Interface dialog box), 6-8
MT ABS_PROC 1, A-6
MT ABS_PROC 2, A-7
MT ABS_PROC 3, A-7
MT ABS_PROC 4, A-8
MT ABS_PROC 5, A-9
MT ABS_PROC 6, A-10
MT ABS_PROC 7, A-10
MT ALARM_ORIG 0, A-11
MT ALARM_ORIG 1, A-11
MT alarms, A-6
MT PERF 10, A-13
MT PERF 19, A-13
MT PERF 6, A-12
MW alarms, A-15
MW PERF 15, A-15
MW PERF 16, A-15
MWI Off (QSIG/SE tab, PBX integration), 7-20
MWI On (QSIG/SE tab, PBX integration), 7-20
MWI Settings dialog box, 7-18
MWI, see message waiting indicator (MWI)

N
Name
(Caller Application Editor), 11-23
NEC properties, 7-10
NEC-2400 (Serial NEC/Ericsson/DMID tab, PBX integration), 7-10
Network Management Station (SNMP tab, Serviceability - VMD), 5-41
Next node option (Caller Application Editor), 11-33
Node option (Caller Application Editor), 11-30
None (PBX type) (General tab, PBX Integration dialog box), 7-6
Normal Messages (Advanced Fax dialog box), 5-23
Notes (Avaya C-LAN tab, PBX integration), 7-23
Number Attempts Rotary Transfer to Busy Receptionist (Receptionist tab, TUI-VMD), 3-6
Number of Calls Placed that Were Not Answered (System Usage report), 12-20
Number of Calls Placed to Busy Extensions (System Usage report), 12-20
Number of Calls that Got Connected (System Usage report), 12-20
Number of Connected Outgoing Calls Excluding Calls to Clients (System Usage report), 12-20
Number of Days before Events expire (Operation History Collection tab, Tracing System dialog box), 5-50
Number of Digits in a Mailbox (General tab,
Number of Failed Calls to Fax Gateway (System Usage report), 12-19
Number of Failed Outgoing Calls Excluding Calls to Clients (System Usage report), 12-20
Number of Incoming Calls (System Usage report), 12-19
Number of Instances (Usage tab, Port Groups dialog box), 8-15
Number of Invalid Mailbox Numbers Entered (Login Failures report), 12-13
Number of Ports (Analog tab, Telephony Interface dialog box), 6-3
Number of Previous Passwords Disallowed (Subscriber tab, TUI-VMD), 3-13
Number of Retries when No Answer (Intercom Paging tab, PBX Configuration - VMD)
   analog, 4-12
   QSIG, 4-24
   set emulation, 4-32
Number of Retries when Paging System is Busy (Intercom Paging tab, PBX Configuration - VMD)
   analog, 4-11
   QSIG, 4-23
   set emulation, 4-31
Number of Successful Calls to Fax Gateway (System Usage report), 12-19
Number of Times Users Logged On (System Usage report), 12-19
Number Plan (Outgoing Calls tab, PBX Configuration - VMD)
   IP H.323, 4-15
   QSIG, 4-22
Number Type (Outgoing Calls tab, PBX Configuration - VMD)
   IP H.323, 4-15
   QSIG, 4-21

O
Offhook port state, 14-10
offline access to messages
   about, 5-35
   configuring, 5-36
Offline Message Store (Offline Access tab, Messaging - VMD), 5-36
Open (Time/Greeting tab, TUI-VMD), 3-8
Open All Day (Time/Greeting tab, TUI-VMD), 3-8
opening
caller applications, 11-41
MAS applications, 1-5
sessions (Operation History Viewer), 13-17
Visual Voice Editor, 10-8
Voice Mail System Configuration
Index

integration), 7-25
Paging Wait Time (sec) (Intercom Paging tab, PBX Configuration - VMD)
    analog, 4-12
    QSIG, 4-24
    set emulation, 4-32
Parity (Serial Settings dialog box), 7-9
Pause before Digits (ms) (General tab, PBX Configuration - VMD), 4-5
Pause before Inband Digits (ms) (Inband tab, PBX integration), 7-12
Pause before Request String (ms) (Inband tab, PBX integration), 7-14
Pause Interval for Comma in Dial String (ms) (General tab, PBX Configuration - VMD), 4-5
PBX integration
    about, 7-2
    configuring, 7-1
    general properties, 7-6
    selecting types, 7-5
PBX Integration dialog box
    General tab, 7-6
    Serial NEC/Ericsson/DMID tab, 7-10
PBX IP Address (IP Configuration tab, PBX integration), 7-24
PBX types
    adding, 9-4
    removing, 9-5
PBXs
    about configuring properties, 4-2
    analog properties
        Call Transfer tab, 4-7
        configuring, 4-4
        General tab, 4-5
        Hangup Detection tab, 4-10
call transfer codes, 4-9
    configuring, 4-1
    intercom paging properties
        analog, 4-11
        QSIG, 4-23
        set emulation, 4-31
    IP H.323 properties, configuring, 4-13
    outgoing call properties
        (IP H.323) Outgoing Calls tab, 4-15
        (QSIG) Outgoing Calls tab, 4-21
    QSIG properties
        configuring, 4-16
        General tab, 4-18
    set emulation properties
        configuring, 4-25
        General tab, 4-26
        Transfer/Outcall tab, 4-27
tone detection properties
    (QSIG) Transfer/Outcall tab, 4-20
    (set emulation) Tone Detection tab, 4-30
    transfer/outcall properties
        (IP H.323) Transfer/Outcall tab, 4-14
        (QSIG) Transfer/Outcall tab, 4-19
PC client applications
    port groups, 8-12
PC Clients (Usage tab, Port Groups dialog box), 8-15
PCM CCITT A-Law, 10-7
PCM CCITT Mu-Law, 10-7
peer servers
    about, 8-4
    configuring primary, 8-5
Percentage (Port Statistics report), 12-16
Percentage of Failed Logon Attempts (Basic Metrics report), 12-28
Percentage of Incoming Calls resulting in Messages (Basic Metrics report), 12-28
Percentage of Subscriber Logon Failures (Basic Metrics report), 12-28
Performance Monitor, 14-2
    counters, 14-3
    using, 14-3
Performance object (Performance Monitor), 14-4
Permit Callers to Access Directory Services (Caller tab, TUI-VMD), 3-14
Permit Callers to Leave Multiple Messages (Caller tab, TUI-VMD), 3-14
Phone number (General tab, Serviceability - MAS dialog box), 8-16
Ping surround (SNMP tab, Serviceability - VMD), 5-42
Playback Volume
    (Analog tab, Telephony Interface dialog box), 6-3
    (General tab, Telephony Interface dialog box)
        IP H.323, 6-5
        QSIG or set emulation, 6-6
    playing customized prompts, 10-15
    Playing port state, 14-11
Port
    (General tab, Telephony Interface dialog box)
        IP H.323, 6-5
        QSIG or set emulation, 6-6
    (IP Configuration tab, PBX integration), 7-25
    Port Disable Key (General tab, PBX Configuration - VMD), 4-26
    Port Field Length (Serial NEC/Ericsson/DMID tab, PBX integration), 7-10
    Port fields (Analog tab, Telephony Interface dialog box), 6-3
    Port Group
        (General tab, Port Groups dialog box), 8-13
        Call Me (Usage tab, Port Groups dialog
box), 8-15
FAX (Usage tab, Port Groups dialog box), 8-15
PC Clients (Usage tab, Port Groups dialog box), 8-15
Telephone User Interface (Usage tab, Port Groups dialog box), 8-15
Port Group Members (General tab, Port Groups dialog box), 8-13
Port Group Name
(IP Configuration tab, PBX integration), 7-25
(MWI Settings dialog box), 7-18
(QSIG/SE tab, PBX integration), 7-20
Port Group Usage (General tab, Port Groups dialog box), 8-13
port groups
about, 8-12
adding, 8-14
Call Me, 8-12
configuring, 8-11
  general properties, 8-13
  usage properties, 8-15
configuring for MWI, 7-20
configuring QSIG and set emulation properties, 7-20
fax, 8-12
guidelines for usage, 8-11
MWI, 8-12
PC client applications, 8-12
telephone user interface, 8-12
Port Groups dialog box
  General tab, 8-13
  Usage tab, 8-15
Port Monitor
  about, 14-2
  using, 14-8
Port Number (Port Statistics report), 12-16
port states
  considerations for managing, 14-12
  disabling, 14-12
  disabling immediately, 14-12
  enabling, 14-12
  managing, 14-12
  viewing, 14-10
  viewing for multiple MASs, 14-9
  viewing for single MAS, 14-9
Port Statistics report
  contents, 12-16
  generating, 12-15
  sample, 12-17
ports
  disabling, 14-13
  disabling immediately, 14-15
  enabling, 14-14
monitoring using Port Monitor, 14-8
testing with Dialogic lines, 14-16
Pressed # to Log On (System Usage report), 12-19
preventive maintenance, 1-3
Primary Directory Server (General tab, Messaging dialog box), 8-5
Primary Id (Analog tab, Telephony Interface dialog box), 6-4
Primary Remote Server Name (Remote tab, PBX integration), 7-19
printing reports, 12-34
private branch exchange, see PBXs
Product identifier (General tab, Serviceability - VMD), 5-40
Prompt (Holiday tab, Auto Attendant - VMD), 5-9
prompts
  about customizing, 10-2
  adjusting amplitude and silence, 10-18
  afternoon, 10-4
  announcement, 11-37
  application, 11-37
  Auto Attendant Main Menu, 10-4
close, 10-4
configuring
  afternoon, 10-24
  Auto Attendant Main Menu, 10-22
close, 10-24
  custom language selection
    greeting, 10-25
evening, 10-24
  holiday, 10-23
  morning, 10-24
time of day, 10-24
creating working copy of prompts file, 10-6
custom language selection greeting, 10-5
customizing, 10-1
editing customized, 10-16
evening, 10-4
  holiday, 10-5
  morning, 10-4
  playing customized, 10-15
  recording
    customized, 10-13
    using Caller Applications Editor, 11-37
setting up customized, 10-11
time of day, 10-4
Provided by runtime option (Caller Applications Editor), 11-33
Q
QSIG (PBX type) (General tab, PBX Integration di-
Index

alog box), 7-7
QSIG/SE tab (PBX integration), 7-20
Quick Message (System Usage report), 12-21

R
RealSpeak
rsude.exe dictionaries, 8-8
receptionist properties (TUI), configuring, 3-6
recording
announcements in Caller Applications Editor, 11-37
customized prompts, 10-13
prompts in Caller Applications Editor, 11-37
Recording port state, 14-11
recordings
exporting, 10-28
importing, 10-27
re-deployment of caller applications, 11-54
Release Code for Intercom Paging (Intercom Paging tab, PBX Configuration - VMD)
analog, 4-11
QSIG, 4-23
set emulation, 4-31
Remote (PBX type) (General tab, PBX Integration dialog box), 7-7
remote properties (PBX integration), 7-19
Remote tab (PBX integration), 7-19
Remove Group (General tab, Port Groups dialog box), 8-13
removing
caller applications deployed in voice mail domains, 11-53
MASs, 8-20
PBX types, 9-5
renaming
attendant schedules, 3-17
voice mail domains, 9-3
Repeat Intercom Paging Phrase (Intercom Paging tab, PBX Configuration - VMD)
analog, 4-11
QSIG, 4-23
set emulation, 4-31
Reporting Tool, running, 12-3
reporting tools
about, 1-4
opening, 1-5
reports
about, 12-2
Basic Metrics, 12-27
Basic Metrics report sample, 12-29
canceling generation, 12-8
enabling transaction generation, 12-4
export formats supported, 12-33
exporting, 12-31
generating, 12-1
Hourly Statistics, 12-9
Hourly Statistics report sample, 12-11
listed, 12-2
Login Failures, 12-12
Login Failures report sample, 12-14
moving between pages, 12-30
Port Statistics, 12-15
Port Statistics report sample, 12-17
printing, 12-34
selecting data sources, 12-5
specifying options, 12-8
System Usage, 12-18
System Usage report sample, 12-22
User Mailbox Statistics, 12-23
User Mailbox Statistics report sample, 12-26
zooming in, 12-30
Request String Supported (Inband tab, PBX integration), 7-14
resolved alarms log
about, 15-2
displaying, 15-5
Retrieve Call (Transfer/Outcall tab, PBX Configuration - VMD), 4-27
Retry Period when Connecting to a Message Application Server (secs) (Operation History Collection tab, Tracing System dialog box), 5-50
Return trap (SNMP tab, Serviceability - VMD), 5-41
Right Alignment of Digits in a Field (Inband tab, PBX integration), 7-14
Ringing In port state, 14-11
Ringing Out port state, 14-11
RNA (System Usage report), 12-21
rsude.exe, 8-8
running
Caller Applications Editor, 11-11
Reporting Tool, 12-3
Visual Voice Editor, 10-8

S
saving
caller applications, 11-41
sessions (Operation History Viewer), 13-16
Scansoft RealSpeak dictionaries, 8-8
schedule grid
attendant schedules, 3-18
Caller Applications Editor, 11-32
Search Entire String for Reason Code (Inband tab, PBX integration), 7-12
Secondary Id (Analog tab, Telephony Interface dialog box), 6-4
Secondary Remote Server Name (Remote tab, PBX
integration), 7-19
Seconds to Fast Forward Message when Fast Forward Button Pressed (Message Timing tab, TUI-VMD), 3-10
Seconds to Pause Message when Pause Button Pressed (Message Timing tab, TUI-VMD), 3-10
Seconds to Rewind Message when Rewind Button Pressed (Message Timing tab, TUI-VMD), 3-10
Select counter from this computer (Performance Monitor), 14-4
Select counters from list (Performance Monitor), 14-4
Selected Hours (Time/Greeting tab, TUI-VMD), 3-8
Selecting
  audio data range, 10-16
  data sources for operation history events, 13-5
  data sources for reports, 12-5
Send alarm at this level or higher (General tab, Serviceability - VMD), 5-40
Send alarms using (General tab, Serviceability - VMD), 5-39
Send message action (Caller Application Editor) assigning, 11-33
Send notification when all alarms are cleared (General tab, Serviceability - VMD), 5-40
Sequence Number (Inband Protocol Settings dialog box), 7-17
Serial (PBX type) (General tab, PBX Integration dialog box), 7-6
  serial general properties, 7-8
Send alarm at this level or higher (PBX Integration Server, Serviceability - VMD), 5-40
Serial General tab (PBX integration), 7-8
Serial NEC/Ericsson/DMID properties, 7-10
Serial NEC/Ericsson/DMID tab (PBX integration), 7-10
Server Name (Port Statistics report), 12-16
serviceability configuring
  MASs, 8-16
  voice mail domains, 5-38
  general alarm notification settings, 5-39
  SNMP alarm notification settings, 5-41
Send message notification (Caller Application Editor) assigning, 11-33
Serial NEC/Ericsson/DMID properties, 7-10
Set Emulation (PBX type) (General tab, PBX Integration dialog box), 7-7
Setting defaults for new sessions (Operation History Viewer), 13-22
Setting up
  audio devices for recording prompts (Visual Voice Editor), 10-12
caller applications, 11-17
Serviceability - MAS dialog box, General tab, 8-16
Serviceability - Voice Mail Domain dialog box
  General tab, 5-39
  SNMP tab, 5-41
session files, 13-2
sessions (Operation History Viewer)
  about, 13-2
  changing properties, 13-18
  creating, 13-8
  displaying properties, 13-18
SNMP (General tab, Serviceability - VMD), 5-39
  alarm notification settings, 5-41
SNMP tab, Serviceability - Voice Mail Domain dialog box, 5-41
specifying options for reports, 12-8
Start Delay for Call Progress (Call Transfer tab, PBX Configuration - VMD), 4-8
  (Transfer/Outcall tab, PBX Configuration - VMD)
  set emulation, 4-27
Start of Afternoon (Time/Greeting tab, TUI-VMD), 3-9
Start of Evening (Time/Greeting tab, TUI-VMD), 3-9
Start of Morning (Time/Greeting tab, TUI-VMD), 3-9
starting
  Caller Applications Editor, 11-11
  Modular Messaging (MM) services, C-3
  Operation History Viewer, 13-3
  Visual Voice Editor, 10-8
  Voice Mail System Configuration application, 5-4
Starting Position (Inband Protocol Settings dialog box), 7-17
Stop Bits (Serial Settings dialog box), 7-9
Stop straight away (General tab, Serviceability -
VMD), 5-40

stopping Modular Messaging (MM) services, C-2
Subscriber (System Usage report), 12-21
Subscriber Administration access control list, 5-27
Subscriber Logons (TUI) as a percentage of Incoming Calls (Basic Metrics report), 12-28
Subscriber Logons (TUI) as a percentage of Logon Attempts (Basic Metrics report), 12-28
Subscriber Options tool, 2-6
subscriber properties (TUI), configuring, 3-12
Suppress alarm notifications (General tab, Serviceability - VMD), 5-39
Swap access key with key (Caller Application Editor), 11-25
Switch Host Address (Avaya C-LAN tab, PBX integration), 7-22
Switch Number (Avaya C-LAN tab, PBX integration), 7-22
Synchronize offline messages with remote store (Offline Access tab, Messaging - VMD), 5-36
syntax for dialing strings, 4-29
System Administration access control list, 5-26
system administration tools
about, 1-2
caller properties, 3-14
configuring, 3-2
dial by name properties, 3-19
greeting and time properties, 3-8
message timing properties, 3-10
port groups, 8-12
receptionist properties, 3-6
subscriber properties, 3-12
time and greeting properties, 3-8
telephony interface
about, 6-2
configuring, 6-1
analog properties, 6-3
IP H.323 properties, 6-5
QSIG properties, 6-6
set emulation properties, 6-6
Tenant Number (Serial NEC/Ericsson/DMID tab, PBX integration), 7-10
Termination action (Caller Application Editor)
assigning, 11-34
testing Dialogic lines, 14-16
text-to-speech configuring, 8-6
configuring general properties, 8-7
customization dictionaries Scansoft RealSpeak, 8-8
customizing, 8-6
Scansoft RealSpeak (all languages), 8-8
distributing licenses across MASs, 5-45
Time All Ports Busy (seconds) (System Usage report), 12-19
Time All Text-to-Speech Ports Busy (seconds) (System Usage report), 12-19
Time All Voice Ports Simultaneously Busy (Port Statistics report), 12-16
time and greeting properties (TUI)
configuring, 3-8
Time Busy (seconds) (Port Statistics report), 12-16
time of day prompts, 10-4
configuring, 10-24
time of day properties (automated attendant), 5-10
Time Periods Starting (Hourly Statistics report), 12-10
Time Port Availability Below Optimum (Port Statistics report), 12-16
Time to Generate Transactions (Transaction Generation tab, Tracing System dialog box), 5-51
Time to store empty mailboxes (Hours) (Offline Access tab, Messaging - VMD), 5-37
Time to store offline messages (Hours) (Offline Access tab, Messaging - VMD), 5-37

T

TCP Port (Avaya C-LAN tab, PBX integration), 7-23
Telephone User Interface - Voice Mail Domain dialog box
Attendant Schedules tab, 3-16
caller properties, 3-14
configuring, 3-2
dial by name properties, 3-19
greeting and time properties, 3-8
message timing properties, 3-10
port groups, 8-12
receptionist properties, 3-6
subscriber properties, 3-12
time and greeting properties, 3-8

Index
cess tab, Messaging - VMD), 5-37
tone detection properties
PBX QSIG telephony, 4-20
PBX set emulation telephony, 4-30
toolbar icons, Caller Applications Editor, 11-14
tools
  diagnostic, 1-4
  Microsoft Windows Performance Monitor, 1-4
  monitoring, 1-4, 14-2
  Operation History Viewer, 1-4
  Port Monitor, 1-4
  Reporting Tool, 1-4
  Subscriber Options, 2-6
  subscriber support, 2-6
  system administration, 1-2
Total (Incoming Calls Xferred to Ext) (User Mailbox Statistics report), 12-24
Total Failed Logins (Login Failures report), 12-13
Total Incoming Calls (Basic Metrics report), 12-28
Total Number of Incoming Calls (Port Statistics report), 12-16
Total Number of Outgoing Calls, 12-16
Total Number of Outgoing Calls Excluding Calls To Clients (System Usage report), 12-20
Total Subscriber Logon (TUI) Attempts (Basic Metrics report), 12-28
Total Subscriber Logon (TUI) Successes (Basic Metrics report), 12-28
Total UM Messages Processed (Basic Metrics report), 12-28
tracing files, configuring size, 8-18
tracing server (TS) alarms, A-17
tracing system
  configuring, 5-48
  general properties, 5-49
  operation history database properties, 5-50
  transaction database properties, 5-51
Tracing System dialog box
  General tab, 5-49
  Operation History Collection tab, 5-50
  Transaction Generation tab, 5-51
Transaction Expiry: Number of Days before Transactions Expire (Transaction Generation tab, Tracing System dialog box), 5-51
transaction generation, enabling, 12-4
Transfer action (Caller Application Editor) assigning, 11-29
Transfer Calls to Receptionist after Maximum Errors (Receptionist tab, TUI-VMD), 3-7
Transfer Completion Code (Call Transfer tab, PBX Configuration - VMD), 4-7
Transfer Failed port state, 14-10
Transfer Initiate (Inband Protocol Settings dialog box), 7-16
Transfer Invalid Mailboxes after Business Hours (Receptionist tab, TUI-VMD), 3-7
Transfer Invalid Mailboxes during Business Hours (Receptionist tab, TUI-VMD), 3-7
Transfer mode
  (Call Transfer tab, PBX Configuration - VMD), 4-7
  (Transfer/Outcall tab, PBX Configuration - VMD)
    IP H.323, 4-14
    QSIG, 4-19
    set emulation, 4-27
Transfer Prefix Code (Call Transfer tab, PBX Configuration - VMD), 4-7
Transfer Release Code when Busy (Call Transfer tab, PBX Configuration - VMD), 4-7
Transfer Release Code when No Answer (Call Transfer tab, PBX Configuration - VMD), 4-7
Transfer Release Code when Reject (Call Transfer tab, PBX Configuration - VMD), 4-8
Transfer to Mailbox (System Usage report), 12-21
Transfer to: Mailbox Number (Attendant Main Menu Editor tab, Auto Attendant - VMD), 5-8
transferralcall properties
PBX IP H.323 telephony, 4-14
PBX QSIG telephony, 4-19
PBXs
  set emulation, 4-27
troubleshooting deployed caller applications, 11-55
Trunk Code (Access Codes dialog box), 5-21
TS alarms, A-17
TS PERF 13, A-17
TS PERF 14, A-17
TTS customization tool (Scansoft RealSpeak), 8-8
TUI, see telephone user interface (TUI)

U
UDP Port Range (IP Configuration tab, PBX integration), 7-25
Unknown Calls (System Usage report), 12-20
Urgent Messages (Advanced Fax dialog box), 5-23
Use native fax support (Fax - VMD dialog box), 5-19
User Mailbox Statistics report
  contents, 12-24
  generating, 12-23
  sample, 12-26
using
  Performance Monitor, 14-3
  Port Monitor, 14-8
Index

V
VB alarms, A-18
VB VB 1, A-18
VB VB 1a, A-18
VB VB 202, A-19
VB VB 203, A-19
VB VB 204, A-20
VB VB 205, A-20
VB VB 209, A-21
VB VB 210, A-21
VB VB 212, A-21
VB VB 999, A-22
Via QuickMsg (User Mailbox Statistics report), 12-24
Via Xfer to MB (User Mailbox Statistics report), 12-24
viewing
alarm logs, 15-1
error logs, 15-1
event logs, 15-1
languages installed on MAS, 8-10
licensing information, 5-44
operation history events, 13-1
port states, 14-10
port states on MAS, 14-9
sessions (Operation History Viewer), 13-13
status of multiple MASs, 14-9
Visual Voice Editor
about, 1-2
adjusting amplitude and silence in prompts, 10-18
comment view, 10-10
copying sections of prompts, 10-17
cutting sections of prompts, 10-17
edit commands, 10-17
editing customized prompts, 10-16
exporting recordings, 10-28
importing recordings, 10-27
main toolbar, 10-9
multimedia recording setup, 10-12
pasting content into prompts, 10-18
playing customized prompts, 10-15
prompt view, 10-9
recording customized prompts, 10-13
screen areas and controls, 10-8
selecting range of audio data, 10-16
setting up audio devices, 10-12
starting, 10-8
status bar, 10-10
telephone recording setup, 10-12
tips for viewing, 10-9
trimming prompts, 10-18
waveform infoobar, 10-9
waveform toolbar, 10-9
waveform view, 10-10
Voice Browser (VB) alarms, A-18
Voice Mail Domain Name
 Rename Voice Mail Domain dialog box, 9-3
voice mail domains, 5-1
 about, 5-2
 configuring security, 5-25
 deploying caller applications, 11-44
 managing, 9-2
 removing deployed caller applications from, 11-53
 renaming, 9-3
Voice Mail System Configuration
 starting, 5-4
voice mail system configuration, 2-1
 about, 2-2
Voice Mail System Configuration application
 about, 1-2
 opening, 2-3
 window sample and description, 2-3
voice server (VS) alarms, A-23
VS alarms, A-23
VS COM 1, A-23
VS COM 2, A-24
VS DOMEX 1, A-24
VS EXCEPTION 1, A-25
VS EXCEPTION 2, A-26
VS EXCEPTION 3, A-26
VS FEDB 1, A-27
VS FEDB 2, A-27
VS FEDB 3, A-28
VS MAILBOX 1, A-29
VS MSS 1, A-29
VS MWI 1, A-30
VS OCTELNET 1, A-31
VS OPHIST 1, A-32
VS PERF 1, A-32
VS PERF 11, A-34
VS PERF 12, A-35
VS PERF 2, A-33
VS PERF 3, A-33
VS PERF 4, A-34
VS PORT 0, A-35
VS PORT 1, A-36
VS PORT 2, A-36
VS PORT 3, A-37
VS PORT 4, A-37
VS PORT 5, A-38
VS RHETORIX 1, A-38
VS SERVICE 6, A-39
VS SPOOL 1, A-40
VS SWLINK 1, A-40
VS VOICE 1, A-41
VS VOICE 2, A-42
VS VOICE 3, A-42
VS VOICE 4, A-42

W
Wait for ports to become idle (General tab, Service-